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Civil 3D interface

Civil 3D interface introduction

Last updated: 2017-12-01

Total video time: 21:39

Workspace components

c3d-intrfc-intro-01.mp4 5:13

 l WisDOT Civil 3D Environment Dialog box
 l  

 l Civil 3D 2016 Getting Started
 l Training documentation (PDF format)

 l Read Latest Updates
 l Open WisDOT Civil 3D Training Index

 l Application Menu Browser 
 l Quick Access Toolbar 
 l Ribbon

 l Tabs and Panels
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 l Drawing Tabs
 l Toolspace

 l Prospector
 l Settings
 l Survey
 l Toolbox

 l Status Bar
 l Toolbars

Application menu browser 

Exercise files: c3d-intrfc-data-c3d16.zip

ProjectID\SheetsPlan\STH25-XS.dwg

c3d-intrfc-intro-02.mp4 3:52

 l General File Functions
 l New, Open, Save, Save As, Export, Publish, Print, Drawing Utilities, and Close 
 l Command Search
 l Recently Opened Files or Currently Open Files List

Quick Access toolbar

c3d-intrfc-intro-03.mp4 4:16

 l Typical program commands
 l New, Open, Save, Plot, Undo/redo 
 l Workspace and workspace settings
 l  Can add your own commands.

 o Add More Commands
 o Right-click icon Add to Quick Access Toolbar 

 l Show Menu Bar
 l Show below ribbon

Toolbars

c3d-intrfc-intro-04.mp4 1:05

 l Held icons prior to ribbon
 l Transparent Commands and filters only ones open by default 

Command line
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c3d-intrfc-intro-05.mp4 2:54

 l For typed versions of commands
 l Input settings
 l Palette can be docked at the top or the bottom of screen 
 l Palette can be moved to another screen
 l View and cycle through previous commands
 l Transparency

Status bar (Icons)

c3d-intrfc-intro-06.mp4 2:43

 l Icons…
 l Function Key Alternatives
 l Customization

Drawing scale

Exercise files: c3d-intrfc-data-c3d16.zip

ProjectID\BaseData\Mapping\ExistSurface.dwg

c3d-intrfc-intro-07.mp4 1:33

 l Always draw at 1” = 1”
 l Drawing Scale controls size of text
 l And space between section views in array

Ribbons and tabs

Last updated: 2017-12-01

Total video time: 5:56

Exercise files: c3d-intrfc-data-c3d16.zip

ProjectID\SheetsPlan\STH25-XS.dwg

c3d-intrfc-rbn-01.mp4 5:56

Tabs for grouping of command panels

Home, Insert, Annotate, Modify, Analyze, View, Output, Survey, ... 

Minimize Arrow icon
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 l Minimize to Panel Buttons 
 l Minimize to Panel Tiles 
 l Minimize to Tabs
 l Show Full Ribbon

Contextual Ribbons

 l Specific to selected object
 l Launchpad commands for selected object

Panels for grouping of similar command icons Icons for starting commands

Panel Pull-downs for less frequently used commands

Panels can be dragged off ribbons and placed back.

Toolspace

Last updated: 2017-12-01

Total video time: 25:32

Toolspace tabs

c3d-intrfc-tlspc-01.mp4 3:21

 l Prospector 
 l Settings 
 l Survey 
 l Toolbox

Preview window

Active Drawing View 

Master View

Drawing objects access & data shortcuts

c3d-intrfc-tlspc-02.mp4 5:15

Drawing objects

 l Points
 l Point Groups
 l Point Clouds
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 l Surfaces
 l Alignments (Profiles and Sections)
 l Sites (Grading and Parcels)
 l Catchments
 l Pipe Networks (including Interference objects)
 l Pressure Networks
 l Corridors
 l Assemblies
 l Intersections
 l Survey
 l View Frame Groups

Data Shortcuts

 l Surfaces
 l Alignments (and Profiles)
 l Pipe Networks
 l Pressure Networks
 l View Frame Groups

Active Drawing View/MasterView

c3d-intrfc-tlspc-03.mp4 3:07

 l Master view
 l Active Drawing Settings View
 l Active Drawing Labels Only View
 l Labels Only View

Object Style Defaults

c3d-intrfc-tlspc-04.mp4 2:24

Managing objects

 l Right-click on object names for Properties or Edit Current Style

Styles for each object

 l Object styles
 l Label styles
 l Table styles
 l Commands
 l Other settings - criteria or rules
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Setting default styles

 l Right-click on object collection name (header) 
 l Edit Feature Settings
 l Drawing Settings and Object Defaults

Command Settings

c3d-intrfc-tlspc-05.mp4 4:35

Commands

 l Macros for creation settings
 l Edit Command Settings

Overall drawing settings

 l Right-click on drawing name > Edit drawing settings
 o Units and Zone (coordinates) 

 o WisDOT specific coordinate systems
 o Transformation (coordinates) 
 o Object Layer defaults 
 o Abbreviations (for labels)
 o Ambient Settings (drawing settings)

Survey database access

Exercise files: c3d-intrfc-data-c3d16.zip

ProjectID\SheetsPlan\STH25-XS.dwg

c3d-intrfc-tlspc-06.mp4 4:16

 l External to any drawing
 l Survey Databases (per project) 
 l Equipment Database

 o Survey equipment data to aid analysis 
 l Figure Prefix Database

 o Point codes that have linework 
 o Manages the linework style, layer

 l Linework Code Sets
 o Field codes that start linework

Toolbox
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Exercise files: c3d-intrfc-data-c3d16.zip

ProjectID\Design\Corridors\Corridor-STH25-4thAve.dwg

c3d-intrfc-tlspc-07.mp4 2:31

Toolbox - extra functionality 

 l Report Manager
 l Subscription Extension Manager
 l Miscellaneous Utilities
 l WisDOT Toolbox

 l WisDOT Macros
 l WisDOT Reports
 l Survey File Conversion

 l Productivity Packs
 l Autodesk Labs tools (extensions)

To access tools

 l Right-click and choose Execute

Command shortcuts and hotkeys

Last updated: 2017-12-01

Total video time: 9:27

Exercise files: c3d-intrfc-data-c3d16.zip

ProjectID\SheetsPlan\STH25-XS.dwg

c3d-intrfc-cmnd-shrtct-htky-01.mp4 9:27

All commands have a typed alternative

Some typed commands are quicker than switching ribbon tabs 

Tip: This is not a comprehensive list – just some helpful ones

Hotkeys

Esc = Exit a command                 

Spacebar = Enter

F1 = Opens Help to topic you are working with

F2 = Expands command line to a window
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F3 = OSNAPS toggle

Shift + Right-Click – Temporary OSNAP Overrides

Shift + Spacebar = selection cycling

Ctrl + Left-click select for some labels

Ctrl + 9 = toggles Command Line palette

Ctrl + 3 = toggles tool palettes

Command line commands

Z ENTER E ENTER = Zoom Extent (“Fit View”)

Z ENTER ENTER = "real-time" zoom

P ENTER = Pan

DELETE = Erase

E = Erase

PL for polyline

PEfor polyline edit

DI for Distance command (slightly different than ribbon version) 

FILEDIA, setting should = 1

CMDDIA, setting, should =1 

GEOMARKERVISIBLITY = 0

OSNAPZ = if 1 then snaps to 3D objects (x/y/z), if 0 then snaps to X/Y but ignores elevation z

OPTIONS = opens OPTIONS dialog box

XREF = opens Xreference manager dialog box

OOPS = Brings back last deleted selection

REA = Regenerates graphics

Basic mouse operations

Last updated: 2017-12-01

Total video time: 4:56
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Exercise files: c3d-intrfc-data-c3d16.zip

ProjectID\SheetsPlan\STH25-XS.dwg

c3d-intrfc-basc-mous-01.mp4 4:56

Exercise file: STH25-XS.dwg

Three-button wheel mouse 

Click = select

Right-click = context menus

Wheel operation

 l Roll forward/backward = zoom in/out 
 l Click wheel = pan
 l Double-click wheel = zoom extents

Keyboard & Mouse clicks

Shift + Right-click = Temporary OSNAPS menu 

 Shift + wheel-button = Orbit

Ctrl + Click for some objects allows individual label editing

Shift + Click  = remove from selection set 

MBUTTONPAN

 l = 1, pan
 l = 0, Temporary OSNAP menu

Options > User Preference tab > Right-click Customization button  = Right-click cus-
tomization

Context sensitive

Repeat Last command

Steering wheel control

Last updated: 2017-12-01

Total video time: 3:10

Exercise files: c3d-intrfc-data-c3d16.zip

ProjectID\SheetsPlan\STH25-XS.dwg
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c3d-intrfc-strng-whl-01.mp4 3:10                 

Navigation controls that follow your cursor 

Sections of the wheel do different tasks

 l Zoom
 l Pan
 l Orbit
 l Center

Open through the Navigation Bar

Different sized steering wheels depending on your preference 

Set pivot point for orbits

Status bar

Last updated: 2017-12-01

Total video time: 8:31

Exercise files: c3d-intrfc-data-c3d16.zip

ProjectID\SheetsPlan\STH25-XS.dwg

c3d-intrfc-status-bar-01.mp4 8:31

Status bar

 l Icons…
 l Function Key Alternatives 
 l Right-Click Settings

Status bar keys

 l Constraints Ctrl+Shift+I
 l Snap/Grid F9/ F7
 l Ortho Snap F8
 l Polar Track F10
 l OSNAP F3
 l 3D OSNAP F4
 l Object Snap Tracking F11
 l Dynamic UCS F6
 l Dynamic Input F12
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 l Lineweight 
 l Transparency
 l Quick Properties Ctrl+Shift+P
 l Selection Cycling Ctrl+W
 l Annotation objects

File open/save/new

Last updated: 2017-12-01

Total video time: 5:32

c3d-intrfc-fil-opn-sav-new-01.mp4 5:32

All new files start with a “template” (.DWT) file 

DWT brings settings into new drawings

Similar to “seed” files

AutoCAD settings like text styles, linestyles, etc. 

Civil 3D specific object and label styles

WisDOT provides four Startup templates for new drawings 

 l wisdot16.dwt
 l wisdot16-county-map-import.dwt
 l wisdot16-plat.dwt
 l wisdot16-survey.dwt

Use the New command 

 1. Application Menu Browser
 2. Browser starts at DWT location
 3. Browse and choose the appropriate template 
 4. Save the new DWG in location and with name

QNEWcommand

 l In Quick Access Toolbar
 l Begins file with default template

Default Template is set at Options > Files > Template Settings > Default Template File Name 
for QNEW

WisDOT Sheets ribbon tab
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 l Startup Templates in tool palette
 l Sheet Templates in tool palette

WisDOT Standards ribbon tab

 l Startup Templates in tool palette

WisDOT Design ribbon tab

 l Startup Templates in tool palette

File/model/layout tabs

Last updated: 2012-09-01

Total video time: 5:32

Exercise files: c3d-intrfc-data-C3D12.zip

File, model & layout tabs

c3d-intrfc-fil-mdl-lyout-01.mp4 5:32

Exercise file: 123456789_2.dwg

File tabs

Display current files open

Turning on/off file tabs

 l Right click in modelspace Options > Display tab 

 l check or uncheck Display File Tabs

Right click on file tab to:

 l New... Open... Save Save as... Save All
 l Close Close All Close All other drawings
 l Copy full file path
 l Open File Location

Layout tabs include:

For plotting to scale

 l The printable area of the paper
 l Titleblock information
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 l Viewport(s) to display portions of modelspace

Turning on layout tabs

 l Right click in modelspace Options > Display tab> 

 l Check or uncheck Display Layout Tabs

 l Right-click on model button
 l Choose Display…

Paperspace

 l Titleblock
 l Dimensions and labels (ACAD labels)

Viewports

 l When viewport is selected, viewport scale pop-up menu is available
 o Regen after changing the scale
 o As many viewports as you need 
 o Can be any shape that you need

Modelspace viewports

Last updated: 2017-12-01

Total video time: 5:46

Exercise files: c3d-intrfc-data-c3d16.zip

ProjectID\Design\Corridors\Corridor-STH25-4thAve.dwg

c3d-intrfc-mdlspc-vwprt-01.mp4 5:46

Exercise file: Corridor-STH25-4thAve.dwg

Divide screen into real-time windows

Individual zoom and pan control

Objects in different areas can be seen together (in context)

Named Views

Configuring the screen

 l Corridor Section Editor is automated configuration
 l Manual configuration = View tab > Model Viewport panel > Set Viewports
 l “In-canvas” controls, minus sign
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Join Viewports

Xreference

Last updated: 2017-12-01

Total video time: 11:10

Exercise files: c3d-intrfc-data-c3d16.zip

Xreference overview part 1

c3d-intrfc-xref-01.mp4 4:44

Exercise files: ProjectID\BaseData\Mapping\ExistSurface.dwg, Pro-
jectID\BaseData\Mapping\Uti-Ex.dwg.

For bringing drawings behind design drawings 

Reduces design drawing size

“Overlays” DWG files 

“Underlays” DGN files 

Attaches Images

Can be Unloaded or Detached

Binding brings the XREF into the current file

Insert tab > References panel > Attach (or type XREF)

Identify file type to attach

 l DWG
 l DGN
 l PDF
 l Image

Attachment dialog
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 l Location, Rotation, Scale (similar to a block) 
 l Path Type: Relative path
 l Attachment versus Overlay

 l Warning: unless told (for good reason) to do otherwise, references should 
always be overlays and they should always be relative. Overlays prevent cir-
cular references from happening and relative path allows for project copying 
and moving and keeping xrefs intact.

Xreference overview part 2

c3d-intrfc-xref-02.mp4 6:26

Exercise file: ProjectID\BaseData\Mapping\Topo-Ex.dwg .

External Reference Manager

 l Select Xref in model space xref contextual ribbon> options panel> external references
 l External references options

You can…

 l label Civil 3D objects
 l sample data for sections
 l draft in relation to those referenced files
 l unload
 l snap to Xref’d drawing entities
 l add data from references into design drawing if needed 

 o Bind, for the entire file
 o NCOPY, for individual entities (not Civil 3D objects)

Reference fading control in Insert tab > Reference Panel pull-down  
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Data shortcuts

Last updated: 2017-12-01

Total video time: 11:10

Exercise files: c3d-intrfc-data-c3d16.zip

ProjectID\Design\Corridors\Corridor-STH25-4thAve.dwg

ProjectID\BaseData\Mapping\ExistSurface.dwg

Overview

c3d-intrfc-data-shrtct-01.mp4 2:33

Exercise file: Existing Surface.dwg

Provides selective object data for use in other files

 l surfaces
 l alignments
 l profiles
 l pipe networks
 l pressure networks
 l view frame groups

Files must be attached to a “project”

Object geometry is in one file, can be referenced into many other files. Allows for different 
styles to be applied to the same object in different references.

Data References can be used simultaneously 

Control/distribution of geometry held in XML file

Data shortcut folder relationship

c3d-intrfc-data-shrtct-02.mp4 3:00

Working Folder = Path where projects are stored (level above project folders) 

Project Folder = in working folder path where project files are stored

“_shortcut” folder = inside Project folder, where actual data shortcuts reside 
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 l The data is in XML format
 l DO NOT go in here – this is for Civil 3D to access/manage  

If a project is moved, these locations are relative.

Data shortcut process

c3d-intrfc-data-shrtct-03.mp4 5:36

 1. Right-click on Data Shortcuts > Set Working Folder
 2. Right-click on Data Shortcuts > New (or Set) Project Folder
 3. Right-click on Data Shortcuts > Create Data Shortcuts

Now that project path and folder are established, this step is repeated throughout project.

Xreference vs data shortcut concepts

Last updated: 2017-12-01

Total video time: 4:14

Exercise files: c3d-intrfc-data-c3d16.zip

ProjectID\SheetsPlan\STH25-XS_2016.dwg

ProjectID\Design\AliProfs\AliProf4thSt-Best-Fit.dwg

Concepts

c3d-intrfc-xref-vs-data-shrtct-01.mp4 4:14

XREFS

 l Connects to an entire file, then items can be filtered out by layer
 l Intended for items that you cannot data shortcut (acad objects, and a few civil 3d 

objects, corridors most notably)

Data shortcuts

 l Connects to individual objects
 l Intelligent data remains intact through connection (example: you can get station offset 

of an alignment through a data shortcut, but not an xref)
 l Styles can be different per connection (you cover this well)

Info: In general, you should use the data connection intended for the object (i.e. 
use data shortcut for those objects, xref for others). The reverse is also true. You 
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should generally not XREF objects that can have a data shortcut. If you happen to 
XREF a file that has connections to data shortcut objects, you can either remove 
the data shortcut or freeze the layer of the data shortcut object in the XREF. Classic 
example here is XREF topo and there's a DS to an alignment. That alignment will 
show up static and cannot be styled or queried. It's better to freeze the ali out of the 
xref and data shortcut it.

Both tools for referencing data in different ways 

 l Data Shortcuts are more Civil 3D specific. 
 l XREFs are “generally” more AutoCAD entities.
 l Civil 3D Objects will Xref and are usable

Data shortcuts usage

 l When you need data from surface, alignment, profile or pipes 
 l View Frames for plan and profile sheets
 l When object interaction is needed
 l Alignment (for sample line creation)

XREFS usage

 l Background information
 l Just for labeling, but not for interaction with other objects 
 l Everything else, especially the corridor

Inquiry tools

Last updated: 2017-12-01

Total video time: 3:15

c3d-intrfc-inqry-01.mp4 3:15

For reporting data from Civil 3D objects

Analyze tab > Inquiry panel

Fill in a field or two to report data

Types of Inquiries: 

 l Point
 l Surface 
 l Alignment
 l Profile and Profile View
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 l Section and Section View
 l Corridor Sections

WisDOT tool palettes

Last updated: 2016-11-30

Total video time: mm:ss

c3d-intrfc-wisdot-tool-paltt-01.mp4 2:30

Civil 3D 2016 – WisDOT configuration

Last updated: 2016-03-09

Total video time: 09:08

acad-C3D2016-cnfg.mp4 9:08

WisDOT drawing startup templates

A startup template is a file with a .dwt extension that is used as the base to create a Civil 3D 
drawing file. WisDOT provides four startup templates to use depending on the content and 
workflow of the drawing being created. A WisDOT Civil 3D drawing should be created using a 
WisDOT startup template. These four startup templates do not have any objects within the 
model or layout drawing spaces.

There are a few additional sheet production templates that are designated as stand-alone lay-
out templates. These consist of Title Sheets and Speed Sheet templates for typical details or typ-
ical sections. Drawings created for these purposes do not require beginning the drawing with 
one of the four startup templates. These templates do contain layout objects and/or some 
model space objects.

WisDOT has reconfigured the drawing startup templates for 2016 to contain only objects and 
components that are being used in the drawing settings, Civil 3D styles, and annotation ele-
ments of the startup template. These templates are lighter and do not require any type of 
purge to remove extra items such as layers, linetypes, blocks and fonts.  The “extra” com-
ponents, along with all the parts and pieces that make up the templates are provided in a Tool 
Palette library accessible through the WisDOT ribbons.  These Tool Palettes are the backbone 
for maintaining and delivering WisDOT standards and design and production components.

The startup templates for WisDOT Civil 3D 2016 can be found in 
C:\WisDOT\Stnd\C3d2016\StartupTemplates, and can be accessed from any of the WisDOT 
ribbons on the Startup panel which opens the Startup Template palette.  
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wisdot16.dwt

Used as the startup template for most design and production drawings.

wisdot16-plat.dwt

Used as the startup template for creating plat drawings.

wisdot16-survey.dwt  

Used as the startup template for survey drawings. This template can also be used as a sec-
ondary template that can be imported into a drawing that was started with the wisdot16.dwt 
template. 

wisdot16-mapping.dwt

Used only for mapping conversion. 

WisDOT standard configuration components

In Civil 3D 2016, WisDOT standards design and production components have been divided into 
object groups. The raw component files can be found in C:\WisDOT\Stnd\C3d2016\Com-
ponents, all of these components can be accessed by the use of a ribbon and specific palettes.

 

Raw component elements are organized in the following folders:

 

Assemblies

Reference files for all WisDOT custom assemblies accessible on palettes. Assembly help files.

Blocks

Collection of WisDOT marker symbol blocks, parametric blocks, and all other blocks used in the 
startup or sheet templates or organized on palettes.
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Dimensions

Reference drawing of WisDOT standard dimension styles accessible on palettes. Reference 
drawing of WisDOT standard multi-leader styles accessible on palettes.

Fonts

Collection of legacy WisDOT font files and a reference drawing of WisDOT text styles accessible 
on palettes.

Layers

Reference drawing of all WisDOT layers accessible on palettes. Layer state and layer filter files. 
Plot style insert configuration file.

Linetype

Reference drawing of WisDOT standard linetypes accessible on palettes.

Reports

Collection of report reference files and style sheets.

SheetSets

Collection of sheet set files for standard WisDOT plan sheets.

SheetTemplates

Reference drawings of WisDOT sheet layout templates accessible on palettes.

Support

Reference shape files and pattern files to support the WisDOT templates, hatches, and line-
types.

The WisDOT Civil 3D 2016 user interface

WisDOT standards, custom components and tools are included on ribbons which deliver custom 
palettes into the tool palette interface. There are four separate ribbon tabs:

 l WisDOT Standards
 l WisDOT Design
 l WisDOT Sheets
 l WisDOT Tools
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Each of these ribbons is divided into panels and each ribbon has a Tools and a Startup panel as 
well as ribbon-specific panels.

The Tools panel on each ribbon consists of:

 l Palettes ON/OFF tool which turns the display of the Tool Palette on and off.
 l WisDOT Support/Training tool which opens the WisDOT Civil 3D Environment Dialog.
 l A Tools drop down option that contains the WisDOT Network/Local Config Switch tool 

and the Refresh/Configure System Profile tool

All of the buttons on the WisDOT ribbons that are provided to access palettes will change the 
palette regardless of whether the tool palettes are being displayed, but will not automatically 
display the palettes if the palettes are turned off. Use the Palettes ON/OFF tool to change the 
display mode.

The Startup panel on each of the ribbons consists of:

 l Startup Templates tool to access the drawing startup templates palette.

User interface best practices

The Civil 3D 2016 configuration provides many palettes and many options to switch between 
these palettes rapidly.

Palette Best performance

For best performance when using the ribbon tools to change palettes, whether docked or float-
ing, keep the tool palette dialog in its expanded mode.  Do not use the hide or auto-hide 
feature.  
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This is a best practice suggestion. You may use the hide or auto-hide feature, but this will result 
in longer wait times for the palette to refresh and the palette may “hang” until you exit and re-
select the palette.

A Palettes ON/OFF tool that mimics the hide feature is provided on each WisDOT ribbon as a 
quicker alternative.

Civil 3D Startup Setting

The STARTUP system variable controls what tabs are displayed when the application is star-
ted, or when a new drawing is opened.  In the WisDOT configuration the Start tab will not dis-
play and the ribbons will be pre-loaded when Civil 3D starts. The WisDOT Civil 3D configuration 
will always open with the STARTUP system variable set this way. 

WisDOT ribbons

Last updated: 2016-03-11

Total video time: 12:43

c3d-intrfc-wisdot-rbn-01.mp4 12:43

Why WisDOT ribbons and palettes for 2016?

One reason Methods Development has created the ribbons and palettes is to encourage 
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drawings to be PURGED and AUDITED with the confidence that any item can easily be added to 
or removed from a drawing. 

The widely adhered best practice is to maintain a clean and healthy drawing file by using Purge 
and Audit regularly. There is a common misconception that drawings should not be purged 
and/or audited.  However, there is no reasonable argument against regularly purging and audit-
ing of a drawing file, and we are working to correct this misconception for the rollout of Civil 
3D 2016.

When a drawing is not purged or audited, it makes the file more likely to become corrupt and 
possibly unrecoverable. Items are purged from a drawing because they are not being consumed 
or used in the drawing. For more instructional information about purge, audit and tips on clean-
ing and keeping drawings clean read:  Keeping Drawings Clean and Working

To add a purged component into a drawing in Civil 3D 2014 the user has to use Windows 
Explorer, copy from another drawing, or use Design Center to find the elements.  A con-
siderable amount of all CAE Support problems and complaints about slowness of drawings, app 
glitches, and crashes can be traced back to a failure to purge and audit. Out of date items or 
objects copied in the wrong manner from other drawings is a bad practice that has lead to 
drawing file problems.

In Civil 3D 2016, we have created the ribbons / palettes to introduce an easier, more reliable 
process, of adding components into a drawing, whether purged or not.  Placing all of the com-
ponents on the palettes allows us to add only the minimum required components to the startup 
templates.  The startup templates now allow components to be added as needed.  This reduces 
the number of items that need to be purged and audited from the start.

We are striving to keep the drawings in a clean, purge an audit ready state, with tools to allow 
the user easy access to all the latest and greatest component(s), if and when the component(s) 
are needed.

Methods Development realizes the components and tool configuration on the palettes will be a 
work in progress. We are open to suggestions for the sequence and groups of the items on the 
palettes.

Purpose of ribbons

The main purpose of the WisDOT ribbons is to provide an organized way to access palettes, 
standards components, and tools needed for specific WisDOT Civil 3D workflows.  

Palettes can be accessed from the ribbons to conveniently add WisDOT standards components 
into a drawing. The components are developed to adhere to WisDOT FDM guidelines, recom-
mendations, and standard design and production practices, to produce the correct deliverable 
output.
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The secondary purpose of the WisDOT ribbons is to provide a common location for delivering 
custom macros, custom reports, and custom tools. 

Tips: Tool Tips: For additional information about a tool simply hover over the tool 
button to expose extended notes and/or a short video or animation.

WisDOT Standards ribbon

The WisDOT Standards ribbon has tools to access the standards components palettes and tools 
to add standards components into a drawing.  

Tools panel

Palettes ON/OFF Toggles the palette window ON or OFF

WisDOT Support/Training
Toggle the WisDOT environment dialog 
ON/Off, which has links to the WisDOT help 
and training.

Tools panel – drop down

WisDOT Network/Local Config 
Switch

This tool allows the user to switch 
between local and network-based work 
environment for instances when a user 
is not connected to the WisDOT server

Refresh/Configure System Profile
This tool will refresh or configure the 
WisDOT system profile

Startup panel

Startup Templates
Launches the WisDOT Startup Tem-
plates palette

Standards Components panel

Add Layers
Adds 2016 WisDOT standard layers into 
drawing
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Add Marker Symbols
Adds 2016 WisDOT standard symbol 
blocks into drawing

Add Dimensions
Adds 2016 WisDOT standard dimension 
styles into drawing

Add Multi-Leaders
Adds 2016 WisDOT standard multileader 
styles into drawing

Add Textstyles
Adds 2016 WisDOT standard text styles 
into drawing

Add Linetypes
Adds 2016 WisDOT standard linetypes 
into drawing

Plot Configuration panel

Page Setups
Launches the WisDOT standard page 
setups palette 

Layer States
Launches the WisDOT standard layer states 
palette

Layer States (pull-down) Layer States set and manage tools.

Plot Configuration panel – drop down

Current Page Setup All
This tool sets all layouts in the current draw-
ing to the current page setup.

WisDOT Design ribbon

The WisDOT Standards ribbon has tools to access the standards components palettes and tools 
to add standards components into a drawing.  

The Design ribbon a design workflow tools and palettes. The Design Utilities panel has six useful 
design tools; Superelevation Design Macro, Extract Corridor Surface Feature Lines, Alignment 
Bearing Tip toggle, Swap Parts List Styles, Swap Pipe Network Parts, and Pipe Network Sump 
Adjust.
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The Assemblies & Subassemblies panel includes a button to access the Autodesk and WisDOT 
subassemblies and assemblies.  The Autodesk Palette includes a button to access all available 
Autodesk palettes.  The Parametric Design panel provides buttons to access the parametric 
design block palettes for Beam Guard and Intersections.

Tools panel

Palettes ON/OFF Toggles the palette window ON or OFF

WisDOT Support/Training
Toggle ON/OFF the WisDOT environment 
dialog which has links to the WisDOT help 
and training.

Tool panel – drop down

WisDOT Network/Local Config Switch

This tool allows the user to 
switch between local and net-
work-based work environment 
for instances when a user is not 
connected to the WisDOT 
server

Refresh/Configure System Profile
This tool will refresh or con-
figure the WisDOT system pro-
file

Startup panel

Startup Templates
Launches the WisDOT Drawing Startup Templates 
palette

Design Utilities panel

Superelevation Design Macro
Updates the superlevation tabular editor 
values to adhere to WisDOT standards

Corridor Surface Feature Lines

Executes the macro to extract surface 
point codes from a corridor surface as 
lines, polylines or feature lines. (Hover 
over tool on ribbon for more information)

Alignment Bearing Tip
Toggles the Alignment Bearing tip On and 
Off. 
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Swap Parts List Styles

Executes the macro to switch all the style 
in a Parts list between design styles and 
production styles, with options to switch 
styles in existing pipe networks.

Swap Pipe Network Part
Executes the macro that changes the part 
type of selected pipes and or structure 
within a pipe network. 

Pipe Network Sump Adjust

Executes the macro which make neces-
sary sump adjustments to account for 
pipe thicknesses when a sump depth of a 
structure is set to zero.

Assemblies & Subassemblies panel

WisDOT/ Civil Imperial
Launches the WisDOT Subassem-
blies/Assemblies palettes

Subassembly Help

Opens the WisDOT subassembly and Assem-
blies help file. Users can look at how the sub-
assemblies work without needing to access 
the palette or an assembly in the drawing.

Autodesk panel

Autodesk Palettes
Launches the out-of-the-box Autodesk palettes and 
groups.

Parametric Design panel

Beam Guard
Launches the Beam Guard EATS palette, with para-
metric blocks to assist in beam guard design lay-
out. 

Intersection Block
Launches the Intersection Layout palette, with 
parametric blocks to assist in intersection design 
layout.

WisDOT Sheets ribbon
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The concept of the WisDOT Sheets ribbon is to provide a single plan production workflow start-
ing point. This should offer the user the ability to progress through the specific sheet (or group 
of sheets) development workflows by selecting the corresponding sheet type button on the 
Sheet Creation Components panel of the ribbon to expose the corresponding workflow grouped 
palettes.

These palettes are not comprehensive and are a work in progress.  Using palettes to deliver 
these tools and components allows for more fluid and instant updates and workflow modi-
fications.

Sheet Utilities panel

The Sheet Utilities panel contains a few tools to assist in creating text using the new fonts styles, 
and creating Superelevation tables.

Superelevation Tables
Create production ready superelevation tables 
within the drawing, and or export excel.

Point Station Offset to UDP
Tool to add station, offset information to point 
collections.

Sheet Creation Components panel

Each sheet tool delivers the specific components, objects and commands on a palette that per-
tain to the workflow to develop the sheet. This panel is divided into two sections. On the left 
side are the buttons to access the sheet workflow palettes. The right side are the general 
AutoCAD component tools. 

Title Sheets Access the Title Sheet palette.

(pull-down)
This pull down offers access to multiple palettes, and 
will show the last palette selected.

Typical Sections, Construction Details, Plan Details, Storm Sewer Plan, Detail Sheets

Quantities Access the Quantities Sheet palette
ROW / Plat Access the ROW / Plat Sheet palette.
Plan / Profile Access the Plan / Profile Sheet palette.
Sign Plates Access the Sign Sheet palette.
Sections Access the Sections Sheet palette.
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Earthwork Access the Title Sheet palette.

Set Textstyle & Size
Opens a floating dialog to set WisDOT textstyle and or 
text size at any time. To be used in conjunction with 
the Mtext and Text commands.

Dimension gallery (pull-
down)

Select a dimension style to make it the current style.

Multileader gallery (pull-
down)

Select a multileader style to make it the current style.

Mtext Multi line text tool.
Dimension tool (pull-
down)

Create dimensions tool.

Mleader Create multileader tool.

 

Wis-Manage panel

The tools on this panel launch the legacy 2014 Wis-manage palettes. 

Plot Configuration panel

Page Setups
Launches the WisDOT standard page setups 
palette.

Layer States
Launches the WisDOT standard layer states 
palette.

Layer States (pull-down) Layer States set and manage tools.

 

Plot Configuration panel – drop down

Current Page Setup All
This tool sets all layouts in the current drawing 
to the current page setup.

 

WisDOT Tools ribbon

 

The WisDOT Tools ribbon has five panels that contain all the macros, reports and tools offered 
in the WisDOT Toolbox as well as additional navigation and drawing maintenance tools.
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Navigation Panel

These tools allow for ease of accessing user-defined model space views between drawings. 

Rotate View

This tool prompts the user to pick two locations in 
modelspace, and uses those to rotate the drawing 
view without changing the current UCS.  Best practice 
for working in modelspace in design drawings is to 
keep the UCS set to World to maintain the proper 
coordinate system.

Plan View
This tool will reset the view back to plan view using 
the current UCS.

 

Info: Important: Be sure that your UCS is set to WORLD before you export or 
import any model space views.

 

Export View

This tool will prompt the user for a name and location to 
save a text file (.txt) and add the information for the cre-
ation of any user-defined model space views in the cur-
rent drawing.

Import Views
This tool will prompt the user to search for a text file con-
taining previously exported view information and add 
the selected views to the current drawing.

Delete Views

Use this tool to delete any user-defined model space 
views from the current drawing. The user can delete a 
saved view in the drawing by typing the name of one par-
ticular view or when prompted press the enter key to 
search for a saved view text file. The tool will delete all 
the saved views within the drawing that match those 
saved in the text file.

DWG Maintenance Panel

DWG Clean
This tool should be used regularly to keep the drawing 
clean. It runs a macro to purge and audit the drawing.
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WisDOT Macros Panel

These are the WisDOT custom macros that are also found on the Toolbox tab on the Toolspace 
palette.

WisDOT Reports Panel

These are the WisDOT custom reports that are also found on the Toolbox tab on the Toolspace 
palette.

Survey File Conversion Panel

These are the WisDOT and Autodesk conversion macros that are also found on the Toolbox tab 
on the Toolspace palette.

Borrowing and returning a Civil 3D license

Last updated: 2017-11-28

Total video time: 1:39

c3d-intrfc-brrw-c3d-lcns-01.mp4 1:39

Borrowing a Civil 3D license

If you borrow a license you are removing it from the network pool of licenses, whether you are 
actively using it or not. The license can be borrowed for a limited amount of time, after which it 
will automatically be removed from your computer and returned to be available on the net-
work. You can only borrow networked licenses, not stand alone licenses.

In the title bar of the Civil 3D instance click the Help button.

At the bottom of the menu choose About AutoCAD Civil 3D.

In the About dialog, upper right, click Product Information (or Product License Information).

Click Borrow License.

In the Borrow License dialog, in the calendar, select the automatic return date. This date must 
be within a length of time set by your administrator.

Click Borrow License.

Click Close in the Borrowed License message.

Returning a borrowed Civil 3D license
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Returning a license earlier than the date specified

The options below all have the exact same result. You only need to choose the method that 
works for the circumstances you find yourself in.

Returning a license earlier than the date specified, option 1

You can return a license earlier than your chosen automatic return date.

At the beginning of each session of Civil 3D while the license is checked out you should receive 
a balloon notification stating that the license is checked out and can be returned early. Click the 
Click Here option in this balloon notification.

In the Return Borrowed License dialog click YES to confirm the early return.

In the License Returned dialog click Close.

Returning a license earlier than the date specified, option 2

If you are not receiving that balloon notification, or you closed it before using the early return 
option, but would like to return the license early do the following steps:

In the title bar of the Civil 3D instance select the Help button.

At the bottom of the menu choose About AutoCAD Civil 3D.

In the About dialog, upper right, choose Product Information (or Product License Information).

In the lower left select the Return License button.

In the Return Borrowed License dialog click YES to confirm the early return.

In the License Returned dialog click Close.

Returning a license earlier than the date specified, option 3

If you are not receiving that balloon notification, or you closed it before using the early return 
option, but would like to return the license early do the following steps:

In the Status Bar in the lower right of the screen, right-click the License button.
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Click Return license early.

In the Return Borrowed License dialog click YES to confirm the early return.

In the License Returned dialog click Close.

Adding a folder link to a Civil 3D dialog

Last updated: 2017-12-01

Total video time: 1:27

Adding a folder link to a Civil 3D dialog

c3d-intrfc-add-fldr-lnk-to-c3d-dlg-01.mp41:27

Adding a folder shortcut

In the Application Menu, select Open

Browse to the project 12345678 folder

Click the up folder icon to go to the c3d folder above the project folders

In the right-hand window click and drag the c3d folder to the blue shortcut bar and release the 
mouse button.

Click on the new c3d shortcut to see the project folders.

In the right-hand window click and drag the 12345678 project folder to the blue shortcut bar 
and release the mouse button.

Left click on the new 12345678 shortcut icon.

Click cancel to close the dialog.

Select Yes when prompted to save changes to the Places list.

Removing a folder link from a Civil 3D dialog

In the Quick Access toolbar select Open.
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In the Open dialog, left-hand blue Places bar, right-click on the 12345678 folder.

Click Remove.

Confirm you wish to remove the shortcut by clicking Yes.

Click cancel to close the dialog.

Select Yes when prompted to save changes to the Places list.

Civil 3D 2016 – WisDOT configuration

Last updated: 2016-03-09

Total video time: 09:08

acad-C3D2016-cnfg.mp4 9:08

WisDOT drawing startup templates

A startup template is a file with a .dwt extension that is used as the base to create a Civil 3D 
drawing file. WisDOT provides four startup templates to use depending on the content and 
workflow of the drawing being created. A WisDOT Civil 3D drawing should be created using a 
WisDOT startup template. These four startup templates do not have any objects within the 
model or layout drawing spaces.

There are a few additional sheet production templates that are designated as stand-alone lay-
out templates. These consist of Title Sheets and Speed Sheet templates for typical details or typ-
ical sections. Drawings created for these purposes do not require beginning the drawing with 
one of the four startup templates. These templates do contain layout objects and/or some 
model space objects.

WisDOT has reconfigured the drawing startup templates for 2016 to contain only objects and 
components that are being used in the drawing settings, Civil 3D styles, and annotation ele-
ments of the startup template. These templates are lighter and do not require any type of 
purge to remove extra items such as layers, linetypes, blocks and fonts.  The “extra” com-
ponents, along with all the parts and pieces that make up the templates are provided in a Tool 
Palette library accessible through the WisDOT ribbons.  These Tool Palettes are the backbone 
for maintaining and delivering WisDOT standards and design and production components.

The startup templates for WisDOT Civil 3D 2016 can be found in 
C:\WisDOT\Stnd\C3d2016\StartupTemplates, and can be accessed from any of the WisDOT 
ribbons on the Startup panel which opens the Startup Template palette.  
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wisdot16.dwt

Used as the startup template for most design and production drawings.

wisdot16-plat.dwt

Used as the startup template for creating plat drawings.

wisdot16-survey.dwt  

Used as the startup template for survey drawings. This template can also be used as a sec-
ondary template that can be imported into a drawing that was started with the wisdot16.dwt 
template. 

wisdot16-mapping.dwt

Used only for mapping conversion. 

WisDOT standard configuration components

In Civil 3D 2016, WisDOT standards design and production components have been divided into 
object groups. The raw component files can be found in C:\WisDOT\Stnd\C3d2016\Com-
ponents, all of these components can be accessed by the use of a ribbon and specific palettes.

 

Raw component elements are organized in the following folders:

 

Assemblies

Reference files for all WisDOT custom assemblies accessible on palettes. Assembly help files.

Blocks

Collection of WisDOT marker symbol blocks, parametric blocks, and all other blocks used in the 
startup or sheet templates or organized on palettes.
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Dimensions

Reference drawing of WisDOT standard dimension styles accessible on palettes. Reference 
drawing of WisDOT standard multi-leader styles accessible on palettes.

Fonts

Collection of legacy WisDOT font files and a reference drawing of WisDOT text styles accessible 
on palettes.

Layers

Reference drawing of all WisDOT layers accessible on palettes. Layer state and layer filter files. 
Plot style insert configuration file.

Linetype

Reference drawing of WisDOT standard linetypes accessible on palettes.

Reports

Collection of report reference files and style sheets.

SheetSets

Collection of sheet set files for standard WisDOT plan sheets.

SheetTemplates

Reference drawings of WisDOT sheet layout templates accessible on palettes.

Support

Reference shape files and pattern files to support the WisDOT templates, hatches, and line-
types.

The WisDOT Civil 3D 2016 user interface

WisDOT standards, custom components and tools are included on ribbons which deliver custom 
palettes into the tool palette interface. There are four separate ribbon tabs:

 l WisDOT Standards
 l WisDOT Design
 l WisDOT Sheets
 l WisDOT Tools
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Each of these ribbons is divided into panels and each ribbon has a Tools and a Startup panel as 
well as ribbon-specific panels.

The Tools panel on each ribbon consists of:

 l Palettes ON/OFF tool which turns the display of the Tool Palette on and off.
 l WisDOT Support/Training tool which opens the WisDOT Civil 3D Environment Dialog.
 l A Tools drop down option that contains the WisDOT Network/Local Config Switch tool 

and the Refresh/Configure System Profile tool

All of the buttons on the WisDOT ribbons that are provided to access palettes will change the 
palette regardless of whether the tool palettes are being displayed, but will not automatically 
display the palettes if the palettes are turned off. Use the Palettes ON/OFF tool to change the 
display mode.

The Startup panel on each of the ribbons consists of:

 l Startup Templates tool to access the drawing startup templates palette.

User interface best practices

The Civil 3D 2016 configuration provides many palettes and many options to switch between 
these palettes rapidly.

Palette Best performance

For best performance when using the ribbon tools to change palettes, whether docked or float-
ing, keep the tool palette dialog in its expanded mode.  Do not use the hide or auto-hide 
feature.  
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This is a best practice suggestion. You may use the hide or auto-hide feature, but this will result 
in longer wait times for the palette to refresh and the palette may “hang” until you exit and re-
select the palette.

A Palettes ON/OFF tool that mimics the hide feature is provided on each WisDOT ribbon as a 
quicker alternative.

Civil 3D Startup Setting

The STARTUP system variable controls what tabs are displayed when the application is star-
ted, or when a new drawing is opened.  In the WisDOT configuration the Start tab will not dis-
play and the ribbons will be pre-loaded when Civil 3D starts. The WisDOT Civil 3D configuration 
will always open with the STARTUP system variable set this way. 
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WisDOT Civil 3D project setup

WisDOT standards – Civil 3D project

Last updated: 2015-01-13

Total video time: 06:05

WisDOT standards – Civil 3D project

prj-wisdot-stnd-c3d-prj-01.mp4 6:05

Why project folder structure is important

Connectivity of referenced data, for data shortcut references and external references (XREF)

Project consistency. The ability to find files based on the type of data.

Project portability. The ability to move a project internally, or externally, and maintain the con-
nectivity and file locations.

How project folder structure is created

Use the data shortcut project creation tools.

 l All projects will need data shortcuts
 l The data shortcuts project creation lends itself well to the WisDOT workflow.

Use the folder structure at C:\Civil 3D Project Templates\WisDOTProjectTemplate

A look at the project folder structure

The top level of the project folders should not change.

Underneath that top level folders can be added.

Standard folders should never be deleted, removed or moved.
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Steps to create the project folder structure

 1. Set the data shortcut working folder to the c3d folder
 2. Create a new project folder
 3. Use the WisDOTProjectTemplate

Requirement: Reference FDM 15-5-3, Att 3.1 for file naming and locations

Wisconsin coordinate system settings in Civil 3D

Last updated: 2017-06-28

Warning: A known issue has been identified related to Wisconsin county coordin-
ate projections. Please review Wisconsin coordinate projection issue - XML/SDB 
and Wisconsin coordinate projection issue - SDB/DWG for more information.

Wisconsin coordinate systems available in Civil 3D

 l SPCS – State Plane Coordinate System – FDM 9-20-26  Developed nationally by the US 
Coast and Geodetic Survey in the 1930s.  Wisconsin has three state plane zones North, 
Central and South that follow county lines.

 l WCCS – Wisconsin County Coordinate System – FDM 9-20-27  Developed in 1993 by 
WisDOT.  Achieved design goal of minimal distortion between grid (map) and ground dis-
tances by creating individualized ellipsoids for every county.

 l WISCRS – Wisconsin Coordinate Reference System – FDM 9-20-28  Developed in 2006.  
Design goal is to arrive at the same WCCS coordinate while utilizing one nationally recog-
nized ellipsoid, making it easier for vendors to include Wisconsin county coordinates in 
their software and equipment.  For all counties except Jackson County, WCCS and WISCRS 
coordinates will essentially be the same for a given point.

 l WTM – Wisconsin Transverse Mercator – FDM 9-20-25.3.1  Developed by the Wisconsin 
DNR in the 1980s.  The Universal Transverse Mercator used by the Department of 
Defense divided Wisconsin almost equally into two zones down the 90 degree west lon-
gitude line.  The WTM is centered on the 90 degree longitude line and allows Wisconsin 
to be covered by one WTM zone rather than two UTM zones.

Updates to coordinate data available in Civil 3D for Wisconsin

 l Previously there were two Wisconsin coordinate systems shown in Civil 3D in the USA, 
Wisconsin category. For example, the two coordinate systems listed for Adams county 
were:

 l Wisconsin Adams, US FT (or use HARN/WI.AdamsWI-F)
 l Wisconsin County Systems: Adams County, US Foot
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Comment: Both of these systems are for WCCS and WISCRS were not available to 
choose from.

  
 l WisDOT also provided multiple coordinate system categories that titled "WisDOT<Hor-

izDatum>-<VertDatum>". These categories and coordinate systems have been moved to 
an "obsolete" category and replaced with a simplified category called "WisDOT".

 l The format of the coordinate naming convention and example is shown below:

Coordinate 
System

Zone / 
County

Horizontal 
Datum 

Year

(Horizontal 
Adjustment 

Year)
Units

SPCS
Wisconsin 
Central

NAD83 (1991) USF

WCCS Adams NAD83 (1991) USF

WISCRS Adams NAD83 (1991) USF

WTM Yes NAD83 (1991) USF

Units

USF  = US Survey Foot

M  = Meters

Selecting the coordinate system for the dwg file

The coordinate system used to collect the survey data should be obtained from the surveyor or 
WisDOT Survey Data Coordinator.  Review the Form DT1773 Geodetic Reference Docu-
mentation with the Survey Data Coordinator.  It is encouraged that new projects are surveyed in 
WISCRS.  It is required that WISCRS coordinates are used for Jackson County.

Drawing Settings

The coordinate system is assigned in the Drawing Settings.  The Drawing Setting can be 
accessed using either of the menus below.
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or

Categories

In the Coordinate System Library, categories group related coordinate systems.
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In order to maintain legacy coordinate information in the Autodesk products the previous Wis-
consin county coordinates could not be renamed.  The Wisconsin coordinates under the category 
USA Wisconsin will still be available however only the coordinates under the WisDOT category   
should be used.  The coordinates in the WisDOT category are only available by downloading the 
information from Wisconsin DOT and will not be offered in the out-of-the-box software offered 
by Autodesk.  WisDOT employees do not need to download the coordinate systems.  They are 
automatically loaded on WisDOT computers

 1. Select the WisDOT category.

 2. Next select the coordinate system used for the project.
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 3. OK after the coordinate system has been selected.

Frequently Asked Questions (FAQ)

Can I select the coordinates for multiple files at once?

To set a coordinate system use the Set Coordinate System – Multiple DWGs macro found in the 
Toolbox tab of the Toolspace under WisDOT Macros. This tool can be used for a single drawing 
or multiple drawings.

Info: The macro cannot be used on a drawing that is currently open.

 

 1. Close the target drawing(s) if currently open.
 2. Execute the Set Coordinate System – Multiple DWGs macro.
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 3. Browse to the drawing(s) by clicking Add…
 4. Select a county from the list in the dialog box and select the datum.
 5. Process All to set the coordinate system.
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What should I do with my existing project?

Check with the Region Survey Data Coordinator to verify that the correct coordinate system has 
been applied to the drawing.  Changing the coordinate system in Civil 3D will not affect the 
drawing itself but may cause errors to referenced aerial photos, GIS information, or survey data-
base data that are based on a different coordinate system.

Is the survey information drawn differently for the adjustment years?

The horizontal datum versions for NAD 83 include (1986), (1991), (1997), (2007) and (2011). 
The differences are fundamentally a result of upgrades and enhancements in technology, sur-
veying methodologies and computing power. In addition, as the Wisconsin Height Modern-
ization program has worked its way around the state, additional measurements (horizontal and 
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vertical) to survey stations has added more data to further refine the previously published 
coordinates.  There is no direct mathematical relationship between NAD83 adjustment years.  
Therefore, any change in coordinate values due to a change in adjustment year should be 
handled by the Region Survey Data Coordinator outside of Civil 3D.

Civil 3D reflects what is imported in the survey database, and if another coordinate system is 
needed by Civil 3D, then the survey data coordinator should transform the data.  

Civil 3D is a design tool and should not be considered a survey adjustment tool.  Any questions or 
concerns regarding the project datum and adjustment should be addressed to the Region Sur-
vey Data Coordinator.  Any changes to the project survey datum and adjustment should be over-
seen by the Region Survey Data Coordinator.

Should I translate my survey data to a newer projection?

No.  Transforming a project to another coordinate system is reserved for the Survey Data 
Coordinator and should not be done by the engineer/designer.  If survey data is collected based 
on the NAD 83 (2011) coordinates and saved to a survey database, then the project is in NAD 83 
(2011) coordinates. Civil 3D projects are a Cartesian plane based on what the survey database 
tells the project the coordinates are.  The adjustment year in the coordinate name does not 
include any additional information that will allow Civil 3D to translate coordinates between 
adjustment years. Only one adjustment year is provided in the "WisDOT" category.

Civil 3D reflects what is imported in the survey database, and if another coordinate system is 
needed by Civil 3D, then the survey data coordinator should transform the data.

What is the difference between WCCS and WISCRS?

In general WCCS is based on a local ellipsoid (the reference surface) for each county whereas 
WISCRS uses GRS 80 as the single reference ellipsoid for all individual coordinate systems.

Horizontal differences

Except for Jackson County, there is negligible difference between WCCS coordinates and 
WISCRS coordinates. The goal of the WISCRS system is to replicate WCCS coordinates (from 
lat/long) using a ‘simpler’ mathematical method. The vast majority of ‘differences’ between 
WCCS and WISCRS (over 97%) are less than 3 mm. There are no differences of over 5mm 
(0.016’). Jackson County WISCRS (Transverse Mercator) is a completely different projection 
than WCCS (Lambert Conformal Conic), so the user will get radically different coordinates from 
the same lat/long.

Vertical differences

There is no difference in elevations between WCCS and WISCRS. It is a horizontal system only. 
See Version updates for elevation version updates from NGS.
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What coordinate system should I use for Jackson County?

Please note that only the WISCRS Jackson County coordinate projection is to be used for new 
DOT projects.  Do not use the WCCS Jackson County coordinate system for new projects.  The 
WCCS-Jackson County coordinates have been retained for legacy projects.  Refer to FDM 9-20-
28 Wisconsin Coordinate Reference System for more information.

What happens if you share a dwg with the DOT custom coordinate naming convention assigned to it and the receiv-
ing party does not have the DOT files installed?

The receiving party would not be able to convert the file to another coordinate system. The 
data will still be valid and be placed in the correct location.

Resources:

FDM Section 9-20 Spatial Reference Systems

Wisconsin State Cartographer’s Office – Coordinate Reference Systems

Data shortcut best practices

Last updated: 2015-04-17

Migrating a project from Civil 3D 2012 to Civil 3D 2014

When migrating a project from Civil 3D version 2012 to version 2014 it is very important that 
you

Warnings: 
 1. DO NOT do anything else with the project files other than migration.
 2. DO NOT move files.
 3. DO NOT copy files.
 4. DO NOT rename files or objects within the files. If there is a problem with data 

shortcuts while migrating a project we do not want to add variables to complicate 
troubleshooting. 

Follow the How to Re-path all subassemblies within project corridor drawings and Project draw-
ing migration Civil 3D 2012 to 2014 sections  for the proper process to migrate your project 
drawings. If this process is followed, the data shortcuts will be migrated properly as well. 

Warning: DO NOT perform a SAVE AS command within the data shortcut editor in 
an attempt to migrate the data shortcuts to the new version. This will create a copy 
of all of the XML files for the data shortcuts which can create a problem. This will 
happen automatically when the above steps are followed. 

Moving a project location 
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When moving a project location on the network drive you should move the ENTIRE project 
folder. This will ensure that all of the data shortcuts and their references will follow the relative 
paths of the moved data shortcut XML files. 

Next, open the data shortcut editor from the start menu, and navigate to the project shortcut 
folder. Perform a Find and Replace command on the paths in order to re-path them to the new 
data shortcut folder location.

Renaming or moving individual project files

Best practice for renaming or moving project files is not to do it at all, but in the event that it 
must be done you must first validate your data shortcuts after renaming or moving a file. 

Once the data shortcut list has been validated you must synchronize the references in any files 
which are consuming the data shortcuts coming from the file which was renamed or moved. 
DO NOT wait on validating the data shortcuts when these types of changes are made. It will 
cause problems downstream such as data shortcut duplications and general confusion among 
team members. 

It is also good practice to inform all team members of such a change so they are aware of it. 

Renaming individual drawing objects 

The same practices should be applied to this type of project change as outlined in the above sec-
tion for renaming or moving individual project files. 

Incorporating external drawings into a project

Warning: When incorporating drawings from an external consultant copy over 
ONLY the drawings. DO NOT copy over any of the shortcut folders nor any of the 
XML files contained therein. 

If these files are replacing existing project files then archive the original files, and replace them 
in windows explorer with these new external files. 

Open these new files, and synchronize references. 

Repair all broken references by navigating to the proper source files from your project folder 
for each broken reference. 

If there were data shortcuts which were created from these external files you will need to recre-
ate these data shortcuts in your project. 

Notable difference between Data Shortcuts in Civil 3D 2012 and in Civil 3D 2014

Data references, other than for surfaces, are now saved (cached) directly in the drawing files. 
This is a great benefit when sharing files remotely. This eliminates the need to re-route all data 
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shortcuts to the source files in order to view and use the data as references.

Project data workflow map

Last updated: 2017-01-27

A map of a typical, basic Civil 3D project has been posted here:

wisdot-prjct-data-flo.pdf

It's purpose is to give a visual example of standard files and objects in a Civil 3D project and the 
connections between the files.

 l The pdf contains the large 48x36 map and 11x17 maps for each orange folder or green 
folder if there are no orange subfolders

 l The large map is linked to all the 11x17 maps and vice versa.  Hover the cursor over the 
orange or green folder until it changes, then click on that area

Edgeline data management

Last updated: 2017-06-06

edgeline-data-mgt.pdf
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The linked PDF shows the relationship among edge line design objects (alignments). Some edge 
line objects are used in both design and production workflows, and others are only used in one 
capacity or the other. 

There are 3 scenarios shown in the map to detail how these objects are used.

Scenario 1 shows this relationship when there is no modeling required.

Scenario 2 shows this relationship when there is one corridor being modeled.

Scenario 3 shows this relationship when there are multiple corridors being modeled.

Updating settings and styles in production DWG files

Last updated: 2015-04-17

Most of the settings and styles that control a DWG file are contained within the file. Updates to 
a template file are not automatically brought into existing files. This topic covers the different 
methods for updating settings and styles for existing files in Civil 3D.

Civil 3D styles and drawing settings update

Use the import styles tool to update a DWG file's Civil 3D standards with those found in the 
latest WisDOT template.

 1. Open the dwg file you wish to update in Civil 3D.
 2. Manage ribbon > Styles panel > Import
 3. Browse to template file containing standards you'd like to apply to the dwg file. In a 

standard Windows7 Civil 3D install, WisDOTxx.dwt is found at C:\User-
s\USERNAME\AppData\Local\Autodesk\C3D 2012\enu\Template\USWI. In a standard 
WindowsXP Civil 3D install, WisDOTxx.dwt is found at C:\Documents and Set-
tings\USERNAME\Local Settings\Application Data\Autodesk\C3D 2012\enu\Tem-
plate\USWI.
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 4. In the Import Civil 3D Styles dialog box, you can review new Civil 3D standards that will 
be imported. You can also choose to delete standards that are no longer in the WisDOT 
template - if they aren't in use in the drawing. You can make modifications to the 
import/delete actions if you wish. You can turn on, or off import drawing settings. Details 
are available in Civil 3D Help documents.

 5.  OK Save the dwg file.
 6. Consider updating AutoCAD standards also.

AutoCAD standards update

Use the import styles tool to update a DWG file's AutoCAD standards with those found in the 
latest WisDOT template.

 1. Open a new drawing using the template containing the new standards you want applied 
to the project dwg file.

 2. C3D button > Save As > AutoCAD Drawing Standards. Remember where you save this 
DWS file.

 3. Open the dwg file you wish to update.
 4. Manage ribbon > CAD Standards panel > Configure
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 5. In the Configure Standards dialog box, Standards tab, click the + button and browse to 
you DWS file.

 6. In the Configure Standards dialog box, Plug-Ins tab, select the types of standards you'd 
like to update. Usually you'd check all.
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 7. Click the Settings... button. The settings should look as shown.

 8. Click Check Standards... button
 9. The tool will notify you of DWG layers that are no longer in the DWS standards file. You 

can cycle through this by clicking Next. The layer will not be deleted from the dwg file.
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 10. When the update is complete you will receive a notification with update statistics.

 11. Close the Check Standards dialog box
 12. Manage ribbon > CAD Standards panel > Configure
 13. Remove the DWS file from the drawing by clicking the X button. Click OK to close the Con-

figure Standards dialog box.
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 14. Save the DWG file.

Migrating blocks between Civil 3D versions

Last updated: 2015-04-17

It is good practice when migrating blocks to insert them into a blank out-of-the-box template. 
This way we avoid saving forward any old settings contained in the drawings within which these 
older blocks reside. Depending on the scale of migration we can accomplish this a couple of dif-
ferent ways. 

Workflow 1 – Migrating a small number of blocks

 1. Start a new block library drawing using the out-of-the-box acad.dwt template found 
here:

 l C:\Users\<user name>\appdata\local\autodesk\c3d 2014\enu\template

 2. Insert older blocks using Design Center
 l Open Design Center, and browse to the source drawing containing the blocks to 

be migrated. The reason this workflow is designed for migrating a small number 
of blocks is because Design Center only allows one block to be inserted at a time. 
That is not ideal for migrating hundreds of blocks, but it does work well for smal-
ler numbers.

 l Open the Blocks section in the source drawing in Design Center, and drag each 
block into model space one at a time. Otherwise, right-click on each block and 
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choose Insert Block.

 3. Save the new block library drawing in the appropriate location with the appropriate 
name, and the newly migrated blocks are now ready to be used. 

Workflow 2 – Migrating many blocks

 1. Start a new block library drawing using the out-of-the-box acad.dwt template found 
here:

 l C:\Users\<user name>\appdata\local\autodesk\c3d 2014\enu\template

 2. Insert and explode existing block library drawing
 l Click on the Insert tab of the Ribbon and then select the Insert button on the Block 

panel. In the Insert dialog box browse to the existing block library drawing you 
wish to migrate. Be sure that the Insertion point, Scale, and Rotation options are 
all unchecked. Be sure the Explode option is checked on. This will insert the entire 
drawing into the new 2014 drawing template and will explode into its individual 
objects. 
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 l Next we will run a few commands in order to clean unwanted items out of the 
new block library drawing.

 l Type PURGE in the command line. Be sure that the option for Confirm 
each item to be purged is unchecked and that the option for Purge nested 
items is checked on. Click on the Purge All button, and close the dialog box 
when the command is finished. 
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 l Type –PURGE in the command line. Type R to select the option Regapps. 
Hit enter to select the default asterisk for name of regapps to purge. This 
will select all regapps. Type N when prompted to verify each name to be 
purged. This will get rid of any 3rd party apps running in the background. 

 l Type AUDIT in the command line. Type Y when prompted to fix any errors 
detected in the drawing. 

 l Save the new block library drawing in the appropriate location with the appro-
priate name, and the newly migrated blocks are now ready to be used.
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AutoCAD fundamentals

AutoCAD basic creation and editing

Last updated: 2017-11-28

Total video time: 19:24

There are several tools available in Civil 3D that are intended for basic geometry object cre-
ation. These basic objects can either be an end product such as with a standard detail layout or 
they can be used as a foundation from which to create Civil 3D objects. This section will focus 
on using basic Line, Polyline, 3D Polyline, Rectangle, Curve and Circle tools along with basic 
Object Snap settings to create geometry for a standard detail drawing.

Osnap & Line

Exercise files: acad-basc-creat-edit-data-c3d16.zip

Start with acad-basc-creat-edit-begin.dwg

acad-basc-creat-edit-01.mp4 5:00

Line

One of the most basic geometry objects available is the Line. In Civil 3D, a single Line has two 
vertices with independent locations and elevations. The Line is often used as a starting point or 
guide by which other objects are laid out.
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 1. Open acad-basc-creat-edit-begin.dwg
 2. Ribbon > Home tab > Draw panel > Line icon > Create Line

 A. Move cursor to location of start point
 I. Left-click

 B. Move cursor to location of end point
 I. Left-click

 3. Enter
 A. repeat steps 2.A-2.B

 4. Activate ERASE command: E
 A. Enter

 I. select both Lines create in steps 2-3
 B. Enter

Info: Keying Enter immediately after a command is executed will repeat the last 
command (see step 3 above)

Object snaps

When laying out object geometry or specifying a location when prompted in a command, it is 
often helpful to be able to reference existing object geometry. The object snap tool is built for 
just that. When Object Snaps are turned on (as a system variable) and you are prompted to spe-
cify a location within a command you can "snap" to the exact point desired based on the type of 
Object Snap turned on simply by moving the cursor within an Object Snap tolerance distance 
from that point. There are multiple ways to turn on Object Snaps for either "one-time" use or to 
remain on until turned off. We will cover these and other uses of Object Snaps in a later train-
ing module. This section is intended to show what Object Snaps are and provide a few examples 
of their use.

 1. Continue working in acad-basc-creat-edit-begin.dwg
 2. Status Bar > right-click Object Snap icon

 A. Endpoint: checked
 B. CEnter: checked
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 3. Status Bar > right-click Object Snap icon
 A. Object Snap Settings

 I. Object Snap On = checked
 II. OK
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 4. F3
 5. F3
 6. Ribbon > Home tab > Draw panel > Line icon > Create Line

 A. Move cursor near bottom endpoint of red guiding line on left side of Section A-A
 B. Observe Endpoint Object Snap glyph appear

 I. Left-click
 C. Move cursor near bottom endpoint of red guiding line on right side of Section A-A

 I. Left-click
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Info: F3 is a "hotkey" that will toggle Object Snaps on/off

 7. Tips: F3 A common theme you will notice in Civil 3D is that there are mul-
tiple ways to access the same commands. Toggling Object Snaps on via 
Object Snaps Settings vs F3 hotkey is only one example. With experience 
you will find the workflows you are comfortable with, thus reducing the 
some of the complexity of Civil 3D.

Polyline

Exercise files: acad-basc-creat-edit-data-c3d16.zip

Start with acad-basc-creat-edit-01.dwg

acad-basc-creat-edit-02.mp4 4:53

A Polyline is arguably one of the most versatile basic AutoCAD drawing objects. It can be edited 
in many ways including joining multiple linear geometry objects to one, adding/removing ver-
tices, adding/removing curves and more. In addition, many Civil 3D objects can be created 
from a Polyline, thus allowing you to set geometry in place using the simpler Polyline object 
then generate more powerful objects necessary for Civil 3D workflows. This section focuses on 
basic Polyline creation. It should be noted that when adding elevation data to your objects, a 
Line can have different elevations at start and end vertices, while a Polyline can have only one 
elevation for all vertices.

 1. Start with acad-basc-creat-edit-01.dwg
 2. Command Line > PL

 A. Spacebar
 I. Move cursor near  red guiding circle on left side of Section A-A

 a. Left Click
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 II. Move cursor near  red guiding circle on just to the left of of Section A-A
 a. Left Click

 III. Mid-command option: A
 a. Enter
 b. Move cursor near endpoint of subgrade Line

 i. Left Click
 ii. Enter

 3. Zoom out using mouse wheel
 A. Command Line > PL

 I. Begin drawing Polyline border using outermost guiding circles
 II. Command line prompt:  Close

Info: PL is a command alias that will activate the Polyline command. A com-
mand alias is an alternative to activating a command from the Ribbon or typ-
ing the full name of the command on the command line. Simply begin typing 
any command alias when your drawing area (ie Modelspace) is active to call 
it up on the command line

 4. Info: Keying Spacebar executes an active command the same way as key-
ing Enter

3D polyline & rectangle

Exercise files: acad-basc-creat-edit-data-c3d16.zip

Start with acad-basc-creat-edit-02.dwg

acad-basc-creat-edit-03.mp4 5:25

3D Polyline

A 3D Polyline behaves in many ways the same as a Polyline. The chief difference is that a 3D 
Polyline can have different elevations at each of its vertices. Having multiple vertex elevations 
assigned ahead of time can be useful when creating a Civil 3D object such as a Feature Line, 
Surface Breakline, or Pipe Network from a 3D Polyline.

 1. Open acad-basc-creat-edit-02.dwg
 2. Select Polyline border

 A. Properties palette > expand Geometry > Elevation = 100
 I. Cycle Current Vertex

 II. Observe same elevation for all vertices
 

 B. Delete
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 3. Ribbon > Home tab > Draw panel > Draw flyout > 3D Polyline button
 A. Begin drawing 3D Polyline border using outermost guiding circles
 B. command line: C

 I. Enter
 C. Select 3D Polyline > Properties palette > expand Geometry > Elevation = 100

 I.  a. Cycle Current Vertex
 b. Observe different elevation for other vertices
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Rectangle

The Rectangle command creates a closed Polyline with rectangle geometry. This simplifies the 
creation of a Polyline using the common rectangle shape.

 1. Continue working in acad-basc-creat-edit-02.dwg
 2. Select 3D Polyline border

 A. delete
 3. Ribbon > Home tab > Draw panel > Rectangle button

 A. Specify first corner
 I. Snap to upper left guiding circle

 B. Specify second corner
 I. Snap to lower right guiding circle

 4. Enter
 A. Repeat 3.A - 3.B around "6" text on left side of drawn objects

 5. Command line: RECT
 A. Enter

 I. Snap to guiding circle around "6" text on right side of drawn objects
 II. D

 a. Enter
 III. 2.8

 a. Enter
 IV. 11.6

 a. Enter, F3
 V. Move cursor to upper right quadrant relative to Rectangle starting corner

 a. Left-click

Curve & Circle

Exercise files: acad-basc-creat-edit-data-c3d16.zip

Start with acad-basc-creat-edit-02.dwg

acad-basc-creat-edit-04.mp4 4:06

Curve

The Curve command includes several variations that use existing reference objects (ie tangent 
Lines) to create single radius, compound, or reverse curves. The object created is referred to as 
an Arc. The curve command can be helpful when laying out geometry from which to create a 
smart Civil 3D object.
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 1. Continue working in acad-basc-creat-edit-02.dwg
 2. Ribbon > Home tab > Draw panel > Curve flyout > Create Curve on Two Lines

 A. Select edge of paved median shoulder (Section A-A) as first tangent
 B. Select left edge of asphalt concrete hatch boundary as second tangent
 C. Radius: 3

 I. Enter

 3. Ribbon > Home tab > Draw panel > Curve flyout > Create Curves between Two Lines
 1. Select one Section B-B Median Foreslope Line as first tangent
 2.  Select other Section B-B Median Foreslope Line as second tangent

 1. R
 1. Enter

 2. SPECIFY RADIUS: 20
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Circle

The Circle command creates an object with circular geometry. Civil 3D refers to the object as a 
Circle. If a Circle object is trimmed, it becomes an Arc object. Several options are built into the 
command from which to dictate the radius and location of the Circle.

 1. Continue working in acad-basc-creat-edit-02.dwg
 2. Ribbon > Home tab > Draw panel > Circle flyout > CEnter, RadiusF

 A. Ensure CEnter Object Snap is toggled on: F3
 B. Pan and Zoom to Plan View, R3-4 signage
 C. Move cursor over existing signage Arcs to activate CEnter Object Snap glyph

 I. Left-click
 II. SPECIFY RADIUS OF CIRCLE: 2.4
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 3. Zoom Extents

Object Selection

In order to direct commands or apply edits to an object, the objects must be selected.  In many 
cases this can be either before or after a command is activated. Selecting an object is also a 
good way to gather information about the object via the Properties palette. Objects can be 
selected using a variety of methods. In this section we will cover simple cursor selection, Win-
dow, Crossing, Lasso, Fence and Quick Selection. We will also cover ways to deselect, append 
and edit the current selection without need to start your selection over from scratch. 

Exercise files: acad-basc-creat-edit-data-c3d16.zip 

Start with acad-basc-creat-edit-end.dwg

acad-basc-creat-edit-05.mp4 6:44
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Properties palette population

When the Properties palette is open, selecting an object or group of objects will populate the 
Properties palette with object information common to the entire selection. 

 1. Open acad-basc-creat-edit-end.dwg
 2. Activate the Properties palette

 A. Command line > PROPERTIES
 3. Move cursor over Line representing subgrade

 A. Left-click Line geometry
 B. Observe population of Properties palette

 4. esc

Cursor selection

 1. Continue working in acad-basc-creat-edit-end.dwg
 A. move cursor PickBox over any object geometry in Modelspace

 I. Left-click to select object
 II. esc

LT-RT Window Select

All objects completely enclosed by a Window Selection will be included in the Selection Set. 
Objects to be selected are highlighted white.

 1. Continue working in acad-basc-creat-edit-end.dwg
 2. Move cursor left of desired object(s)

 A. Left-click to activate Window Selection
 B. Move cursor right of desired object(s)
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 C. Left-click to specify selection area
 D. esc

RT-LT Crossing Select

All objects at least partially enclosed by a Window Selection will be included in the Selection 
Set. Objects to be selected are highlighted white.

 1. Continue working in acad-basc-creat-edit-end.dwg
 2. Move cursor right of desired object(s)

 A. Left-click to activate Crossing Selection
 B. Move cursor left of desired object(s)
 C. Left-click to specify selection area
 D. esc
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Fence Select

All objects crossed by a Fence Selection path will be included in the Selection Set. Objects to be 
selected are highlighted white.

 1. Continue working in acad-basc-creat-edit-end.dwg
 2. Move cursor to desired location of Fence

 A. Left-click to activate Selection
 I. Command Line > F

 II. Enter
 a. Left-click to dictate additional Fence path vertices
 b. Enter
 c. Esc

Window Polygon Select

Similar to the standard Window Selection, all objects completely enclosed by a Window Polygon 
Selection will be included in the Selection Set. Objects to be selected are highlighted white.

 1. Continue working in acad-basc-creat-edit-end.dwg
 2. Move cursor to desired initial vertex of Window Polygon

 A. Left-click to activate Selection
 I. Command Line > WPF

 II. Enter
 a. Moving clockwise, Left-click to dictate successive Window Polygon 

vertices
 b. Enter
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 c. Esc

Crossing Polygon Select

Similar to the standard Crossing Selection, all objects at least partially enclosed by a Crossing 
Polygon Selection will be included in the Selection Set. Objects to be selected are highlighted 
white.

 1. Continue working in acad-basc-creat-edit-end.dwg
 2. Move cursor to desired initial vertex of Window Polygon

 A. Left-click to activate Selection
 I. Command Line > WP

 II. Enter
 a. Left-click to dictate successive Window Polygon vertices
 b. Enter
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 c. Esc

Lasso Select

Similar to both standard Window/Crossing or Polygon Window/Crossing Selection, a Lasso selec-
tion can be applied either clockwise or counter-clockwise. Objects to be selected are high-
lighted white.

 1. Continue working in acad-basc-creat-edit-end.dwg
 2. Move cursor to desired initial start point of Lasso Selection

 A. Left-click and hold mouse button to activate Lasso Selection
 I. Move cursor along desired boundary of Lasso Selection (begin path left of 

start point for crossing-type and vice-versa)
 II. Release mouse button
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 III. esc

Quick Select

The Quick Select tool allows you to build a selection query based on object properties. The 
query can either be inclusive (select what is queried) or exclusive (select all but what is quer-
ied). The query can also be set to append or replace any current selection set.

 1. Continue working in acad-basc-creat-edit-end.dwg
 A. Command line > QSELECT

 I. Apply to = Entire drawing
 II. Object type = Line

 III. Operator = Select All
 IV. Include in new selection set = checked
 V. Append to current selection = checked

 VI. OK
 B. Command line > QSELECT

 I. Apply to = Entire drawing
 II. Object type = Text
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 III. Operator = Equals
 IV. Value = CalibriLight
 V. Include in new selection set = checked

 VI. Append to current selection = checked
 VII. OK

 C. esc

Editing current selection

Once multiple objects are selected, you may wish to remove certain objects from the selection 
set. To switch selection tools from selecting to deselecting, hold the Shift key while performing 
the selection in Modelspace. A "-" glyph indicating deselection will appear next to the cursor 
when holding the Shift key and hovering over an object in the current selection set.
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 1. Continue working in acad-basc-creat-edit-end.dwg
 A. Select multiple objects using RT-LT Crossing Select method
 B. Hold Shift

 I. Use cursor selection to deselect objects from the selection set
 C. esc
 D. D

Grips

When an object is selected, Grips will be displayed along the object. These Grips make various 
geometric object edits available. They are generally located at key points along or adjacent to 
an object (ie Line endpoints/midpoint or Arc endpoints/midpoint/radius point. To edit an object 
based on a Grip, click on a Grip or hover over it and choose from available Grip options. There 
are several advanced object edits that can be performed using grips. Many of these will be 
covered in a later training module. This section will cover a sample of basic grip functions. This 
is intended to provide a general understanding of grips as a foundation for further independent 
exploration.

Tips: When performing grip edits, displacement values can be keyed in or spe-
cified by mouse click.

Exercise files: acad-basc-creat-edit-data-c3d16.zip 

Start with acad-basc-creat-edit-end.dwg

acad-basc-creat-edit-06.mp4 3:23
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Line grips

When a Line is selected, three Grips are display. The two endpoint vertex Grips allow you 
move/stretch or lengthen the respective vertex independently. The midpoint Grip allows you to 
move the Line with the midpoint as a basepoint, keeping all other geometry properties intact 
(ie length, rotation).

 1. Open acad-basc-creat-edit-end.dwg
 2. Select Line representing subgrade

 A. Left-click endpoint Grip
 I. Move mouse

 II. Left-click
 B. Hover over endpoint Grip

 I. Lengthen
 a. Move mouse
 b. Left-click

 C. Left-click midpoint Grip
 I. Move mouse

 II. Left-click
 3. Close acad-basc-creat-edit-end.dwg(do not save)

Arc grips

When an Arc is selected, four Grips are displayed. The two endpoint vertex Grips allow you 
move/stretch or lengthen the respective vertex independently. The midpoint Grip allows you to 
change the radius of the arc keeping intact either the location of the endpoint vertices or their 
alignment with the radius point. The radius point grip allows you to move the arc with the 
radius point as a basepoint,  keeping all other geometry properties intact (ie radius).
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 1. Open acad-basc-creat-edit-end.dwg
 2.  Select Arc representing median nose

 A. Hover over midpoint Grip
 I. Stretch

 a. Move mouse
 b. Left-click

 B. Hover over midpoint Grip
 I. Radius

 a. Move mouse
 b. Left-click

 C. Hover over endpoint Grip
 I. Stretch

 a. Move mouse
 b. Left-click

 D. Hover over endpoint Grip
 I. Lengthen

 a. Move mouse
 b. Left-click

 3. Close acad-intrfc-begin.dwg(do not save)

Polyline grips

When a Polyline is selected, square Grips are displayed at all vertices and dash Grips are dis-
played at all line segment midpoints. Endpoint vertex Grips allow you stretch (ie move) the 
respective vertex independently or add a vertex adjacent to the endpoint. The midpoint Grip 
allows you to stretch the line segment, add a vertex between the two adjacent endpoint ver-
tices, or convert the line segment to an arc. When stretching a line segment, the length and 
rotation geometry of the selected line segment stays intact. Geometry of any adjacent line seg-
ments will adjust as necessary. When converting a Polyline line segment to arc, a radius must 
be specified. A Polyline arc segment can also be converted back to a line segment.
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 1. Open acad-basc-creat-edit-end.dwg
 2. Select Polyline representing bottom of base course

 A. Hover over endpoint Grip
 I. Add Vertex

 a. Move mouse
 b. Left-click

 B. Hover over midpoint Grip
 I. Add Vertex

 a. Move mouse
 b. Left-click

 C. Hover over Polyline line segment midpoint Grip
 I. Convert to Arc

 a. Move mouse
 b. Left-click

 D. Hover over Polyline arc segment midpoint Grip
 I. Convert to Line

 3. Close acad-basc-creat-edit-end.dwg(do not save)

Object snaps

Last updated: 2017-12-01

Total video time: 19:47

Object Snaps are tools built into Civil 3D that help ensure precision when laying out geometry 
with both basic objects (ie Line, Polyline) and smart Civil 3D objects. The idea is that when 
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specifying location during a command, a given Object Snap will force the location to be at the 
exact specified object point when the command is active and your cursor is within the Object 
Snap buffer distance. When an Object Snap is ready to take effect, a glyph will appear indic-
ating this.

Object snap glyphs

Object 
Snap

Glyph Image
Object 

Snap
Glyph Image

Endpoint Extension

Midpoint Insertion

Center
Per-
pendicular

Geometric 
Center

Tangent
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Object 
Snap

Glyph Image
Object 

Snap
Glyph Image

Node Nearest

Quadrant
Apparent 
Intersection

Inter-
section

Parallel

Introduction & settings

Exercise files: acad-objct-snp-data-c3d16.zip 

Start with acad-objct-snp-begin.dwg

acad-objct-snp-01.mp4 4:06

Access to settings

One of the most intuitive ways to access Object Snap settings is by interacting with the Object 
Snap icon on the Status Bar.
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 1. Open acad-objct-snp-begin.dwg
 2. Status Bar > Customization

 A. 2D Object Snaps = checked

 3. Status Bar > Object Snap icon
 A. Right-click

 I.  Midpoint = checked
 B. Left-click icon to Turn on Object Snaps
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 4. Ribbon > Home tab > Draw panel > Polyline button
 A. Move cursor over existing objects

 I. Observe Midpoint glyph appear
 II. Left click to "snap" to Object Snap location

 III. esc
 5. Status Bar > Object Snap icon

 A. Left-click flyout triangle 
 B. Observe access to running Object Snaps list

 I. Object Snap Settings...
 a. Drafting Settings dialog box, Object Snap tab
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 a. Object Snap On = checked
 b. Select All
 c. Clear All
 d. Endpoint = checked

 6. Modelspace
 A.  Shift+right-click

 I. Osnap Settings...
 B. Observe access to Drafting Settings dialog, Object Snap tab

Introduction to Object Snap use

In this example you will use the Midpoint Snap to move Mtext to the correct location on a title 
block.

 1. Continue working in  acad-intrfc-begin.dwg
 2. Status Bar > Object Snap icon

 A. Right-click
 I. Midpoint = checked
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 3. Select "MAINTAINENCE CROSSOVER FOR FREEWAYS" Mtext object
 A. Select insertion point grip

 I. Move cursor near middle of red construction line
 II. Observe Midpoint glyph appear

 III. Left-click

 B. Select red construction line
 I. delete

Workflow efficiency

Exercise files: acad-objct-snp-data-c3d16.zip 

Start with acad-objct-snp-01.dwg

acad-objct-snp-02.mp4 5:34

F3 hotkey

A "hotkey" is essentially a single keystroke shortcut designed to streamline execution of a task 
or string of tasks. Many hotkeys are programmed and ready for use in Civil3D. The"f3" key is 
one powerful hotkey relevant to Object Snap use. You might incorporate this into your typical 
Object Snap workflow to improve efficiency.

 1. Open  acad-objct-snp-01.dwg
 2. Toggle Object Snaps off: f3
 3. Toggle Object Snaps on: f3
 4. Ribbon > Home tab > Draw panel > Polyline button

 A. Hold f3
 B. Hover over a Line object
 C. Observe that Object Snaps are temporarily suppressed
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Object snap cycling

Pressing the tab key allows you to cycle through Object Snaps relevant to a given object as long 
as those Object Snaps are turned on.

 1. Continue working in  acad-objct-snp-01.dwg
 2. Status Bar > Object Snap icon

 A. Right-click
 I. Endpoint = checked

 II. Midpoint = checked
 B. Verify Object Snaps turned on

 3. Ribbon > Home tab > Draw panel > Polyline button
 A. Hover cursor over middle of EDGE OF PAVED MEDIAN SHOULDER Line

 I. Observe Midpoint glyph appear
 II. tab

 III. tab
 IV. tab

System variable: ignore elevation

By default, Civil 3D will apply existing geometry elevation  when using Object Snaps and existing 
geometry to specify location. You can change this behavior so elevation properties are ignored 
and only location in the X,Y plane are used when "snapping". This is done by resetting the 
OSNAPZ System Variable. When this is done, the elevation Z=0 will be used for new location spe-
cification.

 1. Continue working in  acad-objct-snp-01.dwg
 2. Ribbon > Home tab > Draw panel > Polyline button

 A. Draw a single Polyline
 I. Select Polyline drawn

 II. Properties Palette > Geometry
 a. Set Elevation = 100
 b. esc
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 3. Ribbon > Home tab > Draw panel > Polyline button
 A. Use Endpoint Snap to specify location on end of Polyline drawn in 2.A

 I. Select Polyline drawn
 II. Properties Palette > Geometry

 a. Observe Elevation = 100
 4. COMMAND LINE: OSNAPZ

 A. enter
 B. 1
 C. enter

 5. Ribbon > Home tab > Draw panel > Polyline button
 A. Use Endpoint Snap to specify location on end of Polyline drawn in 2.A

 I. Select Polyline drawn
 II. Properties Palette > Geometry

 a. Observe Elevation = 0
 6. Select previous three Polylines drawn

 A. delete

Temporary overrides

Calling up temporary Object Snap overrides either through the command line or right-click 
menu allows a "one-time use" override to current Object Snap settings. For example, you could 
have Endpoint Object Snaps currently on, then use a temporary Midpoint Object Snap override 
to ignore all Endpoint Snaps and use Midpoint Snaps for the next location specification. Altern-
atively you might have all running Object Snaps off, then use any temporary Object Snap over-
rides as you need them for the next location specification. This temporary override workflow 
avoids the need to open a running Object Snap interface and thus can improve efficiency.

Command line

After a command requiring location input is activated, type in the Object Snap override alias 
you wish to use and "enter" to execute. This will generally be the first three letters of the 
Object Snap name (ie "end" for Endpoint). You can then continue with the cursor based location 
specification.

 1. Continue working in  acad-objct-snp-01.dwg
 2. Toggle Object Snaps off: f3
 3. Ribbon > Home tab > Draw panel > Polyline button

 A. COMMAND LINE: END
 I. enter

 B. Move cursor to existing object endpoint
 I. Observe endpoint glyph appear

 II. Left-click
 C. Move cursor to existing object endpoint

 I. Observe lack of endpoint glyph
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 D. esc

Right-click menu

After a command requiring location input is activated, hold Shift key and right-click to open the 
temporary Object Snap override menu. Choose a one-time use temporary Object Snap override 
from this list. Continue location specification.

 1. Continue working in  acad-objct-snp-01.dwg
 2. Turn on running Endpoint Object Snap using your method of choice
 3. Ribbon > Home tab > Draw panel > Polyline button

 A. Specify first Polyline vertex using Endpoint Object Snap
 B.  Shift+Right-click

 I. Left-click Midpoint
 C. Move cursor near middle of existing Line object

 I. Left-click

Examples 1

Exercise files: acad-objct-snp-data-c3d16.zip 

Start with acad-objct-snp-01.dwg

acad-objct-snp-03.mp4 4:08

Geometric Center

This Object Snap analyzes any closed area object and snaps to the centroid of that area. The 
object can be irregularly shaped, but must show as "closed" in the properties palette for the 
Geometric Center snap to work.

 1. Continue working in  acad-objct-snp-01.dwg
 2. Turn on running Geometric Center Object Snap using your method of choice
 3. Select "6" Mtext at right of drawing extents

 A. Select middle-center Mtext insertion point
 I. Move cursor to hover over adjacent rectangular closed Polyline

 II. Observe Geometric Center glyph appear
 III. Left-click
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Quadrant

This Object Snap grabs the location on a Circle, Ellispse or Arc object intersecting with any of 
the four 2D quadrant lines (ie along X or Y axis).

 1. Continue working in  acad-objct-snp-01.dwg
 2. Turn on running Quadrant Object Snap using your method of choice
 3. Select Line representing signage in the PLAN VIEW area of drawing extents

 A. Select midpoint grip on Line 
 B. Move cursor near Circle representing sign post in PLAN VIEW area of drawing 

extents
 I. Observe Quadrant glyph along positive X-axis appear

 II. Left-click
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Examples 2

Exercise files: acad-objct-snp-data-c3d16.zip 

Start with acad-objct-snp-02.dwg

acad-objct-snp-04.mp4 5:59

Tangent

The Tangent Object Snap finds the point of tangency on a Circle, Arc, or Ellipse object coming in 
from any Line or Polyline object.

 1. Open  acad-objct-snp-02.dwg
 2. Turn on running Center and Tangent Object Snaps using your method of choice
 3. Ribbon > Home tab > Draw panel > Polyline button

 A. Move cursor near red Circle guiding mark in PLAN VIEW area of drawing extents
 I. Observe Center Object Snap glyph appear

 II. Left-click
 B. Move cursor near Circle representing median back of curb in PLAN VIEW area of 

drawing extents
 I. Observe Tangent Object Snap glyph appear

 II. Left-click
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Parallel

Use the Parallel Object Snap to lay out new linear objects while referencing existing linear 
objects for directional orientation. You will first start the new linear object command (ie Line), 
then hover over the desired linear reference object. This will activate the Parellel Object Snap 
and you will see a dashed extension line as a preview of your new linear object draw parallel to 
that existing.

 1. Continue working in  acad-objct-snp-02.dwg
 2. Turn on running Enpoint, Apparent Intersection and Parallel Object Snaps using your 

method of choice
 3. Ribbon > Home tab > Draw panel > Line flyout > Create Line

 A. Move cursor near upper right of SECTION A-A, CRUSHED AGGREGATE 
BASE COURSE border Line

 I. Observe Endpoint Object Snap glyph appear
 II. Left-click

 B. Move cursor to hover over adjacent TOPSOIL Line
 I.  Observe Parallel Object Snap glyph appear

 C. Move cursor along path from the new Line starting vertex parallel to TOPSOIL 
Line

 I. Observe Parallel preview line appear
 D. Move cursor to point of intersection of parallel preview line and existing BOTTOM 

OF MEDIAN Line.
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 I. Observe Apparent Intersection Object Snap glyph appear
 II. Left-click

Polar and osnap tracking

Last updated: 2017-12-01

Total video time: 13:52

Both Polar Tracking and Object Snap (aka Osnap) Tracking are tools designed to streamline the 
process of specifying location precisely when executing a command. Polar tracking allows "snap-
ping" along vectors based on preset angle increments around an initially specified point. Osnap 
Tracking allows projection out from existing Osnap locations to specify the next command loc-
ation. These projection vectors can come from multiple Osnap locations and can use current 
Polar Tracking angles to form the projections. Once you become familiar with the tools, both 
Polar Tracking and Object Tracking can greatly improve efficiency when specifying command 
location.

Polar Tracking

Exercise files: acad-polr-osnp-trak-data-c3d16.zip

Start with acad-polr-osnp-trak-begin.dwg

acad-polr-osnp-trak-01.mp4 4:12

Basics

This section will get you started using Polar Tracking with an example exercise laying out title 
block Lines.

 1. Open acad-polr-osnp-trak-begin.dwg
 2. Status Bar > Customization flyout

 A. Polar Tracking = checked
 3. Status Bar

 A. Polar Tracking on
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 4. Status Bar > Polar Tracking icon
 A. Right-click

 I. Increment = 45, 90, 135, 180...

 5. Ribbon > Home tab > Draw panel > Polyline button
 A. Left-click anywhere in Modelspace to specify first points
 B. Rotate cursor around first point location
 C. Observe Polar Tracking vector "snapping"

 6. Status Bar
 A. Dynamic Input off
 B. Polar Tracking off
 C. Center Object Snap on

 7. Zoom to lower right of drawing extents
 8. L

 A. Enter
 B. Snap to bottom red guiding Circle for first point

 I. @26<180
 a. Enter

 II. Enter
 C. Enter
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 D. Status Bar
 I. Dynamic Input on

 E. Snap to middle red guiding Circle for first point
 I. 26

 II. tab
 III. 180

 a. Enter
 9. Status Bar

 A. Dynamic Input off
 B. Polar Tracking on

 10. L
 A. enter
 B. Snap to top red guiding Circle for first point

 I. Move cursor until 180 deg Polar Tracking vector appears
 a. 26

 i. enter
 II. Move cursor until 270 deg Polar Tracking vector appears

 a. 16.5
 i. enter

Access to settings

Exercise files: acad-polr-osnp-trak-data-c3d16.zip

Start with acad-polr-osnp-trak-01.dwg

acad-polr-osnp-trak-02.mp4 4:28

You can customize the way Polar Tracking works based on your preferences and/or workflow 
needs. Here you will be able to add increment angles, additional angles (single angle relative to 
0 deg), set display preferences, set Osnap Tracking interaction preferences, and toggle 
between relative (direction of last drawn line segment is assumed as 0 deg) and absolute angle 
measurement. This section will walk you through these settings and their effect on Polar Track-
ing function.
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 1. Open acad-polr-osnp-trak-begin.dwg
 2. Status Bar > Polar Tracking icon > Polar Tracking flyout > Tracking Settings

 A. Polar Tracking On = checked
 B. Polar Angle Settings

 I. Increment angle = 60
 C. OK

 3. PL
 A. enter
 B. Left-click in anywhere in Modelspace to specify first point

 I. Rotate cursor around first point
 II. Observe 60 deg Polar Tracking angle increments

 C. esc
 4. Status Bar > Polar Tracking icon > Polar Tracking flyout > Tracking Settings

 A. Polar Angle Settings
 I. Additional angles = checked

 II. New
 III. 75

 B. OK
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 5. PL
 A. enter
 B. Left-click in anywhere in Modelspace to specify first point

 I. Rotate cursor around first point
 II. Observe 75 deg Polar Tracking additional angle

 C. esc
 6. Status Bar > Polar Tracking icon > Polar Tracking flyout > Tracking Settings

 A. Polar Angle measurement
 I. Absolute = checked

 B. OK
 7. Status Bar > Polar Tracking icon > Polar Tracking flyout

 A. Increment = 45, 90, 135, 180...
 8. PL

 A. enter
 B. Left-click in anywhere in Modelspace to specify first and second points

 I. Rotate cursor around second point
 II. Observe Polar Tracking increment angle relative to positive x-axis = 0 deg

 III. Status Bar > Polar Tracking icon > Polar Tracking flyout > Tracking Set-
tings

 a. Polar Angle measurement
 i. Relative to last segment = checked

 b. OK
 IV. Rotate cursor around second point
 V. Observe Polar Tracking increment angle relative to last line segment 

drawn = 0 deg
 C. esc

Object Snap Tracking

Exercise files: acad-polr-osnp-trak-data-c3d16.zip

Start with acad-polr-osnp-trak-02.dwg

acad-polr-osnp-trak-03.mp4 4:59

In this section you will be introduced to the Object Snap (aka Osnap) Tracking tool including 
functionality when combined with Polar Tracking and Dynamic Input. Keep in mind that for 
Object Snap Tracking to take effect, you will first need to have at least one Osnap turned on.

Basics

 1. Open acad-polr-osnp-trak-02.dwg
 2. Status Bar > Polar Tracking icon > Polar Tracking flyout

 A. Increment = 45, 90, 135, 180...
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 3. Status Bar > Object Snap icon > Object Snap flyout
 A. Endpoint = checked

 4. Status Bar
 A. Polar Tracking on
 B. Object Snap Tracking on
 C. Object Snap on

 5. PL
 A. enter

 6. Move cursor to hover over a Line endpoint
 A. Observe Object Snap Tracking activate
 B. Rotate cursor around active Object Snap Tracking location
 C. Observe Tracking vectors available based on Polar Tracking increments

 7. Move cursor to hover over additional endpoint
 A. Move cursor until Tracking vectors intersect

 8. Status Bar > Polar Tracking icon > Polar Tracking flyout > Tracking Settings...
 A. Object Snap Tracking Settings

 I. Track orthogonally only = checked
 B. OK

 9. Move cursor to hover over a Line endpoint
 A. Observe Object Snap Tracking activate
 B. Rotate cursor around active Object Snap Tracking location
 C. Observe Tracking vectors available based on x and y-axes only

 10. Move cursor to hover over activated Object Snap Tracking location again to deactivate
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Exercise: align objects

 1. Continue working in acad-polr-osnp-trak-02.dwg
 2. Status Bar > Object Snap icon > Object Snap flyout

 A. Midpoint = checked
 B. Insertion Point = checked

 3. Select both SECTION A-A and SECTION B-B Mtext objects
 A. Hold shift

 I. Select middle insertion point grips on both Mtext objects
 II. Note grip color change to red

 A. Release shift
 4. Select one red Mtext grip to begin Move command

 A. Move cursor to hover over insertion point grip
 I. Observe insertion point Osnap Tracking activate

 B. Move cursor to hover over midpoint of top sheet border Line
 I. Observe midpoint Osnap Tracking activate

 C. Move cursor to intersection of Osnap Tracking vectors
 D. Left-click to specify destination location for Move command
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Exercise: lay out geometry

 1. Continue working in acad-polr-osnp-trak-02.dwg
 2. Status Bar > Object Snap icon > Object Snap flyout

 A. Endpoint = checked
 3. Status Bar

 A. Polar Tracking on
 B. Dynamic Input on

 4. L
 A. enter

 5. Move cursor to hover over lower right sheet border Line endpoint
 A. Observe Object Snap Tracking activation
 B. Move cursor left of Endpoint Snap location along 180 deg Object Snap Tracking 

vector 
 I. 26

 II. enter
 III. Move cursor above Line first point along 90 deg Object Snap Tracking vec-

tor
 a. 16.5
 b. enter

 IV. Move cursor right of Line second point along 0 deg Object Snap Tracking 
vector

 a. 26
 b. enter

AutoCAD modify

Last updated: 2017-12-01
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Total video time: 39:51

Modify commands are used to make changes to objects that have already been drawn. These 
commands can greatly improve workflow efficiency by eliminating the need to re-create 
objects, streamlining object creation and location specification, combining multiple commands, 
and otherwise utilize existing geometry objects.

Move & Copy

Exercise files: acad-modify-data-c3d16.zip

Start with acad-modify-begin.dwg

acad-modify-01.mp4 3:40

Move

The Move command allows you to relocate objects either by keying in X, Y, Z displacement or 
by cursor-selecting a base point and destination point.

 1. Open acad-modify-begin.dwg
 2. Ribbon > Home tab > Modify panel > Move

 A. Select objects: SD.D.11.A 1-3 text in lower right of drawing extents 
 B. Specify base point: lower right Endpoint of sheet border Line
 C. Specify second point: lower left Endpoint of sheet border Line
 D. Ctrl+z 

 3. sRibbon > Home tab > Modify panel > Move
 A. Select objects: SD.D.11.A 1-3 text in lower right of drawing extents 
 B. D

 I. Enter
 C. -50,0,0

 I. enter
 D. Ctrl+z  

Page: 112

Published on: 2/21/2018

AutoCAD modify

http://www.c3dkb.dot.wi.gov/data/acad/acad-modify-data-c3d16.zip
http://www.c3dkb.dot.wi.gov/video/acad/acad-modify-01.mp4


Copy

The Copy command allows you to duplicate an existing object and then paste it to a location 
either by keying in X, Y, Z displacement or by cursor-selecting a base point and destination 
point.

 1. Continue working in acad-modify-begin.dwg
 2. Ribbon > Home tab > Modify panel > Copy

 A. Select objects: SD.D.11.A 1-3 text in lower right of drawing extents 
 I. Right-click

 B. Specify second point: lower left Endpoint of sheet border Line
 C. Left-click multiple additional destination points
 D. Quick Access Toolbar > Undo

 3. Ribbon > Home tab > Modify panel > Copy
 A. Select objects: SD.D.11.A 1-3 text in lower right of drawing extents 

 I. Right-click
 B. D

 I. enter
 C. -50,0,0

 I. enter
 D. Ctrl+z

 4. CO
 A. enter
 B. Mode

 I. Single
 C. Displacement

 I. -50,0,0
 a. enter

Rotate & Scale

Exercise files: acad-modify-data-c3d16.zip

Continue with acad-modify-begin.dwg

acad-modify-02.mp4 5:05

Rotate

The Rotate command allows you to rotate an object in the XY plane about a point either by key-
ing in a rotation angle, selecting a relative rotation point, or picking two points to form a ref-
erence "line" and two points to form a destination rotation "line". 
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 1. Continue working in acad-modify-begin.dwg
 2. Select SD.D.11.A 1-3 text in lower middle of drawing extents 

 A. M
 I. enter

 B. hold f3 to temporarily override Osnaps
 I. Specify base point: lower left of SD.D.11.A 1-3 text

 II. Specify second point: lower left Endpoint of sheet border Line
 1. Ribbon > Home tab > Modify panel > Rotate

 1. Select SD.D.11.A 1-3 text
 1. Right-click
 2. Specify base point: lower left Endpoint of sheet border Line
 3. SPECIFY ROTATION ANGLE: 180

 1. enter
 2. RO

 1. enter
 3. Select SD.D.11.A 1-3 text

 1. Right-click
 2. Reference

 1. Left-click first and second reference angle points 

 3. Specify the new angle: P
 1. enter

 4. Left-click first and second new angle points 
 5. Select SD.D.11.A 1-3 text

 1. Right-click
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 6. RO
 1. enter
 2. Hold shift to temporarily use ORTHOMODE (force cursor along X or 

Y-axis)
 3. Move cursor until text is rotated 180 degrees
 4. left-click

Scale

The Scale command allows you to resize a selection of objects while holding a specified base 
point either by keying in a scale factor or referencing existing objects.

 1. Continue working in acad-modify-begin.dwg
 2. Double-click middle mouse wheel to Zoom Extents
 3. Window-Select full-sized "PLAN VIEW"

 A. delete
 4. Ribbon > Home tab > Modify panel > Scale

 A. Select objects: Window-Select half-size objects to left of full-size objects
 B. Specify base point: lower right of half-size border Line
 C. Specify scale factor: 2

 I. enter
 D. Ctrl+z

 5. Window-Select half-sized objects to left of full-size objects
 A. SC

 I. enter
 B. Specify base point: lower right of half-size border Line
 C. Reference

 I. enter
 D. Specify reference length: Left-click beginning and end of bottom half-size border 

Line
 E. Specify new length: P

 I. enter
 II. Left-click beginning and end of bottom full-sized border Line

 6. Window Select "PLAN VIEW" objects that were Scaled up
 A. M

 I. enter
 B. Specify base point: lower left of bottom border Line that was Scaled up
 C. Specify second point: lower left of original full-size bottom border Line

 7. Select redundant border Lines
 A. delete

 8. Double-click middle mouse wheel to Zoom Extents

Join & Explode
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Exercise files: acad-modify-data-c3d16.zip

Start with acad-modify-01.dwg

acad-modify-03.mp4 5:34

Join

The Join command will take all Line and/or Arcs objects included in a selection set that share 
common start and end point coordinates (same X,Y,Z) and combine them into a single Polyline.

 1. Open acad-modify-01.dwg
 2. Pan and zoom to PLAN VIEW detail
 3. Ribbon > Home tab > Modify panel flyout > Join button
 4. Select Lines and Arc representing median back of curb

 A. enter
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 1. J
 A. enter

 2. Select all "breakline symbol" Polylines along right side of PLAN VIEW detail
 A. enter

 3. Observe "0 objects joined, 6 objects discarded..." on command line history
 4. Select  "breakline symbol" Polyline near bottom right of PLAN VIEW detail

 A. Left-click vertex grip
 B. Use Endpoint Object Snap to set vertex at same location as adjacent Polyline ver-

tex

 5. Select two Polylines whose vertices were aligned in step 4
 6. J

 A. enter
 7. Observe "5 segments joined into 1 polyline" on command line history
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Explode

The Explode command will break objects down into foundational pieces. For example, a single 
Polyline can be Exploded into multiple Lines and/or Arcs that make up the Polyline geometry.

Warning: Never Explode a Civil 3D Object (ie Alignment, Surface, Corridor). This 
will cause you to lose dynamic updating, labeling, data referencing and other 
powerful object functionality. Thus, the Explode command should be limited to 
simple AutoCAD objects as demonstrated in this section.

 

 1. Continue working in acad-modify-01.dwg
 2. Ribbon > Home tab > Modify panel  > Explode button
 3. Select PLAN VIEW median Polyline previously Joined

 A. enter
 4. Zoom and pan to R3-4 signage detail
 5. X

 A. Select R3-4 Block
 B. enter

 6. X
 A. Select outermost Polyline resulting from the Exploded R3-4 Block
 B. enter
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Erase & Stretch

Exercise files: acad-modify-data-c3d16.zip

Continue with acad-modify-01.dwg

acad-modify-04.mp4 2:41

Erase

The Erase command allows you to remove a selection set of objects from a drawing. You can 
either invoke the command and then select objects to remove using your selection method of 
choice or vice-versa.

Tip: It is a good idea to hit esc a couple times before selecting objects to erase. 
This will ensure that you do not have objects selected that you do not intend to 
erase. Selected objects are not always visible depending your current Zoom level 
and Pan location. Your Properties Palette is a good place to check on what is 
included in the current selection set.
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 1. Continue working in acad-modify-01.dwg
 2. Ribbon > Home tab > Modify panel  > Erase button
 3. Select outermost Lines surrounding the R3-4 and R3-4A details

 A. enter

Stretch

The Stretch command allows you to move objects and simultaneously lengthen and reorient 
adjacent objects while maintaining the original attachment location. After invoking the Stretch 
command, any objects completely enclosed in a Crossing selection will be moved and any 
objects partially enclosed in the same Crossing selection will be lengthened and reoriented.

 1. Continue working in acad-modify-01.dwg
 2. Ribbon > Home tab > Modify panel flyout > Stretch
 3. Use a Window Selection to select all "breakline symbol" Polylines on the left side of the 

PLAN VIEW detail
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 A. enter

 B. Right-click to finish selection
 I. Left-click to specify base point

 II. Move Cursor and Left-click to specify second point
 III. Observe move-only behavior

 4. Ctrl+z
 5. Ribbon > Home tab > Modify panel flyout > Stretch
 6. Use a Crossing Selection to select all "breakline symbol" Polylines on the left side of the 

PLAN VIEW detail
 A. enter
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 B. Right-click to finish selection
 I. Left-click to specify base point

 II. Move Cursor and Left-click to specify second point
 III. Observe intended Stretch behavior

Mirror & Offset

Exercise files: acad-modify-data-c3d16.zip

Start with acad-modify-02.dwg

acad-modify-05.mp4 5:21

Mirror

The Mirror command allows you to essentially copy, rotate, and paste an object in the X-Y 
plane about a mirror line you specify. You can then choose to keep or remove the original 
object you have mirrored. This can greatly reduce your task time  whenever you are creating 
object with an axis of symmetry in the X-Y plane.

 1. Open acad-modify-02.dwg
 2. Zoom and Pan to PLAN VIEW detail area of drawing
 3. Ribbon > Home tab > Modify panel > Mirror
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 4. Select "section line arrow" and "B" Text in upper pavement area of PLAN VIEW detail
 A. Right-click
 B. Turn on Quadrant Osnap
 C. Use Quadrant Osnap to specify first point of mirror line at quadrant point on 

median Arc
 D. Use Quadrant Osnap to specify second point of mirror line at center of opposite 

median Arc

 A. ERASE SOURCE OBJECTS: N
 I. enter

 5. MIR
 A. enter
 B. Select "THROUGH PAVEMENT" Text and adjacent "arrow symbol"
 C. Right-click
 D. Turn on Midpoint Osnap
 E. Use Midpoint Osnap to specify first point of mirror line at upper midpoint of edge-

of-pavement Line
 F. Use Midpoint Osnap to specify second point of mirror line at lower midpoint of 

edge-of-pavement Line
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 G. ERASE SOURCE OBJECTS: N
 I. enter

 6. Select newly created "THROUGH PAVEMENT" Text and adjacent "arrow symbol"
 7. M

 A. enter
 B. Specify base point and second point to move objects to lower pavement area of 

PLAN VIEW detail

Offset

The Offset command allows you to create an object in reference to existing Polyline, Line or 
Arc objects. The geometry of the newly created objects is dictated by a constant distance meas-
ured perpendicularly from the source object. You can call out the offset distance using a known 
numeric value or by specifying an offset location using your cursor. This tool is especially help-
ful when laying out proposed roadway or parcel linework (ie Edge of Pavement, ROW)

Tip: Using modify commands such as Offset to manipulate Polylines is a great way 
to lay the foundation for dynamic Civil 3D Objects. This is because many dynamic 
Civil 3D Objects (ie Alignment, Feature Line) can be initially created from simpler 
AutoCAD Objects (ie Polyline). 

 

 1. Continue working with acad-modify-02.dwg
 2. Zoom and Pan to SECTION A-A detail area of drawing
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 3. Ribbon > Home tab > Modify panel > Offset button
 A. SPECIFY OFFSET DISTANCE: 1.5
 B. enter
 C. SELECT OBJECT TO OFFSET: select subgrade Line on left side of SECTION 

A-A detail
 D. SPECIFY POINT ON SIDE TO OFFSET:  left-click above subgrade Line

 A. enter
 4. OFFSET

 A. enter
 B. SPECIFY OFFSET DISTANCE: THROUGH
 C. Turn on Endpoint Osnap
 D. SPECIFY THROUGH POINT: Endpoint of median nose Arc

 E. SELECT OBJECT TO OFFSET: select "CRUSHED AGGREATED BASE COURSE 
SHOULDER" Line on right side of SECTION A-A detail

 F. SPECIFY THROUGH POINT: Endpoint of median nose Arc on right side of 
SECTION A-A detail

 5. OFFSET
 A. enter
 B. SELECT OBJECT TO OFFSET: MEDIAN FORESLOPES Polyline in SECTION B-

B detail
 C. SPECIFY OFFSET DISTANCE: 10

 I. enter
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 D. specify point on side to offset: above selected Polyline
 E. Repeat steps 5.A thru 5.D selecting previously offset Polyline as object to offset

 I. Observe disappearance of Arc segement on offset Polyline

Trim, Extend & Lengthen

Exercise files: acad-modify-data-c3d16.zip

Continue with acad-modify-02.dwg

acad-modify-06.mp4 3:50

Trim

The Trim command allows you to modify existing geometry such that a section is removed 
based on intersection with other referenced existing geometry. For example, a Line can be 
shortened to the point at which it intersects with another Line. The Trim command applies to 
objects such as Line, Polyline, Circle, Ellipse, and Arc.

 1. Continue working with acad-modify-02.dwg
 2. Zoom and Pan to SECTION A-A detail area of drawing
 3. Ribbon > Home tab > Modify panel > Trim

 A. SELECT OBJECTS: select smaller Arc intersecting with Line representing 
AGGREGATE SHOULDER

 B. TRIM: select segment of Line you wish to trim
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Extend

The Extend command is essentially the reverse of the Trim command. Extend allows you to 
lengthen a geometry object (ie Line, Polyline, Arc) up to the point where it would intersect ref-
erenced existing geometry.

 1. Continue working with acad-modify-02.dwg
 2. Ribbon > Home tab > Modify panel > Extend

 A. SELECT OBJECTS: select median nose Arc on right side of SECTION A-A detail
 B. EXTEND: select Line you wish to extend

Tips: 
Hold shift while the Trim command is active in order to switch to the Extend command 
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on the fly.

While selecting objects to Extend or Trim, choose the mid-command option <select all>. 
This allows you to use any existing geometry object as a potential Extend boundary or 
Trim cutting edge.

Lengthen

The Lengthen command allows you to continue an object along it's current direction without 
the need for existing geometry to serve as a boundary to extend to. You can use Object Snaps to 
specify the amount you wish to lengthen the object. The Lengthen command also includes mid-
command options to measure selected object geometry.

 1. Continue working with acad-modify-02.dwg
 2. Ribbon > Home tab > Modify flyout > Lengthen button

 

 A. SELECT AN OBJECT TO MEASURE OR: DY
 I. enter

 B. SELECT AN OBJECT TO CHANGE: select Line on left side of SECTION A-A 
representing SUBGRADE

 C. SPECIFY NEW END POINT: use Endpoint Osnap to select the end of the 
Line representing CRUSHED AGGREGATE BASE COURSE SHOULDER on the right 
side of SECTION A-A detail

 D. enter
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Fillet & Break

Exercise files: acad-modify-data-c3d16.zip

Start with acad-modify-03.dwg

acad-modify-07.mp4 6:03

Fillet

The Fillet command allows you to insert an Arc at the intersection (or apparent intersection) of 
two Lines (or Polylines) and trim the Lines at the points of tangency of the Arc. Fillet mid-com-
mand options allow you to specify Radius, apply Fillets to all line segment intersections on a 
Polyline, or continue the command and apply it multiple times consecutively.

 1. Open acad-modify-03.dwg
 2. Zoom and Pan to R3-4 sign above PLAN VIEW detail
 3. Ribbon > Home tab > Modify panel > Fillet button

 A. SELECT FIRST OBJECT OR: R
 I. enter

 B. SPECIFY FILLET RADIUS: 0
 I. enter
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 C. 
 D. SELECT FIRST OBJECT: select one of the outermost R3-4 detail Lines
 E. SELECT SECOND OBJECT TO APPLY CORNER: select adjacent R3-4 

detail Line
 4. F

 A. enter
 B. SELECT FIRST OBJECT OR: R

 I. enter
 C. SPECIFY FILLET RADIUS: 0.35

 I. enter
 D. SELECT FIRST OBJECT: select one of the outermost R3-4 detail Lines
 E. SELECT SECOND OBJECT TO APPLY CORNER: select adjacent R3-4 

detail Line
 5. F

 A. enter
 B. SELECT FIRST OBJECT OR: M

 I. enter
 C. Apply Fillets to all remaining outermost R3-4 detail Lines

 I. enter
 6. Select all four innermost Lines on R3-4 detail

 A. J
 I. enter
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 B. F
 I. enter

 C. SELECT FIRST OBJECT OR: R
 I. enter

 D. SPECIFY FILLET RADIUS: 0.2
 I. enter

 E. SELECT FIRST OBJECT OR: POLYLINE
 I. enter

 F. SELECT 2D POLYLINE: select Polyline formed in Step 6.A

Tip: Use the Fillet command with radius=0 to extend line segments to their point of 
apparent intersection. The arc segment will then be omitted.

Break

The Break command allows you to create two Lines or Polylines from a single existing Line. You 
have the option to Break the Line at a single point so that the two resulting Lines share a com-
mon endpoint location or to Break the Line at two points so that a gap is formed between the 
two resulting Lines.

 1. Continue working with acad-modify-03.dwg
 2. Zoom and Pan to PLAN VIEW detail area of drawing
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 3. Ribbon > Home tab > Modify flyout > Break

 A. SELECT OBJECT: select Line bounding MEDIAN SHOULDER on bottom side of 
PLAN VIEW detail tangent to median Arc

 B. SPECIFY SECOND BREAK POINT OR: F
 I. enter

 C. SPECIFY FIRST BREAK POINT: Use Endpoint Osnap to select intersection 
of median Arc and Line

 D. SPECIFY SECOND BREAK POINT OR: Use Endpoint Osnap to select inter-
section of median Arc and Line on opposite side of median crossover detail

Array
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Exercise files: acad-modify-data-c3d16.zip

Continue with acad-modify-04.dwg

acad-modify-08.mp4 4:34

The Array command allows you to copy a selected object and paste the object repetitively in a 
Rectangular, Polar, or Path based Array. A Rectangular Array is arranges the copied object in 
rows and columns. A Polar Array arranges the copied object at a radius and incremental angle 
about a specified location. A Path Array arranges the copied object at a specified location along 
a path based on an existing Line or Polyline. This section will cover the Rectangular Array.

 1. Open acad-modify-04.dwg
 2. Zoom and Pan to PLAN VIEW detail area of drawing
 3. Ribbon > Home tab > Modify panel > Array (Rectangular)

 A. SELECT OBJECTS: select Polyline representing "breakline symbol"
 I. Right-click

 B. Ribbon > Array contextual tab > Columns panel
 I. Columns = 1

 C. Ribbon > Array contextual tab > Rows panel
 I. Rows = 6
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 D. SELECT GRIP TO EDIT ARRAY OR: SPACING
 I. enter

 E. SPECIFY DISTANCE BETWEEN ROWS: Use Endpoint Osnap to select two 
similar points on "breakline symbol" Polylines on left side of PLAN VIEW

 I. enter
 II. enter

Reverse & Align

Exercise files: acad-modify-data-c3d16.zip

Continue with acad-modify-04.dwg

acad-modify-09.mp4 3:03

Reverse

The Reverse command will change the order of Polyline vertices. This is helpful when you wish 
to add a vertex to the end of an existing Polyline. By default, Civil 3D will add the vertex in front 
of the highest numbered vertex (the last vertex placed). If you want to add a vertex to the end 
of the lowest numbered vertex (vertex 1), it will instead be placed between vertex 1 and 2. The 
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order of Polyline and Line vertices also affects how a Linetype is generated. Linetypes will start 
at vertex 1.

 1. Continue working with acad-modify-04.dwg
 2. Open Properties Palette

 A. PROPS
 I. enter

 3. Select Polyline drawn along bottom of 10" CRUSHED AGGREGATE BASE COURSE Hatch
 A. Properties palette > Geometry dropdown > Current Vertex
 B. Toggle between numbered vertices
 C. Observe glyph showing vertex location in drawing area

 D. Hover cursor over vertex 1
 I. Add vertex

 II. Observe default placement of new vertex
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 E. Ribbon > Home tab > Modify flyout > Reverse
 I. Properties palette > Geometry dropdown > Current Vertex

 II. Observe reversed order of Polyline vertices
 F. Hover cursor over vertex 5

 I. Add vertex
 II. Observe default placement of new vertex

 III. Use desired Osnap to place new vertex

Align

The Align command combines the functionality of the Move, Rotate, and Scale commands. 
Most basic AutoCAD objects can be affected by the Align command (ie Polyline, Block, Hatch, 
Text). Once the command is activated, you will select obects to Align then select at least two 
source and destination points. If any rotation, repositioning, or scaling is necessary to replace 
the source points with destination points, the Align tool will do this for you.

 1. Continue working with acad-modify-04.dwg
 2. Zoom and Pan to area including SECTION A-A detail and misaligned objects above sheet 

border Line
 3. Ribbon > Home tab > Modify flyout > Align

 A. SELECT OBJECTS: select misaligned objects above sheet border Line
 I. Right-click
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 B. SPECIFY FIRST SOURCE POINT: use Endpoint Osnap to select lower left 
Polyline vertex

 C. SPECIFY FIRST DESTINATION POINT: use Endpoint Osnap to select 
analogous destination point on SECTION A-A detail

 D. SPECIFY SECOND SOURCE POINT: use Endpoint Osnap to select lower 
right Polyline vertex
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 E. SPECIFY SECOND DESTINATION POINT: use Endpoint Osnap to select 
analogous destination point on SECTION A-A detail

 F. SPECIFY THIRD SOURCE POINT OR <CONTINUE>:
 I. enter

 G. SCALE OBJECTS BASE ON ALIGNMENT POINT?: Y
 I. enter

Hatch

Last updated: 2017-12-01

Total video time: 14:23

A Hatch is an object that fills in a bounded area and displays either a Solid, Pattern, or Gradient. 
The display of the Hatch can be affected by setting a hatch scale, rotation, color (typically 
ByLayer), and/or transparency. The origin of the Hatch pattern can be reset so that it displays 
appropriately depending on the shape of the area filled, the hatch rotation, and the hatch scale. 
There are also options to associate the Hatch with a boundary object such as a Polyline so that a 
change to the boundary object will affect the Hatch accordingly such as with a Move, Scale or 
Rotate command. A Hatch object can be made Annotative so that the scale of the drawing dic-
tates the scale of the Hatch. There are several additional Hatch options such as Match Prop-
erties and Separate Hatches that affect the way a Hatch is defined.

Warning: Having a large number of Hatch objects can significantly reduce drawing 
performance and stablitly. This is especially true if Hatch transparency is used.

Info: Many of the desired effects of a Hatch object are handled by Styles when 
working with Civil 3D objects (ie Surface, Pipe Network, or Corridor objects). This 
has the benefit of the "hatched" area of the Civil 3D object being created auto-
matically as part of the object, being dynamically linked to the object, and being 
turned on/off at any time by editing Style display settings.

Hatch Creation, Pattern, & Properties

Exercise files: acad-htch-data-c3d16.zip

Start with acad-htch-begin.dwg

acad-htch-01.mp4 6:29

Hatch creation

 1. Open acad-htch-begin.dwg
 2. Zoom and Pan to SECTION A-A detail
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 3. Ribbon > Home tab > Draw panel > Hatch

 4. HATCH PICK INTERNAL POINT OR: leave default to pick internal point
 A. Or, if necessary, HATCH SELECT OBJECTS OR: PICK INTERNAL 

POINT
 B. Move cursor inside area bounded by Lines representing 4" ASPHALTIC CONCRETE
 C. Observe Hatch preview
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 D. Left-click to place Hatch

 E. Select previously created Hatch
 I. delete

 5. Ribbon > Home tab > Draw panel > Hatch
 A. Ribbon > Hatch contextual tab > Boundaries panel > Select
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 B. Select individual Lines bounding SECTION A-A PAVEMENT area
 I. enter

 C. Select previously created Hatch
 I. delete

 6. Select individual Lines bounding SECTION A-A PAVEMENT area
 A. J

 I. enter
 7. Ribbon > Home tab > Draw panel > Hatch

 A. Ribbon > Hatch contextual tab > Boundaries panel > Select
 B. Select single Polyline bounding SECTION A-A PAVEMENT area

 I. enter
 8. Ribbon > Home tab > Draw panel > Hatch

 A. Ribbon > Hatch contextual tab > Pattern panel > ANSI31
 B. Ribbon > Hatch contextual tab > Boundaries panel > Pick Points
 C. Left-click inside Lines bounding both SECTION A-A TOPSOIL areas

 I. enter
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 9. Ribbon > Home tab > Draw panel > Polyline
 A. Use Endpoint Osnap to pick vertices bounding SECTION A-A 10" CRUSHED 

AGGREGATE BASE COURSE area

Tip: It may be necessary to create a Polyline to help with Hatch creation if existing 
linework does not get you the results you are after. You can delete the Polyline 
afterward if desired and still retain the Hatch.

Pattern & Properties

Use the Pattern panel flyout found on the Hatch contextual tab to choose from the available Pat-
terns. Use the Properties panel to set fill type (Pattern, Solid, or Gradient), scale, rotation angle, 
and transparency. A Hatch scale will work in combination with the drawing scale if the Hatch is 
set to be annotative (see Associative & Annotative section). 

 10. Ribbon > Home tab > Draw panel > Hatch
 A. Ribbon > Hatch contextual tab > Pattern panel > ANGLE
 B. Ribbon > Hatch contextual tab > Boundaries panel > Select

 I. Select Polyline bounding SECTION A-A 10" CRUSHED AGGREGATE BASE 
COURSE area

 a. enter
 II. Select Polyline bounding SECTION A-A 10" CRUSHED AGGREGATE BASE 

COURSE area
 a. delete

 11. Select previously created TOPSOIL Hatch
 A. Ribbon > Hatch contextual tab > Properties panel

 I. Hatch pattern scale = 10
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 B. Ribbon > Hatch contextual tab > Pattern panel flyout
 I. Patten = AR-SAND

Associative & Annotative

Exercise files: acad-htch-data-c3d16.zip

Start with acad-htch-01.dwg

acad-htch-02.mp4 5:25

Associative Boundaries

A Hatch is an independent object. As such, it does not depend on the presence of a boundary 
object in order to be retained after it is first generated. If desired, however, a Region or 
Polyline boundary can be created to aid in moving or retaining the original shape of a Hatch. 
For example, a Polyline boundary provides basepoint grips when performing a Move command 
on a Hatch. A Region will retain the original shape of the Hatch in the event the Hatch needs to 
be rebuilt. In order for the Hatch to move with or respond to edit to the boundary, the boundary 
must be made associative.Ipsum lorem. Ipsum lorem. Ipsum lorem. Ipsum lorem.

 1. Open acad-htch-01.dwg
 2. Zoom and Pan to left side of SECTION B-B detail
 3. Select Hatch representing PAVEMENT section

 A. M
 I. enter

 II. Select basepoint and second points

 4. Observe lack of Hatch boundary
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 5. Select Hatch
 A. Observe available grips
 B. M

 I. entern
 II. Observe lack of grips during Move command

 III. esc
 6. Ctrl+z to undo initial Move
 7. Select Hatch

 A. Ribbon > Hatch contextual tab > Boundaries panel > Recreate
 I. ENTER TYPE OF BOUNDARY OBJECT: POLYLINE

 a. enter
 II. ASSOCIATE HATCH WITH NEW BOUNDARY? Y

 a. enter
 B. esc

 8. Select Hatch boundary Polyline
 A. M

 I. enter
 II. Select basepoint and second point

 III. Observe Hatch association with Polyline
 9. Select Hatch boundary Polyline

 A. M
 I. enter

 II. Use Endpoint Osnap to move Polyline back to original location

Annotative

Annotative scaling is used to dynamically set an annotative object's displayed scale based on 
the current drawing scale. It can also be used control visibility of annotative objects based on 
inclusion of scales in an object's annotative scales list. The end goal here is to display objects at 
the correct scale when plotting layouts. More detail on annotative scaling in general can be 
found in the training module dedicated to the topic. This section will walk you through making a 
Hatch annotative and managing the annotative scales list. You will also see how the Hatch pat-
tern scale is different from a Hatch annotative scale, and how the two can work together.

 1. Continue working in acad-htch-01.dwg
 2. Select Hatch representing PAVEMENT section on left side of SECTION B-B detail

 A. Ribbon > Hatch contextual tab > Properties panel
 I. Observe Hatch pattern scale = 5.0000
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 B. Properties palette > Pattern dropdown 
 I. Annotative = Yes
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 A. Observe Hatch pattern displayed scale change
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 B. Ribbon > Hatch contextual tab > Properties panel
 I. Hatch pattern scale: 0.5

 3. Status bar > Current drawing scale flyout
 A. Select 1 IN:5 FT
 B. Observe no change in Hatch pattern displayed scale

 4. Status bar > Current drawing scale flyout
 A. Select 1 IN: 10 FT

 5. Select Hatch representing PAVEMENT section on left side of SECTION B-B detail
 A. Ribbon > Hatch contextual tab > Properties panel

 I. Pattern dropdown > Annotative scale > dialog box icon
 a. Annotation Object Scale dialog

 i.  Add...
 1. Add Scales to Object dialog

 1. 1 IN:5 FT
 2. OK
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 6. Status bar > Current drawing scale flyout
 A. Select 1 IN:5 FT
 B. Observe change in Hatch pattern displayed scale

Match Properties & Separate Hatches

Exercise files: acad-htch-data-c3d16.zip

Continue with acad-htch-01.dwg

acad-htch-03.mp4 2:29

Match Properties

Use the Match Properties button found on the Hatch contextual tab to push pattern, color, trans-
parency, and Hatch pattern scale from a source to destination Hatch. This saves you time if you 
need to update multiple Hatches to have similar Hatch properties. 
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 1. Continue working in acad-htch-01.dwg
 A. Select PAVED SHOULDER Hatch on left side of SECTION B-B detail
 B. Ribbon > Hatch contextual tab > Options panel > Match Properties

 I. Select FINISHED SHOULDER as source Hatch

Separate Hatches

You can set your Hatch creation options so that picking multiple bounded areas while in a single 
Hatch command creates either a single Hatch throughout all bounded areas or individual Hatch 
objects for each bounded area. You can also break an existing single Hatch that covers multiple 
bounded areas into separate Hatch objects for each bounded area.
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 1. Continue working in acad-htch-01.dwg
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 A. Zoom and Pan to PLAN VIEW detail
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 B. Ribbon > Home tab > Draw panel > Hatch
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 I. Ribbon > Hatch contextual tab > Options flyout button
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 a. Hatch and Gradient dialog
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 i. Create separate hatches = unchecked
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 II. Pick internal points in the three bounded areas along top of PLAN VIEW 
detail

 a. enter
 b. Observe a single Hatch object created that covers all three bounded 

areas
 C. Ribbon > Home tab > Draw panel > Hatch

 I. Ribbon > Hatch contextual tab > Options flyout button
 a. Hatch and Gradient dialog

 i. Create separate hatches = checked
 II. Pick internal points in the MEDIAN SHOULDER and median crossover areas 

through center of PLAN VIEW detail
 a. enter
 b. Observe multiple Hatch objects created for the bounded areas

 D. Select Hatch created in step 1.B
 I. Ribbon > Hatch contextual tab > Options dropdown > Separate Hatches

 II. Observe single Hatch split into multiple Hatches

Grips

Last updated: 2017-12-01

Total video time: 22:29
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Object Grips are used to interact with and edit objects in through the drawing view (ie 
Modelspace). Upon selecting an object, available Grips will display for the object(s) selected. 
Depending on the type of object selected, you may have Multifunction Grips allowing access to 
several options for Grip editing. Additionally, for all Grips, you can cycle between Grip Modes 
including Move, Rotate, Scale, and Mirror. Though many of the edits you perform using Grips 
can be handled elsewhere, utilizing Grip edits in combination with object snaps, polar tracking, 
and dynamic input can significantly expedite your object editing workflow.

Basics: stretch vs move

Exercise files: acad-grips-data-c3d16.zip

Start with acad-grips-begin.dwg

acad-grips-01.mp4 3:21

Arguably the most basic Grip function is the Stretch. Within the category of Stretch Grip func-
tions, are two distinct types of editing behavior: Stretch and "move". In general, an endpoint  
Grip has a Stretch behavior and a midpoint or insertion Grip has "move" behavior. The Stretch 
behavior relocates the Grip and changes the length or radius and rotation or centerpoint of an 
object as necessary. The "move" behavior will relocate the Grip and object while retaining all 
other object geometry properties such as length and rotation.

Grips with Stretch function exhibiting "stretch" behavior:

 l Polyline vertex and endpoint
 l Line endpoint
 l Arc endpoint

Grips with Stretch function exhibiting "move" behavior

 l Text insertion point
 l Line midpoint
 l Circle center
 l Block insertion point
 l COGO Point

Info: The COGO Point is a Civil 3D object. COGO Points are covered in detail in 
later training modules and thus are not included in the example workflows here.

 1. Open acad-grips-begin.dwg
 2. Select CRUSHED AGGREGATE BASE COURSE SHOULDER Line on left side of SECTION A-A 

detail
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 A. Observe display of two endpoint Grips and one midpoint Grip
 B. Left-click midpoint Grip to activate

 I. Move cursor and observe behavior
 II. esc

 3. Select R3-4 Block at top of PLAN VIEW detail
 A. Observe display of insertion point Grip
 B. Left-click insertion point Grip to activate

 I. Move cursor and observe behavior
 II. esc

 4. Select SECTION A-A Text
 A. Properties palette > Text dropdown > Justify

 I. Observe Justify=Center
 B. Left-click insertion point Grip

 I. Move cursor and observe behavior
 II. esc

 5. Zoom & Pan left of SECTION A-A detail
 6. Select red guiding Circle

 A. Observe display of four quadrant Grips and one center Grip
 B. Left-click center Grip to activate

 I. Move cursor and observe behavior
 II. esc

 7. Select CRUSHED AGGREGATE BASE COURSE SHOULDER Line on left side of SECTION A-A 
detail

 A. Left-click endpoint Grip to activate
 I. Move cursor and observe behavior

 II. esc
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 8. Repeat step 7 for Polyline bounding 10" CRUSHED AGGREGATE BASE COURSE Hatch
 9. Repeat step 7 for SECTION A-A detail median nose Arc

Shift+select multiple

Exercise files: acad-grips-data-c3d16.zip

Continue with acad-grips-begin.dwg

acad-grips-02.mp4 5:42

Hold the Shift key and select multiple Grips to simultaneously apply a similar Grip edit to mul-
tiple object Grip locations. The Grips will display red once selected and activated. Release the 
Shift key and select one of the activated Grips to apply a Grip edit as normal. The Grip edit will 
then be applied to all Grips included in the selection.

 1. Continue working in acad-grips-begin.dwg
 2. Zoom and Pan left of SECTION A-A detail
 3. Observe location of red guiding Circles
 4. Turn on Center and Endpoint Object Snaps
 5. Select BOTTOM OF MEDIAN Line

 A. Left-click left-most endpoint Grip
 I. SPECIFY STRETCH POINT OR:

 a.  Use Osnaps to relocate Line endpoint at center of guiding Circle
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 6. Select both CRUSHED AGGREGATE BASE COURSE and SUBGRADE Lines
 A. shift+select both leftmost endpoint Grips

 I. Release shift key
 II. Left-click one of the shift+selected Grips

 a. Use Osnaps to relocate Line endpoints at center of guiding Circles

 7. Select PAVED MEDIAN SHOULDER Line
 A. Verify Dynamic Input is on

 I. Status bar > Customization button
 a. Dynamic Input = checked

 II. Status bar
 a. Dynamic Input toggled on
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 B. Hover cursor over leftmost Line endpoint
 I. Observe Dynamic Input tooltip

 II. SPECIFY END POINT: 5
 a. enter

 III. Use Osnaps to Lengthen Line to center of red guiding Circle

Page: 162

Published on: 2/21/2018

Grips



 8. Select both CRUSHED AGGREGATE BASE COURSE and SUBGRADE Lines
 A. shift+select both leftmost endpoint Grips

 I. Release shift key
 II. Left-click one of the shift+selected Grips

 a. ctrl to cycle Grip function = Lengthen

 B. Use Osnaps to Lengthen Lines to leftmost endpoint of PAVED MEDIAN SHOULDER 
Line
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 9. Pan to right of SECTION A-A detail
 A. Use crossing selection to select TOPSOIL Hatch and bounding Lines

 A. shift-select appropriate endpoints of selected objects
 I. Release shift key

 II. Select rightmost endpoint of BOTTOM OF MEDIAN Line
 a. Move cursor and observe behavior
 b. Use Osnaps to uniformly relocate selected linework endpoints
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Ctrl+select to copy

Exercise files: acad-grips-data-c3d16.zip

Continue with acad-grips-begin.dwg

acad-grips-03.mp4 2:44

Hold the ctrl key when selecting a Grip to make a copy of the objects attached to the Grip. For 
example, ctrl+select a Text Grip to copy the full Text object. Ctrl+select a Polyline vertex to 
copy and  the Line segements touching the selected Grip(s). You can combine the ctrl+select  
technique with the shift+select technique to copy multiple objects attached to the shift+selected 
Grips

 1. Continue with acad-grips-begin.dwg
 2. Select SECTION A-A Text

 A. ctrl+select insertion point Grip
 I. Release ctrl key

 II. Pan to SECTION B-B detail
 a. Use Osnaps to place copied Text at center red guiding Circle
 b. esc

 3. Pan to PLAN VIEW detail
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 4. Select breakline symbol Polyline at top-right of PLAN VIEW detail
 A. shift+select all vertex Grips
 B. Release shift key

 I. ctrl+select righmost vertex Grip
 II. Release ctrl key

 a. Use Osnaps to place copies at all remaining red guiding Circles

Grip modes

Exercise files: acad-grips-data-c3d16.zip

Start with acad-grips-01.dwg

acad-grips-04.mp4 6:46

In addition to object-specific Grip edit behavior, all Grips have the ability to edit associated 
objects using four standard behaviors. These standard Grip editing behaviors are known as Grip 
Modes. They include Move, Rotate, Scale, and Mirror.  Once an object is selected and a Grip is 
activated, use the enter key to cycle between Grip Modes. Once you begin cycling, you are lim-
ited to one of the four standard Grip Modes. Hit esc and re-activate a Grip to perform a non-
Grip Mode edit such as Stretch or Lengthen.
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 1. Open acad-grips-01.dwg
 2. Zoom and Pan to PLAN VIEW detail
 3. Select  Line just below R3-4A signage

 A. Left-click topmost endpoint Grip
 I. Observe command line prompt SPECIFY STRETCH POINT OR:

 II. Move cursor and observe behavior
 a. enter

 III. Observe command line prompt change SPECIFY STRETCH MOVE 
OR:

 IV. Repeat steps 3.A.I - 3.A.III to cycle all Grip Modes
 V. esc

 B. esc
 4. Zoom and Pan to SECTION A-A detail
 5. Select CRUSHED AGGREGATE BASE COURSE SHOULDER Multileader

 A. Left-click leader Grip
 I. enter

 II. SPECIFY MOVE POINT OR: COPY
 a. Left-click to place a copy of Multileader on right side of SECTION A-

A detail
 b. esc

 6. Pan to SECTION B-B detail
 7. Verify midpoint Object Snap is on
 8. Window select breakline symbol Polyline and Hatch near EDGE OF PAVEMENT 

Multileader
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 1. Left-click one of the displayed Grips
 A. enter to cycle to Mirror Grip Mode

 I. SPECIFY SECOND POINT OR: BASE POINT
 a. Use midpoint Object Snap to specify midpoint of 4" ASPHALTIC 

CONCRETE Polyline
 II. SPECIFY SECOND POINT OR: COPY

 a. Hold shift key for temporary Orthomode
 b. Left-click second mirror point above basepoint
 c. esc

 2. Select PAVED SHOULDER Hatch one left side of SECTION B-B detail
 A. Left-click a displayed Grip

 I. Right-click
 a. Mirror

 II. Repeat steps 1.A.I - 1.A.II to place copy of PAVED SHOULDER Hatch
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Multifunction grips

Exercise files: acad-grips-data-c3d16.zip

Continue with acad-grips-01.dwg

acad-grips-05.mp4 3:56

In addition to the four standard Grip Modes, some objects have Multifunction Grips. The first 
example we saw of this was the Line endpoint Grip. This is a Multifunction Grip with Stretch and 
Lengthen functions. Once a Multifunction Grip is activated, use the ctrl key to cycle between 
Grip functions. When only a single Multifunction Grip is activated, hover your cursor over the 
Grip to see a Multifunction Grip menu. This menu will not display when multiple Grips are activ-
ated such as when shift+selecting multiple Grips. 
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 1. Continue with acad-grips-01.dwg
 2. Zoom and Pan to SECTION B-B detail
 3. Select MEDIAN FORESLOPES APPROACHING CROSSOVER Multileader

 A. Left-click the leader landing Grip
 I. ctrl to cycle Grip functions to Add Leader

 a.  SPECIFY LEADER ARROWHEAD LOCATION:
 i. Use endpoint Object Snap to specify location at Arc endpoint

 II. ctrl to cycle Grip funcitons to Stretch
 a. Use red guiding Circle to relocate leader vertex

 B. Select Polyline representing MEDIAN FORESLOPES APPROACHING CROSSOVER
 I. Left-click Polyline arc segment midpoint Grip

 a. ctrl to cycle Grip functions to Convert to Line
 b. enter

 C. Select Polyline representing MEDIAN FORESLOPES APPROACHING CROSSOVER
 I. Left-click Polyline line segment midpiont Grip

 a. ctrl to cycle Grip functions to Convert to Arc
 i. SPECIFY MIDPOINT OF ARC SEGMENT:

 1. Use Osnaps to place specify center of red guiding 
Circle 

 2. esc

Layers and their properties

Last updated: 2017-12-01

Total video time: 35:48

Layer basics
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Exercise files: acad-layr-prprtis-data-c3d16.zip

Start with acad-layr-prprtis-begin.dwg

acad-layr-prprtis-01.mp4 4:36

Layers in AutoCAD are used to control object display properties, visibility, plotting, object selec-
tion, and organization. All objects in a drawing will reside on a Layer. The Layer an individual 
object resides on is known as the Object Layer. When AutoCAD objects are created, they will be 
placed on the Current Layer. You can set which Layer is the Current Layer either through the 
Ribbon Layer Panel or Layer Properties Manager. Some of the most commonly used/edited 
Layer properties are On/off, Isolate/unisolate, Freeze/thaw, Lock/unlock.

Info: 
Civil 3D objects are made up of components. For example, an Alignment can have Line, 
Curve, Spiral, etc components. The object and it's component can all be on unique Lay-
ers.

When Civil 3D objects (ie Alignments, Corridors, Surfaces) are created, they will be 
placed on the default Object Layer specified in the Drawing Settings dialog. An optional 
Layer name wildcard can be included that will append the default Object Layer name 
with the name you give to the Object. In this way, a new Layer will be created for each 
named Civil 3D Object created. For example, the default Object Layer for Alignments in 
the WisDOT design template is P_ALI_*. The * character is the wildcard. If an Alignment 
is named HWY 14, the default Object Layer created will be P_ALI_HWY 14.

 1. Open acad-layr-prprtis.dwg
 2. Ribbon > Home tab > Layers panel

 A. Observe Current Layer = E_ALI
 3. Application menu dropdown > Drawing Utilities > Drawing Settings > Object Layers 

tab
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 A. Observe default Civil 3D Object Layers
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 4. PLINE
 A. enter
 B. Draw Polyline with two vertices anywhere between SECTION A-A and SECTION B-

B details
 C. Select Polyline just drawn
 D. Properties palette > General 

 I. Observe Object Layer = E_ALI
 5. Select BOTTOM OF MEDIAN Line on right side of SECTION A-A detail

 A. Ribbon > Home tab > Layers panel
 I. Observe Object Layer = P_XS_FinalBorrow

 B. Info: The Ribbon Layer Panel shows the Current Layer if no object is 
selected. It shows the selected Object Layer if a object is selecting

 C. Properties palette > General 
 I. Observe Object Layer = P_XS_FinalBorrow

 D. esc
 6. PLINE

 A. enter
 B. Ribbon > Home tab > Layers panel

 I. Observe dropdown display change to Current Layer = E_ALI
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 C. Draw Polyline with two vertices anywhere between SECTION A-A and SECTION B-
B details

 7. Select BOTTOM OF MEDIAN Line on right side of SECTION A-A detail
 A. Ribbon > Home tab > Layers panel > Make Current

 8. PLINE
 A. enter
 B. Ribbon > Home tab > Layers panel

 I. Observe Current Layer = P_XS_FinalBorrow
 C. Draw Polyline with two vertices anywhere between SECTION A-A and SECTION B-

B details
 9. Select multiple objects 

 A. Properties palette > General
 I. Observe Layer = *VARIES*

 B. esc
 C. Ribbon > Home tab > Layer panel > Layer list dropdown

 I. Choose Layer for all selected objects
 a. Observe Object Layer change

 II. Match Layer
 a. SELECT OBJECT ON DESTINATION LAYER

 i. Select BOTTOM OF MEDIAN Line on right side of SECTION A-
A

 b. Observe Object Layer for selection = P_XS_FinalBorrow

Layer commands: off, freeze, isolate, lock

Exercise files: acad-layr-prprtis-data-c3d16.zip

Start with acad-layr-prprtis-begin.dwg

acad-layr-prprtis-02.mp4 6:57

Commonly edited Layer properties
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Layer property Description

On/off
When a Layer is turned off, objects residing on that Layer will not dis-
play, although they will be accounted for when processing object dis-
play, such as when you Zoom Extents or Regen.

Isolate/unisolate
Depending on Layer settings, Layer Isolate will either Lock and fade 
display or turn off all Layer except those of selected objects.

Freeze/thaw

When a Layer is frozen, objects residing on that Layer will not display 
and will not be accounted for when processing object display. Freez-
ing a Layer with an extraordinarily large number of objects can help 
drawing performance.

Lock/unlock
Objects on a locked Layer cannot be deleted or edited. Locking Layers 
can be helpful when you wish to use objects on a Locked Layer for 
visual reference or Osnapping while protecting their geometry.

On/  off

 1. Continue working in acad-layr-prprtis-begin.dwg
 2. Ribbon > Home tab > Layer panel > Off

 3. SELECT AN OBJECT ON THE LAYER TO BE TURNED OFF
 A. Select multiple objects below SECTION A-A detail
 B. esc
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 4. Double-click middle mouse wheel
 A. Observe Zoom Extents still accounting for Layers turned off

 5. Ribbon > Home tab > Layer panel > Turn All Layers On

Freeze/  thaw

 1. Continue working in acad-layr-prprtis-begin.dwg
 2. Ribbon > Home tab > Layer panel > Freeze

Page: 176

Published on: 2/21/2018

Layers and their properties



 3. SELECT AN OBJECT ON THE LAYER TO BE FROZEN
 A. Select multiple objects below SECTION A-A detail
 B. esc

 4. Double-click middle mouse wheel
 A. Observe Zoom Extents not accounting for frozen Layers

 5. Ribbon > Home tab > Layer panel > Thaw All Layers
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Isolate/  unisolate

 1. Continue working in acad-layr-prprtis-begin.dwg
 2. Ribbon > Home tab > Layer panel > Isolate

 3. SELECT AN OBJECT ON THE LAYER TO BE ISOLATED
 A. Select BOTTOM OF MEDIAN Line on right side of SECTION A-A detail
 B. enter
 C. Observe non-isolated Layers fade and lock
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 4. Ribbon > Home tab > Layer panel flyout
 A. Adjust Locked Layer Fading with slider

 5. Ribbon > Home tab > Layer panel > Layer Properties
 A. Layer Settings

 I. Isolate Layer Settings
 a. Settings for Layers not isolated = Off
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 B. OK

 6. Ribbon > Home tab > Layer panel > Unisolate
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 7. Ribbon > Home tab > Layer panel > Isolate
 8. SELECT AN OBJECT ON THE LAYER TO BE ISOLATED

 A. Select BOTTOM OF MEDIAN Line on right side of SECTION A-A detail
 B. enter
 C. Observe non-isolated Layers turn off

 9. Ribbon > Home tab > Layer panel flyout > Layer Previous

Tip: Use Layer Previous to turn on or thaw only the single Layer or selection of Lay-
ers you previously changed. The Ribbon buttons only allow you to turn on or thaw 
all layers
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Lock/  unlock

 1. Ribbon > Home tab > Layer panel > Lock

 2. Select an object on the layer to be Locked
 A. Select BOTTOM OF MEDIAN Line on right side of SECTION A-A detail
 B. enter
 C. Observe Locked layer display fade
 D. Hover cursor over object on locked Layer
 E. Observe "padlock" glyph indicating the Layer is locked

 3. Select an object on the locked Layer
 A. Observe absence of any Grips
 B. M

 I. enter
 II. Observe command line history and inability to edit object on locked Layer:

 a. MOVE 1 FOUND, 1 WAS ON A LOCKED LAYER
 III. esc
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 4. Ribbon > Home tab > Layer panel > Unlock
 A. Select an object on locked P_XS_FinalBorrow Layer

 5. Select the three extraneous Lines drawn near SECTION A-A detail
 A. delete

Layer properties manager: interface & editing

Exercise files: acad-layr-prprtis-data-c3d16.zip

Start with acad-layr-prprtis-begin.dwg

acad-layr-prprtis-03.mp4 6:39
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The Layer Properties Manager is where you can sort, create and delete Layers or edit Layer 
properties such as Layer name, description, display color, visibility (on/off or freeze/thaw), plot 
style name (how thick a lines will plot), whether the Layer will plot or not, etc. Take advantage 
of shift+select and ctrl+select to affect multiple Layers at once.

 1. Continue with acad-layr-prprtis-begin.dwg
 2. Ribbon > Home tab > Layer panel > Layer Properties

 A. Observe "366 total Layers" listed along bottom of Layer Properties Manager 
palette

 3. Ribbon > Home tab > Layer panel > Layers dropdown > P_XS_EAR_Base
 A. Layer Properties Manager

 I. Observe Status = Current

Info: Alternatively, set a Layer Current by selecting a row and 
clicking the Set Current button  or double-clicking a row in 
Layer Properties Manager

 II. Select a row in by left clicking
 a. Left click once more on the Layer name to edit the name
 b. Left click elsewhere in  to cancel or finish the name edit
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 4. Select BOTTOM OF MEDIAN Line on left side of SECTION A-A detail
 A. Ribbon > Home tab > Layer panel > Make Current
 B. Layer Properties Manager

 I.  P_XS_FinalBorrow row
 a. Toggle Layer Off

 i. "The current layer will be turned off. What do you want to 
do?"

 1. Turn the current layer off

 b. Toggle Layer On
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 c. Toggle Layer Freeze
 i. "This layer cannot be frozen because it is the current layer."

 1. Close

 II. P_XS_EAR_Waste row
 a. Set current by double clicking this row

 III. P_XS_FinalBorrow row
 a. Toggle freeze

 i. Observe Layer not displayed in modelspace
 b. Toggle thaw
 c. Toggle lock

 i. Observe Layer display fade in modelspace
 d. Color column

 i. Color = yellow
 ii. OK

 1. Observe layer color change in modelspace
 e. Color column

 i. Color = 30
 ii. OK

 f. Linetype column
 i. Select Linetype: choose Ecomlin from list

 ii. OK
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 g. Linetype column
 i. Select Linetype: choose Continuous from list

 ii. OK
 h. Lineweight column

 i. Lineweight = 0.80mm
 1. observe no change to display in modelspace

 ii. LINEWEIGHT
 1. enter
 2. Display Lineweight = checked
 3. OK
 4. Observe change to display in modelspace

 iii. Lineweight = 0.30mm
 iv. LINEWEIGHT

 1. enter
 2. Display Lineweight = unchecked
 3. OK

 i. Plot column
 i. Toggle plot/  noplot

 j. Plot Style column
 i. Click on 5B-wisdot named Plot Style

 1. Observe list of Plot Styles
 2. Cancel

Warning: Named plot styles have been 
assigned intentionally to Layers included in 
the WisDOT design template. These Plot 
Styles dictate the plotted color (ie Black), line-
type and lineweight of plotted objects. Do not 
change these assigned Plot Styles as doing 
so will result in non-uniformity among plotted 
WisDOT plan sets.

 k. New VP Freeze column
 i. Toggle New VP Freeze

Info: New VP Freeze affect creation of new View-
ports. Viewports are used for plan production to 
"look" from you plan sheet Layout (Paperspace) 
into your Civil 3D model (Modelspace). The con-
cepts and use of Layouts, Viewports and Paper-
space vs Modelspace will be covered in more depth 
in later training modules.
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 C. Model and Layout tabs
 I. New Layout

 II. Click newly created Layout 1 to make active
 a. Status Bar > Customization > Model Space = Checked
 b. Status Bar > Model or paper space = Model

 III. Layer Properties Manager
 a. Observe VP Freeze = frozen

 i. Observe no display of P_XS_FinalBorrow in this Viewport only
 b. VP Freeze = thawed

 D. Model and Layout tabs
 I. Set Model tab active

 E. Layer Properties Manager
 I. Right-click any column header

 a. Maximize all columns
 II. Right-click Name column header

 a. Freeze column
 i. Observe static display of Name and Status Column while 

scrolling left-right
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Layer properties manager: create new & layer notification

Exercise files: acad-layr-prprtis-data-c3d16.zip

Continue with acad-layr-prprtis-begin.dwg

acad-layr-prprtis-04.mp4 2:49

Page: 189

Published on: 2/21/2018

Layers and their properties

http://www.c3dkb.dot.wi.gov/data/acad/acad-layr-prprtis-data-c3d16.zip
http://www.c3dkb.dot.wi.gov/video/acad/acad-layr-prprtis-04.mp4


 1. Continue with acad-layr-prprtis-begin.dwg
 2. Layer Properties Manager

 A. Select E_ALI row
 B. Create New Layer

 I. Layer name = E_ALI2

Info: When creating a new Layer in Layer Properties Manager, 
all properties of the selected Layer other than the Layer name 
will be assigned to the new Layer created.

Requirement: When creating a new layer, follow the WisDOT 
Layer naming convention. For example, E_ALI_<object name> 
("E for existing or P for proposed"_"three or four letters for object 
type"_"optional additional sections of three or four letters for 
object type"_ "object name or description")

 C. Select E_ALI2
 I. Right-click > Merge selected layer(s) to...

 a. Select E_ALI
 b. OK
 c. "The selected layers will be merged into layer E_ALI. Do you want to 

continue?"
 i. Yes

 D. Layer Settings
 I. New Layer Notification = checked

 II. Evaluate new layers added to drawing = checked
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 III. Evaluate all new layers = filled

 E. Select E_ALI
 F. Create new Layer
 G. Right click newly created Layer 1

 I. Reconcile Layer

Layer properties manager: properties filter & settings

Exercise files: acad-layr-prprtis-data-c3d16.zip

Continue with acad-layr-prprtis-begin.dwg

acad-layr-prprtis-05.mp4 6:07

Layer Properties Filters essentially query all the Layers in your drawing based on Layer name 
text or other Layer properties. This allows you to reduce the Layers listed in Layer Properties 
Manager, making Layers easier to find and work with. You can also use the search field in the 
upper right corner of Layer Properties Manager to filter the Layers shown based on Layer 
name. Using Layer Settings, you can also apply the current Layer Properties Filter to the Ribbon 
Layer Panel dropdown list.

 1. Continue working in acad-layr-prprtis-begin.dwg
 2. Layer Properties Manager

 A. Filters
 I. Alignment

 a. Observe reduced list of Layers displayed in Layer Properties Man-
ager

 b. Observe Layer quantification note in lower-left of Layer Properties 
Manager window
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 II. Right-click Alignment Layer Filter > Properties
 a. Observe Layer Filter Properties name-based query

 III. Right-click All Used Layers Filter
 a. Observe inability to modify properties or delete this filter

Info: The All Used Layers Filter is one of the default Layer 
Filters automatically created in any drawing. These 
default Layer Filters cannot be modified or deleted. Addi-
tional default Layer Filters include External Reference, 
Non-External Reference, Unreconciled Layers and View-
port Overrides.
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 b. Shift-select multiple Layers included in the All Used Layers Filter
 i. Right-click selection

 1. Delete Layer
 2. Observe notification informing that you cannot delete 

these Layers

Info: When Layers are referenced by a Civil 
3D Style included in a drawing or template, 
the Layers are included in the All Used Lay-
ers Filter and cannot be deleted. This is true 
even if there are no Civil 3D objects in the 
drawing. For example the Alignment Civil 3D 
Style is included in the WisDOT design tem-
plate even before any Alignments are cre-
ated.

 3. Ribbon > Home tab > Toolspace
 A. Toolspace palette > Settings tab > Alignments > Alignment Styles > Double-

click ALI Existing
 I. Alignment Style palette > Display tab > Layer column

 a. Observe Layers referenced by the ALI Existing Civil 3D Alignment 
Style

 4. Layer Properties Manager
 A. Shift-select all Layer Filters

 I. Save filter group
 a.  Save Layer Filters dialog > File name = filter groups.lft
 b. Save
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 B. Shift-select all Layer Filters > Right-click > Delete
 C. Load Filter Groups

 I. "Note, that this action will remove any Layer Filter assignments that 
already exist. Do you wish to continue?"

 a. Yes

 II. Browse to filter groups.flt
 a. Open
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 D. Layer Properties Manager search field
 I. syntax = p_ar*

 II. Observe real-time filtering of Layer list

 E. Layer Settings
 I. Dialog Settings > Apply layer filter to layer toolbar = unchecked

 II. OK
 F. Set Beam Guard Layer Filter active

 5. Ribbon > Home tab > Layer panel > Layer list dropdown
 A. Observe all Layers in drawing included in Layer list 

 6. Layer Properties Manager
 A. Layer Settings

 I. Dialog Settings > Apply layer filter to layer toolbar = checked
 II. OK

 7. Ribbon > Home tab > Layer panel > Layer list dropdown
 A. Observe only the Current Layer and those Layers included in the Beam Guard 

Layer Filter included in Layer list dropdown

Layer states & layer walk

Exercise files: acad-layr-prprtis-data-c3d16.zip

Continue with acad-layr-prprtis-begin.dwg

acad-layr-prprtis-06.mp4 5:00

A Layer State is a saved version of the way a drawings Layer properties are set up. The prop-
erties saved in a Layer State include Layer On/ off, Freeze/ thaw, Lock/ unlock, Color, Linetype, 
Lineweight, Transparency, Plot style, Plot/ no plot, New VP Freeze and VP Freeze. Layer States 
can be imported, saved from the current Layer Properties setup, or restored in a drawing at 
any time. Restoring a Layer State will reset all Layer properties currently set in a drawing to 
those saved in the Layer State. Use Layer States to quickly and accurately switch to a desired 
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Layer properties setup for specific design, external referencing, or plotting workflows. Some 
key Layer States are included in the WisDOT design template and on the Ribbon WisDOT Stand-
ards tab. The Layer States on the WisDOT Standards tab can be imported through the Layers 
Tool Palette.

The Layer Walk command allows you to sort and select Layers from a list or your drawing area 
and see them displayed in real time. You can use Layer Walk to efficiently select a group of Lay-
ers either by name or by selecting objects in the drawing area, then create a Layer State based 
on that selection from within the Layer Walk dialog. The Layer State created from within the 
Layer Walk command will only affect visibility through the Layer on/ off property. All other 
properties will remain unchanged.

Layer states

 1. Continue working in acad-layr-prprtis-begin.dwg
 2. Ribbon > Home tab > Layers panel flyout > Layer State dropdown > New Layer State

 A. New layer state name = color
 B. OK

 3. Layer Properties Manager
 A. Shift+select all Layers
 B. Click any Layer Color field

 I. Color = white
 II. OK

 4. Ribbon > Home tab > Layers panel flyout > Layer State dropdown > New Layer State
 A. New layer state name = white
 B. OK

 5. Ribbon > Home tab > Layers panel flyout > Layer State dropdown > color
 A. Observe all Layer Color properties restored based on color Layer State
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 6. Layer Properties Manager
 A. Shift+select all Layers
 B. Click any Layer Lock field

 7. Ribbon > Home tab > Layers panel flyout > Layer State dropdown > white
 A. Observe Layer Color and Lock properties restored based on white Layer State

Layer walk

 1. Ribbon > Home tab > Layers panel flyout > Layer Walk

 A. Layer Walk dialog
 I.  Right-click in Layer list

 a.  Select all
 b. Observe Layers displayed in drawing area

 II. Select objects
 a. Use crossing selection to select objects in drawing area
 b. Observe selection in Layer list based on object selection:
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 III. Right-click in Layer list
 a.  Save Layer State

 i. New layer state name = layer walk
 ii. OK

 IV. Select only P_XS_Final Borrow
 V. Restore on exit = checked

 a. Close
 2. Ribbon > Home tab > Layers panel flyout > Layer State dropdown > layer walk

 A. Layer Properties Manager
 I. Observe Layer On property restored based on layer walk Layer State

WisDOT layer tools & best practices

Exercise files: acad-layr-prprtis-data-c3d16.zip

Continue with acad-layr-prprtis-begin.dwg

acad-layr-prprtis-07.mp4 3:40

Find tools to import WisDOT Layers and Layer States in the Ribbon WisDOT Standards tab. You 
might import all WisDOT Layers if a drawing is lacking standard WisDOT Layers either because 
the drawing was started from a template other than WisDOT design or if Layers have been 
Purged. Several pre-defined Layer States can also be imported to help with things like switching 
a drawing so Layer Plot Style properties work with the latest WisDOT Plot Style Table.

Two key best practices for working with Layers in Civil 3D are to always assign relevant object 
Layers (don't leave objects on Layer 0) and to never assign object the Defpoints Layer. Layer 0 
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is unique in that it is used by many Civil 3D styles to inherit parent object Layers or used by 
AutoCAD Blocks so that objects within a Block are control by the overall Block object Layer. The 
Defpoints Layer is used by Civil 3D to track object geometry for things like Dimensions. Civil 3D 
objects will typically default to the appropriate Layer based on default Object Layers as covered 
in previous videos in this training module. Basic AutoCAD Layers for thing like preliminary or 
reference line work must be assigned correct Layers, however. AutoCAD Blocks and Dimensions 
will be covered in detail in later training modules

Warning: Never leave objects on Layer 0 when finishing a drawing or workflow. 
Always assign or verify assignment of relevant Layers to objects created. Never 
place objects on the Defpoints Layer. The Defpoints Layer is used by Civil 3D to 
track object geometry for things like Dimensions. Placing objects on the Defpoints 
Layer will inevitably cause drawing corruption at some point.

 1. Continue working in acad-layr-prprtis-begin.dwg
 2. Layer Properties Manager

 A. Observe total number of Layers in drawing = 366
 3. Ribbon > WisDOT Standards tab > Standards Components panel > Add Layers

 A. Observe total number of Layer in drawing = 669
 4. PURGE

 A. enter
 B. Items not used in drawing:

 I.  Layers
 II. Confirm each item to be purged = unchecked

 III. Purge
 C. Observe total number of Layers in drawing = 366

 5. Ribbon > WisDOT Standards tab > Plot Configuration panel > Layer States
 A. Layer State Tool Palette > Translate Layer States > Load Layer State: Translate 

2014 Layers to 2016 Standards
 6. Ribbon > Home tab > Layers panel flyout > Layer States dropdown > Layer Translate 

2014 to 2016
 7. Ribbon > Home tab > Layers panel > Thaw all layers

 A. Observe all Layers turned on in Layer Properties Manager
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 8. Ribbon > Home tab > Layers panel flyout > Previous

Tip: If you do not have a Layer State to restore to, but you made an unintentional 
change to one or more Layer properties, use the Layer Previous button to revert 
back to the previous setup of Layer properties. This is your "undo" button specific 
for Layers.

Blocks and external references

Last updated: 2017-12-01

Total video time: 60:11

Both Block References (aka Blocks) and External References (aka Xrefs) allow you to bring pre-
viously created, external objects into your Civil 3D drawing. 

A Block is an object type that is made up of one or more other drawings objects. When objects 
are contained in a Block, they are easily inserted into any drawing to avoid duplicated work in 
assembling the various objects making up the Block. Blocks are typically used for Survey Point 
Markers, standard construction or plan details, plan set sheet text and typical plan-view line-
work. Blocks can be dynamics in that you have special control options for visibility or editing. 
They can also contain attributes, which are text objects whose content can be edited while lock-
ing down the text Style/Layer/etc.

You can think of an Xref as a view in a destination drawing back to a source drawing. In the des-
tination drawing, the Xref source objects are protected from editing beyond Layer display con-
trol. Additionally, a source drawing can be Externally Referenced into multiple destination 
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drawings simultaneously. Whenever a change is made to an Xref source drawing, you are 
prompted in the destination drawing to update the Xref. In this way, the referenced source con-
tent is easily kept up to date and consistent throughout all destination drawings. Xrefs can be 
used in design drawings to see and reference linework or other objects for the purposes of 
design without actually having those reference objects in your current drawing. Another use for 
an Xref is for displaying existing conditions or other site objects needed on multiple plan sheets. 
If you only want to display certain objects from the Xref on certain plan sheets, you can accom-
plish this through Viewport Freezing Layer control. More detailed information on plan pro-
duction will be covered in later training module. 

Block creation basics

Exercise files: acad-blk-xref-data-c3d16.zip

Start with acad-blk-xref-begin.dwg

acad-blk-xref-01.mp4 5:07

In this exercise, you will create a Block such that you have Layer control of the Block once cre-
ated. You will do this by setting the objects making up the Block on Layer 0.

 1. Open acad-blk-xref-begin.dwg
 2. Set Current Layer = 0
 3. Ribbon > Home tab > Draw panel

 A. Draw a Circle
 I. Radius = 15±

 B. Draw a Polyline within the Circle
 4. Ribbon > Insert tab > Block panel > Create

 A. Name = test
 B. Base Point

 I. Specify on-screen = unchecked
 II.  Pick point

 a. Use Osnaps to specify center of Circle
 C. Settings

 I. Block unit = unitless
 D. Objects

 I. Specify on-screen = unchecked
 II. Convert to block = filled

 III. Select objects
 a. Select Circle and Polyline
 b. enter
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 E. Behavior
 I. Annotative = unchecked

 II. Scale uniformly = checked
 III. Allow exploding = checked

 F. OK

 5. Select test Block
 A. Properties palette > General

 I. Layer = E_ALI_Marker
 II. Observe Layer properties take effect

Info: In order to have Layer control of a Block Reference, the objects 
included in the Block must be placed on Layer 0. The Block itself can 
then be placed on any Layer as needed and the Layer properties will 
take effect.

Block creation continued, attributes & editing

Exercise files: acad-blk-xref-data-c3d16.zip

Continue with acad-blk-xref-begin.dwg

acad-blk-xref-02.mp4 5:24

In this exercise, you will create a Block such that you do not have Layer control, then edit the 
Block so that you do have Layer control. You will also learn how to add a Block Attribute, which 
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is a text object contained in the Block whose properties are protected and whose content value 
can be edited  in a user-friendly interface. When you insert an Attributed Block into a drawing, 
you will be prompted to enter specific information for the attribute content. Block Attributes 
are a great way to ensure that necessary text information is entered and that it is in the correct 
format. In the process of completing this exercise, you will take an introductory look at the 
Block Editor interface.

 1. Continue working in acad-blk-xref-begin.dwg
 2. Current Layer = E_ALI
 3. Ribbon > Home tab > Draw panel

 A. Draw a Circle
 I. Radius = 15±

 B. Draw a Polyline within the Circle
 4. BLOCK

 A. enter
 B. Name = test2
 C. Base Point

 I.  Pick point
 a. Use Osnaps to specify center of Circle

 5. Objects
 A. Select objects

 I. Select Circle and Polyline
 II. enter

 6. Select test2 Block
 A. Properties palette > General

 I. Layer = E_ALI_Marker
 II. Observe Layer properties not taking effect

Info: If a Block has been created such that you do not have Layer con-
trol, you can enter Block Editor and place the objects contained in the 
Block on Layer 0. Then you will have Layer control of the Block.

 7. Ribbon > Insert tab > Block panel > EDIT
 A. Block to create or edit = test2
 B. OK

 I. Select Circle and Polyline
 a. Properties > General

 i. Layer = 0
 II. Block Editor Ribbon > Close panel > Close Block Editor

 a. Save the changes to test2
 8. Observe Layer properties take effect
 9.  Select test2 Block

 A. Properties palette > General
 I. Layer = E_ALI
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 10. Double-click test2 Block
 A. Block to create or edit = test2
 B. OK

 I. Block Editor Ribbon > Action Parameters panel > Attribute Definition
 a. Attribute

 i. Tag = Marker_ID
 ii. Prompt = Enter Marker ID

 iii. Default = Default ID
 b. Text Settings

 i. Annotative = unchecked
 ii. Text Height = 1

 c. OK

 II. Specify insertion point of Attribute within Circle
 C. Block Editor Ribbon > Close panel > Close Block Editor

 I. Save the changes to test2
 11. Ribbon > Insert tab > Blocks panel flyout > Synchronize Attributes

 A. ENTER AN OPTION: SELECT
 B. Select test2 Block
 C. enter

 12. Double-click test2 Block
 A. Enhanced Attribute Editor > Attribute tab

 I. Value = 12345
 II. OK

Insert from block definition & edit insertion point

Exercise files: acad-blk-xref-data-c3d16.zip
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Continue with acad-blk-xref-begin.dwg

acad-blk-xref-03.mp4 2:53

In this exercise you will learn to insert a Block from the definition stored in the current drawing. 
You will also learn two methods to reset a Block insertion point in Block Editor.

 1. Continue with acad-blk-xref-begin.dwg
 2. Ribbon > Insert tab > Insert dropdown > More Options

 A. Block to create or edit = test2
 I. Insertion point

 a. Specify on-screen = checked
 II. Scale

 a. Specify on-screen = unchecked
 b. X = 1

 III. Rotation
 a. Specify on-screen = unchecked
 b. Angle = 0

 IV. OK

 3. Specify insertion point of test2 Block near other drawing objects
 A. Edit Attributes

 I. Enter Marker ID = 6789
 B. OK

 4. BE
 A. enter
 B. Block to create or edit = test2

 I. Select all objects in Block Editor drawing area
 a. M
 b. enter
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 II. Specify base point
 a. Select bottom of Circle using Osnap

 III. Specify second point
 a. Verify Dynamic Input is off
 b. 0,0
 c. enter

 C. Block Editor Ribbon > Close panel > Close Block Editor
 I. Save the changes to test2

 5. Select test2 Block
 A. Observe Grip location at bottom of Circle

 6. BE
 A. enter
 B. Block to create or edit = test2
 C. Block Editor Ribbon > Action Parameters panel > Parameters dropdown > 

Basepoint
 I. SPECIFY PARAMETER LOCATION

 a. Use Osnap to specify center of Circle
 D. Block Editor Ribbon > Close panel > Close Block Editor

 I. Save the changes to test2
 7. Select test2 Block

 A. Observe Grip location at center of Circle

Write block (WBLOCK)

Exercise files: acad-blk-xref-data-c3d16.zip

Continue with acad-blk-xref-begin.dwg

acad-blk-xref-04.mp4 2:55

The WBLOCK command will write a Block Definition based on either existing Blocks or objects 
in the current drawing or the entire current drawing to a new, external drawing. This workflow 
is commonly used to write an entire drawing that has become corrupt to Block in order to leave 
behind those elements causing the corruption. This Block can then be inserted into a new draw-
ing created from the appropriate template.

 1. Continue with acad-blk-xref-begin.dwg
 2. WBLOCK

 A. enter
 B. Source

 I. Entire drawing = checked
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 C. Destination
 I. File name and path: ...

 a. Browse to folder containing acad-blk-xref-begin.dwg
 b. File name = new block.dwg
 c. Save

 D. Insert units = unitless
 E. Include AutoCAD Map information in the export?

 I. No
 3. Ribbon > Insert tab > Insert > More Options

 A. Browse
 I. Browse to new block.dwg

 II. Open
 B. Explode = unchecked
 C. OK

 4. Specify insertion point near other drawing objects

Info: When an entire drawing is written to a Block Definition using WBLOCK, the 
insertion point for the newly written Block will be at the same location relative to the 
newly written Block objects as the 0,0 coordinate in the original drawing was to the 
original drawing objects. 

Tip: In the case where WBLOCK is used to insert an entire drawing  into a blank 
drawing started from an appropriate template in order to leave behind corruption, 
the Insertion point: Specify on-screen option is typically unchecked. This way the 
objects in the original drawing and the Block inserted into the new drawing will be 
a the same coordinates. Additionally, the Explode option is typically checked. This 
way the newly inserted Block is automatically broken down to the level of the 
objects in the original drawing,

 5. X
 A. enter
 B. SELECT OBJECTS

 I. Select new block
 II. enter

Tip: Another method to insert an entire drawing into another drawing is to drag and 
drop the DWG file from Windows File Explorer into the Civil 3D drawing area.

 6. Windows File Explorer
 A. Browse to folder containing new block.dwg
 B. Select new block.dwg

 I. Drag and drop into Civil 3D drawing area
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 7. Specify insertion point near other drawing objects
 A. ENTER X SCALE FACTOR <1>:

 I. enter
 B. ENTER Y SCALE FACTOR <USE X SCALE FACTOR>:

 I. enter
 C. SPECIFY ROTATION ANGLE <0>:

 I. enter

Purged block definitions & WisDOT standards tab

Exercise files: acad-blk-xref-data-c3d16.zip

Start with acad-blk-xref-01.dwg

acad-blk-xref-05.mp4 5:26

In this video you will how it is possible to purge Block Definitions if they are not currently inser-
ted into the drawing are or referenced by Civil 3D or AutoCAD Styles. You will then use the Add 
Marker Symbols tool located on the Ribbon WisDOT Standards tab to bring those Block Defin-
itions back into the drawing. The Add Marker Symbols tool can be used to add the standard 
WisDOT Marker Blocks into any drawing regardless of whether that drawing ever had those 
Block Definitions or not.

 1. Open acad-blk-xref-01.dwg
 2. Ribbon > Insert tab > Insert > More Options

 A. Name = AC
 B. OK

 3. Specify insertion point near other drawing objects
 4. Ribbon > WisDOT Standards tab > Standards Components panel > Add Marker Sym-

bols
 5. Ribbon > Insert tab > Insert > More Options

 A. Name = ZOR
 B. OK

 6. Specify insertion point near other drawing objects
 7. Select all objects in drawing area

 A. delete
 8. Ribbon > Insert tab > Insert > More Options

 A. Name dropdown
 B. Observe ZOR, test, test2 and new block listed
 C. Cancel

 9. PURGE
 A. enter
 B. Items not used in drawing

 I. select Blocks
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 C. Purge
 D. Iterate steps 9.B - 9.C until no Blocks are listed

 10. Ribbon > Insert tab > Insert > More Options
 A. Name dropdown

 I. Observe ZOR, test, test2 and new block not listed
 B. Cancel

 11. Ribbon > WisDOT Standards tab > Standards Components panel > Add Marker Sym-
bols

 12. Ribbon > Insert tab > Insert > More Options
 A. Name dropdown

 I. Observe ZOR listed
 B. Cancel

Design center: insert block

Exercise files: acad-blk-xref-data-c3d16.zip

Continue with acad-blk-xref-01.dwg

acad-blk-xref-06.mp4 2:19

In this exercise you will explore options to insert a Block Definition from an external drawing 
when it is not available through the WisDOT contextual tabs. You can either insert an entire 
external drawing using the INSERT command or pick which Block(s) to insert from an external 
drawing using the Design Center interface.

 1. Continue working in acad-blk-xref-01.dwg
 2. INSERT

 A. enter
 B. Browse

 I. Browse to folder containing new block.dwg
 II. Select new block.dwg

 III. Open
 C. Specify insertion point anywhere in drawing area

 3. INSERT
 A. enter
 B. Name dropdown
 C. Observe new block listed
 D. Cancel

 4. Select new block
 A. delete
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 5. PURGE
 A. enter
 B. Items not used in drawing

 I. select Blocks
 C. Purge
 D. Iterate steps 9.B - 9.C until no Blocks are listed

 6. Ribbon > Home tab > Palettes panel flyout > Design Center
 A. Folders tab > expand Folder list to new block.dwg

 I. Select Blocks
 II. Drag and drop test2 into drawing area

 7. Edit Attributes
 A. OK

WisDOT sheets tab: topo tool palette

Exercise files: acad-blk-xref-data-c3d16.zip

Start with acad-blk-xref-02.dwg

acad-blk-xref-07.mp4 4:23

The topography Blocks used as Point Markers in Civil 3D Point Styles can be found and inserted 
directly as Blocks into any drawing through the WisDOT Topo Tool Palette, which is found on 
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the WisDOT Sheets contextual Ribbon. The Blocks inserted from these Tool Palettes are defined 
in external source drawings that install with the WisDOT Standards package.

 1. Open acad-blk-xref-02.dwg
 2. Ribbon > WisDOT Sheets

 A. Sheet Creation Components panel > Topo
 B. Tools panel > Palettes ON/OFF

 I. Topo Tool Palette > BuildingFencesTrees tab
 a. Tree Stump

 i. Specify insertion point near other drawing objects
 3. Select STMP Block

 A. Properties palette > General
 I. Layer = E_LAND_Vegetation

 4. Select STMP Block
 5. Ribbon > Home tab > Layers > Make Current

Info: The Blocks included on the Topo Tool Palette are also included as Block 
Definitions in most of the WisDOT templates. They are referenced as Point Mark-
ers in Civil 3D Point Styles which are also included in the WisDOT templates. 
More detailed information on Civil 3D Point Styles and Markers can be found in 
the Points training module.

Automatic scaling: block units & insertion units

Exercise files: acad-blk-xref-data-c3d16.zip

Continue with acad-blk-xref-02.dwg

acad-blk-xref-08.mp4 5:44

When a Block is inserted into a drawing it will be automatically scaled by a factor based on the 
drawing Insertion Units and the individual Block Units. The scale factor applied to a Block upon 
insertion will  represent the Block in terms of the drawing Insertion Units. For example, a Block 
with Block Units of "inches" and a length magnitude of 24 that is inserted into a drawing with 
Insertion Units of "feet" will be scaled by a factor of 1/12 and will be have a length magnitude 
of 2 after insertion. Both the Insertion Units and the Block Units must be set to a value other 
than "unitless" in order for this form of automatic scaling to take place. If either is set to unit-
less in the source drawing, the Block will come in with the same length quantity as that in the 
source drawing.

Info: Note that automatic Block scaling is not Annotative scaling, which will be 
covered in later training modules. 
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 1. Continue working in acad-blk-xref-02.dwg
 2. Select STMP Block
 3. Properties palette > Misc

 A. Observe Block Unit = Unitless
 B. Observe that this field is not editable here

 4. BE
 A. enter
 B. Block to create or edit = STMP
 C. OK
 D. Properties palette > Block

 I. Units = Inches
 E. Block Editor Ribbon > Close panel > Close Block Editor

 I. Save the changes to STMP
 5. INSERT

 A. Name = STMP
 B. OK

 6. Specify insertion point near other objects
 A. Observe automatic scaling

 7. Topo Tool Palette  > BuildingFencesTrees tab
 A. Tree Stump

 I. Specify insertion point near other objects
 II. Observe lack of automatic scaling

 8. When a Block is inserted from an external Block Definition, such as the source drawing 
used by the WisDOT Topo Tool Palette, the Block will scale based on the units in that 
external source drawing even if the Block Definition in the current drawing has been 
edited to have different Block units. To avoid this, the Block Definition in the source draw-
ing would need to be edited.

Warning: The Blocks included in the WisDOT Tool Palettes and various 
Templates should not be edited by the end user. This training module exer-
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cise is intended to teach you general Block behavior. You may need to edit 
Blocks coming from outside of WisDOT, however.

 9. Select STMP Block inserted in step 7.B
 A. Properties palette

 I.  Geometry
 a. Observe Scale = 12

 II. Misc
 a. Observe Block unit = Inches

 10. Topo Tool Palette  > BuildingFencesTrees tab
 A. Right-click Tree Stump
 B. Redefine

 11. Select STMP Block inserted in step 7.B
 A. Properties palette

 I. Geometry
 a. Observe Scale = 1

 II. Misc
 a. Observe Block unit = unitless

 12. Select all instances of STMP Block
 A. Properties palette > Geometry

 I. Scale = 1

Automatic scaling: redefine block from design center

Exercise files: acad-blk-xref-data-c3d16.zip

Continue with acad-blk-xref-02.dwg

acad-blk-xref-09.mp4 4:16

The Blocks included on the WisDOT Tool Palettes can be redefined in a drawing by right-click-
ing on the corresponding Tool Palette button and choosing Redefine. For those Blocks not 
included on the WisDOT Tool Palettes, you can redefine the drawing Block Definition by brows-
ing to the source drawing through Design Center. This exercise goes through the workflow to 
redefine a Block through Design Center.

 1. Continue with acad-blk-xref-02.dwg
 2. Select test2 Block
 3. BE

 A. enter
 B. Block to create or edit = test2
 C. OK
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 4. Properties palette > Block
 A. Units = Inches
 B. Block Editor Ribbon > Close panel > Close Block Editor

 I. Save the changes to test2
 5. Insert

 A. Name = test2
 B. OK
 C. Specify insertion point near other drawing objects

 I. Edit Attributes
 II. OK

 6. DC
 A. enter
 B. Folders

 I.  Browse to new block.dwg
 a. Blocks

 i. Drag & drop test2 into drawing area
 ii. Edit Attributes

 iii. OK
 7. Properties palette

 A.  Geometry
 I. Observe Scale = 12

Info: In order to Insert a Block from an external source, such as through a Design 
Center, and have that external Block Definition update that in the current drawing, 
the Block in the external source drawing must be edited. Then you can browse to 
that Block in the external source through Design Center and redefine any instances 
of that Block Definition in the current drawing. This is the same functionality that is 
found by right-clicking a WisDOT Tool Palette button and choosing Redefine, but it 
applies to any Block even if it is not included in the WisDOT Tool Palette.

 8. Open new block.dwg
 9. BE

 A. enter
 B. Block to create or edit = test2
 C. OK

 10. Properties palette > Block
 A. Units = Inches
 B. Block Editor Ribbon > Close panel > Close Block Editor

 I. Save the changes to test2
 11. Application menu > SaveAs

 A. File name = new block1.dwg
 B. Save
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 12. DC
 A. enter
 B. Folders

 I. Browse to new block 1.dwg
 a. Blocks
 b. right-click test2

 i. Redfine only
 13. Select all instances of test2 Block

 A. Properties palette > Geometry
 I. Scale = 1

WisDOT sheets tab: signs tool palette

Exercise files: acad-blk-xref-data-c3d16.zip

Start with acad-blk-xref-03.dwg

acad-blk-xref-10.mp4 3:23

This exercise will walk you through the unique features included in the WisDOT Signs Tool 
Palette. The Blocks included on this tool palette represent the WisDOT standard signage details. 
These Dynamic Blocks include the ability to choose a version of each block from a dropdown list 
(Visibility Set) as well as a hyperlink to quickly view the associated WisDOT standard detail 
sheets. 

 1. Open acad-blk-xref-03.dwg
 2. Ribbon > WisDOT Sheets tab > Sheet Creation Components panel > Signs

 A. D-Signs tab
 I. D1-51

 a. Specify insertion point anywhere in drawing area
 3. Select D1-51 Block

 A. Visibility set dropdown
 B. Choose alternative Visibilty from list
 C. esc
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 4. Double-click D1-51Block
 A. Enhanced Attribute Editor

 I. Select SIZE row
 II. Value = 120"X15"

 III. Observe update to D1-51 Block in drawing area
 B. OK

 5. Ctrl+click D1-51 Block
 A. Observe web browser open the WisDOT signage detail D1-51.pdf

WisDOT design tab: intersections, beam guards & general blocks

Exercise files: acad-blk-xref-data-c3d16.zip

Continue with acad-blk-xref-03.dwg

acad-blk-xref-11.mp4 4:37

The WisDOT Intersection Blocks and Beam Guard Tool Palattes contain dynamic Blocks which 
include easily editable linework to get started with your geometric layout. Insert these Blocks 
and use the Properties palette or dynamic Block grips to edit the linework. The WisDOT Design 
Ribbon tab also includes the Autodesk Palettes button. This will populate your Tool Palette with 
all of the default Autodesk Tool Palette tabs. Some of these default Tool Palette tabs contain 
default Autodesk Blocks that could potentially be useful to convey your design intentions.
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 1. Continue working in acad-blk-xref-03.dwg
 2. Ribbon > WisDOT Design > Parametric Design panel > Intersection Blocks  

 A. Int-Type-A-Q-Grtr-80-In-Curve
 B. Specify insertion point near other drawing objects

 3. Select Int-Type-A-Q-Grtr-80-In-Curve Block
 A. Select Grip along incoming intersection centerline

 I. Specify point location for centerline
 B. Select Visibility Set dropdown

 I. Graphics Mode = checked
 C. Properties palette > Custom

 I. Observe editable parameters in tabulated form
 D. esc

 4. Ribbon > WisDOT Design >  Parametric Design panel > Beam Guard
 A. BG EAT R Right Curve
 B. Specify insertion point near other drawing objects

 5. Select BG EAT R Right Curve Block
 A. Observe grips to edit linework geometry
 B. Properties palette > Custom

 I. Observe editable parameters in tabulated form
 C. esc

 6. Ribbon > WisDOT Design >  Autodesk panel > Autodesk Palettes
 A. Left-click "stacked" tabs at bottom of Tool Palette
 B. Scroll down in list

 I. Highways
 a. Scroll to explore available out-of-the-box Blocks

 II. External Works
 a. Scroll to explore available out-of-the-box Blocks

Xref: overlay vs attach

Exercise files: acad-blk-xref-data-c3d16.zip

Start with acad-blk-xref-04.dwg, acad-blk-xref-05.dwg and acad-blk-xref-06.dwg

acad-blk-xref-12.mp4 5:56

This exercise will introduce you to the External Referencing (Xref) workflow. You will create an 
Overlay Xref then change it to an Attach Xref and observe behavioral differences between the 
two. When an Xref is created as the type "Overlay", the Externally Referenced source drawing 
will not be carried forward if the destination drawing is then Externally Referenced into 
another drawing. When an Xref is created as the type "Attach", the Externally Referenced 
source drawing will be carried forward.
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 1. Open acad-blk-xref-04.dwg, acad-blk-xref-05.dwg and acad-blk-xref-06.dwg
 2. File tab > acad-blk-xref-05
 3. Ribbon > Home tab > Palettes panel flyout > External References Manager

 4. External References palette > Attach dropdown > Attach DWG
 A. Browse to acad-blk-xref-04.dwg

 I. Open
 5. Attach External Reference

 A. Reference Type = Overlay
 B. OK
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 6. Ribbon > Home tab > Layers panel > Layer Properties
 A. Observe presence of Xref Layer Filters and Xref Layers
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 7. File tab > acad-blk-xref-06
 8. XR

 A. enter
 9. External References palette > Attach dropdown > Attach DWG

 A. Browse to acad-blk-xref-05.dwg
 I. Open

 B. Info: 
When acad-blk-xref-05.dwg is externally referenced into acad-blk-xref-
06.dwg, no objects are displayed in acad-blk-xref-06.dwg. This is because 
the objects displayed in acad-blk-xref-05.dwg are only an "Overlay" xref of 
acad-blk-xref-04.dwg. "Overlay" xrefs are not carried forward when their 
destination drawing is then used as an xref source drawing in another draw-
ing. "Attach" xrefs are carried forward in this manner, however.
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When acad-blk-xref-05.dwg is externally referenced into acad-blk-xref-
06.dwg, xref Layers prefixed with acad-blk-xref-05 are created and are sim-
ilar to the Layers in acad-blk-xref-04.dwg. This is because both acad-blk-
xref-04.dwg and acad-blk-xref-05.dwg were started from the same tem-
plate (wisdot16.dwt) and this template includes all of those Layers.

 10. File tab > acad-blk-xref-05
 11. XR

 A. enter
 12. External References palette > right-click acad-blk-xref-04

 A. Xref Type = Attach
 13. Save acad-blk-xref-05.dwg
 14. File tab > acad-blk-xref-06

 A. Status Bar > External Reference File Has Changed prompt > Reload acad-blk-
xref-05 - <username> <computer name>

Xref source path: full vs relative

Exercise files: acad-blk-xref-data-c3d16.zip

Continue with acad-blk-xref-04.dwg, acad-blk-xref-05.dwg and acad-blk-xref-06.dwg

acad-blk-xref-13.mp4 4:00

You have three options to specify how the Xref file path relationship between the source draw-
ing and destination drawing is defined. A Full Path Xref requires that the source drawing exist at 
the exact drive location called out in the destination drawing when the Xref was created. If not, 
the Xref source file will not be read and a notification will be displayed. A Relative Path Xref 
requires that the source drawing exist at the same folder hierarchy location relative to the des-
tination drawing. In other words, the source and destination drawings must be the same num-
ber of folders away from each other in order for the Xref source drawing to be read. There is 
also a No Path option which requires that the path to the source drawing be included in the Civil 

Page: 221

Published on: 2/21/2018

Blocks and external references

http://www.c3dkb.dot.wi.gov/data/acad/acad-blk-xref-data-c3d16.zip
http://www.c3dkb.dot.wi.gov/video/acad/acad-blk-xref-13.mp4


3D profile options support file search path list. This No Path Xref type is less common and will 
not be covered in this exercise.

 1. Continue working in acad-blk-xref-04.dwg, acad-blk-xref-05.dwg and acad-blk-xref-
06.dwg

 2. XR
 A. enter
 B. Observe full path displayed in acad-blk-xref-04 row, Saved Path column

 3. File tab > Close acad-blk-xref-04
 4. Windows File Explorer

 A. Browse to acad-blk-xref-04.dwg
 B. Move acad-blk-xref-04.dwg into xref folder

 5. External References palette > right-click acad-blk-xref-04
 A. Reload
 B. Observe "Not Found" displayed in acad-blk-xref-04 row, Status column

 6. Windows File Explorer
 A. Browse to acad-blk-xref-04.dwg
 B. Move acad-blk-xref-04.dwg to location displayed in Saved Path column of External 

References palette
 7. External References palette > right-click acad-blk-xref-04

 A. Reload
 B. Observe "Loaded" displayed in acad-blk-xref-04 row, Status column
 C. Right-click acad-blk-xref-04

 I. Make Relative
 II. Observe partial file path displayed in acad-blk-xref-04 row, Saved Path 

column
 8. Save acad-blk-xref-05.dwg
 9. File tab > Close acad-blk-xref-05

 10. Windows File Explorer
 A. Browse to acad-blk-xref-04.dwg
 B. Move acad-blk-xref-04.dwg and acad-blk-xref-05.dwg into xref folder

 11. Open acad-blk-xref-05.dwg
 12. External References palette

 A. Observe "Loaded" displayed in acad-blk-xref-04 row, Status column

Bind xref

Exercise files: acad-blk-xref-data-c3d16.zip

Start with acad-blk-xref-07.dwg

acad-blk-xref-14.mp4 3:48
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Once an Xref is created in a drawing, you can insert the source objects, styles, Block Definitions 
and Layers through the BIND command. This will insert the source drawing content and create 
or merge similar content (ie similarly named Layers or Blocks) depending on the type of Bind 
you specify. In this exercise, you will Bind an Xref using both types of the Bind command and 
observe behavioral differences between the two.

 1. Open acad-blk-xref-07.dwg
 2. XR

 A. enter
 B. Browse to acad-blk-xref-04.dwg
 C. Open

 3. Add External Reference
 A. OK

 4. External References palette > Right-click acad-blk-xref-04
 A. Bind
 B. Bind Xrefs/DGN underlays

 I. Bind Type = Bind
 II. OK

Info: When you Bind an Xref using the type Bind, any content in the 
source drawing similarly named in the destination drawing will be 
duplicated. That duplicated content will be named with a prefix based 
on the source drawing name. When you Bind using the type Insert, 
any content in the source drawing similarly named in the destination 
drawing will be merged. The version of that similar content in the des-
tination drawing will be used.

 5. Select all drawing objects
 A. Properties

 I. Observe selected object is a Block Reference
 II. Misc

 a. Observe name = acad-blk-xref-04
 6. Ribbon > Home tab > Layers panel > Layer Properties

 A. Observe duplicate Layer naming convention
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 7. Quick Access toolbar > Undo dropdown > External References
 8. XR

 A. enter
 9. External References palette > Right-click acad-blk-xref-04

 A. Bind
 B. Bind Xrefs/DGN underlays

 I. Bind Type = Insert
 II. OK

 10. Select acad-blk-xref-04 Block
 11. Ribbon > Home tab > Layers panel > Layer Properties

 A. Observe no duplicate Layers created

Annotation

Last updated: 2017-11-28
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Total video time: 40:14

This section will cover annotation tools used to add notes and callouts to a drawing. We will go 
over AutoCAD tools to create Multiline Text (text-only notes), Multileaders (callouts with text 
and pointer), and Dimensions as well as their associated styles. It should be noted that any Civil 
3D objects have their own Label Styles which can automatically label key design features and 
dynamically update based on changes to associated Civil 3D objects. These Civil 3D Labels 
Styles should always be used where possible as they reduce the potential for human error and 
eliminate tedious, manual annotation work.  The annotation tools covered in this section are typ-
ically reserved for cases where Civil 3D Label Styles are not applicable. For example, they can 
be used for things like construction details, title sheets, and plan sheet borders.

  

Multiline text

Exercise files: acad-annotatn-data-c3d16.zip

Start with acad-annotatn-begin.dwg

acad-annotatn-01.mp4 7:01

Multiline text is the preferred method in Civil 3D for typing or inserting general notes.

 1. Open acad-annotatn-begin.dwg
 2. Ribbon > Annotate tab > Text panel > Multiline text

 A. SPECIFY FIRST CORNER:
 I. Use Osnaps to pick upper left corner of title block box

 B. SPECIFY OPPOSITE CORNER:
 I. Use Osnaps to pick lower right corner of title block box
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 C. Type notes in  Mtext box
 D. Open maintainence crossover.txt in Notepad

 I. Copy text content
 E. Paste text content into Mtext box

 3. Select previously created Mtext with single click
 A. Observe insertion, column height and column width Grips displayed
 B. esc

 4. Double click previously created Mtext
 A. Observe Mtext contextual Ribbon displayed
 B. Mtext Ribbon

 I.  Formatting panel > Text style dropdown
 a. Choose alternative Text style
 b. Set back to Callibri Light

 II. Style panel > Text height field
 a. Key in new Text height
 b. Set back to 0.1000

 III. Paragraph panel > Justification dropdown
 a. Choose Middle Center

 C. Left-click outside Mtext editing box
 5. Select Mtext object

 A. Use Geometric Center Osnap to place insertion point at centroid of title block 
area

 B. esc
 6. Ribbon > Annotate tab > Text panel > Multiline Text

 A. SPECIFY FIRST CORNER:
 I. Pick lower endpoint of green guiding Line
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 B. SPECIFY OPPOSITE CORNER:

 C. Type general notes into Mtext box
 D. Highlight general notes text content
 E. Mtext Ribbon > Formatting panel > Change case dropdown

 I. Uppercase
 F. Mtext Ribbon > Tools panel flyout > Import text

 I. Browse to general notes.txt
 II. Open

 G. Select part of the Mtext content
 H. Mtext Ribbon

 I.  Formatting panel > Text style dropdown
 a. Change Text style

 II. Style panel > Text height field
 a. Change Text height

 III. Formatting panel > Match
 a. Highlight Text content with source formatting
 b. Highlight Text content for which to apply formatting

 IV. Highlight entire Mtext content
 a. Style panel > Text height field

 i. Text height = 0.1250
 V. Insert panel > Columns dropdown > No Columns

 a. Right click top of Mext box
 i. Set Mtext width = 38

 ii. OK
 I. Left-click outside Mtext box to finish editing

Text editing & legacy text
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Exercise files: acad-annotatn-data-c3d16.zip

Continue with acad-annotatn-begin.dwg

acad-annotatn-02.mp4 5:20

In this exercise, you will learn some time-saving text editing functions including Change 
Case, Convert to Mtext, Text Align, Match Properties, Check Spelling, and Find/ 
Replace as well as  the differences between Multiline Text (Mtext) and Text (aka Dtext). 
Essentially, Text is the old version of Mtext. Where Mtext can have multiple lines of text 
content sorted into columns and rows as desired, Text is single line and has no column 
sorting ability built in. You can type mulitple lines of text content in a Text object, but 
each line will result in its own individual Text object. There is much less editing ability 
with Text vs Mtext and no associated contextual Ribbon. All that said, many older draw-
ings or Civil 3D drawings with content imported from Microstation will contain the older 
legacy Text.

 1. Continue working in acad-annotatn-begin.dwg
 2. Ribbon > Annotate tab > Text panel > Multiline text dropdown > Single line

 A. SPECIFY START POINT OF TEXT OR
 I. Pick bottom endpoint of the green Line above SECTION B-B detail

 B. SPECIFY PAPER HEIGHT <0.1000>
 I. enter

 C. SPECIFY ROTATION ANGLE OF TEXT <0>
 I. enter

 D. Type section a-a
 I. Left-click outside of Text object

 II. esc
 3. Select section a-aText

 A. Right click > Change Case > UPPERCASE
 4. Type MA to initiate the match properties command

 A. enter
 B. SELECT SOURCE OBJECT

 I. Left click SECTION B-B Text
 C. SELECT DESTINATION OBJECT

 I. Left click SECTION A-A Text
 5. Select SECTION A-A Text

 A. Properties palette > Text
 I. Justify = Center

 6.  Ribbon > Express tools tab > Text panel > Convert to Mtext
 A. SELECT OBJECTS

 I. Select STATE OF WISCONSIN DEPARTMENT OF Text
 II. Select TRANSPORTATION Text

 III. enter
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 7. Select STATE OF WISCONSIN DEPARTMENT OF TRANSPORTATION Mtext
 A. Properties palette > Text

 I. Justify = Middle Center
 II. esc

 8. Ribbon > Annotate tab > Text panel > Text Align
 A. SELECT TEXT OBJECTS TO ALIGN

 I. SECTION B-B Text
 II. SECTION A-A Text

 III. enter
 IV. SELECT TEXT OBJECT TO ALIGN TO

 a.  SECTION A-A Text
 b. PICK SECOND POINT

 i.  shift + left click below SECTION A-A Text
 9. Ribbon > Annotate tab > Text panel > Check Spelling

 A. Start
 B. Add to Dictionary
 C. Close

 10. Ribbon > Annotate tab > Text panel
 A. Find and Replace field: shld
 B.  Find and Replace

 I. Replace with: SHOULDER
 II. Replace All

 III. Done

Text Styles

Exercise files: acad-annotatn-data-c3d16.zip

Continue with acad-annotatn-begin.dwg

acad-blk-xref-03.mp4 3:35
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Whenever creating either Mtext or Text, the first step is to choose a Text Style. You pick this 
from a dropdown list on your Ribbon. As with other Civil 3D and AutoCAD Styles, the Text Styles 
available are associated with a drawing or template. The WisDOT Design templates come with 
the standard WisDOT Text Styles pre-loaded, though you may need to create or edit one when 
working with a drawing not created from the WisDOT template. A Text Style mainly controls 
font, text height, and annotative scaling functionality. In the following exercise you will learn 
how to interface with, edit and create a Text Style.

 1. Continue with acad-annotatn-begin.dwg
 2. Ribbon > Annotate tab > Text Style

 3. Current Text Style: Callibri Light
 4. New

 A. Style Name: style 1
 B. OK

 I. Font Name: Cambria
 II. Font Style: Regular

 III. Paper Text Height = 0.0000
Info: When Paper Text Height = 0 in a Text Style, the height set in the 
TEXTSIZE system variable or the last Text Height used is applied.

 IV. Font Name: cdm.shx
Info: Two basic font types can be used in Civil 3D. They are True 
Type or SHX. Where True Type fonts such as Arial and Callibiri can 
have unique shapes and thickness, the older, SHX fonts are only one 
pixel wide and are more limited in styling options. WisDOT Text Styles 
as well as most design firms and software applications in general use 
True Type fonts. Note the different icons in the Font Name dropdown.
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Multileader creation

Exercise files: acad-annotatn-data-c3d16.zip

Start with acad-annotatn-01.dwg

acad-annotatn-04.mp4 4:05

A Multileader (aka Mleader) is an annotation object consisting of a combination of a text and 
one or more leader/pointers. It is used to manually add notes pointing to a specific area of 
interest. The text portion behaves just like Mtext and the leader portion is dynamically attached 
to the text portion. The behavior of an Mleader is quite flexible. For instance, you can add mul-
tiple leaders on one or both sides of the text portion of an Mleader if you like. A typical use 
case for an Mleader would be for manual annotation of construction details or title sheets. In 
the following exercise, you will learn how to create and edit Mleaders.

Keep in mind that Civil 3D objects have their own automatically generated Civil 3D Labels that 
will automatically annotate key information like Alignment stationing, Points of Curvature/Tan-
gency, PVIs, Corridor Cross Section information, etc and thus do not require manually created 
Mleaders for annotation. More information on Civil 3D Label Styles will be covered in other 
training modules. Use of Mleaders should be reserved for cases where you are either not deal-
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ing with a Civil 3D object or need to add extra information not feasible to put into a Civil 3D 
Label. 

 1. Open acad-annotatn-01.dwg
 2. Select BOTTOM OF MEDIAN Mleader on right of SECTION A-A detail

 A. Double-click on the text portion
 B. Observe Mtext contextual Ribbon populated
 C. Left-click away from Mleader 

 3. Ribbon > Annotate tab > Leaders panel > Multileader
 A. SPECIFY LEADER ARROWHEAD LOCATION

 I. Use Nearest Osnap to pick bottom of TOPSOIL Line on right side of 
SECTION A-A detail

 B. SPECIFY LEADER LANDING LOCATION
 I. Pick below and left of arrowhead location

 C. Type TOPSOIL
 I. Left-click away from Mleader

 4. Repeat Steps 3.A - 3.C for 10:1 MAX 20:1 NORMAL Mleader

 5. Select TOPSOIL Mleader
 A. Select arrow Grip

 I. SPECIFY STRETCH POINT
 a. Pick to left of TOPSOIL text portion

Info: Note that the Leader portion of the Mleader is dynamically 
attached to the text portion. Once the specified location of the 
Leader arrow crosses the middle of the text portion, the Leader 
landing will automatically flip to the other side of the text.

 B. Select text insertion Grip
 I. SPECIFY STRETCH POINT

 a. Left-click a new location
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 C. Hover cursor over Leader landing Grip
 I. Lengthen landing

 a. SPECIFY LEADER LANDING ENDPOINT
 i. Left-click new location

 II. Add Leader
 a. SPECIFY LEADER ARROWHEAD LOCATION

 i. Left-click multiple new locations
 D. Hover cursor over arrow Grip

 I. Remove Leader
 E. Ribbon > Annotate tab > Leaders panel > Remove Leader

 I. SPECIFY LEADERS TO REMOVE
 a. Select Leader
 b. enter

 F. Ribbon > Annotate tab > Leaders panel > Align
 I. SELECT MULTILEADERS

 a. Select TOPSOIL and 10:1 MAX 20:1 NORMAL Mleaders
 b. enter

 II. SELECT MULTILIEADER TO ALIGN TO
 a. Select 10:1 MAX 20:1 NORMAL Mleader

 III. SPECIFY DIRECTION
 a. shift + left-click left of 10:1 MAX 20:1 NORMAL Mleader

Multileader styles

Exercise files: acad-annotatn-data-c3d16.zip

Continue with acad-annotatn-01.dwg

acad-annotatn-05.mp4 7:04

Whenever creating an Mleader, you want to be aware of the currently set Mleader Style. You 
set this through the Ribbon Mleader Style Manager button. Mleader Styles control what Text 
Style is used for the Text portion, what the Leader and arrow portion looks like, whether a user-
defined Block is used for either the arrow or in place of the text, and whether the Mleader is 
affected by Annotative Scaling among other things.  Through the following exercise, you will 
learn how to set the current Mleader Style, how to create or edit an Mleader Style, and what 
key Mleader parameters are set through the Mleader Style. The WisDOT templates come pre-
loaded with standard WisDOT Mleader Styles and as with other Civil 3D or AutoCAD Styles, 
these should be used to streamline the plan production workflow and maintain a standard 
appearance across WisDOT plan sets.
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 1. Continue working in acad-annotatn-01.dwg
 2. Select TOPSOIL Mleader

 A. Properties palette > Misc
 I. Observe Multileader style = 070

 3. Ribbon > Annotate tab > Leaders panel > Mleader Style Manager

 A. Current mulitleader style: 070
 B. Modify
 C. Leader Format tab

 I. General
 a. Type = Straight

 II. Arrowhead
 a. Symbol = Dot

 III. OK
 D. Close
 E. Observe update to existing Mleaders with 070 Mleader Style
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 4. Ribbon > Annotate tab > Leaders panel > Mleader Style Manager
 A. Modify
 B. Leader Format tab

 I. Arrowhead
 a. Symbol = Closed filled

 II. Leader break
 a. Break size = 0.0700

 III. OK
 C. Close

 5. Select TOPSOIL and 10:1 MAX 20:1 NORMAL Mleaders
 A. Use Mleader Grips to relocate  Leader landings such that Leader lines cross

 6. Ribbon > Annotate tab > Dimensions panel > Break
 A. SELECT DIMENSION TO ADD/REMOVE BREAK

 I. Select 10:1 MAX 20:1 NORMAL Mleader
 B. Select object to break dimension

 I. Select TOPSOIL Mleader
 II. enter

Tip: The "object to break dimension" does not need to be an Mleader 
or Dimension. This could be most any Civil 3D or AutoCAD object
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 7. Ribbon > Annotate tab > Leaders panel > Mleader Style Manager
 A. Modify
 B. Leader Structure tab

 I. Constraints
 a. Maximum leader points = 2

Info: Setting Maximum leader points = 3 or greater means you will be 
prompted for intermediate vertex points between the arrowhead and 
Leader landing when creating an Mleader. If Maximum leader points = 
2, you can still place additional Leader vertices manually by hovering 
your cursor over an Mleader arrowhead Grip and choosing Add vertex.

 I. Landing settings
 a. Automatically include landing = unchecked
 b. Observe effect in preview window
 c. Automatically include landing = checked

 II. Scale
 a. Annotative = checked

 C. Content tab
 I. Multileader type = Block

 a. Block options
 i. Source block = Detail Callout

 II. OK
 D. Close

 8. Ribbon > Annotate tab > Leaders panel > Multileader
 A. SPECIFY LEADER ARROWHEAD LOCATION

 I. Pick any location
 B. SPECIFY LEADER LANDING LOCATION

 I. Pick any location
 C. Edit Attributes

 I. Enter view number = 1
 II. Enter sheet number = 2

 D. OK
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 9. Ribbon > Annotate tab > Leaders panel > Mleader Style Manager
 A. Content tab

 I. Multileader type = Block
 a. Block options

 i. Source block = User Block
 ii. Observe ability to pick any Block Definition in the current 

drawing
 iii. Cancel

 II. Multileader type = Mtext
 a. Text options

 i. Text Style = Calibri Light
 ii. Text Style Manager 

 i. Cancel
 b. Leader connection

 i. Observe options affecting Horizontal, Vertical Leader landing 
attachment

Dimension creation

Exercise files: acad-annotatn-data-c3d16.zip
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Start with acad-annotatn-02.dwg

acad-annotatn-06.mp4 3:07

In Civil 3D, a Dimension is an object used to call out an angle or distance (length, radius, etc) in 
your drawing. It is made up of Dimension lines, Tick marks, and an automatically generated and 
dynamic Dimension value derived from the object or points you specify, the drawing units, and 
the Dimension Style units. The following exercise will walk you though how to create a Dimen-
sion as well as the importance of setting the correct Dimension Style.

 1. Open both acad-annotatn-02.dwg and acad-annotatn-end.dwg
 2. acad-annotatn-end filetab

 A. Observe 20'-0"V.C. Dimension in SECTION B-B detail
 B. Observe 3' CRUSHED AGGREGATE BASE COURSE and 12' Dimensions in SECTION 

A-A detail
 3. acad-annotatn-02 filetab

 A. Ribbon > Annotate tab > Dimensions panel > Dimension Style dropdown > 
070-PLAN-CONVENTIONAL

 B. Dim Layer Override = Use Current
 C. Ribbon Home tab > Layers panel > Layer dropdown > P_MISC
 D. Ribbon > Annotate tab > Dimensions panel > Dimension type dropdown > Lin-

ear
 E.  Linear

 I. SPECIFY FIRST EXTENSION LINE ORIGIN
 a. Left end of arc in SECTION B-B

 II. SPECIFY FIRST EXTENSION LINE ORIGIN
 a. Right end of arc in SECTION B-B

 III. SPECIFY DIMENSION LINE LOCATION
 a. Above arc
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 4. acad-annotatn-end filetab
 A. Double click 20'-0" V.C. Dimension

 I. Observe that all text in cell is highlighted 
Info: The highlighted text in a Dimesion is automatically generated 
based on the geometry of the Dimension along with the Dimension 
Style. It can include a prefix or suffix such as "ft" etc. among other 
things

Dimension styles

Exercise files: acad-annotatn-data-c3d16.zip

Continue with acad-annotatn-02.dwg

acad-annotatn-07.mp4 5:24

 1. Continue with both acad-annotatn-02.dwg and acad-annotatn-end.dwg
 2. acad-annotatn-02 filetab

 A. Select 20.00' Dimension
 I. Properties palette > Misc

 a. Observe Dim Style = 070-PLAN-CONVENTIONAL
 II. Ribbon > Annotate tab > Dimension Style Manager

 III. Styles
 a.  Select 070-PLAN-CONVENTIONAL

 i. Set Current
 IV. New...

 a. Continue
 b. New Dimension Style dialog

 i.  Primary Units tab
 1. Unit format = Engineering
 2. Precision = 0'-0"
 3. Suffix = V.C.

 c. OK
 V. Close
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 A. Primary Units tab
 I. Scale factor = 12

 II. Place a space before V.C.
 III. Toggle off all Zero suppression boxes

 B. OK
 C. Close

 3. Select 20.00' Dimension
 A. Properties palette > Misc

 I. Dim Style = Copy(2) of 070-PLAN CONVENTIONAL
 4. Ribbon > Annotate tab > Dimensions panel > Dimension Style Manager

 A. Select Copy(2) of 070-PLAN CONVENTIONAL Dimension Style
 B. Modify

 I. Primary Units tab
 a. Linear dimensions

 i. Scale factor = 12
 b. Zero suppression

 i. 0 feet = unchecked
 ii. 0 inches = unchecked

Page: 240

Published on: 2/21/2018

Annotation



 C. OK
 D. Close

 

Additional Dimension Tools

Exercise files: acad-annotatn-data-c3d16.zip

Continue with acad-annotatn-02.dwg

acad-annotatn-08.mp4 4:38

 1. Continue with both acad-annotatn-02.dwg and acad-annotatn-end.dwg
 2. acad-annotatn-end filetab

 A. Observe dimensions for SECTION A-A

Page: 241

Published on: 2/21/2018

Annotation

http://www.c3dkb.dot.wi.gov/data/acad/acad-annotatn-data-C3D16.zip
http://www.c3dkb.dot.wi.gov/video/acad/acad-annotatn-08.mp4


 3. acad-annotatn-02 filetab
 4.  Ribbon > Annotate tab > Dimensions panel > Dimension Style dropdown

 A. Select Copy of 070-PLAN CONVENTIONAL
 5. Ribbon > Annotate tab > Dimensions panel > Linear

 A. SPECIFY FIRST EXTENSION LINE ORIGIN
 I. Left endpoint of pavement in SECTION A-A

 B. SPECIFY SECOND EXTENSION LINE ORIGIN
 I. Crown endpoint of pavement in SECTION A-A

 C. SPECIFY DIMESION LINE LOCATION
 I. Above SECTION A-A detail

 6. Ribbon > Annotate tab > Dimensions panel > Continue
 A. SPECIFY SECOND EXTENSION LINE ORIGIN

 I. Right endpoint of pavement in SECTION A-A
 I.  

 B. SPECIFY SECOND EXTENSION LINE ORIGIN
 I. Right endpoint of SECTION A-A Crushed Aggregate Shoulder

 II. enter
 7. Select previously drawn Dimensions
 8. delete
 9. Status bar > Selection cycling = on

 10. Ribbon > Annotate tab > Dimensions panel > Quick
 A. SELECT GEOMETRY TO DIMENSION

 I. Select Lines on top of SECTION A-A Pavement
 II. enter

 B. SPECIFY DIMENSION LINE POSITION
 I. Above SECTION A-A detail

 11. Ribbon > Annotate tab Dimension panel > Continue
 A. SPECIFY SECTION DIMENSION LINE ORIGIN

 I. Right endpoint of SECTION A-A Crushed Aggregate Shoulder
 12. Ribbon > Annotate tab > Dimension panel > Linear

 A. SPECIFY FIRST EXTENSION LINE ORIGIN
 I. Left endpoint of SECTION A-A Crushed Aggregate Shoulder

 B. SPECIFY SECOND EXTENSION LINE ORIGIN
 I. Left endpoint of pavement in SECTION A-A 

 13. Double click 3' Dimension
 A. Place cursor after auto-generated Dimension text
 B. Type CRUSHED AGGREGATE BASE COURSE SHOULDER

 14. Repeat step 13 for other 3' Dimension
 15. Select 3' CRUSHED AGGREGATE BASE COURSE SHOULDER Dimension

 A. Hover cursor over text Insertion Grip
 I. Move Text Only

 II. Relocate Dimension text beside outer Dimension extension line
 16. Repeat step 15 for other 3' CRUSHED AGGREGATE BASE COURSE SHOULDER Dimension
 17. Select 3' CRUSHED AGGREGATE BASE COURSE SHOULDER Dimension

 A. Reset width to 12 units
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 18. Repeat step 17 for other 3' CRUSHED AGGREGATE BASE COURSE SHOULDER Dimension

 

Annotative scale

Last updated: 2017-12-01

Total video time: 17:15

Annotative scaling is a way to control display and scaling of certain annotation-related AutoCAD 
objects when setting up a sheet layout to plot. The purpose of this scaling is to maintain read-
ability of your plan sheet regardless of the sheet  scale. For instance, you may want to label indi-
vidual property parcels on a 1 IN:40 FT scale, but omit the parcel labels at a 1 IN:200 FT scale 
since they would not be readable. You may want to label street or highway names at a constant 
plotted text height on both a 1 IN:40 FT scale sheet and a 1 IN:200 FT sheet. You can accomplish 
both of these scenarios without  creating duplicate text objects and Layers for different sheet 
sizes. It should be noted that Civil 3D objects will be labeled automatically based on their Label 
Style and these Labels will automatically scale similarly to AutoCAD objects affected by Annot-
ative scaling.

Any object that will be affected by Annotative Scaling is said to be Annotative. AutoCAD objects 
available to be Annotative include Multiline Text, legacy single line Text, Blocks, Hatch objects, 
Dimensions and Multileaders. Many of the text-related WisDOT Styles (Multiline Text, Dimen-
sion and Multileader Styles) are already set up to be Annotative. You can also change any Non-
annotative Multiline Text, legacy single line Text, Block, Hatch object, Dimension or 
Multileader to be Annotative through the Properties Palette.

This training module will familiarize you with basic sheet Layout concepts necessary to under-
stand Annotative Scaling, how Annotative Scaling works and tools/best practices for managing 
Annotative objects. More detailed information on sheet Layouts and plotting will be covered in 
other training modules.

Model vs paper, layouts & viewports

Exercise files: acad-annotatv-scl-data-c3d16.zip

Start with acad-annotatv-scl-begin.dwg

acad-annotatv-scl-01.mp4 5:02

This exercise will introduce you to the concepts of Model space vs Paper space, Layouts, View-
ports, and Viewport Scales. Model space is the interface you will design your Civil 3D model in. 
It includes all of the Civil 3D and AutoCAD objects you will create to represent your modeled 
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design. You can switch from Model space to a Layout interface where you will set up what your 
plotted plan sheet will look like. In a Layout, you can either draw objects in Paper space, which 
will not affect Model space, or have a Viewport object that acts as a window looking into Model 
space. You will learn how to switch between Model space and a Layout, how to work in Paper 
space and Model space within a Layout, and how to create a Viewport and work with the View-
port scale. 

 1. Open acad-annotatv-scl-begin.dwg
 2. Observe the Model tab and Layout tab in the bottom left of your interface

 A. Click S11A103 Layout tab to activate the Layout

 3. Status Bar
 A.  Customization 

 I. Paper space = checked
 B. Paper space active
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 C. Draw a Circle on your Layout in Paper space
 4. Click Model tab to activate Model space

 A. Observe no Circle displayed in Model space
 5. S11A103 

 A. Delete the Circle drawn in step 3.C
 6. Status Bar

 A. Model space active
Info: Activating Model space by toggling the Status Bar PAPER/MODEL but-
ton allows you to work in Model space through your Layout Viewport. This is 
not the same as switching to Model space by clicking the Model tab in the 
bottom left of your interface.
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 B. Draw a Circle on your Layout in Model space
 7.   Model 

 A. Observe Circle displayed in Model space
 8.   S11A103 

 A. Delete the Circle drawn in step 6.B
Info: Double-click in grey area outside your Viewport as an alternative 
method to activate Paper space. Double-click in area inside a Viewport as 
an alternative method to activate Model space.

 9. Select Viewport
 A. delete
 B. Observe Model space objects not displayed

 10. Ribbon > Home tab > Layers panel > Layer Properties
 A. Filters

 I. All = checked
 B. P_MISC_NoPlot = Current

 11. MVIEW
 A. enter
 B. SPECIFY CORNER OF VIEWPORT: 0,0

 I. enter
 C. SPECIFY OPPOSITE CORNER: 17,11

 I. enter
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 12. Select Viewport created in step 11
 A. Observe Viewport scale ≠ 1IN:10 FT
 B. Viewport scale dropdown > 1IN:10 FT

 13. Status bar
 A. Lock Viewport scale

 B. Zoom in/out
 I. Observe Viewport scale unchanged

 14. Status bar
 A. Unlock Viewport scale
 B. Double-click inside Viewport to activate Model space
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 C. Zoom in/out
 I. Observe Viewport scale changed

 D. Undo Zoom command to reverse Viewport scale change

Scaling factor, display options & object scales list

Exercise files: acad-annotatv-scl-data-c3d16.zip

Continue with acad-annotatv-scl-01.dwg

acad-annotatv-scl-02.mp4 6:23

In this exercise you will learn how Annotative Scale factors are applied based on the currently 
set Annotative Scale (aka Viewport Scale). Annotative objects have a constant Paper space size 
and a Model space size that depends on the current Annotative Scale. After completing this 
exercise, you will learn how to manually add scales to an Annotative Object's scales list to 
enable Annotative Scaling of the object. Additionally, you will learn how to utilize Annotative 
scaling Status Bar options to control when Annotative Objects are displayed and whether scales 
are added to Annotative Objects automatically.

 1. Continue working in acad-annotatv-scl-01.dwg
 2. Select S.T.H. 25 Annotative Mtext near 557+00

 A. Properties Palette > Text
 I. Observe Paper Text Height = 0.1250, Model Text Height = 5.0000

 3. Status Bar
 A. Observe current view Annotative Scale = 1 IN:40 FT

Info: For Annotative Objects, the Paper size is set manually or by the object 
Style. The current view Annotative Scale is set manually by selecting from a 
dropdown list on the Status Bar. The Model size is set automatically and is a 
product of the Paper Size and the current Annotative Scale (ie Model Text 
Height = Paper Text Height x Annotative Scale = 0.1250" x (40'/1") = 5.0000'

 4. Click 1IN_40FT - 4 Layout tab
 5. Verify Paper text height

 A. DIST
 I. enter

 B. SPECIFY FIRST POINT
 I. Left-click near bottom of S.T.H. 25 Mtext

 C. SPECIFY SECOND POINT
 I. Move cursor near top of S.T.H. 25 Mtext

 II. Observe tooltip displaying approx. 0.1250
 I. esc
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 6. Verify Model text height
 A. Double-click inside plan  Viewport
 B. Repeat steps 5.A - 5.C.I

 I. Observe tooltip displaying approx. 5.0000
 C. esc

 7. 1IN_200FT - 1
 8. Status Bar

 A. Show annotation objects = on

Turning "Show annotation objects" on allows all Annotative objects to be displayed 
regardless of whether they have the current view Annotative Scale added to their object 
Scales List or not. If objects do have the current view Annotative Scale added to their 
object Scales List, they will be scaled using the current view Annotative Scale. If not, they 
will be displayed  using the original Annotative Scale added to their scales list.

 B. Observe all Annotative Objects displayed in plan view Viewport
 9. Select one of the S.T.H. 25 Mtext objects

 A. Properties > Text 
 I. Observe Annotative scale = 1IN:40 FT

 B. Right-click menu > Annotative Object Scale > Add/Delete Scales
 I. Add

 a. 1 IN:200 FT
 b. OK

 II. OK
 10. Select S.T.H. 25 Mtext from step 9

 A. Properties > Text
 I. Observe Annotative scale = 1 IN:200 FT

 II. Observe multiple scale previews displayed
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 B. Use insertion grip to move Mtext
 I. Observe only the display of the 1IN:200 FT scaled Mtext is moved

Info: When an Annotative Object has multiple scales, you have dif-
ferent locations for the display of the object at each scale. Do this by 
setting the scale of the display you want to move as the current Annot-
ative Scale, then use the displayed Insertion Grip to move the object. 
The object will not be moved for the remaining object scales.

 II. esc

 11. Select 4TH AVE Mtext
 A. Right-click menu > Annotative Object Scale > Add Current Scale

 12. Select 4TH AVE Mtext
 A. Use insertion grip to move Mtext for readability

 13. Status Bar
 A. Show annotation objects = off
 B. Observe annotative objects lacking the current Annotation Scale in their object 

scales list no longer displayed

Use cases & scales list best practices
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Exercise files: acad-annotatv-scl-data-c3d16.zip

Continue with acad-annotatv-scl-01.dwg

acad-annotatv-scl-03.mp4 5:50

In this exercise, you will learn best practices for Annotative object management including how 
to use the Annotative Scaling Status Bar options, strategies for object Scales List management, 
how to clean up multiple insertion points for objects with multiple object scales.

 1. Continue working in acad-annotatv-scl-01.dwg
 2. Click Model tab
 3. Status bar

 A. Add scales to annotative objects when the annotation scale changes = on
 B. Note that the above Status bar option is commonly referred to as "Add scales auto-

matically" or similar

 4. Status bar > Annotation scale dropdown > 1 IN:200 FT
 A. Observe scaling of both AutoCAD Annotative objects and Civil 3D Labels

Info: When the "Add scales automatically" Status Bar option is turned on 
and you change the current view Annotative scale, the new Annotative scale 
will be automatically added to all Annotative object Scales lists in the draw-
ing.

Warning: If you find yourself switching the current view Annotative scale 
often, it is best to leave the "Add scales automatically" Status Bar option 
turned off. This will prevent you from adding extraneous object scales to 
Annotative objects unintentionally. You may not want all Annotative objects 
displayed at a given scale and thus should be more selective about adding 
Annotative Scales to object Scales lists. Additionally Civil 3D must read all 
object Scales for display generation and this can become a significant 
resource drain if the number of object scales is too great.

 5. Select one of the S.T.H. 25 Mtext objects
 A. Properties palette > Text

 I. Observe Annotative scale = 1 IN:200 FT
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 6. 1IN_200FT - 1
 A. Observe all Annotative objects now displayed at 1 IN:200 FT scale

 7. Model
 A. Status bar > Annotation scale dropdown > 1 IN:40 FT

 8. Select all Annotative Mtext objects
 A. Right-click menu > Annotative Object Scale > Add/Delete Scale

 I. List all scales for selected objects = checked
 II. 1 IN:200 FT

 a. Delete
 III. OK

 9. Status bar
 A.  Add scales automatically = off
 B. Current view Annotative Scale dropdown > 1 IN:200 FT

 10. Select 4TH AVE Mtext and S.T.H. 25 Mtext near 380+00
 A. Right-click menu > Annotative Object Scale > Add Current Scale

 11. Select the Mtext from step 10
 A. Relocate respective insertion points for readability
 B. esc
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 12. Select 4TH AVE Mtext
 A. Right-click menu > Annotative Object Scale > Synchronize multiple scale pos-

itions
Info: When running Synchronize multiple scale positions, the insertion point 
location used for synchronization is that associated with the current view 
Annotative Scale. Conveniently, this will be this insertion point whose Grip is 
displayed.

Text styles - fonts

Last updated: 2016-03-11

2016 fonts

Page: 253

Published on: 2/21/2018

Text styles - fonts



All of the custom DOT-fonts and DOT .shx font files are being retired as of the Civil 3D 2016 
release. WisDOT Civil 3D 2016 standard fonts are now all Windows True-Type fonts. 

The old fonts will be provided for legacy purposes during the transition from Civil 3D 2014 to 
Civil 3D 2016, but should not be used going forward.  The legacy text styles that use the DOT 
fonts are not included in the 2016 startup templates or sheet templates. The following is a list 
of the new 2016 Text Styles with corresponding fonts.

Style Name Font Name Font Style Annotative
ArialBlack Arial Black Regular Yes
ArialNarrow Arial Narrow Regular  Yes
ArialNarrowBold Arial Narrow Bold Bold  Yes
ArialRegular Arial Regular Regular Yes
CalibriLight Calibri Light Regular Yes
CalibriRegular Calibri Regular Yes
Legend Calibri Regular No
Standard Arial Regular No

Annotative text styles

The default for all but two of these Text Styles is Annotative. The text height is set to 0.00 in 
each style. The size of text should be addressed at the Civil 3D style level or annotation tool 
level and not at the Text Style level. This allows to leverage the civil annotation tools without 
the need for multiple styles with different sizes. To maintain typical WisDOT production stand-
ards it is unnecessary to develop any other Text Styles.

Legacy text styles & DOT fonts vs. Civil 3D 2016 text styles

The default for all but two of these Text Styles is Annotative. The text height is set to 0.00 in 
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each style. The size of text should be addressed at the Civil 3D style level or annotation tool 
level and not at the Text Style level. This allows to leverage the civil annotation tools without 
the need for multiple styles with different sizes. To maintain typical WisDOT production stand-
ards it is unnecessary to develop any other Text Styles.

Legacy 2016  Legacy 2016
C3D Text Style C3D  Text Style  DOT Font C3D  Text Style
080 CalibriLight  DOT_FONT_5 CalibriLight
100 CalibriLight  Dot_Font_10 CalibriLight
120 CalibriLight  dot_font15 ArialRegular
140 CalibriLight  dot_font20 CalibriLight
175 CalibriLight  dot_font25 TBD
200 CalibriLight  dot_font35 ArialBlack
350 CalibriLight  dot_font44 TBD
TPP_240 ArialRegular  dot_font45 ArialRegular
TPP_280 ArialRegular  dot_font49 TBD
TPP_400 ArialRegular  dot_font55 CalibriRegular
TPP_500 ArialRegular  dot_font125 TBD
TPP_525 ArialRegular    

Light drafting techniques

Last updated: 2017-06-06

Total video time: 5:31

Exercise files: acad-lit-drfting-data-C3D16.zip

acad-lit-drfting.mp4 5:31

Light drafting technique

 1. c3d > 12345678 > Design > AliProfs
 2. Open file AliProf-Sth-15-Alt3.dwg
 3. Scroll down to Data Shortcuts

 A. Right-Click on Data Shortcuts > Set Working Folder
 I. Set to folder 2 folders above shortcut folder

 a. c3d and OK
 B. Right-Click on Data Shortcuts > Set Data Shortcut Project Folder > choose pro-
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ject folder > 
 I. OK

 4. Data Shortcuts pull down > Surfaces > right-click on Exist > Create Reference
 A. OK

 5. Double Click on wheel mouse to Zoom.
 6. Data Shortcuts pull down > Alignments > centerline alignments > right-click on 15-

Alt1 > Create Reference

 A.  OK
 7. Left-Click on the surface > Modify panel > Surfaces Properties
 8.  A. Information tab > Surface style = EX Contours 5'Major:1'Minor

 B. OK.
 C. ESC

 9. Draw panel of the Ribbon > Polyline

 A. Starting from the left hand side and working to the right click a series of points. 
 B. Enter  

 10. Annotate tab of the Ribbon > Multiline Text
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 11. Left-Click to create a text box.
 12. Type in the box Passing lane 150' - widen 12'

 13. Left-Click to enter text box.
 14. Click on text and enter SC in the command line.
 15. Click on text and type in 10.
 16. Enter

Using Design Center to transfer layouts from one dwg file to another

Last updated: 2015-04-17

Using Design Center to transfer layouts from one dwg file to another 

Open Design Center

In the Design Center folder view, browse to the backup dwg file containing layouts, expand the 
backup file in folder view

Select layout category shown within file in Folder list
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Shift select to select all layouts in the backup file shown on the right side of Design Center. 
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Right-click on the selected layouts, choose Add Layout(s) from the right-click menu

Layouts are now in the updated dwg file, save and close.

Linetype best practices

Last updated: 2014-10-05

Linetype best practices

Linetype scaling on or off with XREFs needs to be a wholesale choice. Turning it off in a file only 
impacts the view in that file. So unless you're going to have linetype scaling turned off in all the 
files you're going to use, it's not helpful in getting the real world linetypes to display correctly. 
Leave MSLTSCALE on always.

While not necessary, it may be easiest to keep all real world linetypes in files separate from 
associative linetypes. I wouldn't do this on mapping files, but it may simplify things for pave-
ment marking and construction staging files.

Object linetype scaling needs to be identical for all of the real world linetypes that you intend to 
use together. The reason for this is the global effect of LTSCALE and not being able to dif-
ferentiate LTSCALE for different XREFs. For simplicity sake, I would recommend having the 
object linetype scaling being identical across a project. You could have it as something like 1 
inch: 1 ft to keep object linetype scale as 1 on all of the objects, but associative linetypes would 
look awful in modelspace. So I would recommend going with something like 1 inch: 100 ft and 
then for real-world linetype files, set CELTSCALE to 0.01 so that all objects you create inherent 
that LTSCALE.

It is possible to create sheets with the different scales than the default scale you choose with 
real world linetypes. To do so, XREF in the real world linetype files that you need and change 
the LTSCALE of the sheet file you're working in. For example, if you set your default scale to 1 
inch:100 ft and you want to create sheets at 1 inch: 50 ft, set the LTSCALE for the 1 inch: 50 ft. 
file to 0.5.

You cannot create a single file with layouts that have different scales and get real world line-
types to look correct in all the layouts. This is an okay workflow if you only have associative line-
types.

WisDOT linetypes

Last updated: 2014-10-05

This document will describe the changes to the WisDOT custom linetypes; the changes in the 
drawing template settings; and outline the workflows for both true size and annotation scales in 
the new template. Linetypes that are true size such as pavement markings and barrels will need 
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to be scaled using the objects properties. The rest of the linetypes such as easement lines and 
utilities will automatically adhere to the annotation scale in the layouts.

Linetype scale reference

There are three linetype settings to consider when setting up your drawings: LTSCALE, 
PSLTSCALE, & MSLTSCALE.

Linetype scale

LTSCALE controls the dash spacing and symbol size in linetypes. For WisDOT new linetypes the 
default scale factor will be set 1.00. A value larger than 1 will scale the linetype up and a value 
less than 1 will scale the linetype down. The Linetype scale is an absolute value and not relative 
value.

MSLTSCALE

Model Space Line Type Scaling only has two options ON or OFF. Setting MSLTSCALE to 1 (ON) is 
the default setting.

Setting MSLTSCALE to 1 (ON) will cause the Line type scale of any geometry in model space to 
be scaled by the Annotation scale. This allows you to have a preview of how the line type scale 
might look when seen through a scaled viewport.

MSLTSCALE Overrides LTSCALE in Modelspace, but it doesn’t effect Paperspace, so it won’t 
change how your geometry looks inside your viewports.

Using MSLTSCALE is a really good way of checking that your linetypes are going to look as you 
expect them to, without having to ‘Flick’ back and forth between Paperspace and Modelspace.

Setting MSLTSCALE to 0 (OFF) will cause the Linetypes displayed on the Model tab to be not 
scaled by the annotation scale.

PSLTSCALE

This variable controls the linetype scaling of geometry displayed in paper space viewports – 
Paper Space Line Type Scale.

This variable only has two settings. Setting PSLTSCALE to 0 (Off) will mean that the linetype 
scale factor of your modelspace geometry will not be effected by the scale of your viewport.

Setting PSLTSCALE to 1 (On) means that the line type scale of your modelspace geometry will 
be scaled to match the viewport scale.

If you use paper space layouts, turning paper space line type scaling on ensures that all your 
geometry will have the correct line type scale, no matter what the viewport scale is.

CELTSCALE
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Sets the current object linetype scaling factor. The linetype scaling for any new objects placed 
in the drawing file will be relative to the LTSCALE command setting. 

A line created with CELTSCALE = 2 in a drawing with LTSCALE set to 0.5 would appear the same 
as a line created with CELTSCALE = 1 in a drawing with LTSCALE = 1. The default value is set to 
1.

Working with existing files

If your drawing is nearing completion and linetypes are working with your project there should 
be no need to update your drawing from the new template. To determine if your drawing file 
has the old linetypes, type LTSCALE at the command line. If it is set to 0.005 then you are using 
the old template with the older linetypes.

Settings for previous templates

Prior to August 2013 all WisDOT drawing templates had the following settings.

LTSCALE = 0.005

CELTSCALE = 1.0

PSLTSCALE = 1

MSLTSCALE = 1

Importing older linetypes into older drawings

When you need to update your old drawing with compatible linetypes follow these steps.
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 1. In the command line type LINETYPE. The Linetype Manager dialog will appear.

 2. In the Linetype dialog click the Load button. The Load or Reload Linetypes dialog will 
appear.

 3. From the Load or Reload Linetypes dialog click the File button. The Select Linetype File 
dialog will appear.

 4. Path to C:\Program Files\Autodesk\AutoCAD Civil 3D 2012\Support\Linetypes and 
select the file wisdot-lt-pre-aug2013.lin click Open. The linetypes will be loaded into the 
Load or Reload Linetypes dialog.
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 5. Select the linetype(s) you wish to add and then click the OK button. The Linetypes – 
Reload Linetypes dialog will appear.

 l You can hold down Ctrl to select several linetypes

 l SHIFT to select a range of linetypes

 l Right click popup menu Select All
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 6. From the Linetypes – Reload Linetypes dialog select Reload all selected linetypes. The 
new linetypes will be added to the drawing file. 

 7. Click the OK button in the Linetype Manager dialog. The dialog will close.
 8. REGEN your drawing to see the change in scales.

Workflow for updating new linetypes into older drawings

If you have an old drawing and you can take advantage of updating your drawing with the new 
linetypes follow these steps.

 1. Prior to importing the linetypes verify the following variables are set. To read and set 
these, type the variable name at the command line.

 l LTSCALE = 1.0

 l CELTSCALE = 1.0

 l PSLTSCALE = 1

 l MSLTSCALE = 1

 2. If any object overrides are applied to your line work the following steps will not show the 
updated linetypes. Select all line work in the drawing file and verify ALL Linetype prop-
erties in the drawing file are set to ByLayer and the Linetype scale is set to 1. 

 3. In the command line type LINETYPE. The Linetype Manager dialog will appear.
 4. In the Linetype dialog click the Load button. The Load or Reload Linetypes dialog will 

appear.
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 5. From the Load or Reload Linetypes dialog click the File button. The Select Linetype File 
dialog will appear.

 6. Browse to the new linetype file
 l For Civil 3D 2012 path to C:\Program Files\Autodesk\AutoCAD Civil 3D 

2012\Support\Linetypes and select the file wisdot-lt.lin click Open. The linetypes 
will be loaded into the Load or Reload Linetypes dialog.

 l For Civil 3D 2014 path to C:\WisDOT\Stnd\c3d2014\Support\Linetype and 
select the file wisdot_2014.lin click Open. The linetypes will be loaded into the 
Load or Reload Linetypes dialog.

 7. Select All the linetypes and then click the OK button. The Linetypes – Reload Linetypes 
dialog will appear.

 l You can hold down Ctrl to select several linetypes
 l SHIFT to select a range of linetypes
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 l Right click popup menu Select All.

 8. From the Linetypes – Reload Linetypes dialog select Reload all selected linetypes. The 
new linetypes will be added to the drawing file and the old linetype definitions will be 
changed to match the new definitions. 

 9. Click the OK button in the Linetype Manager dialog. The dialog will close.
 10. Regen your drawing to see the change in scales.

Updating layers with new ByLayer symbology

The linetypes are now in the design file but the layer definitions need to be updated to reflect 
the new linetype names.

 1. From the ribbon Manage tab > CAD Standards panel > Layer Translator. The Layer 
Translator dialog will appear.
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 2. Pick the Load button from the Translate To section of the dialog.
 3. Change the Files of type to Drawing Template (*.dwt)
 4. Path to the WisDOT templates and select wisdot12.dwt or wisdot14.dwt depending on 

the version you are using, and click Open. The Layers will be loaded in the Translate To 
section of the dialog.
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 5. Click the Map Same button. The layers will be added to the Layer Translation Mappings 
section of the dialog.
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 6. Click the Translate button. An alert box will appear asking if you want to save the map-
ping information. Click Translate Only. The layers will be translated to the new layer 
scheme. 

 7. Verify the layers are correct by opening the Layer manager and checking a couple P_PM 
layers. For a complete listing of Layers that changed see Appendix A.
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 8. In the command line type PURGE. Purge all unused linetypes from the drawing file.
 9. Save the drawing file.

Workflow to update Xref files with old linetypes

If your file has an xref file using the old linetypes you will need to update the linetypes and the 
properties of the xref-dependent layers.

 1. Open each Xref design file that is attached to a host file and follow the workflow above 
named Workflow for Updating New Linetypes into Older Drawings.

 2. After each xref file is updated then open each Host file (the drawing file that is con-
suming the external referenced drawings).

 3. In the command line type VISRETAIN=0.

Info: Note: Setting Visretain to 0 will allow each xref to be reloaded and the layer 
table, as stored in the reference drawing (xref), will take precedence.

 4. Click View tab > Palettes panel > External References Palette
 l Command: XREF

 5. Select each xref to be reloaded and Right click. From the menu select Reload. The ref-
erence will be reloaded and the new layer properties will be updated.

 6. In the command line set VISRETAIN back to 1.
 7. Save the host file and Exit.

Working with the new template

After August 2013 all WisDOT drawing templates have the following settings.

LTSCALE = 1.0

CELTSCALE = 1.0

PSLTSCALE = 1

MSLTSCALE = 1

Workflows for true size linetypes

Objects using the True Size linetypes must be scaled by changing the linetype scale of the 
object.

 1. Select the objects whose linetype scale you want to change.
 2. Click Home tab > Palettes panel > Properties. 
 3. On the Properties palette, click the Linetype scale control.
 4. Change the linetype scale that you want to assign to the objects.

Layout scales = Linetype scale
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When LTSCALE is set to 1 use the equation (linetype scale = (1/Desired Scale) to determine the 
linetype scale.

Below is a list of common Linetype scale settings.

Viewport ScaleLinetype Scale

1IN:10FT = 0.10

1IN:20FT = 0.05

1IN:40FT = 0.025

1IN:50FT = 0.02

1IN:100FT = 0.01

1IN:200FT = 0.005

In a drawing that contains a vast majority of objects using the True size linetypes, it is a good 
practice to set MSLTSCALE to 0 (zero). MSLTSCALE sets whether the objects linetypes are affect 
by the annotation scale in the Model tab. 0 = Off and 1 = On. Setting MSLTSCALE off will display 
the objects linetypes as true size. The same way it will be displayed in the Layout viewport.

Annotative linetypes

To change the linetype of an object, to use the layout’s annotation scale.

 1. Verify that LTSCALE is set to 1, PSLSCALE is set to 1 and MSLTSCALE is set to 1.
 2. Select the objects whose linetype scale you want to use annotation scale.
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 3. Click Home tab > Palettes panel > Properties. 
 4. On the Properties palette, click the Linetype scale control.
 5. Change the linetype scale to 1.0.

WisDOT annotate tool

Last updated: 2016-03-09

Total video time: 02:37

acad-wisdot-anno-tl-01.mp4 02:37 - This video contains the training for this entire module.

Info: The WisDOT Annotate Tool is used to quickly set current a textstyle and text 
height. The tool can then be used to switch to the AutoCAD Annotate ribbon to 
place or edit text.

Ribbon location

The WisDOT Annotate Tool is located on the WisDOT Sheets ribbon, in the Sheet Utilities 
panel. Select Set Textstyle & Size to reveal the tool.

Using the tool

The tool launches a floating window.
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 l Select a textstyle from the dropdown
 l Select a text height from the dropdown
 l There is no Apply or OK button. The values are immediately set as the current textstyle 

and text height. 

The Mtext tool is located right next to the Set Textstyle & Size button on the WisDOT Sheets rib-
bon. If the WisDOT Annotate dialog is left open, then the Mtext tool will need to be pressed 
twice, even if the Mtext button on the Annotation ribbon is used.

The user is provided the option to select the Open Annotate Ribbon button to quickly switch to 
the Annotate ribbon. Note that the current textstyle and text height on the annotation ribbon 
has been set by the WisDOT Annotation tool.

Exiting the tool

The WisDOT Annotate Tool window can be left open and will not interfere with any other com-
mands. The window floats over the application area and can also be moved to another monitor. 
Pressing the Exit button will dismiss the window.
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Points

Civil 3D point basics

Last updated: 2017-06-06

Total video time: 04:21

Exercise files: pnt-basc-data-c3d16.zip

pnt-basc-01.mp4 4:21

Point basics

Three types of points in Civil 3D

 l AutoCAD Point aka "Node"  
 l COGO Point
 l Survey Point

Definitions

AutoCAD Point

 l Very basic traditional AutoCAD point object with limited attributes beyond Cartesian 
coordinates (XYZ)

 l Not used for most Civil 3D workflows
 l Limited selection of symbols using PTYPE System Variable. All points in drawing share 

same symbol.
 l Limited display control; only Layers

COGO Points

 l Smart object that contains many properties such as name, number, raw description, full 
description, coordinates, etc.

 l Typically used for proposed construction staking points, not existing survey data.
 l Appearance is controlled by Civil 3D Styles with Description Key Set.  Point Style for the 

symbol, Point Label Style for the text.
 l Text and symbol are one object, not separate entities.

Survey Points

 l Smart object that’s nearly identical to COGO points except it cannot be moved on the 
screen and is generated through a Survey Database

 l Typically created by importing existing topographic survey data
 l Uses Civil 3D Styles with Description Key Set in the same way as COGO Points
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 l Can be inserted into drawing from Survey Database  with survey Template
 l Should not typically be inserted in drawings other than by survey department

Point Groups

 l Used to control the display of points in mass, or to easily reference a group of points with 
a common characteristic.

 l Referenced points share a common property. For example, all Electrical Utility shots or 
all shots brought in from the same point file.

Description Key Set

 l A set of field codes, Styles, Layers, and other properties.
 l When a point is imported/created, Civil 3D checks to see if there is a code matching the 

Raw Description. If so, the point will take on the properties defined in the Description 
Key Set. Exception to this is when there is an overriding Point Group. This will be dis-
cussed in detail in later training.

Survey Databases

 l Stores and manages raw survey data, which is then inserted into a drawing
 l Works in conjunction with Equipment Database, Figure Prefix Database and Linework 

Code Set. These files are stored outside the drawing.
 l Primary toolset for Automatic Linework functionality

Accessing Civil 3D points

Last updated: 2017-06-06

Total video time: 03:39

Exercise files: pnt-basc-data-c3d16.zip

pnt-accss-01.mp4 3:39

Point Access

Civil 3D Points and related tools can be accessed through the Ribbon, Toolspace and  Model 
Space. Point properties can quickly be viewed through the Properties Palette

Ribbon

Access Point creation, conversion and modification tools through the Ribbon

Point creation and conversion

 1. Home tab > Create Ground Data panel > Points dropdown
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Point Contextual Ribbon Tools

 1. Modify tab > Ground Data panel > Points

Toolspace

Access Points and Point Groups through the Toolspace Prospector tab and Item View. When 
Points or Point Groups are selected in the Prospector tree, detailed information is displayed in 
Item View.

Points

 1. Toolspace palette > Prospector tab > Points
 A. Left-click > Points populates Item View
 B. Right-click > Points for contextual functions

Point Groups

 1. Toolspace palette > Prospector tab > Point Groups
 A. Left-click > Point Groups populates Item View
 B. Right-click > Point Group for contextual functions

 I. Properties to set hierarchy
 C. Expand Point Group list

 I. Right-click > Point Group name for contextual functions

Info: Right click a column heading in Item View to customize the data displayed. 
Left click a column heading to sort rows by selected column heading. Right click a 
row in Item View for contextual functions

Tips: Use familiar Ctrl-A, Shift-Select and Ctrl-Select macros then right click to 
apply contextual functions to a group of objects in Item View

Modelspace

Directly selecting a COGO or Survey Point  in Modelspace opens the respective Contextual Rib-
bon. Once selected you can right-click for contextual functions. A Contextual Ribbon is not avail-
able when multiple Survey Points are selected.

Properties Palette

Regardless of how you select a Point or multiple Points, you can see detailed information and 
make limited modifications in the Properties Palette. Properties shown in grey tone are not 
available for edit within the Properties Palette, such as with Survey Points. 

Warnings: Modifying properties within the Properties Palette sets object level 
overrides to properties that can be difficult to track and thus are often best set else-
where. For example, a Point Style, Point Label Style and Layer is best dictated by 
a Description Key Set and Point Raw Description.
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Point groups and styles

Last updated: 2017-06-06

Total video time: 07:45

Exercise files: pnt-grp-styl-data-c3d16.zip

pnt-grp-styl-01.mp4 3:00

pnt-grp-styl-02.mp4 4:45

Point groups and styles

Point display is largely set by the Point Style, Point Label Style and Layer properties assigned to 
a Point. These properties can be controlled on an object level during Point creation by assigning 
a Raw Description code referencing a Description Key Set stored in the current drawing. 

Point Groups can also be created and set to filter which Points are displayed and apply over-
rides to properties set by a Description Key Set. 

Point Tables can be generated from any drawing containing Points for display in the drawing or 
export to other file formats. By default, Point tables update dynamically with changes to 
included Point properties.

Info: When Point Styles or Point Label Styles are not dictated by a Description 
Key Set, Civil 3D looks to applicable Point Groups for Point Style and Point Label 
Style application. One example of this is when a Point Raw Description does not 
match the Description Key Set or when an individual Point Style is not defined in 
the Description Key Set.

Definitions

Point Style  

Marker used to display the Point. These are defined by AutoCAD Blocks, or other basic symbols. 

Point Label Style 

Controls the display and arrangement of text properties associated with a Point. 

Layer

Controls display and plot behavior of Points set to display By Layer

Raw Description

Code referencing a Description Key Set to assign display properties to a Point
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Description Key Set

An applicable Description Key Set will be set up and included in a template to set Point display 
properties upon Point creation. It defines the Point Style, Point Label Style, Layer and other prop-
erties given to a Point based on a matching Raw Description Code. A Description Key Set is only 
available if it has been built in the template used to start a drawing.

Point Group

Points in a drawing are queried based on assigned Point properties (ie Raw Description, Full 
Description, Point Number, Point Name, Elevation) . Point Groups are used to filter the display 
and plotting of Points in a drawing based on a point group hierarchy. They can also assign Point 
Styles and Point Label Styles when they are not dictated by a Description Key Set or when Point 
Group overrides are set.

Point creation tools

Last updated: 2017-06-06

Total video time: 04:06

Exercise files: pnt-creat-tl-data-c3d16.zip

pnt-creat-tl-01.mp4 4:06

Point Creation Tools

Many tools are available to specify location and/or elevation while manually creating COGO 
Points in your drawing. The various tools available can reference objects such as existing Points, 
Alignments, Surfaces, Corridors, Lines/Polylines/Arcs, Parcels, etc. You can use typical surveying 
techniques such as referencing a bearing or azimuth angle, lattitude/longitude or northing/east-
ing for example as well. There is a great deal of flexibility and functionality built into these 
tools that warrants exploration.

Manual Point Creation Tools

All manual Point creation tools will generate a COGO Point as specified through unique com-
mand prompts for each respective tool. The differences between the tools lie in the techniques 
used to specify Point coordinates. Two ways to access point tools:

 1. Ribbon > Home tab > Create Ground Data > Points dropdown > Point Creation Tools
 A. Create Points toolbar> Point command category dropdown > Point command

 1. Ribbon > Home tab > Create Ground Data > Points dropdown > Create Point - 
******** flyout

 A. Choose Point command
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Tip: Hover over a Point command category or Point command for a quick brief 
description of the tool. This is a quick way to determine the appropriate coordinate 
specification technique for your situation

Commands Categories Available

 l Miscellaneous - Coordinates specified using a variety of techniques including reference 
to line, polyline, survey resection etc. Conversion from AutoCAD Points also available.

 l Intersection - Distance and/or direction from existing Points or objects (ie line, arc) used 
to specify intersection coordinates.

 l Alignment - Coordinates specified based on reference to alignment such as Sta-
tion/Offset.

 l Surface - Various horizontal coordinate specification with elevation pulled from specified 
Surface at Point location.

 l Interpolate - Coordinates interpolated from two known Points or object locations.
 l Slope - Coordinate specifed by distance or vertical displacement at given slope from a 

know Point.

Tip: Transparent commands can be used within Point Creation commands while 
specifying coordinates. These will be discussed in detail in a later training module.

Importing points from a file

Last updated: 2017-06-06

Total video time: 04:08

Exercise files: pnt-imprt-frm-fil-data-c3d16.zip

pnt-imprt-frm-fil-01.mp4 4:08

Import Points From File

Point data can be transferred between applications and/or organizations by exporting and 
importing Point Files. Point files are simple text files that Civil 3D can read and use to generate 
COGO points.  

Display of imported Points is controlled by a Description Key Set and/or Point Group in the same 
way as with other Point creation methods.

Info: Various file extensions can be given to Point Files depending on the applic-
ation used to export/generate the Point File.
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Warning: Design staff should NOT import survey data point files into design draw-
ings. Contact your Survey Data Coordinator for survey data workflows

Point Import Workflow

 1. Open drawing from the WisDOT Survey Template
 A. Application dropdown > New > wisdot16-survey.dwt
 B. Save drawing

 2. Import Point File
 A. Ribbon > Insert tab > Import panel > Points from File

 I. Browse to file
 II. Select correct File Format (ie. PNEZD - Point Number, Northing, Easting, 

Elevation, Description)
 III. Toggle Add Points to Point Group On/Off
 IV. OK

Editing points

Last updated: 2017-06-06

Total video time: 4:42

Exercise files: pnt-edit-data-c3d16.zip

pnt-edit-01.mp4 4:42

Editing Points

After creating or inserting Points into your drawing, you may need to edit location or attribute 
data. Point editing tools are available when selecting a Point in modelspace, through Toolspace 
Prospector and through the Contextual Ribbon. 

COGO Points and Survey Points exhibit different editing behavior. When inserted into a drawing 
from a Survey Database, Survey Points are locked and thus cannot be edited beyond simple 
label movement and display changes. Contact your Survey Data Coordinator for workflows deal-
ing with Survey Points. COGO Points are unlocked and available for edit by default. They can be 
locked/unlocked within a drawing as needed.

Modelspace

Select a COGO Point directly in your Modelspace canvas to activate grip editing functions. 
Hover over the Marker Grip or Label Grip to see a menu of respective movement and rotation 
edit functions.
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Marker Grip Edit

 l Move Point - Reset Point location with mouse or applicable Transparent Commands 
(covered in later training module)

 l Rotate label and marker - Rotate marker and label about horizontal Point location. 
Label remains readable by flipping vertically as needed.

 l Rotate marker - Rotate marker only about horizontal Point location.

Label Grip Edit

 l Move label - Reset location with mouse or applicable Transparent Commands (covered 
in later training module)

 l Rotate label  - Rotate label only about horizontal Point location. Label remains readable 
by flipping vertically as needed.

 l Toggle sub-item grips- Activate additional grips to move label rows independently.

Tips: Options to reset label or reset all (marker rotation and label) are available 
after applicable edits are performed. Point (marker) location cannot be reset this 
way.

Toolspace Prospector

Open the Point Editor Panorama through the right-click contextual menu. Choose specific Points 
for inclusion in the Panorama by Point Group or selection from the Item View pane. 

COGO Points can be renumbered, locked/unlocked for edit and/or have elevations edited based 
on row selection within the Point Editor Panorama. 

When Points are unlocked, attribute overrides can be directly entered into cells within the Pan-
orama as well.

Renumber Points

 1. Toolspace > Prospector tab > Right-click  Points or Point Group Name or selection 
from Item View

 A. Select row(s) from Panorama
 I. Right-click > Renumber

 II. ENTER ADDITIVE FACTOR (Overwrite or Next option if specified num-
ber already in use)

Change Elevations by Factor

 1. Toolspace > Prospector tab > Right  Points or Point Group Name or selection from 
Item View

 A. Select row(s) from Panorama
 I. Right-click > Datum

 II. ENTER CHANGE IN ELEVATION (or use Reference option)
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Assign Elevations from Surface

 1. Toolspace > Prospector tab > Right  Points or Point Group Name or selection from 
Item View

 A. Select row(s) from Panorama
 I. Right-click > Elevation From Surface

 a. Select Surface dialog box > Surface dropdown > Surface Name
 b. OK

Info: Most Point editing functions are available through Modelspace right click 
menu and Contextual Ribbon upon selection as an alternative to the Point Editor 
Panorama

Transparent commands for points

Last updated: 2017-06-06

Total video time: 04:38

Exercise files: pnt-trnsprnt-cmnd-data-c3d16.zip

pnt-trnsprnt-cmnd-01.mp4 4:38

Transparent Commands

Transparent Commands are tools available to aid in specifying location when prompted within 
another command. They can only be used once another command is started (ie start Polyline 
command, then start Transparent command of choice to specify vertex coordinates). A Trans-
parent Commands toolbar is available from which to chose commands. Alternatively, you can 
enter the command alias into the command line.

Reference Existing Points

There are a variety of Transparent Commands available for use in Civil 3D, some of which ref-
erence existing Point coordinates when prompted for a location within a command. These can 
be useful for preliminary Alignment layout or whenever you would like to reference existing 
Point locations to build an Entity. 

Transparent Command Aliases

Enter one of these options to use known Point coordinates when prompted for a location within 
a command

 l Point Number: 'PN - Specify Point Numbers individually, by range, by list or by a com-
bination of these (ie 1 or 1-3 or 1,2,3 or 1-3,5). Point Numbers called out need not be con-
secutive or sequential.
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 l Point Name: 'PA - Specify Points Name sequentially
 l Point Object: 'PO - Select desired Points in Modelspace sequentially

Transparent Commands Toolbar

Pick  from the Transparent Commands Toolbar. If it is not visible in your interface:

 1. Ribbon > View tab > Interface panel > Toolbars dropdown > Civil > Transparent Com-
mands

Best Fit Alignment Example Workflow

This example workflow uses COGO Points and the Point Number Transparent Command in Pnt-
Trnsprnt-Cmnd-begin.dwg to generate a preliminary Alignment.

 1. Ribbon > Home tab > Create Design panel > Alignment dropdown > Create Best Fit 
Alignment

 A. Within Create Best Fit Alignment dialog box click object selection icon  next to 
Path 1 point group

 I. Select Point Number icon  from Transparent Commands Toolbar or 
enter 'PN in the command line

 II. Enter Point Number range 1-11
 III.  Esc once to end Transparent Command
 IV. Enter or Right-click to end object selection

 B. Leave all other Create Best Fit Alignment dialog box options as default 
 C.  OK  
 D. Review Best Fit Report and close dialog box

Points from Alignment

Last updated: 2017-06-06

Total video time: 6:00

Points from Alignment

Exercise files: pnt-frm-ali-data-c3d16.zip

pnt-frm-ali-01.mp4 6:00

COGO Points can be created with horizontal location, elevation and description data generated 
automatically from a specified Alignment and Profile within a drawing. Point data can then be 
exported to a number of file formats (ie CSV) and uploaded to a survey data collector in pre-
paration for staking work.
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Info: Civil 3D Alignments and Profiles can also be uploaded directly to a survey 
data collector in preparation for staking work.

Points from Alignment

Create Points from Alignment

In the following workflow you will create typical COGO Points for staking including those at 
even stationing, horizontal geometry points and profile geometry points. You will then edit 
COGO Points with elevation 0.000' to pull elevation data from a surface and export Point data 
to a CSV file.

Create Points

 1. Ribbon > Home tab > Create Ground Data panel > Points dropdown > Point Creation 
Tools

 A. Expand settings chevron  
 B. Expand Points Creation

 I. Prompt For Elevations = Automatic
 II. Prompt For Descriptions = Automatic - Object 

 

 C. Collapse settings chevron
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 D. Create Points - Alignment dropdown > Measure Alignment
 I. Pick Alignment 25

 II. Select Profile 25-Prop from dropdown
 III. OK
 IV. Enter for default Starting Station
 V. Enter for default Ending Station

 VI. Enter for default Offset
 VII. SPECIFY INTERVAL: 50Enter

 E. Create Points - Alignment dropdown > At Geometry Points
 I. Pick Alignment 25

 II. Select Profile 25-Prop from dropdown
 III. OK
 IV. Enter for default Starting Station
 V. Enter for default Ending Station

 F. Create Points - Alignment dropdown > Profile Geometry Points
 I. Pick Alignment 25

 II. Select Profile 25-Prop from dropdown
 III. OK
 IV. Enter for default Starting Station
 V. Enter for default Ending Station

Edit Points

 Toolspace > Prospector tab > Right Click Points > Edit Points
 1. Click Point Elevation column header to sort numerically
 2. Shift-select all 0.000' elevation fields
 3. Right-click > Elevations from Surface...

 A. Choose Exist Surface from dropdown
 4. Close Point Editing Panorama

Export Points to File

 Ribbon > Output tab > Export Points
 1. Format =  PNEZD (comma delimited)
 2. Browse to Destination File path desired
 3. Save as 25 Align.csv
 4. Open with text editor or Microsoft Excel to view/sort/etc as needed
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Surfaces

Accessing Civil 3D surfaces

Last updated: 2017-06-06

Total video time: 4:52

Exercise files: srfc-accs-data-c3d16.zip

Start with 12345678\Design\Surfaces\srfc-accs.dwg

srfc-accs.mp4 4:52

Accessing Civil 3D surfaces

Surfaces and many of the editing and analysis tools available for working with them can be 
access via the Standard Ribbon, Toolspace Prospector and Modelspace.

Standard ribbon

Surface creation tools can be found on the Standard Ribbon. You can either create an empty Sur-
face and proceed to add data or Create a Surface from existing data (ie from external DEM file 
or Point Cloud within current drawing). Most of these tools will generate a TIN Surface
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 1. Ribbon > Create Data panel > Surfaces dropdown > Create Surface or Create Surface 
from ****

Toolspace prospector

Several Surface creation, export and editing options are available through Right-Click menus at 
various levels of Prospector tree expansion.
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 1. Toolspace palette > Prospector tab > Right-click Surfaces
 A. Access to:

 l Create Surface
 l Create Surface from DEM
 l Create Surface from TIN
 l Export to DEM
 l Export LandXML

 1. Toolspace palette > Prospector tab > expand Surfaces > right click Exist
 A. Access to:

 l Surface Properties
 l Edit Surface Style
 l Rebuild tools
 l Snapshot tools
 l Add Label (ie Contour, Slope, Spot/Grid Elevations)
 l Export tools

 1. Toolspace palette > Prospector tab > expand Surfaces > expand Exist > expand Defin-
ition

 A. Access to:
 l Masks
 l Watersheds
 l Add Surface definition:

 l Boundaries
 l Breaklines
 l Countours
 l DEM files
 l Drawing Objects
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 l Edits
 l Point Files
 l Point Groups
 l Point Survey Queries
 l Figure Survey Queries

 1. Toolspace palette > Prospector tab > expand Surfaces > expand Exist > expand Defin-
ition> right-click Edits

 A. Access to Surface editing tools:
 l Line editing
 l Point editing
 l Minimize Flat Areas (based on tolerance inputs)
 l Raise/Lower Surface
 l Smooth Surface (adds data)
 l Paste Surface (make composite surface by pasting existing Surfaces 

"pieces" into one)
 l Simplify Surface (removes data)
 l Add Label (ie Contour, Slope, Spot/Grid Elevations)

Modelspace

Select a Surface in Modelspace to activate the Surface Contextual Ribbon. The properties 
palette will now be populated with Surface object data. In Modelspace, the right-click menu 
also provides access to Surface Properties and Edit Surface Style options.
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Contextual ribbon

 1. Select Surface
 2.  Contextual Ribbon > Labels & Tables tab

 A. Access to:
 l Add Surface Labels - spot/grid elevations, slopes, contours
 l Add Legends - these may correspond with a Surface style and analysis. For 

example Elevation ranges displayed in a range of solid colors.
 3. Contextual Ribbon > General Tools tab

 A. Access to:
 l Inquiry - determine coordinates at a specified point or coordinates for and 

slope between two specified points on a Surface.
 l Object Viewer - rotate to isometric view of Surface

 4. Contextual Ribbon > Modify tab
 A. Access to:

 l Surface Properties - change Style, Name, manipulate Definition Operations, 
perform analyses

 l Add Data - Boundaries, Breaklines
 l Edit Surface tools
 l Surface tools - Drape Image, Extract From Surface, Move to Surface
 l Launch Pad

 5. Contextual Ribbon > Analyze tab
 A. Access to:

 l Water Drop - create 2D or 3D Polyline along downhill slope of TIN triangles 
until a low point is found

 l Resolve Crossing Breaklines
 l Visibility Check - check for visibility of a location or in all directions by spe-

cifying height of eye at a location
 l Catchment Area - creates catchment area from Surface for TR-55 time of 

concentration hydrology analysis
 l Volumes Dashboard - create Volume Surface and generate cut/fill reports
 l Stage Storage - generate stage-storage volume report (conic or average 

end area)
 6. Contextual Ribbon > Surface Tools tab

 A. Access to:
 l Drape Image
 l Extract/ Move to Surface

 7. Contextual Ribbon > Launch Pad tab
 A. Access to:

 l Quick Profile - temporary profile view of Surface lying beneath line, poly-
line, arc, parcel segment or feature line (Quick Profile view and data not 
saved with drawing)
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 l Data Shortcut
 l Create Profile - create Profile object with surface elevation data Surface
 l Grading Creation Tools

Surface styles

Last updated: 2017-01-10

Total video time: 4:12

Exercise files: srfc-styl-data-c3d16.zip

Start with 12345678\Design\Surfaces\srfc-styl-begin.dwg

srfc-styl.mp4 4:12

Surface styles

Surface Styles control the display of a Surface. Certain display features are only available with 
some styles. For instance, a style with Contours turned on is necessary to display Contour 
Labels. Further, certain styles will correspond with Surface Legend Tables and associated Sur-
face analysis. Surface analysis will be discussed in detail in a later training module. Styles 
included with the template chosen can be accessed through Toolspace Settings, the Surface Con-
textual Ribbon or Surface Properties.

Change surface style

Use the following workflow to set the Surface Style after Surface is created. An initial Surface 
Style is specified in the Surface creation dialog.

 1. Select Surface from Modelspace or Toolspace Prospector > Right-Click menu > Sur-
face Properties > Information tab

 A. Select Surface Style from dropdown menu
 B. Edit Surface Style  to view Surface Style definition
 C.  OK  
 D.  OK

Review surface style definition

Open the Surface Style dialog box to review how a Surface Style is defined. This can be opened 
as described above or through Toolspace Settings.
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 1. Toolspace palette > Settings tab > expand Surface > expand Surface Style > Right-
click on Surface Style Name > Edit

 A. Display tab > View Direction dropdown > Select Plan, Model, or Section
 B. Review respective Display definition 
 C. OK  
 D.  OK  

Warning: Surface Styles should be used as built in the WisDOT template and not 
edited. This helps to maintain standardization.

Surface basics

Last updated: 2017-01-10

Total video time: 5:14

srfc-basc.mp4 5:14

Surface basics
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What is a Civil 3D surface

A Civil 3D Surface is a dynamic object representing elevation. One and only one elevation (Z) is 
assigned for a given location (X,Y) within the extents of the data used. A Surface representing 
existing conditions is typically built using topographical data gathered from Survey Points, Auto-
matic Linework and/or Figures combined with LiDAR from an online data clearinghouse. A Sur-
face representing proposed design is typically built from Civil 3D design objects such as 
Corridors, Grading Objects, and Feature Lines. A Surface can either be built as a TIN  or Grid.

 l Dynamic object representing elevation
 l Only one Z per X,Y
 l Existing Surface from Survey Linework, Figures, Points and LiDAR
 l Design Surface from Corridor, Grading, Feature Lines

TIN surface

A TIN (Triangulated Irregular Network) Surface consists of a series of points and edges forming 
a series of interconnected triangles. Each point has unique elevation and location. Nearly all Sur-
faces you will encounter in design will be TIN Surfaces.
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Grid surface

A Grid Surface consists of a series of adjacent equally sized grid squares, each with a unique 
elevation and central location. A Grid Surface is built based on a Digital Elevation Model (DEM) 
file available from an online data clearinghouse. Supported DEM file types are: 

 l ESRI Binary Grid (.adf)
 l USGS DEM (.dem)
 l GEOTIFF (.tif)
 l ESRI ASCII Grid (.asc)
 l ESRI ASCII Grid (.txt)

Boundary vs border

A Surface Border is automatically created based on the outer edge or TIN lines defined by the 
data used to build the Surface.

A Surface Boundary is data manually added by the user to specify limits. A Surface Boundary 
can be defined by a closed polygon such as closed Polyline or Parcel. Surface Boundary types 
are:

 l Data - sets limits for data calculation
 l Outer - sets outer display limits
 l Hide - hide area inside Surface
 l Show - show are inside a Hide Boundary
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Breakline

A Breakline is added to a Surface to force new elevation data along the object used to define 
the Breakline. Objects that can be added to a Surface as a Breakline are 3D Lines/Polylines and 
Feature Lines as well as Survey Linework and Survey Figues.

Volume surfaces

A Volume Surface is actually a comparison of two Surfaces already in the drawing. These can 
then be used to automatically calculate cut and fill volumes.

Surface properties - General

Last updated: 2017-06-06

Total video time: 3:00
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Surface properties - General

The Surface Properties dialog box is split into four tabs: Information, Definition, Analysis and 
Statistics. This training module will focus on the Information and Statistics tabs.

 1. Modelspace > Select Exist Surface > Right-click menu or Contextual Ribbon > Surface 
Properties

 1. Statistics or Information tab

or

 1. Toolspace palette > Prospector tab > Expand Surfaces > Right-click Exist  >  Surface 
Properties

 A. Statistics or Information tab

Statistics tab

The Statistics tab is used to view statistical information about the Surface. This may be helpful 
to get a general idea of what makes up your Surface. Within the Statistics tab are General, 
Extended, and TIN listings.

General

Expand the General listing for statistics on Points, Coordinates, and Elevation
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Extended

Expand the Extended listing for statistics on Surface area and Minimum/ Max-
imum/ Mean slope

TIN

Expand the TIN listing for statistics on the Quantity of and Minimum/ Maximum 
area/ length of the triangles making up the Triangulated Irregular Network

Information tab

Within the Information tab you can:

 l Rename the Surface
 l Add a Description to the Surface
 l Select a Surface Style
 l Preview or View Display properties of available Surface Styles
 l Apply Render Material 
 l Lock/Unlock Surface object for editing
 l Turn Tooltips On/Off

Tip: Turning Tooltips off can help remedy performance/ processing speed issues

Warning: Renaming a Surface after a Data Shortcut has been created from it can 
cause problems that may propagate to drawings with a Data Reference of the Sur-
face. Repathing or recreating Data Shortcuts and Data References may be 
required. 

Surface properties - Definition

Last updated: 2017-01-10

Total video time: 5:05
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Exercise files: srfc-prprtis-def-data-c3d16.zip

Start with 12345678\Design\Surfaces\srfc-prprtis-def.dwg

srfc-prprtis-def.mp4 5:05

Surface Ppoperties - Definition

The Definition tab of the Surface Properties window provides access to the Definition Options 
table and the Operation Type table. Use the Definition Options table to view or change Surface 
definition settings. Use the Operation Type table to work with existing Surface operations.

Definition options

Expand Edit operations  to toggle on/off (Use? Yes/No) all existing and future instances of any 
specific Edit Surface operation for the selected Surface.

Expand Data operations to toggle on/off (Use? Yes/No) all existing and future instances of any 
specific Add Data operation for the selected Surface.

Expand Build to toggle on/off (Yes/No) and set values for unique Surface building operations. 
This training module examines Use Maximum Triangle Length and Allow Crossing Breaklines 
specifically.
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Use maximum triangle length

Setting this Definition Option to Yes allows you to limit the length of the longest 
side edge of any given TIN triangle. This technique is used to eliminate long "sliver" 
triangles that add data without much affect on the Surface definition or shape. Elim-
inating them can improve drawing performance.

 1. Modelspace > Select Exist Surface > Right-click menu or Contextual Rib-
bon > Surface Properties

 1. Definition tab > Expand Build
 2. Use Maximum Triangle Length =  Yes
 3. Maxium Triangle Length =  50
 4. Apply

 2. Dialog box > Rebuild the surface
 3. Observe "holes" in Surface
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Warning: Setting the Maximum Triangle Length value too low can cre-
ate "holes" or interior boundaries in your Surface. The appropriate 
value may vary by Surface depending on the data used to build.

Allow crossing breaklines

Crossing Breaklines should be avoided when adding data such as Feature lines or 
Grading Objects to a Surface. An example of where you not be able to avoid cross-
ing Breaklines is when Automatic Linework is generated along roadway centerline 
Survey Points when importing data to a Survey Database. When working with such 
a Surface, you will need to decide if Crossing Breaklines will be allowed. 

Remeber, only one elevation (Z) is allowed at any given horizontal location (X,Y) for 
a Surface. If a Surface has Crossing Breaklines with different elevation at their inter-
section, there are two elevations at the same horizontal location. You must specify 
how to assign the elevation at this point. 

Set to "No"

If the Allow Crossing Breaklines value is set to No, only one of the crossing Break-
lines  is used and the other is not added to the Surface.

Set to "Yes"

When the Allow Crossing Breaklines value is set to Yes, you must further specify 
how to assign the elevation at the crossing Breakline intersection:

 l Use first breakline elevation at intersection - the elevation from the first 
crossing breakline listed under Operation Type is used

 l Use last breakline elevation at intersection - the elevation from the last 
crossing breakline listed under Operation Type is used

 l Use average breakline elevation at intersection - this option should not be 
used since it requires extra data processing and may cause performance 
problems or crashing.

 1. Modelspace > Select Exist Surface > Right-click menu or Contextual Rib-
bon > Surface Properties

 1. Definition tab > Expand Build
 1. Allow crossing breaklines = No
 2. Under Operation Type, Add breakline = checked
 3. Apply

 2. Dialog box > Rebuild the surface
 3. Observe Events notification indicating one breakline was not added
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 4. Surface Properties Definition tab 
 1. Allow crossing breaklines = Yes
 2. Elevations to use = Use first breakline elevation at inter-

section
 3. Apply

 5. Dialog box > Rebuild the surface
 6. Observe Events notification indicating the remaining breakline was 

added

Operation type

All of the Surface Operations (ie Add Data, Edit Surface, Snapshots) currently used to build the 
Surface are listed in this table. Where all instances of a given Add Data or Edit Surface oper-
ation can be toggled in the Definition Options table, individual Surface building operations can 
be toggled on/off or reordered in the Operation Type table. The order of Surface Operations 
can and often will affect the end result of how a surface is built.

 1. Modelspace > Select Exist Surface > Right-click menu or Contextual Ribbon > Surface 
Properties

 1. Click Definition tab
 2. Select an Operation Type

 3. Reorder build operation with up/down arrow buttons (ie )
 4. Apply

 1. Dialog box > Rebuild the surface
 2. Observe effect of Operation Type reordering

Tip: Be cautious and observe individual changes whenever Surface operations are 
toggled on/off or reordered in the Operation Type table.

Surface breaklines

Last updated: 2017-06-06

Total video time: 6:22

Exercise files: srfc-brklin-data-c3d16.zip

Start with 12345678\Design\Surfaces\srfc-brklin.dwg

srfc-brklin.mp4 6:22

Surface breaklines

Adding a Breakline to a Surface forces new elevation and location along the object used as a 
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Breakline. Polylines, 3D Polylines and Feature lines as well as Survey Linework and Survey Fig-
ures can all be added to a Surface as Breaklines. New triangulation is forced for TIN triangles 
adjacent to any Breakline added. When adding a breakline you must specify the type of Break-
line to add. You can choose from Standard, Proximity, Wall, Non-destructive and From File. 

Standard

New TIN lines and verticies are forced along the Breakline object. All elevation and location 
data is pulled directly from the Breakline object.

 1. Toolspace Prospector > Expand Surfaces > Expand Exist > Expand Definition > Right-
Click Breaklines > Add

 A. Add Breaklines dialog > Type dropdown > Standard
 B. OK

 2. Select polyline
 3. Right-Click

Proximity

Elevation data is pulled from the existing TIN vertex closest to any given Breakline vertex. Adja-
cent triangulation is updated acordingly.

 1. Toolspace Prospector > Expand Surfaces > Expand Exist > Expand Definition > Right-
Click Breaklines > Add

 A. Add Breaklines dialog > Type dropdown > Proximity
 B. OK

 2. Select polyline
 3. Right-Click

Wall

An offset side of and vertical displacement from the Breakline is specified. The effect is a near-
vertical wall in a Surface. 

 1. Toolspace Prospector > Expand Surfaces > Expand Exist > Expand Definition > Right-
Click Breaklines > Add

 A. Add Breaklines dialog > Type dropdown > Wall
 B. OK

 2. Select polyline
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 3. Specify offset side by clicking
 4. Enter option for wall heights - ALL
 5. Enter
 6. Enter elevation difference for offset points - 1
 7. Enter

Info: A minimum offset (0.0001 drawing unit) is necessary to maintain unique Sur-
face elevation (Z) values for every location (X,Y). Specifying All applies the vertical 
displacement to all Breakline verticies

Non-destructive

New Verticies and TIN lines are created along the Breakline, but Surface elevations remain 
unchanged.

 1. Toolspace Prospector > Expand Surfaces > Expand Exist > Expand Definition > Right-
Click Breaklines > Add

 A. Add Breaklines dialog > Type dropdown > Non-destructive
 B. OK

 2. Select polyline
 3. Enter

From file

This option imports Breakline data from an FLT file. You can choose to either maintain a 
dynamic link to the FLT file or break the link and write the data directly to the Surface definition 
in the drawing.
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 1. Open srfc-brklin-flt-begin.dwg
 2. Toolspace Prospector > Expand Surfaces > Expand From File flt > Expand Definition > 

Right-Click Breaklines > Add
 A. Add Breaklines dialog > Type dropdown > From File
 B. Add Breaklines dialog > File link options dropdown > Break link to file

 I. Import Breakline File dialog
 II. Browse to EXIST.flt

 III. Open
 IV. Dismiss Events Panorama

Surface creation

Last updated: 2017-06-06

Total video time: 5:47

Exercise files: srfc-creat-data-c3d16.zip

Start with 12345678\Design\srfc-creat-begin.dwg
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srfc-creat.mp4 5:47

Surface creation

There are many approaches to Surface creation both from a Survey standpoint dealing with 
existing conditions and from a Design standpoint using dynamic Civil 3D tools. In either case, a 
Surface can either be created first with data then added afterword or created with available 
Surface definition data specified at the time of creation. Typically, existing conditon Surfaces 
are created from topo Survey data (Survey Points, Linework and Figures) and proposed design 
Surfaces are created largely from Corridors and Grading Object Featurelines. The workflow 
shown in this training module involves creating a Surface with no definition and subsequently 
adding data. Specifically, an external point file (.pnt) and external breakline file (.flt) will be 
used to add Surface definition data after creation.

Create surface

 1. Ribbon > Home tab > Create Ground Data panel > Surfaces dropdown > Create Sur-
face
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 A. Create Surface dialog: Layer
 I. Object Layer dialog:  Layer

 a. Layer = E_SURF
 b. OK

 II. Name = Existing
 III. Style Ellipses

 a. Select Surface Style dialog
 b. EX Contours 10' Major: 2' Minor
 c. OK

Add data

 1. Toolspace > Prospector tab > Expand Surfaces > Expand Definition > Right-click Point 
Files > Add

 A. Add Point File dialog
 I. Browse to EXIST.pnt

 II. Open
 B. Point file format = PENZ (space delimited)
 C. OK

 2. Zoom Extents
 3. Toolspace Prospector > Expand Surfaces > Expand From File flt > Expand Definition > 

Right-Click Breaklines > Add
 A. Add Breaklines dialog > Type dropdown > From File
 B. Add Breaklines dialog > File link options dropdown > Break link to file

 I. Import Breakline File dialog
 II. Browse to EXIST.flt

 III. Open
 IV. Dismiss Events Panorama

Surface boundaries

Last updated: 2017-01-12

Total video time: 8:59

Surface boundaries - Data clip & outer

Exercise files: srfc-bndry-data-c3d16.zip

Start with 12345678\Design\Surfaces\srfc-bndry-begin.dwg

srfc-bndry-01.mp4 4:24

Surface Boundaries can be added to any Surface to set data processing and/or display limits. 
There are four available Surface Boundary types: Data Clip, Outer, Hide and Show. For all types 

Page: 306

Published on: 2/21/2018

Surface boundaries

http://www.c3dkb.dot.wi.gov/data/srfc/srfc-bndry-data-c3d16.zip
http://www.c3dkb.dot.wi.gov/video/srfc/srfc-bndry-01.mp4


but Data Clip, you have the option to add the Boundary as a Non-destructive Breakline. Doing so 
interpolates Surface slopes and adds TIN lines and points so that the Surface is displayed exactly 
up to the limits of the object used as a Boundary. If the Non-destructive Breakline option is 
unchecked, the Surface will be displayed using only previously existing TIN lines and points com-
pletely within the limits of the polygon used as a Boundary. 

Closed polygon objects such as 2D or 3D Polylines, Circles, Parcels and Survey Figures can all be 
used as a dynamic reference for a Surface Boundary. If a polygon is not closed, Civil 3D will 
define and force a closed polygon when adding a Boundary. If the object referenced to add a 
Surface Boundary contains arcs, TIN tessellation is generated based on the Mid-ordianate dis-
tance specified in the Add Boundaries dialog. The mid ordinate distance is the distance from 
the center of the chord connecting adjacent points along an arc perpendicular to the center of 
the arc. TIN lines are then generated along the chord after adding the Surface Boundary. A 
smaller mid-ordinate distance results in a "smoother" arc on a Surface Boundary.

The following section describes the Data Clip and Outer Boundary Types.

Data clip

A Data Clip Boundary is used to limit the area where new data will be processed when added. 
This can help improve drawing performance and utilize hardware resources more efficiently. 
Only data added after the Data Clip Boundary is added will be affected by the Data Clip Bound-
ary. For this reason, it is a good idea to add any Data Clip Boundary during the initial steps of 
Surface creation.

Create surface and add data clip boundary

 1. Toolspace palette > Prospector tab > Right-click on Surfaces > Create Surface > 
Create Surface dialog

 A. Name = Exist
 B. Style = EX Triangles
 C. OK

 2. Ribbon > Home tab > Draw panel > Activate Polyline command
 A. Draw simple polygon around externally referenced (xref) mapping data

 3. Toolspace palette > Prospector tab > Expand Surfaces > Expand Exist > Expand Defin-
ition > Right-click Boundaries > Add > Add Boundaries dialog

 A. Name = Data Clip
 B. Type = Data Clip
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 C. OK
 4. Select Polyline drawn in Step 2.1
 5. Toolspace palette > Prospector tab > Expand Surfaces > Expand Exist > Expand Defin-

ition > Right-click Point Files > Add > Add Point File dialog

 A. Add Point File dialog > Selected Files section >  > EXIST.pnt > Open
 B. Specify point file format section

 I. Point file format = PENZ
 C. OK

Outer

An Outer Boundary is used to define the outermost display limits of a Surface. Multiple Outer 
Boundaries may be added to a Surface, but only the most recently added Outer Boundary will 
be used during Surface rebuilding. If multiple Outer Boundaries have been added to a Surface, 
they may be toggled on/off in the Definition tab of the Surface Properties dialog.

Add outer boundary to surface

 1. Complete the Create Surface and add Data Clip Boundary workflow
 2. Ribbon > Home tab > Draw panel > Activate Polyline command

 A. Draw simple polygon within the Data Clip Boundary. Be sure to enclose all pre-
viously drawn "building pad" Polylines as these will be used in the next exercise

 3. Toolspace palette > Prospector tab > Expand Surfaces > Expand Exist > Expand Defin-
ition > Right-click Boundaries > Add > Add Boundaries dialog

 A. Name = Outer
 B. Type = Outer
 C. Uncheck Non-destructive breakline
 D. OK

 4. Select Polyline drawn in Step 2.
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Surface boundary - Hide & show

Exercise files: srfc-bndry-data-c3d16.zip

Start with 12345678\Design\Surfaces\srfc-bndry-01.dwg

srfc-bndry-02.mp4 2:35

The following section describes the Data Clip and Outer Boundary Types.

Hide

A Hide Boundary is used to prevent display of an area inside an Outer Boundary. One example 
situation where a Hide Boundary may be useful is to prevent display of constant-elevation build-
ing pads. When a Hide Boundary type is specified and the Non-destructive breakline option is 
checked, another Surface may be selected as the reference object to define a Hide Boundary.

Add hide boundary to surface

 1. Complete the Add Outer Boundary to Surface workflow or start from srfc-bndry-01.dwg
 2. Ribbon > Home tab > Layers panel > Activate LAYERFRZ (Layer Freeze) command 

 A. Select a TIN line on the Surface
 3. Window select "building pad" Polylines
 4. Shift+select to deselect the Polyline drawn inside one of the "building pad" Polylines.
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 5.  Toolspace palette > Prospector tab > Expand Surfaces > Expand Exist > Expand Defin-
ition > Right-click Boundaries > Add > Add Boundaries dialog

 A. Name = Hide
 B. Type = Hide
 C. Check Non-destructive breakline
 D. OK

Show

A Show Boundary is used to allow display of an area inside a Hide Boundary or to build TIN lines 
and points within a gap on a single Surface. If the Show Boundary falls within a Hide Boundary, 
be sure to add any Show Boundaries after the corresponding Hide Boundary. Keep in mind any 
Add Data operations can be reordered in the Definition tab of the Surface Properties dialog.

Add show boundary to surface

 1. Complete the Add Hide Boundary to Surface workflow
 2.  Toolspace palette > Prospector tab > Expand Surfaces > Expand Exist > Expand Defin-

ition > Right-click Boundaries > Add > Add Boundaries dialog
 A. Name = Show
 B. Type = Show
 C. Check Non-destructive breakline
 D. OK

 3. Select "courtyard" Polyline (inside one of the "building pad" hide boundaries)

Surface masks

Last updated: 2017-06-06

Total video time: 4:20

Exercise files: srfc-msk-data-c3d16.zip

Start with 12345678\Design\Surfaces\srfc-msk-begin.dwg

srfc-msk.mp4 4:20

Surface masks

Surface Masks can be used to control the display of a Surface based on a closed polygon object. 
Many closed polygon objects can be used as reference objects for a Surface Mask including 2D 
or 3D Polylines, Survey Figures, Feature Lines, Parcels and other Surfaces. You can specify that 
a Surface Mask should affect Rendering only or not. Surface Rendering applies a Render Mater-
ial available in the drawing template used (ie concrete or grass) as an aid in design visu-
alization. This can be viewed in Object Viewer. You can specify to "mask" (not display) either 
the Surface inside or outside the polygon object used.
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Info: It is worth noting that Surface Masks differ from Hide or Show Boundaries in 
that they only affect graphic display and do not add TIN data to the Surface. Also, 
the ability to add Surface Masks is more limited than that of Surface Boundaries

Create surface mask

Inside mask

 1. Toolspace palette > Prospector tab > Expand Surface > Expand Exist > Right-click 
Mask > Create Mask

 2. Select Polyline around the intersection
 3. Right-Click 

 A. Mask Type = Inside
 B. OK

 4. Toolspace palette > Prospector tab > Expand Surface > Expand Exist > Expand Masks 
> Right-click Mask 1 > Mask Properties

 A. Mid-Ordinate Distance = 1
 B. OK

Info: Specifying Mask type as Inside prevents additional Masks from being cre-
ated for the Surface. Changing the Mask type to Outside opens up the ability to 
add more Surface Masks.

Outside mask

 1. Toolspace palette > Prospector tab > Expand Surface > Expand Exist > Expand Masks 
> Right-click Mask 1 > Mask Properties

 A. Mask Type = Outside
 B. OK

 2. Toolspace palette > Prospector tab > Expand Surface > Expand Exist > Right-click 
Mask > Create Mask
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 3. Select previously drawn Polyline around the building pad
 4. Right-Click 

 A. Mask Type = Outside
 B. OK

Info: You can select multiple closed polygons when creating a single mask, but 
you will be limited to Mask type = Outside and Render only = Yes

Change display order

While you can have multiple Outside type Surface Masks on a Surface, only the Mask at the top 
of the Display Order list will affect the rendered display.

 1. Toolspace palette > Prospector tab > Expand Surface > Expand Exist > Expand Masks 
> Right-click Mask 1 > Display Order

 A. Mask Display Order
 B. Select Mask 2

 C. Move Mask 2 to top of list 
 D. OK

Surface edits

Last updated: 2017-11-28

Total video time: 11:00

Surface edits - Add/delete lines & points

Exercise files: srfc-edit-data-c3d16.zip

Start with 12345678\Design\Surfaces\srfc-edit-begin.dwg

srfc-edit-01.mp4 4:00

Many updates to Surfaces will be driven by dynamic links to smart Civil 3D objects such as Cor-
ridors or Grading Feature Lines (see the Corridor and Grading Objects training modules for 
more information on these types of dynamic Surface updates). For minor refinements, the Add 
Line, Delete Line, Add Point and Delete Point Surface editing tools can be useful. 

Warnings: 
Add/Delete Lines & Points Surface edits should be applied conservatively as final minor 
refinement. They are manually applied and the workflow can become time intensive.
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Surface edits in design should never be used to correct errors in corridors or gradings. 
They should only be used to fix incorrect triangulation in the surface.

Refinement edits

Use Object Viewer to identify refinement editing needs. Use Delete Line, Delete Point and Add 
Line tools to perform final minor refinements to a Surface created from Grading Feature Lines.

Object viewer

 1. Open srfc-edit-begin.dwg
 2. Select Driveway and Crdr-25 Surfaces in Modelspace

 A. Multiple Surfaces Contextual Ribbon > Object Viewer
 I. Pan and zoom to identify Surface refinement needs

 II. Close Object Viewer

Line & point edits

 1. Esc
 2. Select Driveway Surface

 A. Surfaces Contextual Ribbon > Edit Surface dropdown > Delete Line
 I. Select TIN lines to delete using Crossing Window

 II. Right-Click
 III. Esc

 3. Select Driveway and Crdr-25 Surfaces
 A. Multiple Surfaces Contextual Ribbon > Object Viewer

 I. Pan and zoom to identify Surface additional refinement needs
 II. Close Object Viewer

 4. Select Driveway Surface
 A. Right-Click > Surface Properties > Information tab

 I. Surface Style = Rfnt-Edits
 II. OK

 B. Surfaces Contextual Ribbon > Edit Surface dropdown > Delete Point
 I. Select Surface points to delete using Crossing Window

 II. Right-Click
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 5. Reiterate steps 1-4 using Delete Line, Delete Point and Add Line until Driveway is final-
ized

Surface edits - Paste surface preparation

Exercise files: srfc-edit-data-c3d16.zip

Start with 12345678\Design\Surfaces\srfc-edit-01.dwg

srfc-edit-02.mp4 1:07

A typical workflow to combine multiple component Surfaces into a single final proposed Surface 
involves creating Data Shortcuts of each component Surface (see Data Shortcuts Training Mod-
ule for more information on setting up a Data Shortcut Working Folder). 

Create component surface data shortcuts

 1. Open srfc-edit-01.dwg
 2. Toolspace palette > Prospector tab > Verify that the Data Shortcuts Working Folder 

path has been set
 3. Save drawing
 4. Toolspace palette > Prospector tab > Right-click Data Shortcuts > Create Data Short-

cut
 A. Place check next to Crdr-25 and Driveway
 B. If Exist Data Shortcut has not yet been created, place a check next to Exist
 C. OK

Surface edits - Paste surface
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Exercise files: srfc-edit-data-c3d16.zip

Start with 12345678\Design\Surfaces\srfc-edit-02.dwg

srfc-edit-03.mp4 3:04

Once all desired edits to component Surfaces have been completed, you are ready to combine 
all Surfaces into a single final Surface. You will do this by creating a new Surface empty of data 
and using the Paste Surface Edit to add and combine component Surface data.

Warning: To avoid potential Surface referencing problems, use only one level of 
Surface Pasting. For example, do not Paste Surfaces 1 and 2 into Surface 3 then 
Paste Surfaces 3 and 4 into Surface 5. Rather, paste Surfaces 1, 2, 3 and 4 into 
Surface 5.

Paste surfaces

Create data references

 1. Open srfc-edit-02.dwg
 2. Toolspace palette > Prospector tab > Expand Data Shortcuts > Expand Surfaces > 

Right-click on Crdr-25
 A. Create Surface Reference dialog
 B. Style = _No Display
 C. OK

 3. Repeat Step 2 for Driveway and Exist Surfaces

Create final surface & perform paste surface edit

 1. Toolspace palette > Prospector tab > Right-click Surfaces > Create Surface
 A. Create Surface dialog
 B. Name = Final
 C. Style = P Triangles
 D. OK
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 2. Toolspace palette > Prospector tab > Expand Surfaces > Expand Final > Expand Defin-
ition > Right-Click Edits > Paste Surface

 A. Select Exist
 B. OK

 3. Repeat Step 2 for Crdr-25
 4. Repeat Step 2 for Driveway
 5. Zoom Extents

Surface edits - Paste surface: survey
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Exercise files: srfc-edit-data-c3d16.zip

Start with 12345678\Design\Surfaces\srfc-edit-03.dwg

srfc-edit-04.mp4 2:49

After a Surface built from survey data is delivered, a typical workflow is to incorporate the sur-
veyed area into the larger project limits by combining the survey Surface with a Surface built 
from mapping data (DEM or LiDAR etc). This will result in an existing conditions Surface built 
with survey level accuracy where feasible and LiDAR level coverage covering the remainder of 
the project limits. Do this by creating a new, blank Surface and adding data by Pasting the map-
ping Surface and survey Surface in.

Warning: To avoid potential Surface referencing problems, use only one level of 
Surface Pasting. For example, do not Paste Surfaces 1 and 2 into Surface 3 then 
Paste Surfaces 3 and 4 into Surface 5. Rather, paste Surfaces 1, 2, 3 and 4 into 
Surface 5.

Paste survey and mapping surfaces into existing conditions surface

 1. Open surf-edit-04.dwg
 2. Ribbon > Home tab > Create Ground Data panel > Surfaces dropdown > Create Sur-

face
 A. Name = Composite
 B. Style = EX Triangles
 C. OK

 3. Modelspace > Select Mapping Example Surface > Right-click > Surface Properties
 A. Information tab
 B. Surface Style = _No Display
 C. OK

 4. Repeat Step 3 for Survey Example Surface
 5. Toolspace palette > Prospector tab > Expand Surfaces > Expand Composite > Expand 

Definition > Right-Click Edits > Paste Surface
 A. Select Mapping Example
 B. OK

 6. Repeat Step 5 for Survey Example

Surface properties - Analysis

Last updated: 2017-06-06

Total video time: 5:13

Exercise files: srfc-prprtis-anlysis-data-c3d16.zip
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Start with 12345678\Design\Surfaces\srfc-prprtis-anlysis-begin.dwg

srfc-prprtis-anlysis.mp4 5:13

Surface properties - Analysis

Several types of Surface Analyses can be performed in order to generate information helpful 
during design. Surface Analysis results can be displayed visually as a Surface Style and/or in tab-
ular format as a Surface Legend. You will specify the number or ranges, range values (ie min 
and max) and corresponding display color. Surface Analysis display is turned on/off in the Dis-
play tab of a given Surface Style Editing window. The following Surface Analysis types are avail-
able in the Surface Properties window:

 l Directions - TIN triangle color based on facing direction
 l Elevation - TIN triangle color based on elevation range
 l Slopes - TIN triangle color based on slope range (all values are positive)
 l Slope Arrows - Direction arrow displayed at each TIN triangle. Color is based on slope 

range
 l Contours - Contour color based on elevation range
 l User-Defined Contour - Specify desired contour values and display based on elevation 

range
 l Watersheds - Uses Surface Slope algorithm to analyze TIN triangles, draw Watershed 

boundaries and hatch according to type (ie Depression, Multi-Drain)

This training module will focus on Surface Slope Analysis. Specifically, you will analyze a pro-
posed pavement Surface for drainage problem areas in flat or steep spots.

Generate and display surface slope analysis

Use a Surface Slope Analysis to identify potential problem areas in a proposed pavement Sur-
face.

Page: 318

Published on: 2/21/2018

Surface properties - Analysis

http://www.c3dkb.dot.wi.gov/video/srfc/srfc-prprtis-anlysis.mp4


 1. Toolspace palette > Prospector tab > Expand Surfaces > Right-click Crdr-25> Surface 
Properties

 A. Analysis tab
 I. Analysis type = Slopes

 II. Legend = WisDOT Standard
 III. Ranges Number = 2

 IV. Populate Range Details, 
 V. Range ID 1 Minimum Slope = default, Maxiumum Slope = 0.29%

 VI. Range ID 2 Minimum Slope = 6.001%, Maximum Slope = default
 VII. Range ID 2 Scheme (color) = green

 B. Information tab 

 I. Surface Style > Edit Current Selection 
 a. Display tab

 i. Component display
 ii. Toggle Slopes Component to Visible

 b. OK
 II. OK

 2. Pan and Zoom to see Surface Slopes Analysis displayed along Crdr-25  

Tip: To Display the "middle range" of Surface Slopes, specify 3 Slope ranges in 
the Surface Properties window Analysis tab. Set Slope range values and Scheme 
colors according to design criteria.
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Modify profile to update corridor surface

 1. Zoom to PV-1 Profile View, Station 395+00
 2. Observe 6.00% Slope on 25-Prop Profile near Station 395+00
 3.  Select 25-Prop Profile
 4. Profile Contextual Ribbon > Modify Profile panel > Geometry Editor

 A.  Profile Layout Tools toolbar > Profile Grid View button 
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 I. Profile Entities panorama
 a. Entity No 6 Grade Out = 5.00%
 b. Enter
 c. Close Profile Entities panorama
 d. Close Profile Layout Tools toolbar

 5. Toolspace palette > Prospector tab > Expand Corridors > Right-click 25 > Rebuild
 6. Pan and Zoom to see updated Surface Slopes Analysis displayed along Crdr-25  

Info: See Profiles training module for more detailed information on Profiles and 
Profile editing

Add surface legend

 1. Ribbon > Annotate tab > Labels & Tables panel > Add Tables dropdown > Add Sur-
face Legend Table

 A. Command Line: Enter (to pick from list)
 I. Select Crdr-25

 II. OK
 B. Command Line: S (specify Slopes table type)
 C. Enter
 D. Command Line: D (specify Dynamic table type)
 E. Enter
 F. Click in Modelspace to insert table

Cropped surfaces

Last updated: 2017-06-06

Total video time: 2:56

Exercise files: srfc-crop-data-c3d16.zip

Start with 12345678\Design\Surfaces\srfc-crop-begin.dwg

srfc-crop.mp4 2:56

Cropped surfaces
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When working on a small area within a Surface which contains a large amount of data, it can 
be helpful to extract only the area of the Surface you need to work with. Do this with the Create 
Cropped Surface command. Using this command will create a new cropped Surface built from a 
source Surface. Edits can be pushed from the source Surface to the cropped Surface by saving 
the source drawing, rebuilding the cropped Surface Snapshot and rebuilding the cropped Sur-
face. This workflow can conserve hardware resources, improve application performance and 
prevent drawing crashing.

Create cropped surface

 1. Open srfc-crop-begin.dwg and srfc-crop-01.dwg
 2. Ribbon > Home tab > Create Ground Data panel > Surfaces dropdown > Create 

Cropped Surface
 A. Click in Select crop area Value field
 B. Click ellipses

 I. Command Line: P
 II. Enter

 III. Draw polygon around desired area of Surface
 IV. Command Line: C
 V. Enter

 C. Drawing for new surface = Select an open drawing
 D. Select an open drawing = *srfc-crop-01.dwg
 E. New surface name = Exist-crop
 F. Surface Style = EX Triangles
 G. Layer = E_SURF
 H. OK

 3. Make srfc-crop-01.dwg the active drawing
 4. Zoom Extents

Update cropped surface

If you wish to apply edits from the source Surface to the cropped Surface, save the source draw-
ing then Rebuild Snapshot of cropped Surface and Rebuild cropped Surface.

 1. Save srfc-crop-begin.dwg
 2. Make active or open srfc-crop-01.dwg
 3. Toolspace palette > Prospector tab > Expand Surfaces > Expand Exist-crop > Right-

click Definition > Rebuild Snapshot
 4. Toolspace palette > Prospector tab > Expand Surfaces > Expand Exist-crop > Defin-

ition > Rebuild Surface
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Alignments

Alignment basics

Last updated: 2017-02-10

Total video time: 06:45

ali-basc-01.mp4 03:31

Alignments in context of project

Project index for location by station and offset.

Basis for design of corridors.

Targets for corridor design.

Basis for profiles, profile views, and sample lines.

Folder and object naming

In FDM 15-5-3 Att. 3.4 the folder location and the file naming is spelled out, with multiple 
examples.

Alignments will be created and saved with any related profiles. Multiple alignment/profile com-
binations can be stored in a single file or split up. In general, fewer files are better unless there 
is a need (such as multi-user editing) to have multiple files. These will be data shortcut ref-
erenced so they can be shared among project files.

Offset alignments, and their profiles, must be in the same file as the parent alignment.

Sites in relation to alignments

Sites are a control mechanism that allow objects to interact. These objects include parcels, grad-
ing elements and possibly alignments. Alignments are an option in the site control since they 
usually do not need the sort of interaction that is required, and can sometimes become a prob-
lem with other objects in the file. It is best to make sure the alignments you create are set to 
“No site” so that accidental interaction does not occur. Places where alignment interaction with 
objects is preferred would be with parcels, and will be discussed in detail there.

ali-basc-02.mp4 03:14

Alignment types

There are five types of alignments that can be created. Generally, users should only be 
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concerned with two of those types, centerlines and rail, outlined below: 

 l Centerlines: Despite its name, centerline type alignments are not always centerlines of a 
design. These are alignments created by a user, and is the predominant type for designs. 
These can be used for design start locations, as well as targeting for design definitions 
(edge of travel ways, shoulder slope breaks, etc.) Centerline alignments can have super-
elevation assigned to them.

 l Rail: If you are creating rail design this type understands the Cant functionality, and will 
build with specific rail needs in mind. You should not use rail alignment types in other 
designs.

 l Offset: This type of alignment creates a child alignment that is geometrically tied to a 
parent alignment. This type is used for creating tapers and geometry parallel to center-
line alignments.

 l Curb Return: This type of alignment is built by the intersection tool to create curb return 
horizontal geometry. The user would not create a curb return alignment manually, and 
an alignment should never have the type changed to this after it is created. In the case 
this switch is made it has prevented other functionality from working.

 l Miscellaneous: The alignment type is created from pipe networks. The user should not 
change an alignment to the miscellaneous type, and there is no acceptable way to create 
a miscellaneous type alignment manually.

Offset Alignments

This type of alignment creates a child alignment that is geometrically tied to a parent align-
ment. This will allow generally parallel design that moves to stay a defined offset from the par-
ent alignment. This type does allow for widening while maintaining the geometric tie to the 
parent alignment. This type is created with specific creation commands, and you should not 
change an alignment you are creating to an offset type manually. In the case this switch is 
made it has prevented other functionality from working. If you need to create an offset align-
ment , select the parent alignment and choose Create Offset to create the geometric con-
nection.

Superelevation assignments in alignments

While creating corridor designs that utilize superelevation to transition subassembly slope over 
long distances, the data needed to accomplish this will be stored in the alignment. This align-
ment data will then work with properly attached subassemblies to create the needed slopes and 
transitions.

Alignment layout tools

Last updated: 2017-06-06
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Total video time: 09:38

Alignment layout toolbar overview

Exercise files: ali-lyout-tool-ovrview-data-C3D14.zip

ali-lyout-tool-01.mp4 1:40

There are both alignment creation and alignment editing tools on the layout toolbar. This series 
covers the creation tools, while the editing tools are covered in a later series.

You can create alignments by drawing tangent to tangent using the first icon tool. This has an 
option to include curves of a specific radius. Alignments can also be created per localized part 
by using the Lines and Curves tools, the 5th and 6th icon on the toolbar. This is useful if you 
have location, bearing and distance, or other parameters that you have to design around.

You can also add, delete, or break the point of intersecting tangents apart in the 2nd, 3rd and 
4th icon. This allows for adding to the design elements of the alignment you have created.

Finally, you can draw alignments with lines and arcs, and translate these directly into an align-
ment. These cannot be polylines, or other objects, only lines and arcs. The line and arc seg-
ments must be snapped together at a coincident point for the alignment to continue through 
the segments. After the segments are selected you will be prompted with the direction the 
alignment will be created, low station to high station. This can prevent unforeseen directional 
issues as you are designing or labeling with the alignment.

Curve settings

Exercise files: ali-lyout-tool-crv-sttings-data-C3D14.zip

ali-lyout-tool-02.mp4 1:27

 1. Open AliProf-All.dwgCrdr-25.dwg
 2. Status bar > right-click on the OSNAPS icon > Settings

 A. Clear all of the OSNAPS except for Node.  
 B. Ok

 3. Home tab > Create Design panel > Alignment drop-down > Alignment Creation Tools 
 A. Alignment name = Lcl-4thAve. 

 4. Ok  
 5. Alignment Layout toolbar > first icon drop-down > Curve and Spiral Settings

 A. Default Radius = 100’
 6.  Ok

Tangent-Tangent (no curves)
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Exercise files: ali-lyout-tool-tngnt-data-C3D14.zip

ali-lyout-tool-03.mp4 1:50

 1. Alignment Layout toolbar > first icon drop-down > Tangent-Tangent (no curves)
 A. Shift + right-click to access the temporary OSNAP menu > Node
 B. Hover near the point number 1201 and left click to begin the alignment there.
 C. Hover near the point number 1203 and left click to draw the alignment there.
 D. Hover near the point number 1204 and left click to draw the alignment there.
 E. Right-click to end the alignment creation.

Tangent-Tangent (with curves)

 1. Alignment Layout toolbar > first icon drop-down > Tangent-Tangent (with curves)
 A. Hover near the end of the alignment at point 1204, and left click to begin the 

alignment there.
 B. Hover near the point number 1202 and left click to draw the alignment there.
 C. Right-click to end the alignment creation.

Exercise files: ali-lyout-tool-PI-edit-data-C3D14.zip

ali-lyout-tool-04.mp4 2:42

Note: Video and exercise files to be used on the following 3 sections

PI Editing - Add PI

 1. Open AliProf-All.dwg.
 2. Status bar > right-click on the OSNAPS icon > Settings

 A. Clear all of the OSNAPS except for Node. 
 B. Ok

 3. Select the Lcl-4thAvealignment.
 4. Geometry Editor
 5. Alignment Layout toolbar > Insert PIicon

 A. Hover near the point number 1206 and left click to draw the alignment there.
 B. Hover near the point number 1205 and left click to draw the alignment there
 C. Right-click to end the alignment creation.

 6. Close the Alignment Layout toolbar by clicking the X in the upper right.

PI Editing - Delete PI

 1. Select the Lcl-4thAvealignment.
 2. Select the Geometry Editor.
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 3. Alignment Layout toolbar > Delete PI
 A. Hover near point 1206 and left-click.
 B. Right-click to end the alignment creation.

 4. Close the Alignment Layout toolbar by clicking the X in the upper right.

PI Editing - Break Apart PI

 1. Select the Lcl-4thAvealignment.
 2. Select the Geometry Editor.
 3. Alignment Layout toolbar > Break Apart
 4. At the command line you are prompted to enter the distance by which to split the PI. 

 A. 25 Enter
 B. Right-click to end the alignment creation.

Exercise files: ali-lyout-tool-sbntity-cntrl-data-C3D14.zip

ali-lyout-tool-05.mp4 1:59

Note: Video and exercise files to be used on the following 2 sections

Subentity Control - Reverse Subentity Direction

 1. Open AliProf-All.dwgCrdr-25.dwg.
 2. Select the Lcl-4thAvealignment.
 3. Select the Geometry Editor
 4. Alignment Layout toolbar > Reverse Subentity Direction

 A. Select the curve near point 1203.
 B. Right-click to end the selection process.

 5. Alignment Layout toolbar > Reverse Subentity Direction
 A. Select the tangent entity between points 1204 and 1202.
 B. Right-click to end the selection process.

Subentity Control - Delete Subentity

 1. Open AliProf-All.dwg.
 2. Select the Lcl-4thAvealignment.
 3. Select the Geometry Editor
 4. Alignment Layout toolbar > Delete Subentity

 A. Select the last tangent of the alignment.
 B. Enter to delete the selected tangent.

 5. The white line that created that tangent is still in the location. Only the alignment por-
tion is deleted.

Alignment lines and curves

Last updated: 2017-06-06
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Total video time: 12:22

Fixed, floating, and free lines and curves

Exercise files: ali-lin-crv-ovrview-data-C3D14.zip

ali-lin-crv-01.mp4 2:16

Fixed, floating, and free lines and curves

When creating an alignment not from start to finish, it is best to add alignment subentities as 
lines or curves. Fixed, floating and free are methods by which these subentities can be added, 
based on already available geometry.

Fixed lines and curves

A “fixed” definition for lines and curves indicates that the geometry is defined and locked geo-
metrically, independent of any other geometry of the alignment. An example of this would be a 
three point curve, where the user defines the start, mid-point and end of the curve geometry.

Floating lines and curves

A “floating” definition for lines and curves indicates that the geometry is geometrically locked 
to a point, but also ties in to some other geometry of the alignment. An example of this is a line 
that is tangent to a previous curve but it needs to go through a specific point. The tangent point 
on the curve will adjust along the curve so that the “through point” can be achieved. The align-
ment will then forgive the portion of the curve that is not needed, while still providing the user 
with a graphical representation of where the excess had been.

Free lines and curves

A “free” definition for lines and curves indicates the object has no geometric definition, but 
rather all definition is dependent on other geometry in the alignment. An example of this would 
be a curve that is tangent to both incoming and outgoing lines of the intersection.

The vast majority of curves should use the free curve option. This is to maintain the tangency to 
both the incoming and outgoing alignment lines.

Alignment layout with fixed lines

Exercise files: ali-lin-crv-fxd-lin-data-C3D14.zip

ali-lin-crv-02.mp4 2:05

Page: 329

Published on: 2/21/2018

Alignment lines and curves

http://www.c3dkb.dot.wi.gov/data/ali/ali-lin-crv-ovrview-data-C3D14.zip
http://www.c3dkb.dot.wi.gov/video/ali/ali-lin-crv-01.mp4
http://www.c3dkb.dot.wi.gov/data/ali/ali-lin-crv-fxd-lin-data-C3D14.zip
http://www.c3dkb.dot.wi.gov/video/ali/ali-lin-crv-02.mp4


 1. Open AliProf-All.dwg.
 2. Home tab > Create Design panel > Alignment pull-down > Alignment Creation Tools
 3. Create Alignment - Layout dialog

 A. Name = Lcl-4thAve
 B. Ok

 4. Alignment Layout toolbar > Line drop down tool > Fixed Line (two points)
 A. Shift right-click to get the Temporary OSNAP menu > Node
 B. Hover near point 1201 and click to begin drawing the alignment.

 5. Transparent Command toolbar > Bearing and Distance tool
 A. 1Enter to select the NE quadrant
 B. 73.5147 Enter  to enter the bearing
 C. 234.85 Enter  to enter the distance
 D. Esc to end the transparent command
 E. Esc to end the alignment creation tool

 6. Close the Alignment Layout toolbar.

Alignment layout with fixed curve options

Exercise files: ali-lin-crv-fxd-crv-data-C3D14.zip

ali-lin-crv-03.mp4 1:20

 1. Open AliProf-All.dwg.
 2. Select the Lcl-4thAve alignment.
 3. Alignment contextual menu > Geometry Editor tool
 4. Alignment Layout toolbar > Curve icon drop-down > More Fixed Curves > Fixed 

Curve (From Entity End Through Point)
 A. Select the tangent of the Lcl-4thAve alignment.
 B. Shift right-click to get the Temporary OSNAP menu >  Node
 C. Hover near point 1207 and click to begin drawing the alignment from here. 

Alignment layout with floating lines

Exercise files: ali-lin-crv-flt-lin-data-C3D14.zip

ali-lin-crv-04.mp4 1:08

Warning: This exercise is unique and may have elements that do not continue 
from the previous video session. It is recommended that you start with the dataset 
specifically for this exercise.

 1. Open AliProf-All.dwg.
 2. Select the Lcl-4thAve alignment.
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 3. Alignment contextual menu > Geometry Editor tool
 4. Alignment Layout toolbar > Line icon drop-down > Floating Line (From Curve End, 

Length)
 A. Select the end of the curved entity of the alignment.
 B. 156.0 Enter
 C. Esc to end alignment creation.

 5. Close the Alignment Layout toolbar.

Alignment layout with floating curves

Exercise files: ali-lin-crv-flt-crv-data-C3D14.zip

ali-lin-crv-05.mp4 1:27

Warning: This exercise is unique and may have elements that do not continue 
from the previous video session. It is recommended that you start with the dataset 
specifically for this exercise.

 1. Open AliProf-All.dwg.
 2. Select the Lcl-4thAve alignment.
 3. Geometry Editor
 4. Alignment Layout toolbar > Curve icon drop-down > More Fixed Curves > Floating 

Curve (From Entity, Radius, Through Point)
 A. Select the end of the last tangent.
 B. At the command line type 90 Enter  for the radius.
 C. At the command line hit Enter  to accept LessThan180.
 D. Shift + right-click for the Temporary OSNAP menu and choose Node.
 E. Hover near point 1216 and left-click to end the curve at this location.
 F. Right-click to end the command.

 5. Close the Alignment Layout toolbar by clicking the X in the upper right.

Alignment layout with free lines

Exercise files: ali-lin-crv-fre-lin-data-C3D14.zip

ali-lin-crv-06.mp4 1:04

Warning: This exercise is unique and may have elements that do not continue 
from the previous video session. It is recommended that you start with the dataset 
specifically for this exercise.
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 1. Open AliProf-All.dwg.
 2. Select the Lcl-4thAve alignment.
 3. Geometry Editor
 4. Alignment Layout toolbar > Line icon drop-down > Free Line (Between Two Curves)

 A. Select the first curve, to the north and west.
 B. Select the second curve, to the south and east.
 C. Right-click to end the command.

 5. Close the Alignment Layout toolbar by clicking the X in the upper right.

Alignment layout with free curves

Exercise files: ali-lin-crv-fre-crv-data-C3D14.zip

ali-lin-crv-07.mp4 1:10

Warning: This exercise is unique and may have elements that do not continue 
from the previous video session. It is recommended that you start with the dataset 
specifically for this exercise.

 1. Open AliProf-All.dwg.
 2. Select the Lcl-4thAve alignment.
 3. Select the Geometry Editor.
 4. Alignment Layout toolbar > Curve icon drop-down   > Fixed Curve Fillet (Between Two 

Entities, Radius)
 A. Select the first tangent to the north and west of the curve.
 B. Select the second tangent to the south and the east of the curve.
 C. Enter  to accept the LessThan180 option.
 D. In the command line type 90Enter  for the radius.
 E. Right-click to end the command.

 5. Close the Alignment Layout toolbar by clicking the X in the upper right.

Changing curve types after placement

Exercise files: ali-lin-crv-chng-crv-type-data-C3D14.zip

ali-lin-crv-08.mp4 1:52

 1. Open AliProf-All.dwg.
 2. Select the Lcl-4thAve alignment.
 3. Select the Geometry Editor.
 4. Alignment Layout toolbar > Alignment Grid View

 A. In the second row, Tangency Constraint column, select the Constrained on Both 
Sides (Free) text.
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 B. From the drop-down menu in this field select Constrained by Previous (Floating) 

Changing Parameter Constraint

 1. In the Alignment Grid View unlock the second row by clicking on the Parameter Con-
straints Lock padlock so that it appears unlocked. This will open the Parameter Con-
straints field for editing.

 A. In the Parameter Constraints field for the second row click on the Passthrough 
Radius text.

 I. From this drop-down menu select Radius and Length.
 II. In the drawing area select on the first curve of the alignment. Notice the 

grip points that are available.
 B. In the Parameter Constraints field for the second row click on the Radius and 

Length text.
 I. From this drop-down menu select Passthrough Radius.

 II. In the drawing area select on the first curve of the alignment. Notice the 
grip points that are available.

 2. Close the Alignment Grid View panorama by clicking on the X in the upper left.
 3. Esc to let go of the alignment.
 4. Close the Alignment Layout toolbar by clicking the X in the upper right.

Create alignment from objects

Last updated: 2017-06-06

Total video time: 18:42

Cleaning up AutoCAD objects prior to conversion

Exercise files: ali-creat-frm-objct-clnup-data-C3D14.zip

ali-creat-frm-objct-01.mp4 2:40

Warning: It is preferred that you use the layout tools to build alignments. This pre-
vents gaps in alignment objects that can cause problems in stationing, targeting, 
and other advanced functions. If you need to translate AutoCAD objects into align-
ment objects it is preferred that these objects be transformed into singular polylines 
prior to conversion. This will prevent tangent segments that are not properly 
snapped from ending an alignment early.

Creating polylines from lines and arcs. 

 1. PE Enterfor polyline edit.
 2. Select the line segment that is the furthest west.
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 3. Y Enter  to turn the line into a polyline segment.
 4. J Enter for Join.
 5. Window select all of the alignment line and arc segments.
 6. Enter to end the selection process.

Snapping lines and arcs

 1. Click on the polyline to make sure it is complete. It should only highlight from the west 
end past the first curve.

 2. Zoom to the location where the highlighted polyline ends.
 3. Esc to let go of the highlighted polyline.
 4. Select the line after the polyline.
 5. Select the west-most grip on the line segment.
 6. Using the Endpoint OSNAP, snap this line end to the polyline end.
 7. Zoom Extents to see the entire project.
 8. PE Enterfor polyline edit.
 9. Select the line segment that is the furthest west.

 10. Y Enter  to turn the line into a polyline segment.
 11. J Enter for Join.
 12. Window select all of the alignment line and arc segments.
 13. Enter to end the selection process.
 14. Left-click on the polyline to make sure it completely highlights. Esc to release the poly-

line.

Create alignment from objects dialog

Create alignment from objects dialog – General tab

Exercise files: ali-creat-frm-objct-dialg-data-C3D14.zip

ali-creat-frm-objct-02.mp4 9:50

 1. Open AliProf-All.dwg
 2. Home tab > Create Design panel > Alignment drop-down > Create Alignment from 

Objects 
 3. Select the polyline on the westernmost end.
 4. Create Alignment from Objects dialog

 A. Name = 25-L-EPS
 B. Starting Station = 4596.64
 C. Add Curves between Tangents = Off
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Create alignment from objects dialog – Design Criteria tab

 1. Create Alignment from Objects dialog > Design Criteria tab
 A. Starting Design Speed = 45 MPH
 B. Use Design Criteria File = Off
 C. Click the ellipsis button at the right of the design criteria path field.

 I. Browse to  C:\wisdot\stnd\c3d2014\Program\Corridor Design Stand-
ards\Imperial.

 II. Select _WisDOT Design Criteria 2009.xml Open.
 III. Default Criteria window

 a. Minimum Radius Table = WisDOT eMax 4%
 b. Transition Length Table = 1LaneRamp, 2LaneUndiv@CL
 c. Ok

Reversing the alignment direction during creation

Exercise files: ali-creat-frm-objct-rvrs-dring-data-C3D14.zip

ali-creat-frm-objct-03.mp4 1:45

 1. Open AliProf-All.dwg
 2. Home tab > Create Design panel > Alignment drop-down > Create Alignment from 

Objects 
 A. Select the polyline on the easternmost end. Enter to end the selection process.
 B. R Enter to reverse the direction.
 C. Create Alignment from Objects dialog

 I. Name = Lcl-4thAve
 II. Start station = 46+50

 III. Ok to create the alignment.
 3. Check the stationing to make sure the alignment is moving west to east.

Reversing the alignment direction after creation

Exercise files: ali-creat-frm-objct-rvrs-aftr-creat-data-C3D14.zip

ali-creat-frm-objct-04.mp4 1:49

 1. Select the Lcl-4thAve alignment.
 2. Green Context> Modify panel pull-down > Reverse Direction 
 3. Ok to the Warning.
 4. Confirm that the stationing is now reversed.

Exercise: Create alignment from objects
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Exercise files: ali-creat-frm-objct-exrcs-data-C3D14.zip

ali-creat-frm-objct-05.mp4 2:38

 1. Open AliProf-All.dwg
 2. PE Enter for polyline edit.
 3. Select the tangent line at the south of the project.
 4. Y Enter to convert it to a polyline.
 5. J Enter for join.
 6. Window select all the line and arc segments. Enter  to end the selection set.
 7. Enter  again to end the polyline edit command.
 8. Home tab > Create Design panel > Alignment drop-down > Create Alignment from 

Objects 
 A. Select the polyline closer to the south end.
 B. Enter  to end the selection process.
 C. Enter  to accept the direction, north to south.

 9. Create Alignment from Objects dialog
 A. Name =   25
 B. Start Station =  33000
 C. Add Curves Between Tangents = Unchecked
 D. Ok to create the alignment.

 10. Select the 25 alignment.
 11. Alignment contextual tab >  Geometry Editor
 12. Alignment Layout toolbar > Curve drop-down > Free Curve Fillet (Between two entit-

ies, Radius)
 A. Select the tangent that is entering the curve on the north end of the alignment.
 B. Select the tangent that is exiting the curve on the north end of the alignment.
 C. Enter  to accept LessThan180.
 D. 2865 Enter  for the radius.
 E. Enter  to end the command.

 13. Close the Alignment Layout toolbar by clicking the x in the upper right corner.

Alignment from existing alignment

Last updated: 2017-06-06

Total video time: 08:25

Create an alignment from an existing alignment using alignment stations

Exercise files: ali-frm-exst-ali-sta-data-C3D14.zip

ali-frm-exst-ali-01.mp4 2:09
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 1. Open AliProf-All.dwg
 2. Home tab > Create Design panel > Alignment pull-down > Create Alignment from 

Existing Alignment 
 3. Select the 25 alignment.
 4. Type 40245 (for station 402+45).
 5. Pull the cursor south until roughly 343+25 (you can type this in for precision).
 6. At the command line type F for Finish.
 7. In the alignment dialog name the alignment 25-Alt1.

Add design to new alignment

Exercise files: ali-frm-exst-add-dsgn-data-C3D14.zip

ali-frm-exst-ali-02.mp4 2:16

 1. Select the 25-Alt1 alignment. It is on top of the original 25 alignment, but the Selection 
Cycling option can aid in this selection.

 2. Select the Geometry Editor
 3. Fixed Line – Two Points icon

 A. Draw a diverging alignment tangent near the north end of the 25-Alt1 alignment.
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 4. Free Curve Fillet (between two entities, through point) 

 A. When prompted for the first entity, select the 25-Alt1 alignment. Make sure you 
are selecting the correct alignment. Selection Cycling can help in this selection.

 B. When prompted for the next entity select the tangent that diverges from the ori-
ginal.

Tip: If the command line reads “Selected Entity must be part of the main 
entity.” And you are prompted for the next entity again, then your first entity 
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selection is not the same alignment of the diverging tangent, and the selec-
tion must be done again.

 C. Identify the point between the two tangents that the curve must pass through. A 
red-X will appear if no solution is possible. Move until a curve connects the two 
tangents. Then left click to accept the location.

Create an alignment from an existing alignment using alignment entities

Exercise files: ali-frm-exst-ents-data-C3D14.zip

ali-frm-exst-ali-03.mp4 4:00

 1. Open AliProf-All.dwg
 2. Home tab > Create Design panel > Alignment pull-down > Create Alignment from 

Existing Alignment 
 A. Select the 25-Alt1.
 B. Type E for Entities. 
 C. Enter 
 D. Select the southern-most curve and the southernmost tangent line.
 E. At the command line type F for Finish.
 F. In the Create Alignment from Existing Alignment dialog change the name to 25-

Alt2.
 G. Ok
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Alignment reverse and compound curves

Last updated: 2017-06-06

Total video time: 03:32

Alignment reverse curve

Exercise files: ali-rvrs-crv-data-C3D14.zip

ali-rvrs-cmpnd-crv-01.mp4 1:45

 1. Open AliProf-4thAve.dwg.
 2. Zoom to the north end of the alignment.
 3. Select the 4thAve alignment.
 4. Select the Geometry Editor

 A. Alignment Layout Tools tool bar > Draw Curves drop-down > More Floating 
Curves > Floating Curve (From Entity, Radius, Through Point) You may need to 
find this option under the More Floating Curves option depending on the last use 
of these tools.
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 B. Select the 4thAve alignment on the curve that you intend to add the compound 
curve. If the selection cycling dialog opens make sure to select Alignment

 C. 90 Enter for the radius
 D. Select Lessthan180 by hitting Enter 
 E. Type R Enter to choose Reverse curve.
 F. Left-click to place the endpoint to the north and east of the alignment, similar to 

the screenshot below.

 5. Enter

Alignment compound curve

Exercise files: ali-cmpnd-crv-data-C3D14.zip

ali-rvrs-cmpnd-crv-02.mp4 1:47

 1. Open AliProf-4thAve.dwg.
 2. Zoom to the north end of the alignment.
 3. Select the 4thAve alignment.
 4. Select the Geometry Editor

 A. Alignment Layout Tools tool bar > Draw Curves drop-down > More Floating 
Curves > Floating Curve (from entity, radius, through point). You may need to 
find this option under the More Floating Curves option depending on the last use 
of these tools.
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 A. Select the 4thAve on the curve that you intend to add the compound curve. If the 
selection cycling dialog opens make sure to select Alignment.

 A. 70 Enter for the radius
 B. Select Lessthan180 by clicking Enter 
 C. C Enter to choose Compound curve
 D. Select a point to the north and east of the alignment, similar to the screenshot 

below.

 5. Enter

Alignment editing

Last updated: 2016-11-30

Total video time: 09:45

Alignment editing with geometric constraints

Info:  Unless modified directly, geometric constraints (fixed, floating, free) are not 
changed by edit operations. They will constrain the edits that are allowed unless 
the constraints are changed.  

 

Alignment grip-point editing

ali-edit-01.mp4 1:52

 1. Open AliProf-All.dwg.
 2. Zoom to the north end of the 25 alignment, close enough to see the curve and last tan-

gent.
 3. Zoom to the north end of the 25 alignment, close enough to see the curve and last tan-

gent.
 4. Graphically select the  25 alignment.
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 5. Select the square grip point at the north end of the alignment and move it a small 
amount to the east and left-click to drop it.

 6. Select the square grip point in the middle of the northern tangent and move it a small 
amount to the west and left-click to drop it.
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 7. Zoom/pan to the curve.
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 8. Select the northern-most circular grip point (the north end of the curve). Move it a small 
amount to the north and left-click to drop it.
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 9. Select the circular grip point in the middle of the curve and pull it a small amount to the 
west to adjust the curve’s radius and left-click to drop it.
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Edit a parameter constraint in the data grid

ali-edit-02.mp4 2:42

 1. In the Alignment Panorama click Parameter Constraint Lock for row 4 to unlock it.
 2. Select the Parameter Constraint for row 4 and choose Radius and Length.
 3. Select alignment 25.
 4. Select the arrow grip point.
 5. Drag that some distance to the north and west.
 6. Click Parameter Constraint Lock symbol to relock that row.
 7. Esc to release the alignment.
 8. Close the panorama window.
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Alignment editing by data grid continued

 1. Open AliProf-All.dwg.
 2. Select the 25 alignment.
 3. In the green context ribbon select Geometry Editor

 4. From the Alignment Layout toolbar select the Alignment Grid View icon.

 5. In the Alignment Panorama select the row 2 Radius entry and change it to 3000.

Page: 348

Published on: 2/21/2018

Alignment editing



 6. Leave the panorama open but zoom to the north-most end of the alignment.

Edit alignment by data grid for single entity

 1. Open AliProf-All.dwg.
 2. Select the 25 alignment.
 3. In the green context ribbon select Geometry Editor.

 4. From the Alignment Layout toolbar select the Pick Sub-Entity icon.

 5. Select the curve to the south of the alignment.
 6. In the radius field change the value to 2685
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 7. Close the sub-entity editor window.
 8. Close the Alignment Layout toolbar by clicking the X in the upper right.

Change alignment direction

ali-edit-03.mp4 2:41

 1. Open AliProf-All.dwg.
 2. Select the 25 alignment.
 3. Green context ribbon > Modify panel pull-down > Reverse direction
 4. Click OK to close the warning that appears.
 5. Click Esc to release the alignment.

Adding to the beginning of an alignment

 1. Open AliProf-All.dwg.
 2. Select the 25 alignment.
 3. Select the Geometry Editor
 4. Tan-Tan(No Curves)
 5. Left click a point out some distance beyond this new location.
 6. Click Esc and left-click to open the temporary OSNAP menu.
 7. Choose Endpoint.
 8. Snap to the end point of the 25 alignment.
 9. Right-click to end the alignment creation tool.
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 10. Click Esc to release the alignment.

Adding to the end of an alignment

 1. Open AliProf-All.dwg.
 2. Select the 25 alignment.
 3. Select the Geometry Editor.
 4. Tangent-Tangent (No Curves)  
 5. Click Esc and left-click to open the temporary OSNAP menu.
 6. Choose Endpoint.
 7. Snap to the end point of the 25 alignment.
 8. Left click a point out some distance beyond this new location.
 9. Right-click to end the alignment creation tool.

 10. Click Esc to release the alignment.

Troubleshooting gaps

ali-edit-04.mp4 2:30

 1. Open AliProf-All.dwg.
 2. Select the 25 alignment.
 3. Select the Geometry Editor.
 4. Select the Reverse Subentity icon.
 5. Select the first alignment tangent that has no labels.
 6. Right-click to end the alignment editing command.

Deleting specific problem elements

 1. Open AliProf-All.dwg.
 2. Select the 25 alignment.
 3. Select the Geometry Editor.
 4. Select the Delete Subentity icon.

 A. Select the southernmost curve. Right-click to end the command.
 5. Free Curve Fillet (Between two entities, Radius)

 A. Select the incoming tangent.
 B. Select the outgoing tangent.

 6. At the command line, accept LESTHAN180Enter.
 7. At the command line, type 2950 Enter for the radius.

Alignment properties

Last updated: 2018-02-20

Total video time: 20:04

Reference point control
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Exercise files: ​ali-prprtis-data-c3d14.zip

Start with: 12345678\Design\aliprofs\AliProf-STH25-begin.dwg

ali-prprtis-01.mp4 2:57

The reference control point, or origin, will be the geometric beginning of the alignment you 
have created. However, you can move this point to some other location along the alignment 
geometry.

 1. Open AliProf-STH25-begin.dwg
 2. Select STH25BestFit alignment > Alignment Properties > Station Control tab
 3. In the Reference point box click the from screen box

 4. You will get a warning sign OK 
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 5. Select the intersection of the two roadways

Tip: Use Shift and right click to open object snap selection box and select 
apparent intersection

 6. In the Station box change the Station from 330+00 to 100+00
 7. OK
 8. You will get another warning OK 
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Station equation

Exercise files: ​ali-prprtis-data-c3d14.zip

Start with: 12345678\Design\aliprofs\AliProf-STH25-01.dwg

ali-prprtis-02.mp4 2:44

The station equations allow you to change the stations along an alignment so you get a dif-
ferent set of stations from a certain point. The alignment will track both the raw or original sta-
tion as well as the station equation adjusted station. You can label either in the table- both are 
available.

 1. Open AliProf-STH25-01.dwg  
 2. Select STH25BestFit alignment > Alignment Properties > Station Control tab
 3. In Station equations 

 a. Select the Add Equation button with the green cross
 b. Station back: 427+59.12'
 c. Station ahead: 428+00'
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 d. OK

 4. The alignment label will now show the original back station and the new ahead station 

Masking
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Exercise files: ​ali-prprtis-data-c3d14.zip

Start with: 12345678\Design\aliprofs\AliProf-STH25-02.dwg

ali-prprtis-03.mp4 2:30

The masked region that you can create will cover up the alignment so it is not visible, both the 
alignment and labels. This doesn't break the alignment or erase parts of it, the whole alignment 
still exists but part is masked.

 1. Open AliProf-STH25-02.dwg
 2. Select the STH25BestFit alignment > Alignment properties > Masking tab >Add mask-

ing region button

 a. Start Station: 423+25
 b. End Station: 455+35
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OK

Tip: You have the option of locking to the stations so if the alignment 
changes the mask will stay the same in regards to the station. You can 
also toggle the mask off or on. To delete select the mask and the 
delete button.

 3. The alignment goes through the curve and you still have editing abilities there even 
though it is masked
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Point of intersection and constraint editing

Exercise files: ​ali-prprtis-data-c3d14.zip

Start with: 12345678\Design\aliprofs\AliProf-4thAve-03.dwg

ali-prprtis-04.mp4 3:04

The point of intersection is going to be how two tangents come together in a curve when they 
are not built with a point of intersection natively. The constraint editing allows for different 
ways of tangency constraint and swapping them out when you are making edits to a curve or to 
an alignment.
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 1. Open AliProf-4thAve-03.dwg
 2. Select Lcl4thAve alignment > Alignment Properties > Point of Intersection tab

 a. By individual curves and curve group: checked

 b. Zoom into the south curve
 c. Hover over the point of intersection until the Solve PI box appears > hover over it 

and select

 d. The two straight segments are joined at the PI and the added geometry 
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disappears

 3. Select Lcl4thAve alignment > Alignment Properties > Constraint Editing tab
 a. Always perform implied tangency constraint swapping: checked

Lock all parameter constraints: checked

OK

Design Speed
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Exercise files: ​ali-prprtis-data-c3d14.zip

Start with: 12345678\Design\aliprofs\AliProf-STH25-04.dwg

ali-prprtis-05.mp4 3:18

You can assign a design speed to an overall alignment or you can create design speed regions 
where the design speed will be changing over the course of the geometry. The design speed is 
one of the integral parts of the superelevation table process and it is important for labeling 
where design speed changes.

 1. Open AliProf-STH25-02.dwg
 2. Select the STH25BestFit alignment > Alignment properties > Design Criteria tab > 

Add Design Speed button

 a. Number 1 Design speed: 45 mi/h
 b. Add another design speed
 c. Number 2 Start Station: 437+75.00
 d. Number 2 Design speed: 30 mi/h
 e. Add another design speed
 f. Number 3 Start Station: 466+75
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 g. Number 3 Speed Design Speed: 45 mi/h

 3. To delete a Design Speed select the speed and click the delete button

Criteria-based design

Exercise files: ​ali-prprtis-data-c3d14.zip

Start with: 12345678\Design\aliprofs\AliProf-STH25-05.dwg

ali-prprtis-06.mp4 3:10

The criteria-based designs tools are made to help you draft an alignment to pre-determined 
data. Here we will be using WisDOT design criteria from 2009.

 1. Open AliProf-STH25-02.dwg
 2. Select the STH25BestFit alignment > Alignment properties > Design Criteria tab > 

Add Design Speed
 3. Number 1 Design Speed: 45 mi/h

Use criteria-based design: checked

Use design criteria file: checked
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 4. Browse to: C:\ProgramData\Autodesk\C3D 2016\enu\Data\Corridor Design Stand-
ards\Imperial\_WisDOT Design Criteria 2009

WisDOT only: The WisDOT Criteria are in the Autodesk default folder in C3D 2016 
and 2018. There is no need to navigate like the video shows. The WisDOT Criteria 
Pre-2009 are for existing roads built prior to 2009.
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 5. Minimum Radius Table: WisDOT eMax 4%

 6. Transition Length Table: 3LaneTWLTL@CL
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 7. Check for tangency between elements: checked

Info: The Design Criteria table is an important step before adding the super-
elevation table.

Exercise

Exercise files: ​ali-prprtis-data-c3d14.zip

Start with: 12345678\Design\aliprofs\AliProf-STH25-06.dwg

ali-prprtis-07.mp4 2:21

This is an alignment properties exercise to show of the more common tools being used for an 
alignment.

 1. Open AliProf-STH25-02.dwg
 2. Select the STH25BestFit alignment > Alignment properties > Station Control tab > 

Add Station Equation
 3. Select the northern most part of the curve

Page: 365

Published on: 2/21/2018

Alignment properties

http://www.c3dkb.dot.wi.gov/video/ali/ali-prprtis-07.mp4


 4. Station ahead: 470+00
 5. Design Criteria tab > Use criteria-based design > Use design criteria file > WisDOT 

Design Criteria 2009
 a. Minimum Radius Table: WisDOT eMax 8%
 b. Transition Length Table: 1LaneRamp, 2LaneUndiv@CL
 c. Attainment Method: Crowned Roadway
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 6. OK

Offset alignments and widenings

Last updated: 2017-06-06

Total video time: 23:15

Creating offset alignments from a parent alignment

Exercise files: ali-offst-widen-creat-data-C3D14.zip

ali-offst-widen-01.mp4 2:32

 1. Open AliProf-All.dwg.
 2. Home tab > Create Design panel > Alignment drop-down > Create Offset Alignments 

 A. Select the 25.
 B. Increment offset = 12 for both right and left
 C. Alignment Style = RDWY Lane Edge
 D. Alignment Label = _No Labels
 E. Ok

 3. Home tab > Create Design panel > Alignment drop-down > Create Offset Alignments 
 A. Select the 25
 B. Increment offset = 15 for both right and left
 C. Alignment Style = RDWY Pavement Edge
 D. Alignment Label = _No Labels
 E. Ok

 4. Home tab > Create Design panel > Alignment drop-down > Create Offset Alignments 
 A. Select the 25.
 B. Increment offset = 18 for both right and left
 C. Alignment Style = RDWY Shoulder Aggregate
 D. Alignment Label = _No Labels
 E. Ok

Clean up offset alignment names

Exercise files: ali-offst-widen-clnup-nms-data-C3D14.zip

ali-offst-widen-02.mp4 2:45

 1. Select the right ETW offset alignment.
 2. Select the Alignment Properties.

 A. In the Information tab change the name from 25-Right-12 to 25-R-ETW.
 B. Ok
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 C. Esc
 3. Select the left ETW offset alignment.
 4. Select the Alignment Properties.

 A. In the Information tab change the name from 25-Left-12 to 25-L-ETW.
 B. Ok
 C. Esc

 5. Select the right EPS offset alignment.
 6. Select the Alignment Properties.

 A. In the Information tab change the name from 25-Right-15 to 25-R-EPS.
 B. Ok
 C. Esc

 7. Select the left EPS offset alignment.
 8. Select the Alignment Properties.

 A. In the Information tab change the name from 25-Left-15 to 25-L-EPS.
 B. Ok
 C. Esc

 9. Select the right EGS offset alignment.
 10. Select the Alignment Properties.

 A. In the Information tab change the name from 25-Right-18 to 25-R-EGS.
 B. Ok
 C. Esc

 11. Select the left EGS offset alignment.
 12. Select the Alignment Properties.

 A. In the Information tab change the name from 25-Left-18 to 25-L-EGS.
 B. Ok
 C. Esc

Creating offset alignments for a portion of a parent alignment

Exercise files: ali-offst-widen-creat-prtn-data-C3D14.zip

ali-offst-widen-03.mp4 3:03

 1. Open AliProf-All.dwg.
 2. Zoom in to the area where the 25 and Lcl-4thAve alignments cross.
 3. Home tab > Create Design panel > Alignment drop-down > Create Offset Alignments 

 A. Select the Lcl-4thAve alignment.
 B. Uncheck the From Start and the From End boxes.
 C. Under From Start select the From Screen icon.
 D. Hover your cursor near station 47+45.
 E. At the command line type 4745Enter 
 F. Under To End select the From Screen icon.
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 G. Hover your cursor near station 52+45 and left click to select the station. Do not 
worry if you are not right on 52+45. This is an approximate station selection.

 H. Increment offset = 12 for both right and left
 I. Alignment Style = RDWY Lane Edge.
 J. Alignment Label = _No Labels.
 K. Ok

 4. Home tab > Create Design panel > Alignment drop-down > Create Offset Alignments 
 A. Select the Lcl-4thAve alignment.
 B. From Start = 4745
 C. To End = 5245
 D. Increment offset = 15 for both right and left
 E. Alignment Style = RDWY Pavement Edge.
 F. Ok

 5. Home tab > Create Design panel > Alignment drop-down > Create Offset Alignments 
 A. Select the Lcl-4thAve alignment.
 B. From Start = 4745
 C. To End = 5245
 D. Increment offset = 18 for both right and left
 E. Alignment Style = RDWY Shoulder Aggregate.
 F. Ok  

 6. Select the right ETW offset alignment.
 7. Select the Alignment Properties.

 A. In the Information tab change the name from Lcl-4thAve -Right-12 to Lcl-4thAve -
R-ETW.

 B. Ok
 C. Esc

Clean up offset alignment names

Exercise files: ali-offst-widen-clnup-nms-prtn-data-C3D14.zip

ali-offst-widen-04.mp4 1:48

 1. Select the left ETW offset alignment.
 2. Select the Alignment Properties.

 A. In the Information tab change the name from Lcl-4thAve -Left-12 to Lcl-4thAve -L-
ETW.

 B. Ok
 C. Esc

 3. Select the right EPS offset alignment.
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 4. Select the Alignment Properties.
 A. In the Information tab change the name from Lcl-4thAve -Right-15 to Lcl-4thAve -

R-EPS.
 B. Ok
 C. Esc

 5. Select the left EPS offset alignment.
 6. Select the Alignment Properties.

 A. In the Information tab change the name from Lcl-4thAve -Left-15 to Lcl-4thAve -L-
EPS.

 B. Ok
 C. Esc

 7. Select the right EGS offset alignment.
 8. Select the Alignment Properties.

 A. In the Information tab change the name from Lcl-4thAve -Right-18 to Lcl-4thAve -
R-EGS.

 B. Ok
 C. Esc

 9. Select the left EGS offset alignment.
 10. Select the Alignment Properties.

 A. In the Information tab change the name from Lcl-4thAve-Left-18 to Lcl-4thAve -L-
EGS.

 B. Ok
 C. Esc

Add widening to an offset alignment

Exercise files: ali-offst-widen-add-widen-data-C3D14.zip

ali-offst-widen-05.mp4 3:43

 1. Open AliProf-All.dwg.
 2. Home tab > Create Design panel > Alignment drop-down > Create Widening .

 A. Select the 25-Right-ETW alignment.
 B. 38370Enter for start station.
 C. 38462Enter  for end station.
 D. 22Enter  to create a 22’ offset from the parent alignment (10’ from the 12’ lane 

edge).
 E. REnter  for right side.
 F. Offset Alignment Parameters dialog > Transition Parameters > Exit transition 

length = 1’
 G. Offset Alignment Parameters dialog > Transition Parameters > Entry transition 

length = 50’
 H. Widening Parameters > Start Station = 38350
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 I. Transition Parameters > Entry > Taper Input Type = By Taper Ratio.
 J. Taper Ratio = 3 (it will assume the 1: portion).
 K. Close the Offset Alignment Parameters dialog by clicking the X in the upper left 

corner.

Add widening areas to the EPS alignment

Exercise files: ali-offst-widen-add-to-EPS-data-C3D14.zip

ali-offst-widen-06.mp4 2:43

 1. Open AliProf-All.dwg.
 2. Home tab > Create Design panel > Alignment drop-down > Create Widening .

 A. Select the 25-Right-EPS alignment.
 B. Snap to the start of the widened area 25-R-ETW alignment.
 C. Snap to the end of the widened area of 25-R-ETW.
 D. 37 ENTER
 E. Transition Parameters > Entry > Taper Input Type = By Taper Ratio.
 F. Taper Ratio = 3
 G. Widening Parameters > Start Station > From Screen icon > Snap to the begin-

ning of the widened region of 25-R-ETW
 H. Transition Parameters > Exit > Transition Length = 1
 I. Close the Offset Alignment Parameters dialog.

 3. Repeat these steps to widen the 25-R-EGS alignment to 40’ from the 25 alignment.

Create a masked area

Exercise files: ali-offst-widen-creat-mask-data-C3D14.zip

ali-offst-widen-07.mp4 1:29

 1. Open AliProf-All.dwg.
 2. Select the 25-R-ETW alignment.
 3. Select the ALIGNMENT PROPERTIES.

 A. Masking tab > Add Masking Region = 33000
 B. Snap to the beginning of the entry transition of 25-R-ETW (station 382+95).
 C. Select the Add Masking Region icon.
 D. Snap to the end of the 25-R-ETW widened region (station 384+65.57).
 E. 48544.46Enter 
 F. Ok

Add widening areas during the offset alignment creation
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Exercise files: ali-offst-widen-widen-dring-offst-data-C3D14.zip

ali-offst-widen-08.mp4 1:53

 1. Open AliProf-All.dwg.
 2. Home tab > Create Design panel > Alignment drop-down > Create Offset Alignment .

 A. Select the Lcl-4thAve alignment.
 B. Create Offset Alignment dialog:

 I. Number of offsets right = 0
 II. Incremental offset on left = 18

 III. Alignment style = RDWY Lane Edge
 IV. Alignment Label = _No Labels

 C. Widening Criteria tab > Checkmark Add widening around curves 
 D. Specify Widening Manually> increase width = 4’
 E. Transition length = 50’
 F. Ok  

Edit the parameters of a widened offset alignment

Exercise files: ali-offst-widen-edit-prmtrs-data-C3D14.zip

ali-offst-widen-09.mp4 1:30

 1. Open AliProf-All.dwg.
 2. Select the north offset alignment.
 3. Modify panel > Offset Parameters

 A. Offset Alignment Parameters dialog > Nominal Offset = -15
 B. Transition In > Curve 2 Radius = 45
 C. Widening Region > Offset = -25
 D. Widening Region > Start station = 5015
 E. Close the Offset Alignment Parameters dialog by clicking the X in the upper left.

Edit a widened offset alignment graphically

Exercise files: ali-offst-widen-widen-grphcly-data-C3D14.zip

ali-offst-widen-10.mp4 1:49

 1. Open AliProf-All.dwg
 2. Graphically select the north offset alignment.
 3. Near the end of the offset alignment select one of the diamond grip points on the parent 

alignment.
 4. Slide that grip point west roughly 20’.
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 5. Select the grey circular grip point in the middle of the offset alignments exit transition 
area.

 6. This turned on to small cyan circular grips at the ends of the transition exit. Select the 
eastern most cyan grip.

 7. Drag this grip to the east roughly 20’.
 8. Toward the start of the offset alignment select the cyan plus grip point to create a new 

widened area.
 9. Select the cyan arrow at the widened area and drag it back roughly 10’.

 10. Select the grey circular grip in the middle of the transition.
 11. This turned on to small cyan circular grips at the ends of the transition exit. Select the 

cyan grip closest to the parent alignment.
 12. Drag that grip to the west roughly 20’.
 13. Click Esc to release the alignment.

Alignment superelevation

Last updated: 2016-11-30

Total video time: 19:36

Check alignment properties are set before creating a superelevation table

ali-super-01.mp4 2:44

 1. Open AliProf-All.dwg
 2. Select the 25 alignment.
 3. Select the Alignment Properties

 A. ALIGNMENT PROPERTIES DIALOG > DESIGN CRITERIA TAB
 I. Design Speed = at least one entry for 60 MPH.

 II. Make sure that the criteria-based design options are on and a file is selec-
ted.

 a. The file should be WisDOT 2009
 III. Minimum Radius Table = WisDOT eMax 4%
 IV. Transition Length Table = 2LaneUndiv@OE, 4LaneUn-

div@CL,4LaneDiv@ME
 B. Ok

Using the superelevation wizard

ali-super-02.mp4 3:08

 1. Open AliProf-All.dwg
 2. Select the 25 alignment.

Page: 373

Published on: 2/21/2018

Alignment superelevation

http://www.c3dkb.dot.wi.gov/video/ali/ali-super-01.mp4
http://www.c3dkb.dot.wi.gov/video/ali/ali-super-02.mp4


 3. Select the Superelevation > Calculate/Edit Superelevation
 A. In the Edit Superelevation message box that opens click Calculate Superelevation 

Now.
 B. Select Undivided Crowned 
 C. Pivot Method = Center Baseline. Next
 D. Lanes tab:

 I. Checkmark the Symmetric Roadway option.
 II. Number of lanes right = 1

 III. Normal lane width = 14’
 IV. Normal lane slope = -2%
 V. Next

 E. In the Shoulder Control tab:
 I. Select Calculate

 II. Normal Shoulder Width = 5’
 III. Normal Shoulder Slope = -5%
 IV. Next

 F. In the Attainment tab:
 I. Superelevation rate table = WisDOT eMax 4%

 II. Transition Length Table = 2LaneUndiv@OE, 4LaneUn-
div@CL,4LaneDiv@ME

 III. Checkmark the Automatically Resolve Overlap.
 G. Finish  
 H. Close the Superelevation Table panorama by clicking the green checkmark at the 

top right.

Review and change superelevation data

ali-super-03.mp4 2:30

 1. Open AliProf-All.dwg
 2. Select the 25 alignment.
 3. Superelevation > View Tabular Editor
 4. Scroll down to the Begin Full Super at 352+27.59 and change the Left Outside Lane to 

2.75%.
 5. Scroll down to the End Full Super at 369+00.36 and change the Left Outside Lane to 

2.75%.

Export the superelevation table

 1. Tabular Editor panorama > Export Superelevation Data
 2. Browse to where the drawing file is stored and save the file as 12345678-Super-

AliProf.csv.
 3. Close the Tabular Editor.
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 4. Close the Superelevation Tabular Editor panorama.

Creating the superelevation view

ali-super-04.mp4 1:58

 1. Open AliProf-All.dwg.
 2. Select the 25 alignment.
 3. Superelevation > Create Superelevation View
 4. Specify superelevation display options > Left Outside Lane > color field

 A. Select the red swatch > Ok
 5. Specify superelevation display options > Right Outside Lane > color field

 A. Select the green swatch > Ok
 6. Ok
 7. Left click a point to the east of the project to place the superelevation view.

Build an assembly that uses subassemblies that superelevate

ali-super-05.mp4 2:08

 1. Open CRDR-25.dwg.
 2. Home tab > Create Design panel > Assembly drop-down > Create Assembly .

 A. Change the assembly name to Main Road.
 B. Leave the Assembly Type as Other.
 C. Ok

 3. Left-click a point to the east of the project to drop the assembly.
 4. From the tool palette switch to the WisDOT Subassemblies palette.
 5. Select the LnGeneric subassembly.
 6. Properties palette > Advanced Properties:

 A. Width = 14
 B. Superelevation Type = Use Outside Lane SE
 C. Subgrade SE Method = Use Outside Lane SE

 7. Select on the Main Road assembly to place the lane.
 8. Select the Main Road assembly again to place the other side lane with the same para-

meters.
 9. Enter 

Open the superelevation table for editing

ali-super-06.mp4 1:48
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 1. Open AliProf-All.dwg
 2. Select the 25 alignment.
 3. Superelevation > Create/Edit Superelevation
 4. Superelevation Curve Manager dialog > Next > curve 2

 A. Normal Shoulder Width = 6
 B. Design Speed = 35
 C. Recalculate  

 5. If you receive a warning that the superelevation data has been changed since the last cal-
culation click continue to calculate.

 6. Close the Superelevation Curve Manager palette.

Adding a curve to a tangent-only alignment

ali-super-07.mp4 5:20

 1. Open AliProf-All.dwg
 2. Select the Cnty-E  alignment.
 3. Select the Geometry Editor
 4. Alignment Layout toolbar > Curve drop-down > More Fixed Curves - Fixed Curve 

(From Entity End, Through Point)
 A. Select the last tangent line of the alignment, to set the start point and direction.
 B. Zoom in as close to the end of the alignment as possible. Left click as close to the 

end of the alignment as possible (do NOT snap to the end point!). Also, try to 
make this curve as straight as possible.

Adding superelevation to a tangent-only alignment (after curve added)

 1. Open AliProf-All.dwg
 2. Select the Cnty-E  alignment.
 3. Superlevation > View Tabular Editor > Superelevation tabular > select the plus sign 

icon
 A. Move the cursor near station 20+85 and left click (you can type it in to be more 

precise).
 B. Expand the Curve1 – and Transition in Region areas to reveal the Manual Station 

entry.
 C. Click the Plus sign icon again.
 D. Move the cursor near station 24+30 and left-click (you can type it in to be more 

precise).
 E. Click the Plus sign icon again.
 F. Move the cursor near station 21+88 and left-click (you can type it in to be more 

precise).
 G. Click the Plus sign icon again.
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 H. Move the cursor near station 23+00 and left-click (you can type it in to be more 
precise).

 I. Change the names of the superelevation cure locations from Manual Station to (in 
order, top to bottom):

 J. Begin Slope Change, Begin Full Slope Change, End Full Slope Change, End Slope 
Change.

 K. In the Left Outside Lane column enter the following values (from top to bottom):
 I.  -2%, -3.62%, -3.7%, -2%

 4. Close the Superelevation Tabular Editor panorama by clicking the green checkmark in 
the upper right corner.

Alignment from best fit

Last updated: 2016-11-02

Create Fixed Line – Best Fit entity

 1. Open AliProf-All.dwg
 2. Home tab > Create Design panel > Alignment drop-down > Alignment Creation Tools 
 3. Alignment Layout toolbar > Line drop-down > Fixed Line - Best Fit
 4. From the Tangent by Best Fit dialog select From COGO points
 5. OK
 6. Select the south-most grouping of points, and the one point just north of that group.
 7. Right-click > Enter 
 8. Review the Regression Graph and click the green check mark in the upper right corner to 

close it and create the alignment.
 9. Click Save.

Create Floating Curve – Best Fit entities

 1. Open AliProf-All.dwg.
 2. Select the 25 alignment.
 3. Select the Geometry Editor
 4. Alignment Layout toolbar > Curve drop-down > Floating curve - Best Fit
 5. When prompted at the command line to select the entity to attach to select, graphically 

select the tangent alignment entity at the south of the project.
 6. In the Curve by Best Fit dialog select the From COGO Points option 
 7. OK
 8. Graphically select the points that are grouped in the lower part of the southern curve.
 9. Right-click > Enter

 10. In the Regression Graph scroll to the bottom and turn on the Pass Through option for the 
last point.
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 11. Click the green check mark in the upper right corner to close it and create the align-
ment.

 12. Zoom into the curve that was just created and graphically select it.
 13. Select the circular grip point at the mid-point of the curve. Drag the grip point back to be 

in line with the COGO point objects.

Create compound curve with Floating Curve – Best Fit

 1. Alignment Layout toolbar > Curve drop-down > Floating curve - Best Fit
 2. When prompted at the command line to select the entity to attach to select, graphically 

select the curve alignment entity that was just created.
 3. In the Curve by Best Fit dialog select the From COGO Points option 
 4. OK
 5. Graphically select the points that are grouped in the upper part of the southern curve.
 6. Right-click > Enter
 7. In the Regression Graph scroll to the bottom and turn on the Pass Through option for the 

last point.
 8. Click the green check mark in the upper right corner to close it and create the align-

ment.
 9. Save

Create Fixed Curve – Best Fit

 1. Open AliProf-All.dwg.
 2. Select the 25 alignment.
 3. Select the Geometry Editor
 4. Alignment Layout toolbar > Curve drop-down > Fixed curve - Best Fit
 5. In the Curve by Best Fit dialog select the From COGO Points option 
 6. OK
 7. Graphically select the points that are grouped in the lower part of the northern curve.
 8. Right-click > Enter
 9. In the Regression Graph scroll to the bottom and turn on the Pass Through option for the 

last point.
 10. Click the green check mark in the upper right corner to close it and create the alignment

Create best fit alignment from points

Last updated: 2017-06-06

Total video time: 10:18

Import survey data - best fit

Exercise files: ali-creat-best-fit-frm-pnt-01-data-C3D16.zip
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ali-creat-best-fit-frm-pnt-01.mp4 3:11

 1. WisDot Standards > Palettes On/Off > Startup Templates 
 2. Design & Production (wisdot16)
 3. Toolspace > Settings tab > Right-click on drawing name > Edit Drawing Settings > 

Units and Zone tab > Categories > WisDot NAD83/86-NAVD88/12

 4. Available coordinate systems > WISCRS-Waukesha NAD 83(1986)-NAVD 88(2012)-USF
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 5. OK
 6. Save As > Project Folder > Design > AliProfs
 7. Save as AliProfSTH25-Best-Fit.dwg
 8. Toolspace > Survey tab > Right-click on Survey Databases > Set working folder > D:\ 

Project Folder\ BaseData\ Survey
 9. Right click on SD12345678 > Open for Edit

 10. The Survey Data needs to be only Read-Only for this workflow
 11. Under Survey Queries, select and drag Centerlines into file

Create first fixed line – best fit entity

Exercise files: ali-creat-best-fit-frm-pnt-02-data-C3D16.zip

ali-creat-best-fit-frm-pnt-02.mp4 2:16

 1. Open AliProf-STH25-Best-Fit.dwg
 2. Home tab > Create Design panel > Alignment drop-down > Alignment Creation Tools 
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 3. Name the alignment  Sth25-Best-Fit
 4. OK
 5. From the Alignment Layout toolbar select Line > Fixed Line - Best Fit

 6. From the Tangent by Best Fit dialog select From COGO points
 7. OK
 8. Select the south-most grouping of points, and the one point just north of that group.
 9.  Enter 

 10. Review the Regression Graph and click the green check mark in the upper right corner to 
close it and create the alignment.

 11. Save

Create second fixed line – best fit entity

Exercise files: ali-creat-best-fit-frm-pnt-03-data-C3D16.zip

ali-creat-best-fit-frm-pnt-03.mp4 1:58

 1. Open AliProf-STH25-Best-Fit.dwg.
 2. Select the Sth25-Best-Fit alignment.
 3. Select the Geometry Editor.
 4. From the Alignment Layout toolbar select Line > Fixed Line - Best Fit  
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 5. From the Tangent by Best Fit dialog select From COGO points  
 6. OK
 7. Select the north-most grouping of points, and the one point just south of that group.
 8. Enter 
 9. Review the Regression Graph and click the green check mark in the upper right corner to 

close it and create the alignment.
 10. Save

Create free  curve – best fit entities

Exercise files: ali-creat-best-fit-frm-pnt-04-data-C3D16.zip

ali-creat-best-fit-frm-pnt-04.mp4 2:53

 1. Open AliProf-STH25-Best-Fit.dwg.
 2. Select the Sth25-Best-Fit alignment.
 3. Select the Geometry Editor.
 4. From the Alignment Layout toolbar select Curve > Free Curve – Best Fit

 5. Graphically select the tangent alignment entity at the south of the project.
 6. In the Curve by Best Fit dialog select the From COGO points option
 7. OK
 8. Graphically select the points that are grouped in the lower part of the southern curve.
 9. Enter  to end the selection process.

 10. In the Regression Graph scroll to the bottom and turn on the Pass Through option for the 
last point.

 11. Click the green check mark in the upper right corner to close it and create the align-
ment.
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 12. Zoom into the curve that was just created and graphically select it.
 13. Shift + right click > None
 14. Select the circular grip point at the mid-point of the curve. 
 15. Drag the grip point back to be in line with the COGO point objects.

Intersection edgeline geometry creation

Last updated: 2017-06-06

Total video time: 25:28

Insert south intersection dynamic block

Exercise files: ali-int-edglin-geom-creat-01-data-C3D16.zip

ali-int-edglin-geom-creat-01.mp4 3:18

 1. Open Crdr-Int-CthE-RiverRd.dwg
 2. Home tab > Layer panel> Layer Properties 
 3. New Layer  

 4. Name new Layer P_Int_Block_NPLT
 5. Mark the Plot Column. 
 6. Close the Layer Manager box.
 7. Open the WisDOT Design tab.
 8. Palettes ON/OFF

 9. Parametric Design panel > Intersection Blocks

Tip: Refer to SDD 9a1: At-Grade Side Road Intersections for type A, B1, B2, C, 
and D.
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 10. Int-Type-B-Tan

 11. Hover near where the south-main road alignment crosses the center line of the sec-
ondary road. 

 A. Shift + right-click > Apparent Intersect 
 I. Snap to that point. 

Adjust south intersection dynamic block

Exercise files: ali-int-edglin-geom-creat-02-data-C3D16.zip

ali-int-edglin-geom-creat-02.mp4 2:39

 1. Open Crdr-Int-CthE-RiverRd.dwg
 2. Select on the block.
 3. Hover over dark blue origin grip point, left-click.

 A. Right-click > Rotate
 I. Shift + right-click > Nearest

 II. Snap to the edge of roadway.
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 4. Left click the blue directional arrow. 

 A. Shift + right-click > Nearest
 B. Snap to the center-line of the secondary road.

 5. Select block.
 A. Right-click > Properties

 I. Scroll to Custom field.
 II. SRLaneWidth = 10

 III. W = 15

 6. Close the Palette. 

Insert north intersection dynamic block and make adjustments

Exercise files: ali-int-edglin-geom-creat-03-data-C3D16.zip

ali-int-edglin-geom-creat-03.mp4 1:39

 1. Open Crdr-Int-CthE-RiverRd.dwg
 2. Intersection Layout palette > Int-Type-B-Tan
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 3. Shift+ right click > Apparent Intersect
 A. Snap to north edge lane.

 4. Select on the block. 
 A. Left-click in grip edit.
 B. Right-click > Rotate
 C. Shift + right-click > Nearest
 D. Snap to west-side of line. 
 E. Left click the blue directional arrow.
 F. Shift + right-click > Nearest
 G. Snap to the center-line of the secondary road.

 5. Select block.
 A. Right-click > Properties
 B. Scroll to Custom field.
 C. SRLaneWidth = 10
 D. W = 15

 6. Esc
 7. Select blocks.
 8. Home tab > Layer panel > Layer Manager pull-down menu

 A. Select the P_Int_Block_NPLT layer

Create curb and gutter edge lines for NW and NE quadrants

Exercise files: ali-int-edglin-geom-creat-04-data-C3D16.zip

ali-int-edglin-geom-creat-04.mp4 2:58

 1. Open Crdr-Int-CthE-RiverRd.dwg
 2. Home tab > Create Design > Alignment > Alignment Creation Tools 

 A. Change the name to Int-CthE-RiverRd-NW-CG.
 B. Change the Alignment style to RDWY Curb&Gutter Flange.
 C. Change the Alignment label set to _No Labels.
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 3. OK
 4. Line Tool > Fixed Line (Two Points).

 A. O-Snap to the top of the North-West intersection.
 B. O-Snap to the end of the curve.
 C. Right-click to set the points. 

 5. Curve Tool > Fixed Curve (Three Points)
 A. O-Snap to the start of the curve.
 B. Shift + right-click > Midpoint
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 C. Select the endpoint of the curve
 D. Right-click to set the points. 

 6. Line Tool > Fixed Line (Two Points)
 A. O-Snap to the end of the curve.
 B. Shift + right-click > Endpoint
 C. Select the endpoint of the line
 D. Right-click to set the points. 

 7. Home tab > Create Design > Alignment > Alignment Creation Tools 
 A. Change the name to Int-CthE-RiverRd-NE-CG.
 B. Leave the rest of the selections as is. 
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 8. OK
 9. Line Tool > Fixed Line(Two Points)

 A. O-Snap to the bottom of the North-East intersection.
 B. O-Snap to the end of the curve.
 C. Right-click to set the points. 

 10. Curve Tool > Fixed Curve(Three Points)
 A. O-Snap to the end of the curve.
 B. Shift + right-click > Midpoint

 11. Select the start of the curve. 
 12. Right-click to set the points. 
 13. Line Tool > Fixed Line (Two Points)

 A. O-Snap to the end of the curve.
 B. Shift + right-click > Endpoint
 C. Select the endpoint of the line
 D. Right-click to set the points. 

Create curb and gutter edgelines for SW and SE quadrants

Exercise files: ali-int-edglin-geom-creat-05-data-C3D16.zip

ali-int-edglin-geom-creat-05.mp4 1:32

 1. Open Crdr-Int-CthE-RiverRd.dwg
 2. Home tab > Create Design > Alignment > Alignment Creation Tools 

 A. Change the name to Int-CthE-RiverRd-SW-CG
 B. Change the Alignment style to RDWY Curb&Gutter Flange
 C. Change the Alignment label set to _No Labels
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 3. OK
 4. Line Tool > Fixed Line (Two Points).

 A. O-Snap to the start of the South-West intersection.
 B. O-Snap to the end of the curve.
 C. Right-click to set the points. 

 5. Curve Tool > Fixed Curve (Three Points)
 A. O-Snap to the start of the curve.
 B. Shift + right-click > Midpoint
 C. Select the endpoint of the curve. 
 D. Right-click to set the points. 
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 6. Line Tool > Fixed Line (Two Points)
 A. O-Snap to the end of the curve.
 B. Shift + right-click > Endpoint
 C. Select the endpoint of the line
 D. Right-click to set the points. 

 7. Home tab > Create Design > Alignment > Alignment Creation Tools 
 8. Change the name to Int-CthE-RiverRd-SE-CG.

 A. Leave the rest of the selections as is. 

 9. OK
 10. Line Tool > Fixed Line (Two Points)

 A. O-Snap to the bottom of the South-East intersection.
 B. O-Snap to the end of the curve.
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 C. Right-click to set the points. 
 11. Curve Tool > Fixed Curve(Three Points)

 A. Shift + right-click > Midpoint
 B. Select the start of the curve. 
 C. Right-click to set the points. 

 12. Line Tool > Fixed Line (Two Points).
 A. O-Snap to the end of the curve.
 B. Shift + right-click > Endpoint
 C. Select the endpoint of the line
 D. Right-click to set the points. 

Create CthE ETW edgelines

Exercise files: ali-int-edglin-geom-creat-06-data-C3D16.zip

ali-int-edglin-geom-creat-06.mp4 2:49

 1. Open Crdr-Int-CthE-RiverRd.dwg
 2. Home tab > Create Design > Alignment > Alignment Creation Tools 

 A. Change the name to CthE-L-ETW.
 B. Change the Alignment style to RDWY Pavement Edge.

 3. OK
 4. Tan-Tan(No Curves)

 5. On the north side of CTH E, endpoint OSNAP to:
 A. the west end of the lane transition.
 B. the west transition line connects to the NW curb and gutter
 C. the east transition line connects to the NE curb and gutter
 D. the east transition meets the ten foot extension of the NE curb and gutter
 E. the widened lane transition ends
 F. the bend in the transition lane
 G. east end of the widened lane transition
 H. the east end of the ten foot transition extension

 6. Right-click to end the Draw Tangent command.
 7. Close the toolbar.
 8. Home tab > Create Design > Alignment > Alignment Creation Tools 

 A. Change the name to CthE-R-ETW.
 9. OK

 10. Tan-Tan(No Curves)
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 11. on the south side of CTH E, endpoint OSNAP to: 
 A. the west end of the ten foot extension of the lane transition.
 B. the west end of the transition line
 C. the west transition line bend
 D. the west transition meets the ten foot extension of the SW curb and gutter
 E. the west transition line connects to the SW curb and gutter
 F. the east transition line connects to the SE curb and gutter
 G. the east transition meets the ten foot extension of the NE curb and gutter
 H. the widened lane transition ends
 I. the east end of the ten foot transition extension

 12. Right-Click to end the Draw Tangent command.
 13. Close the toolbar

Create CthE EPS edgelines

Exercise files: ali-int-edglin-geom-creat-07-data-C3D16.zip

ali-int-edglin-geom-creat-07.mp4 1:43

 1. Open Crdr-Int-CthE-RiverRd.dwg
 2. Home tab > Create Design > Alignment > Alignment Creation Tools 

 A. Change the name to CthE-L-EPS
 B. Change the Alignment style to RDWY Shoulder Paved. 
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 3. OK
 4. Tan-Tan(No Curves)

 5. Snap to the end of the paved shoulder, end of the transition, end of the line.
 6. Right-Click to lock in the points.
 7. Close the tool bar. 
 8. Home tab > Create Design > Alignment > Alignment Creation Tools 

 A. Change the name to CthE-R-EPS
 B. OK
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 7. Snap to the end of the lane, the end of the transition, and the end of the paved shoulder. 
 8. Right-Click to lock in the points.
 9. Close the tool bar.

Create CthE EGS edgelines

Exercise files: ali-int-edglin-geom-creat-08-data-C3D16.zip

ali-int-edglin-geom-creat-08.mp4 1:42

 1. Open Crdr-Int-CthE-RiverRd.dwg
 2. Home tab > Create Design > Alignment > Alignment Creation Tools 

 A. Change the name to CthE-L-EGS
 B. Change the Alignment style to RDWY Shoulder Aggregate. 
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 3. OK
 4. Tan-Tan(No Curves)

 5. On the north side of CTH E, endpoint OSNAP to:
 A. the west end of the EGS line.
 B. the west EGS line bends before the NW curb and gutter
 C. the west EGS connects to the NW curb and gutter
 D. the east EGS connects to the NE curb and gutter
 E. the east EGS transition bend
 F. the east end of the EGS line

 6. Right-Click to end the Draw Tangent command.
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 7. Close the toolbar.
 8. Home tab > Create Design > Alignment > Alignment Creation Tools 

 A. Change the name to CthE-R-EGS.

 9. OK
 10. Tan-Tan(No Curves)
 11. On the south side of CTH E, endpoint OSNAP to:

 A. the west end of the EGS
 B. the west EGS bend in transition line
 C. the west end of the EGS where it matches the SW curb and gutter
 D. the east end of the EGS where it matches the SE curb and gutter 
 E. the east EGS line bends after the SE curb and gutter
 F. east end of the EGS line. 

 12. Right-Click to end the Draw Tangent command.
 13. Close the tool bar.

Create RiverRd ETW edgelines
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Exercise files: ali-int-edglin-geom-creat-09-data-C3D16.zip

ali-int-edglin-geom-creat-09.mp4 2:07

 1. Open Crdr-Int-CthE-RiverRd.dwg
 2. Home tab > Create Design > Alignment > Alignment Creation Tools 

 A. Change the name to RiverRd-L-ETW.
 B. Change the Alignment style to RDWY Shoulder Aggregate

 3. OK
 4. Tan-Tan(No Curves)

 5. Starting at the south end 
 A. snap to the end of the extension
 B. snap to the beginning of the transition
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 C. snap to the end of transition.
 6. Jump to the other side

 A. snap to where it touches the curve
 B. snap to where it returns back to the pavement
 C. snap to the end of the extension
 D. snap to the end of the 10 foot extension. 

 7. Right-Click to lock in the points.
 8. Close the tool bar.
 9. Home tab > Create Design > Alignment > Alignment Creation Tools 

 A. Change the name to RiverRd-R-ETW.

 10. OK
 11. Tan-Tan(No Curves)

 A. the south end of the ETW at the 10' extension
 B. the south end of the transition lane line
 C. the south end where the transition line meets the SW curb and gutter
 D. the north end where the transition line meets the curb and gutter
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 E. the north end where the transition meets the 10' extension of the curb and gutter
 F. the north end of transition line
 G. the north end f the 10' extension of the transition line

 12. Right-Click to end the Draw Tangent command.
 13. Close the toolbar.

Create RiverRd EGS edgelines

Exercise files: ali-int-edglin-geom-creat-10-data-C3D16.zip

ali-int-edglin-geom-creat-10.mp4 1:43

 1. Open Crdr-Int-CthE-RiverRd.dwg
 2. Home tab > Create Design > Alignment > Alignment Creation Tools 

 A. Change the name to RiverRd-L-EGS.
 B. Change the Alignment style to RDWY Shoulder Aggregate
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 3. OK
 4. Tan-Tan(No Curves)

 5. on the west side of River Rd, endpoint OSNAP to:
 A. the south end of the EGS
 B. the south end where the EGS line meets the SW curb and gutter
 C. the north end where the EGS line meets the curb and gutter
 D. the north end of the EGS

 6. Right-click to end the Draw Tangent command.
 7. Close the toolbar.
 8. Home tab > Create Design > Alignment > Alignment Creation Tools 

 A. Change the name to RiverRd-R-EGS.
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 9. OK
 10. Tan-Tan(No Curves)
 11. on the east side of River Rd, endpoint OSNAP to:

 A. the south end of the EGS
 B. the south end where the EGS line meets the SW curb and gutter
 C. the north end where the EGS line meets the curb and gutter
 D. the north end of the EGS

 12. Right-Click to end the Draw Tangent command.
 13. Close the toolbar

Create layers for edgeline alignments

Exercise files: ali-int-edglin-geom-creat-11-data-C3D16.zip

ali-int-edglin-geom-creat-11.mp4 2:38

 1. Home tab > Layer panel > Layer Properties
 2. New Layer 

 A. Name the new layer P_RDWY_LaneEdge-L.
 B. Enter

 3. Create another new layer.
 A. Name this new layer P_RDWY_LaneEdge-R.
 B. Enter

 4. Create another new layer.
 A. Name this new layer P_RDWY_ShldAgg-L.
 B. Enter

 5. Create another new layer.
 A. Name this new layer P_RDWY_ShldAgg-R.
 B. Enter

 6. Create another new layer.
 A. Name this new layer P_RDWY_ShldPaved-L.
 B. Enter

 7. Create another new layer.
 A. Name this new layer P_RDWY_ShldPaved-R.
 B. Enter

 8. Close the Layer Properties manager.

Assign edgeline alignments to layers

Exercise files: ali-int-edglin-geom-creat-12-data-C3D16.zip
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ali-int-edglin-geom-creat-12.mp4 4:25

 1. Left-Click on the north side of CTH E and the west side of River Rd
 A. Right-click > Properties
 B. Select the Layer pull-down.
 C. Select P_RDWY_LaneEdge-L
 D. ESC

 2. Select the south side of CTH E and the east side of River Rd.
 A. With both selected Right-click > Properties
 B. Select the Layer pull-down.
 C. Select P_RDWY_LaneEdge-R
 D. ESC

 3. Select the paved shoulder west of CTH E.
 A. With both selected Right-click > Properties
 B. Select the Layer pull-down.
 C. Select P_RDWY_ShldPaved-L
 D. ESC

 4. Select the paved shoulder on the left hand side of CTH E.
 A. With both selected Right-click > Properties
 B. Select the Layer pull-down.
 C. Select P_RDWY_ShldPaved-R
 D. ESC

 5. Select the shoulder aggregate left of CTH E and the shoulder aggregate west side of 
River Rd.

 A. With both selected Right-click > Properties
 B. Select the Layer pull-down.
 C. Select P_RDWY_ShldAgg-L
 D. ESC

 6. Select the shoulder aggregate right of CTH E and the shoulder aggregate east side of 
River Rd.

 A. With both selected Right-click > Properties
 B. Select the Layer pull-down.
 C. Select P_RDWY_ShldAgg-R.
 D. ESC

 7. Select all the Curb&Gutter radii. 
 A. With both selected Right-click > Properties
 B. Select the Layer pull-down.
 C. Select P_RDWY_C_and_G.
 D. ESC

 8. Close out the Properties Dialogue box.

Create data shortcuts

Page: 403

Published on: 2/21/2018

Intersection edgeline geometry creation

http://www.c3dkb.dot.wi.gov/video/ali/ali-int-edglin-geom-creat-12.mp4


Exercise files: ali-int-edglin-geom-creat-13-data-C3D16.zip

ali-int-edglin-geom-creat-13.mp4 1:38

 1. Open Crdr-Int-CthE-RiverRd.dwg
 2. Save
 3. Prospector > Right-click on Data Shortcuts [] > Create Data Shortcuts

 4. Click on Centerline Alignments to select all the alignments.
 5. OK

Mask CthE ETW and EGS edgelines in intersection

Exercise files: ali-int-edglin-geom-creat-14-data-C3D16.zip
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ali-int-edglin-geom-creat-14.mp4 2:51

 1. Open Crdr-Int-CthE-RiverRd.dwg
 2. Select on the north ETW alignment. 

 A. Home tab > Modify panel> Alignment Properties

 B. Go to the Masking tab.
 C. Create Masking Station.
 D. Endpoint Snap to:

 I. ETW where it matches to the NW curb and gutter
 II. ETW where it matches to the NE curb and gutter.

 E. OK
 F. ESC

 3. Select on the north EGS alignment. 
 A. Go to the Masking  tab
 B. Create Masking Station.
 C. Endpoint Snap to:

 I. EGS where it matches to the NW curb and gutter
 II. EGS where it matches to the NE curb and gutter.

 D. OK
 E. ESC

 4. Select on the south ETW alignment. 
 A. Endpoint Snap to:

 I. ETW where it matches to the NW curb and gutter
 II. ETW where it matches to the NE curb and gutter.

 B. OK
 C. ESC to release the ETW.

 5. Select on the south EGS alignment. 
 A. Endpoint Snap to:

 I. EGS where it matches to the NW curb and gutter
 II. EGS where it matches to the NE curb and gutter.

 6. OK
 7. ESC to release the EGS

Mask RiverRd ETW and EGS edgelines in intersection
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Exercise files: ali-int-edglin-geom-creat-15-data-C3D16.zip

ali-int-edglin-geom-creat-15.mp4 2:38

 1. Open Crdr-Int-CthE-RiverRd.dwg
 2. Select on the River Rd west ETW alignment. 

 A. Home tab > Modify panel> Alignment Properties

 B. Go to the Masking tab.
 C. Create Masking Station.
 D. Endpoint Snap to where the west ETW line intersects the SW curb and gutter.
 E. Endpoint snap to where the west ETW line intersects the NW curb and gutter.
 F. OK
 G. ESC

 3. Select on the River Rd east ETW alignment. 
 A. Home tab > Modify panel> Alignment Properties

 B. Go to the Masking tab.
 C. Create Masking Station.
 D. Endpoint Snap to where the west ETW line intersects the SE curb and gutter.
 E. Endpoint snap to where the west ETW line intersects the NE curb and gutter.
 F. OK
 G. ESC

 4. Select on the River Rd west EGS alignment. 
 A. Home tab > Modify panel> Alignment Properties
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 B. Go to the Masking tab.
 C. Create Masking Station.
 D. Endpoint Snap to where the west EGS line intersects the SW curb and gutter.
 E. Endpoint snap to where the west EGS line intersects the NW curb and gutter.
 F. OK
 G. ESC  

 5. Select on the River Rd east EGS alignment. 
 A. Home tab > Modify panel> Alignment Properties

 B. Go to the Masking Tab.
 C. Create Masking Station.
 D. Endpoint Snap to where the east EGS line intersects the SE curb and gutter.
 E. Endpoint snap to where the east EGS line intersects the NE curb and gutter.
 F. OK
 G. ESC  

Mask curb return extensions

Exercise files: ali-int-edglin-geom-creat-16-data-C3D16.zip

ali-int-edglin-geom-creat-16.mp4 2:47

 1. Beginning in the Northwest Quadrant select on the alignment. 
 2. Home tab > Modify panel> Alignment Properties

 A. Go to the Masking tab.
 B. Create Masking Station.
 C. Starting at the North end of the block

 I. Endpoint Snap to the beginning of the curb return extension.
 II. Endpoint snap to where the curb return actually begins.

 D. Create Masking Station.
 E. From the South end of the block.

 I. Endpoint snap to where the curb return actually begins.
 II. Snap to the beginning of the curb return extension.

 F. OK
 G. ESC

 3. Beginning in the Northeast Quadrant select on the alignment. 
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 4. Home tab > Modify panel> Alignment Properties
 A. Go to the Masking tab.
 B. Create Masking Station.
 C. Starting at the east end of the block

 I. Endpoint Snap to the beginning of the curb return extension.
 II. Endpoint snap to where the curb return actually begins.

 D. Create Masking Station.
 E. From the North end of the block.

 I. Endpoint snap to where the curb return actually begins.
 II. Snap to the beginning of the curb return extension.

 F. OK
 G. ESC

 5. Beginning in the Southwest Quadrant select on the alignment. 
 6. Home tab > Modify panel> Alignment Properties

 A. Go to the Masking tab.
 B. Create Masking Station.
 C. Starting at the west end of the block

 I. Endpoint Snap to the beginning of the curb return extension.
 II. Endpoint snap to where the curb return ends.

 D. Create Masking Station.
 E. From the South end of the block.

 I. Endpoint snap to where the curb return ends.
 II. Snap to the beginning of the curb return extension.

 F. OK
 G. ESC

 7. Beginning in the Southeast Quadrant select on the alignment. 
 8. Home tab > Modify panel> Alignment Properties

 A. Go to the Masking tab.
 B. Create Masking Station.
 C. Starting at the South end of the block

 I. Endpoint Snap to the beginning of the curb return extension.
 II. Endpoint snap to where the curb return ends.

 D. Create Masking Station.
 E. From the South end of the block.

 I. Endpoint snap to where the curb return actually begins.
 II. Snap to the beginning of the curb return extension.

 F. OK
 G. ESC

 9. Home tab > Layers panel> Layer pull down
 A. Type in P_INT_BLOCK_NPLT
 B. Freeze the layer 

 10. Save

Edit CthE geometry and linework
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Exercise files: ali-int-edglin-geom-creat-17-data-C3D16.zip

ali-int-edglin-geom-creat-17.mp4 2:46

 1. Open Crdr-Int-CthE-RiverRd.dwg

Tip: This is only to show the edit process, should that be necessary. This will not 
be part of the regular creation workflow.

 2. Home tab > Layer panel > Layer Panel Pull-down
 A. Find the P_Int_Block_NPLT layer and thaw it. 

 3. Select on the northern block.
 A. Right-click > Properties
 B. Scroll down to Custom. 
 C. R1 = 50

 D. Close the window.
 E.  ESC to let go of the block.
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 4. Select on the block. 
 A. Select on the alignment for the curb-return.
 B. Grab the end point of the alignment and move it to the end.
 C. Grab the end of the straight portion and move it to the end of the curb.
 D. On the top half of the block grab the end point of the alignment and move it to 

the end.
 E. Grab the end of the straight portion and move it to the end of the curb.

 5. Select on the ETW.
 A. Move the end of the ETW to the intersection point. 

 6. Select on the EGS.
 A. Move the top end point to the end of the EGS line.
 B. Move the end point to where the EGS line matches the curb and gutter.
 C. ESC

 7. Select (2:30 Mark) 
 8. Snap overlap to the end of the block.
 9. Snap the corner to the end of transition.

 10. ESC
 11. Select the EGS and snap that to the end of the EGS line.
 12. Repeat the steps for the top half of the curve.

Edit RiverRd geometry and linework and masks

Exercise files: ali-int-edglin-geom-creat-18-data-C3D16.zip

ali-int-edglin-geom-creat-18.mp4 2:51

 1. Open Crdr-Int-CthE-RiverRd.dwg
 2. Select on the ETW.

 A. Select on the end point of the ETW an move it to the end of the transition. 
 B. Move the ETW match point to curb to the new location of the end of the curb.
 C. ESC

 3. Select on the EGS line.
 A. Select on the end point of the EGS and move it to the end of the transition. 
 B. Move the EGS match point with the curb to the new location of the end of the 

curb.
 C. ESC

 4. Select on the West EGS alignment.
 5. Home tab > Modify panel> Alignment Properties

 A. Click on the Masking tab.
 B. Select the Start Station inside Region 1.
 C. Select from Screen Icon.
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 D. Endpoint OSNAP to the end of the curb and gutter.
 E. OK
 F. ESC

 6. Select on the West ETW alignment.
 7. Home tab > Modify panel> Alignment Properties

 A. Click on the Masking tab.
 B. Select the Start Station inside Region 1.
 C. Select from Screen Icon.
 D. Endpoint OSNAP to the end of the curb and gutter
 E. OK
 F. ESC

 8. Select on the North ETW alignment.
 9. Home tab > Modify panel> Alignment Properties

 A. Click on the Masking tab.
 B. Select on the North EGS alignment.
 C. Select the Start Station inside Region 1.
 D. Select from Screen Icon.
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 E. Select back of curb endpoint.
 F. OK
 G. ESC

 10. Select on the North EGS alignment.
 11. Home tab > Modify panel> Alignment Properties

 A. Click on the Masking tab.
 B. Select the End Station inside Region 1.
 C. Select from Screen Icon.
 D. Select back of curb endpoint.
 E. OK.
 F. ESC

 12. Grab the end of the EGS alignment and snap it to the new location of the end of the EGS.
 A. ESC

 13. Grab the ETW alignment and snap it to the new location of the end of the ETW.
 A. ESC

 14. Home tab > Layer panel > Layer Panel Pull-down
 15. Type P_INT_BLOCK_NPLT and select the sunshine icon to freeze the block.

Make edgelines ready for plan production

Last updated: 2017-06-06

Total video time: 12:53

Data reference edgeline alignments into Pavt.dwg

Exercise files: ali-mak-edglin-rdy-pln-prod-01-data-C3D16.zip

ali-mak-edglin-rdy-pln-prod-01.mp4 4:15
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 1. 12345678 > Design Folder > Edgelines Folder > Open pavt.dwg file
 2. Prospector > Right-click on Data Shortcuts [] > Set Working Folder

 A. Open C3D file.
 3. Data Shortcuts > Alignments > Centerline Alignments > Right-click on CthE-L-EGS > 

Create Reference
 A. Alignment style = RDWY Shoulder Aggregate
 B. Label Set = _No Label

 4. OK

 5. Right-Click on CthE-R-EGS > Create Reference
 A. OK

 6. Right-Click on RiverRd-L-EGS > Create Reference
 A.  OK
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 7. Right-Click on RiverRd-R-EGS > Create Reference
 A. OK

 8. Right-Click on the CthE-L-EPS > Create Reference
 A. Alignment style = RDWY Shoulder Paved

 B. OK
 9. Right-Click on the CthE-R-EPS > Create Reference

 A. OK
 10. Right-Click on the CthE-L-ETW > Create Reference

 A. Alignment style = RDWY Pavement Edge

 B. OK
 11. Right-Click on the CthE-R-ETW > Create Reference

 A.  OK
 12. Right-Click on the RiverRd-L-ETW  > Create Reference

 A. OK
 13. Right-Click on the RiverRd-R-ETW > Create Reference

 A. OK
 14. Right-Click on the Int-CthE-RiverRd-NE-CG > Create Reference

 A. Alignment style = RDWY Curb&Gutter Flange
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 B. OK
 15. Right-Click on the Int-CthE-RiverRd-NW-CG  > Create Reference

 A.  OK
 16. Right-Click on the Int-CthE-RiverRd-SE-CG > Create Reference

 A. OK
 17. Right-Click on the Int-CthE-RiverRd-SW-CG  > Create Reference

 A. OK

Create offsets for back of curb edgelines

Exercise files: ali-mak-edglin-rdy-pln-prod-02-data-C3D16.zip

ali-mak-edglin-rdy-pln-prod-02.mp4 4:08

 1. Home Tab > Create Design > Alignment > Create Offset Alignment
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 2. Select NW Curb and Gutter Flange.
 A. Un-Check From Start and To End
 B. Click select from Screen Icon for the start.

 C. Select the North End for the start.
 D. Click the select from screen button for the end.
 E. Snap to the end.
 F. Offsets on right = 1
 G. Incremental offset on right = 36"
 H. Alignment Style = RDWY Curb&Gutter Back
 I. Select the sheet icon in the Alignment layer.

 I. Modifier = None
 II. Base Layer Name = P_RDWY_C_and_GBack
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 J. Alignment label set = _No Labels

 K. OK
 3. Home Tab > Create Design > Alignment > Create Offset Alignment
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 5. Select NE Curb and Gutter Flange.
 A. Un-Check From Start and To End
 B. Click select from Screen Icon for the start.

 C. Select the North End for the start.
 D. Click the select from screen button for the end.
 E. Snap to the end.
 F. Select the sheet icon in the Alignment layer.

 I. Modifier = None
 II. Base Layer Name = P_RDWY C_and_GBack
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 G. OK
 6. Home Tab>Create Design>Alignment > Create Offset Alignment
 7. Select SW Curb and Gutter Flange.

 A. Un-Check From Start and To End
 B. Click select from Screen Icon for the start.

 C. Select the North End from the west end.
 D. Click the select from screen button for the end.
 E. Snap to the south end. 
 F. Select the sheet icon in the Alignment layer

 I. Modifier = None
 II. Base Layer Name = P_RDWY_C_and_GBack

 G. OK
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 8. Home Tab > Create Design > Alignment > Create Offset Alignment
 9. Select SE Curb and Gutter Flange.

 A. Un-Check From Start and To End
 B. Click select from Screen Icon for the start.

 C. Click the select from screen button for the end.
 D. Snap to the east end. 
 E. Select the sheet icon in the Alignment layer.

 I. Modifier = None
 II. Base Layer Name = P_RDWY_C_and_GBack

 F. OK

Create offsets for face  of curb edgelines

Exercise files: ali-mak-edglin-rdy-pln-prod-03-data-C3D16.zip

ali-mak-edglin-rdy-pln-prod-03.mp4 3:14

 1. Home Tab > Create Design > Alignment > Create Offset Alignment
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 2. Select the NW back of curb.
 A. Check From Start and To End
 B. Offsets on left = 1
 C. Offsets on right = 0
 D. Incremental offset on left = 6"
 E. Alignment Style = RDWY Curb&Gutter Face
 F. Select the sheet icon in the Alignment layer.

 I. Modifier = None
 II. Base Layer Name = P_RDWY_C_and_GFace

 G. Alignment label set = _No Labels
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 H. OK
 3. Home Tab > Create Design > Alignment > Create Offset Alignment
 4. Select the NE back of curb.

 A. Select the sheet icon in the Alignment layer.
 I. Modifier = None

 II. Base Layer Name = P_RDWY_C_and_GFace

 B. OK
 5. Home Tab>Create Design>Alignment > Create Offset Alignment
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 6. Select the SW back of curb.
 A. Select the sheet icon in the Alignment layer.

 I. Modifier = None.
 II. Change the Base Layer Name to P_RDWY_C_and_GFace.

 B. OK
 7. Home Tab > Create Design > Alignment > Create Offset Alignment
 8. Select the SW back of curb.

 A. Select the sheet icon in the Alignment layer.
 I. Change the modifier to None.

 II. Change the Base Layer Name to P_RDWY_C_and_GFace.

 B. OK
 9. Save  

Edit curb and gutter offset edgelines

Exercise files: ali-mak-edglin-rdy-pln-prod-04-data-C3D16.zip

ali-mak-edglin-rdy-pln-prod-04.mp4 1:16
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 1. Left-Click on the back of curb.
 2. Select the diamond that appears on the parent flange of curb
 3. Adjust the length of the parent alignment. 

Profiles

Profile basics

Last updated: 2018-02-12

Total video time: 3:44

prfl-basc-01.mp4 3:44

Profiles are sub-entities of alignments. During creation of a profile you will be required to 
assign an alignment.

Definition of important terms:

 l Profile is the actual elevation data..
 l Profile View is the grid and the text around it.
 l Profile Band is the display of profile elevations at the bottom of the profile view grid.

Profile data types:

 l Surface profile can be surface conditions but can also be surfaces from proposed cor-
ridors.

 l Design profile is information you have built yourself.

Profiles are a key element of elevation in design

 l Baseline elevation, where design is initiated.
 l Target elevation that design is going to.

Create surface profile

Last updated: 2018-02-14

Total video time: 21:08

Create surface profile

Exercise files: prfl-data-c3d16.zip

Start with prfl-01.dwg

prfl-creat-srfc-01.mp4 4:42

Quick access toolbar open AliProf-CthE.dwg
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 1. Home Tab > Create Design > Profile > Create Surface Profile option

 2. Click the alignment name drop-down and choose CthE.

Tip: If there is any doubt about which alignment you are dealing with use the 
Select from Screen icon.

 3. In the To Sample section leave the Start and End stations for the entire station length.
 4. You could type the start and end stations, or use the Select from Screen icon to assign 

start and end stations.
 5. Under Surface Selection choose Exist. 

Tip: If there is any doubt about which surface you are dealing you can use 
the green select from screen icon. 

 6.  Add>> to create the profile. 
 A. Check  Sample Offsets: 20
 B. Add>>
 C. Select in the Style field for the 20' offset profile.

 I. Pick Profile Style > drop down menu > RDWY Lane Edge
 D. To delete a profile you just created click Remove.
 E. Click Draw in Profile View.

 

Create Profile View - General Tab

prfl-creat-srfc-02.mp4 2:54 

The Create Profile View  General tab is open.
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 1. Select the CthE alignment.

Tip: If there is any doubt about which alignment you are dealing with use the 
Select from Screen icon.

 2. Profile view name: PV-(<Next Counter(CP)>)
 3. Profile view style: Stations 100' Major: 50' Minor
 4. Profile view layer: P_PROF_Misc
 5. Vertically stacked option: off
 6. Next >

Create Profile View - Station and View Height tabs

prfl-creat-srfc-03.mp4 3:16

The Create Profile View Station Range tab is open.

 1. Automatic option selected.

Tip: You can select User Specified range to shorten the views that need to 
be truncated.

 2.  Next >.
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Profile View Height tab

 1. Automatic profile view height option selected.
 2. select User Specified if you do not have room for the entire height of the profile view.

 A. Type in the Minimum and Maximum elevation.
 B. Select Split profile view to cut missing profile view sections and drop it within 

height limits. 
 I. The Split Station option allows control for what station the split occurs:

 a. Options include Exact, Previous Major, Previous Minor.
 II. The Datum Option allows control for what elevation the split occurs:

 a. Options include Exact, Previous Major, Previous Minor.
 C. Deselect Split profile view

 3.  Next >

Create Profile View - Profile Display Options tab

prfl-creat-srfc-04.mp4 3:20

The Create Profile Display Options tab is open.

In the Profile Display Options tab you can see the profiles tied to the alignment assigned in the 
General Tab.

 1. In the Draw column select both profiles that will appear in the view.
 2. Style column: RDWY Lane Edge.
 3. CthE-Exist row, select the Labels field.

 A. Pick Profile Label Set: _No Labels
 4.  Next >

Create Profile View - Data Bands tab

prfl-creat-srfc-05.mp4 2:03

The Create Profile View - Data Bands tab is open.
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Info: We skipped over the Pipe/Pressure Networks because there are no pipes in 
the file.

 1. Select band set: Elevation Both with High-Low Point (Exist Left Proposed Right)
 2. Location: Bottom of Profile View
 3. Set Band Properties:

 A. Style Elevation Left (Exist), set Profile 1 and Profile 2 to CthE-Exist.
 B. Style Elevation Right (Proposed), set Profile 1 and Profile 2 to Exist - Surface - 

20.000 (1)
 4.  Next >

Create Profile View - Hatch Options tab

prfl-creat-srfc-06.mp4 1:37

The Create Profile View - Hatch Options tab is open.

Info: This page hatches your profile view between two surfaces you define. 

 1.  Cut Area:
 A. Upper Boundary: CthE-Exist
 B. Lower Boundary: Exist-Surface-20.000(1)

 2.  Fill Area:
 A. Upper Boundary: CthE-Exist
 B. Lower Boundary: Exist-Surface-20.000(1)

Tip: Multiple Boundaries can be used if the differences between more than two sur-
faces is required.

To remove hatching areas select the area to remove and click  delete button.

 3. Create Profile View  
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Create a separate profile view

prfl-creat-srfc-07.mp4 3:16

Home Tab > Profile & Section Views > Create Profile View

 1. Select alignment  CthE

Warning: It is important to confirm  the correct alignment has been selected. 

Tip: If there is any doubt about which alignment you are dealing with use the 
Select from Screen icon.

 2.  Next >
 3. User specified range:

 A. Start:  1100
 B. End: 1500  

 4. Next > for Profile View Height tab.
 5. Next > for Profile Display Options tab.

 A. Scroll over to the labels and make sure that both profiles are set to _No labels.
 6. Next > for Data Bands tab.

 A. For Elevation Right(Proposed), set Profile 1 and Profile 2  to Exist-Surface-20.000 
(1).

 7.  Create Profile View .
 8. Click where the lower left corner of the entire profile view should be located, above the 

original profile view.

Warning: When a User Defined station profile view is placed, you are selecting 
where the origin of the view grid is, even if the visible grid does not begin for sev-
eral stations. This can make the view appear shifted too far right. Place the views 
accordingly.

Profile properties and styles

Last updated: 2018-02-09

Total video time: 7:16

Profile styles
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Exercise files: prfl-data-c3d16.zip

Start with prfl-01.dwg

prfl-prprtis-styl-01.mp4 2:28

Change profile style for existing surface profile

 1. Select CthE-Exist profile.
 2. Context ribbon > Modify Profile > Profile Properties > Information tab

 A. Object Style: PROF Proposed
 B.  Apply
 C.  OK

 3. Esc
 4. Select CthE-Exist profile.
 5. Context ribbon > Modify Profile > Profile Properties > Information tab

 A. Object Style: RDWY Lane Edge
 B.  Apply
 C.  OK

 6. Esc

Change profile style for design profile

 1. Select CthE profile.
 2. Context ribbon > Modify Profile > Profile Properties > Information tab

 A. Object Style: PROF Ditch Flow Line
 B.  Apply
 C.  OK

 3. Esc

Profile properties - Profile Data tab

prfl-prprtis-styl-02.mp4 1:42

Select the CthE profile

Context ribbon > Modify Profile > Profile Properties > Information tab.

 1. Name
 2. Description
 3. Object style

Profile Data tab

 1. Statistics of the profile

Profile properties - Design Criteria tab
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prfl-prprtis-styl-03.mp4 1:14

Profile properties dialog > Design Criteria tab

 1. Check Use Criteria Based Design

 2.   ... ellipsis button 
 A. Select _WisDOT Design Criteria 2009.xml
 B.  Open

 3. Minimum K Table > Value field drop down: WisDOT Standard - Desirable Category 1

Profile properties - Profile Locking tab

prfl-prprtis-styl-04.mp4 1:52

Profile properties dialog > Profiles Locking tab

 1. Select the Anchor profile geometry points to alignment geometry points
 2. Select Modify affected entities
 3. Select Notify which entities are affected
 4. OK

Profile view properties

Last updated: 2018-02-12

Total video time: 10:45

Open profile view properties

Exercise files: prfl-data-c3d16.zip

Start with prfl-01.dwg

prfl-vu-prprtis-01.mp4 1:58

Prospector Tab>Alignments>CthE>Profile Views

Right-Click on profile view PV-(1) and select Properties.

Cancel out of the dialogue box.

Left-Click on the grid.

Expand Profile View Properties.
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Select Profile View Properties.

 

Information tab

prfl-vu-prprtis-02.mp4 1:08

The name of the Profile is edited.

Description Field allows you to create a small description of the profile.

Optic Style controls how the grid is displayed and the band information is presented at the bot-
tom.

Station tab

prfl-vu-prprtis-03.mp4 1:21

The Station tab is how long the view is gonig to be covering our profile.

Shows us the Alignment Name.

 l Is not editable.

Allows us to adjust the Station range.

 l The Automatic feature covers the entire length of the alignment.
 l The User specified range allows us to select which portion of the alignment we are deal-

ing with.

Elevation tab

prfl-vu-prprtis-04.mp4 2:52

The elevation tab allows us to work in the elevation of the grid.
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The Automatic feature goes from the lowest height to the highest height for the entire length of 
our profile.

The User specified range allows for us to set what heights we would like the grid to show.

The Split profile view is used when you have requirements on size.

 l The Automatic will detect where the paper ends and should auto cut it for you.
 l Manual is used for selecting where you want the adjustments to take place.

Profiles tab

prfl-vu-prprtis-05.mp4 1:46

The Profiles tab shows us what profiles are used in the view and allows for features of them to 
be edited.

 l The Draw tab controls which Profiles are shown in the view.
 l The Clip Grid is used to clip the grid at one of the profiles.
 l The Split At is for when using automatic split view which then splits at the first major, 

minor, or exact station of the assigned profile.

Bands and Hatch tabs

prfl-vu-prprtis-06.mp4 1:40

The Bands tab displays all the band information that will be displaying at the bottom of the grid.

The Hatch Tab is used for cutting or adding material in the space between the existing and pro-
posed.

Profile layout tools

Last updated: 2018-01-30

Total video time: 9:36

Profile layout by tangent

prfl-lyout-tl-01.mp4 3:37
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 1. Layout toolbar > Draw Tangents > Curve Settings

 2. OK
 3. Layout toolbar > Draw Tangents > Draw Tangents with Curves

 A. Shift right-click Endpoint.
 B. Snap to beginning point of existing profile.

Warning: Make sure you are snapping to the point you intend. Exist-
ing profiles have many small line slopes, and it is easy to snap to an 
incorrect point

 C. Left-click a point to the east, and above the existing profile.
 D. Left-click a point to the east, and below the existing profile.
 E. Right-click to end profile creation.

Profile layout tool Add/Delete PI

prfl-lyout-tl-02.mp4 1:23

 1. Layout toolbar > Draw Tangents > Draw Tangents

 A. Shift right-click Endpoint.
 B. Snap to end of CthE-Prop profile.
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 C. Left-click a point to the east, and above the existing profile.
 D. Left-click a point to the east, and below the existing profile.

 2. Layout toolbar > Insert a PI point

 A. Left-click a point below the CthE-Prop profile, in the middle of a profile slope.
 B. Right-click to end PI point creation.

 3. Layout toolbar > Delete PI point.

 A. Left-click near the PI point that was recently added.

Profile layout tool by data

prfl-lyout-tl-03.mp4 2:03

 1. Close the layout toolbar by clicking the X in the top right.
 2. Home > Create Design > Profile > Profile Creation Tools.

 3. Select on the profile view grid.

 A. Name: CthE-Prop-Data
 B.  OK

 4. Layout toolbar > Insert PVIs - Tabular.

 A. Select Parabolic Curve

Station Elevation Curve Len

1000 890 0

1200 897 200

1400 890 0

 B. OK

Profile layout tool copy design
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prfl-lyout-tl-04.mp4 2:33

 1. Layout toolbar > Copy Profile.

 A. PVI Range: All
 B. Destination profile options: Create new profile

 C. OK
 2.  Esc to release selected profile.
 3. Select the proposed profile.
 4. In the Selection cycling dialog select the top of the profiles listed.

 1. Layout toolbar > Raise/Lower PVI.

 A. Elevation change: -6
 B. PVI Range: All
 C. OK

 2. Select CthE (Copy) profile.
 3.  Delete  

Profile lines and curves

Last updated: 2018-02-09

Total video time: 7:36

Create profiles with lines

Exercise files: prfl-data-c3d16.zip

Start with prfl-01.dwg

prfl-lin-crv-01.mp4 2:48
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 1. Home tab > Create Design > Profile > Profile Creation Tools

 A. Select on the profile view grid.
 B. Name: CthE-Prop-2
 C. OK

 2. Layout toolbar > Lines > Fixed Tangent (Two Points)

 A. Shift right-click Endpoint.
 B. Snap to the end of the existing profile.
 C. Click a point to the east, along the existing profile.
 D. Right-click to end the line creation.

 3. Layout toolbar > Lines > Fixed Tangent (Two Points).
 A. Click two points along the existing profile line.
 B. Right-click to end the line creation.

Create profiles with curves

prfl-lin-crv-02.mp4 4:48

 1. Layout toolbar > Curves > Free Curves > Free Vertical Curve (Parabola).

 A. Select the incoming slope tangent.
 B. In Selection Cycling dialog select the top profile.

 C. Select the outgoing slope tangent.
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 D. In Selection Cycling dialog select the top profile.

 E.  R Enter
 F.  1000 Enter

 2. Layout toolbar > Curves > Floating Curves > Floating Vertical Curve (Parameter, 
through point).

 A. Select the incoming slope tangent.
 B. Enter
 C. Click a point to the east that completes the curve.
 D. If the point you want to select creates a red X image there is not enough room to 

mathematically complete the curve.
 3. Layout toolbar > Lines > Floating Lines > Floating Tangent (Through point).

 A. Select the curve entity at the end of the design.
 B. The line will always be tangent to the curve.
 C. Click a point to the east near the end of the exiting profile.
 D. If the point you want to select creates a red X image there is not enough room to 

mathematically complete the line tangent to the curve.
 E. Right-click to end the line creation.

 4. Layout toolbar > Curves > Fixed Curves > Fixed Vertical Curve (Three point).
 A. This curve will not be tangent to the entities you snap it to.
 B. Shift right-click Endpoint.
 C. Snap to the end of the CthE_Prop-2 profile.
 D. Click a second point to the east that represents the mid-point of a 3-point curve.
 E. Click a point to the east that represents the endpoint of the 3-point curve.
 F. Right-click to end the curve creation.

Create design profile

Last updated: 2018-02-09

Total video time: 9:00

Create design profile

Exercise files: prfl-data-c3d16.zip
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Start with prfl-01.dwg

prfl-creat-dsn-01.mp4 3:59

 1. Home Tab  >  Create Design  >  Profile  > Profile Creation Tools

 2. Select profile view grid.
 3. Select the grid lines, or any grid label (anything but the profile data itself).
 4. Name: CthE-Prop
 5. General tab

 A. Profile style: PROF Proposed
 B. Profile layer: P_PROF_CthE-Prop
 C. Profile label set: WisDOT Standard

 6. Design Criteria tab
 A. Use criteria-based design: Checked
 B. Use design criteria file: _WisDOT Design Criteria 2009
 C. Default criteria: WisDOT Standard - Desirable Category 1
 D. Use criteria-based design: Unchecked
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 E.  OK

Create design profile transparent tools

prfl-creat-dsn-02.mp4 5:01

 1. Home > Create Design > Profile > Profile Creation Tools.
 A. Select the profile view grid
 B. Name the profile CthE-Prop-Trans
 C. In the layout toolbar select the Draw Tangents  > Draw Tangents

 D. Shift right-click Endpoint snap.
 E. Snap to end of existing profile.

 F. Click Profile Station Elevation transparent command 
 I. Select the profile view grid.

 II.  1375  Enter
 III. Left-click a point above the existing profile.

 G. Click the Profile Grade Station transparent command 
 I.  -5  Enter

 II.  2040  Enter
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 H. Click the Profile Grade Station transparent command 
 I.  5  Enter

 II.  904  Enter

 I. Click the Profile Grade Length transparent command 
 I.  2  Enter

 II.  10  Enter
 III.  5  Enter
 IV.  40  Enter
 V. Esc

 J. Esc

Edit design profile

Last updated: 2018-02-12

Total video time: 11:10

Edit design profile with grip points

Exercise files: prfl-data-c3d16.zip

Start with prfl-01.dwg

prfl-edit-dsn-01.mp4 2:37

Endpoint grip point

 1. Select CthE profile.
 2. Left-click the grip point at the end of CtE.
 3. Shift right-click.
 4. Select Endpoint.
 5. Snap the end point snap to the end of the CthE-Exist profile.

Midpoint grip point

 1. Select the square grip point in the middle of the last slope of the CthE profile.
 2. Move the grip point.
 3.  Esc

Curve length grip points

 1. Select the circular grip point at the beginning of the last curve.
 2. Drag it to the right to shorten the length of the curve.
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Curve radius grip point

 1. Select the circular grip point in the middle of the last curve.
 2. Move the grip point up and down to graphically change the radius of the curve.
 3. Esc

PVI grip points

PVI adjusting incoming and outgoing slopes

 1. Grab the triangle grip point that points straight up.
 2. Move it up and down, left and right to move the PVI point.
 3. Esc.

PVI maintain one slope

 1. Select the triangular grip point that points to the right.
 2. Move the grip point left and right to adjust the PVI while holding the incoming tangent.
 3. Esc

Edit design profile through toolbar edits

prfl-edit-dsn-02.mp4 2:14

 1. Select the CthE profile.
 2. Context ribbon > Modify panel > Geometry Editor.

 3. Insert PVI.

 4. Click near the middle slope line.
 5. Delete PVI points.

Page: 442

Published on: 2/21/2018

Edit design profile

http://http//www.c3dkb.dot.wi.gov/video/prfl/prfl-edit-dsn-02.mp4


 6. Click near the PVI point that was just added.
 7. Move PVI.

 8. Select near the sag curve PVI point.
 9. Left-click a new point to the right of the original PVI location.

 10. Esc to end command.

Delete design profile entities

prfl-edit-dsn-03.mp4 1:08

 1. Select the CthE profile.
 2. Context ribbon > Modify Profile > Geometry Editor

 3. Select the Delete Entity icon.

 4. Select the last tangent line.
 5. Left-click on the curve attached to the last tangent line.
 6. In the toolbar select the Undo icon.
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Edit design profile by data grid

prfl-edit-dsn-04.mp4 m:ss

 

In the toolbar select Profile Grid View .

In the third entity row make the following changes:

Variable Value

Station 2097

Elevation 895

Grade In -2.5

Grade Out 3

Profile Curve Length 500

K Value 90

Curve radius 8000

Click the X in the title bar to close the Profile Grid View panorama.

Edit design profile by parameter grid

prfl-edit-dsn-05.mp4 2:21

Select the Select PVI icon.

Select near the PVI at the sag curve.

In the dialog make the following changes:
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Variable Value

Grade In -2.5

Grade Out 3

PVI Station 2079

PVI Elevation 899

Profile Curve Length 400

Low Point Elevation 902

Curve radius 1500

K Value 74

Click the X in the upper right of the dialog.

Esc

Profile labels

Last updated: 2018-02-09

Total video time: 4:36

Profile Label sets

Exercise files: prfl-data-c3d16.zip

Start with prfl-01.dwg

prfl-lbl-01.mp4 1:55

 1. Select the profile view grid.
 2. Context ribbon > Labels > Edit Profile Labels

 A. Select the CthE profile data inside the profile view grid.
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 B.  Import Label Set.
 I. Select the WisDOT Standard [ALI DESC]+00 set.

 II.  OK
 C.  OK

 3.  Esc
 4. Select the profile view grid.
 5. Context ribbon > Labels > Edit Profile Labels
 6. Select the CthE profile data inside the profile view grid.

 A.  Import Label Set.
 I. Select the WisDOT Standard set.

 II.  OK
 B. OK

Profile View labels

prfl-lbl-02.mp4 1:35

 1. Select the profile view grid.
 2. Context ribbon > Labels > Add View Labels > Station Elevation.

 A.  1265 Enter.
 B.  912.65 Enter.
 C. Esc

 3. Select the profile view grid.
 4. Context ribbon > Labels > Add View Labels > Depth.

 A. Select a point inside the profile view grid.
 B. Select a second point inside the profile view grid.
 C. Esc

Removing profile labels

prfl-lbl-03.mp4 1:06

 1. Select one of the labels that needs to be removed.
 2. Context ribbon > Modify > Edit Label Group

 A.  Import Label Set
 B. Select _No Labels
 C. OK

 3. OK
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Create best fit profile

Last updated: 2018-02-12

Total video time: 11:02

Create best fit profile (part 1)

Exercise files: prfl-data-c3d16.zip

Start with prfl-01.dwg

prfl-creat-best-fit-01.mp4 3:59

Warning: The Best Fit alignment creation tool often doesn't work for creating pro-
file design for WisDOT projects. The following is a work flow to create a best fit pro-
file while using tools that are more appropriate for WisDOT design needs.

 1. Home Tab>Create Design Panel > Profile Dropdown > Profile Creation Tools

 A. Left click Profile View Grid
 B. In the Create Profile dialog box:

 1. Name: CthE-Prop-Best Fit
 2. Click OK

 2. On the Profile Layout Tools toolbar
 A. Profile Layout Tools toolbar > Draw Tangents dropdown > Draw Tangents

 B. Shift+Right Click>Endpoint Snap
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 C. Select endpoint of CthE-Exist profile by Left Click
 D. Left click on location of next PVI
 E. Left Click to select an endpoint PVI
 F. Right click to end the command

 G. Adjust tangents with Arrow Grips

 3. Profile Layout Tools toolbar>Curve Dropdown>More Free Vertical Curves>Free Ver-
tical Parabola (PVI based)

 A. Left click near PVI
 B. Type K
 C. Click Enter
 D. Type 45
 E. Click Enter
 F. Click Enter to exit the command

 4. Use the grip points to further edit the profile geometry
 5.  A. Input Type: Surface Profile

 B. Surface profile: CthE-Exist  
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 C. Profile name: CthE-Prop-BestFit
 D.  OK

 6. Check the regression graph against the created profile.

Create best fit profile (part 2)

prfl-creat-best-fit-02.mp4 03:41

Warning: The Best Fit alignment creation tool has been deemed incorrect for cre-
ating profile design for WisDOT projects. The following is a work flow to create a 
best fit profile while using tools that are more appropriate for WisDOT design 
needs.

 1. Profile Layout Tools toolbar>Draw Tangents dropdown>Draw Tangents

 
 2. Profile Layout Tools toolbar>Line Command>Fixed Tangent (Two points)

 3.  A. Left click the desired start point of the tangent
 B. Left click the desired endpoint of the tangent
 C. Left click the desired start point of the 2nd tangent
 D. Left click the desired endpoint of the 2nd tangent
 E. Left click the desired start point of the 3rd tangent
 F. Shift+Right click>Endpoint snap 
 G. Select the endpoint of the CthE-Exist profile
 H. Click Esc.to end command

 4. Profile Layout Tools toolbar>Curve Tool>Free Vertical Curve (Parabola)
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 5. Left Click on Incoming line
 6. Left Click on Outgoing line
 7. Enter the "K" value of 175 Enter
 8. Esc
 9. Profile Layout Tools toolbar>Delete Segment

 10. Left Click on segment to be deleted Enter
 11. Profile Layout Tools toolbar>Curve Tool>Free Vertical Curve (Parabola)
 12. Left Click to select the incoming line
 13. Left Click to select the outgoing line
 14. Enter to accept default "K" value of 36.7
 15. Right Click to end command
 16. Left Click on curve to select it
 17. Profile Layout Tools toolbar>Select PVI

 18. Left Click near PVI point
 19. In the Profile Layout Parameters dialog box enter a new "K" value of 75
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 20. Enter
 21. Close the Profile Layout Parameters dialog, Close the Profile Layout Tools toolbar

Create best fit profile (part 3)

prfl-creat-best-fit-03.mp4 03:23

Warning: The Best Fit alignment creation tool has been deemed incorrect for cre-
ating profile design for WisDOT projects. The following is a work flow to create a 
best fit profile while using tools that are more appropriate for WisDOT design 
needs.

 1. Left Click on CthE-Exist
 2. Contextual Ribbon>Profile Properties
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 3. Profile Properties Dialog Box>Profile Data Tab

 A. Update Method, change to Static
 B. Click OK

 4. Contextual Ribbon>Geometry Editor

 5. Profile Layout Tools toolbar>Copy Profile

 6. Click OK
 7. Click Esc
 8. Select CthE-Exist
 9. Contextual Ribbon>Profile Properties>Profile Properties Dialog box>Profile Data Tab

 A. Update Method, change to Dynamic
 B. Click OK
 A. Contextual Ribbon>Profile Properties>Profile Properties Dialog Box>In-

formation Tab
 B. Change name CthE-Prop-Best Fit
 C. Click OK

 10. Select CthE-Exist [Copy]
 11. Profile Layoout Tools toolbar>Delete PVI

 12. Left Click to remove PVIs
 13. Click Esc

Page: 452

Published on: 2/21/2018

Create best fit profile





Roadway design

Subassemblies and assemblies

Subassembly elements

Last updated: 2018-02-14

Total video time: 04:56

Subassembly elements

Exercise files: sub-asmbly-data-c3d16.zip

Start with CthE.dwg

sa-sub-elemnt-01.mp4 04:56

  1. Hover over subassemblies to highlight
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 2. Point Codes
 l Hover over point codes for more information

 3. Links
 l Hover over links for more information

 4. Shape codes
 l Left Click on CGBasic
 l Contextual Ribbon>Subassembly Properties>Subassembly Properties dialog 
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box>Codes tab

Tip: To re-size point markers and labels, adjust drawing scale

Subassembly parameters

Last updated: 2018-02-14

Total video time: 04:56

Subassembly parameters

sa-sub-prmtr-01.mp4 04:56

Exercise files: sub-asmbly-data-c3d16.zip

Start with CthE.dwg

sa-sub-prmtr-01.mp4 04:56

 1. WisDOT Design tab > Palettes On/Off > Assemblies & Subassemblies > WisDOT & Civil 
Imperial

Page: 456

Published on: 2/21/2018

Subassemblies and assemblies

http://www.c3dkb.dot.wi.gov/video/rdwy-dsn/sub-asmbly/sa-sub-prmtr-01.mp4
http://www.c3dkb.dot.wi.gov/data/rdwy-dsn/sub-asmbly/sub-asmbly-data-c3d16.zip
http://www.c3dkb.dot.wi.gov/video/rdwy-dsn/sub-asmbly/sa-sub-prmtr-01.mp4


 2. Select the Lanes & Shoulders tab of the Tool palette
 3. Left Click on LnExtendBase

 4. Scroll down in the Properties Panel
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 5. Make necessary changes to subassembly parameters
 6. Left Click on Assembly marker
 7. Esc

 

Corridor targets in subassemblies

Last updated: 2018-02-14

Total video time: 03:00

Corridor targets in subassemblies

Exercise files: sub-asmbly-data-c3d16.zip

Start with CthE.dwg

sa-sub-crdr-trgt-01.mp4 03:00

Subbassembly target types

 l Horizontal targets
 l Vertical targets
 l Surface targets

Page: 458

Published on: 2/21/2018

Subassemblies and assemblies

http://www.c3dkb.dot.wi.gov/data/rdwy-dsn/sub-asmbly/sub-asmbly-data-c3d16.zip
http://www.c3dkb.dot.wi.gov/video/rdwy-dsn/sub-asmbly/sa-sub-crdr-trgt-01.mp4


To view the default parameters for a subassembly

 1. Left Click to select subassembly
 2. Contextual ribbon > subassembly Properties
 3. Subassembly properties dialog box > parameters tab

AutoDesk and WisDOT subassemblies

Last updated: 2018-02-14

Total video time: 02:59

Autodesk and WisDOT subassemblies

Exercise files: sub-asmbly-data-c3d16.zip

Start with CthE.dwg

sa-sub-adsk-wisdot-01.mp4 02:59

There are 2 set of subassemblies in the WisDOT template files

Autodesk subassemblies and WisDOT provided subassemblies
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To access subassemblies

 1. Ribbon>WisDOT Design tab>Tools panel>Palettes ON/OFF

 2. Ribbon>WisDOT Desgn tab>Assemblies & Subassemblies panel>WisDOT & Civil Imper-
ial

Page: 460

Published on: 2/21/2018

Subassemblies and assemblies



 3. Left Click on the bottom of the tabs on the tool palette 

WisDOT Subassemblies are ALL CAPS

Do not mix WisDOT and Autodesk Lanes and Shoulders subassemblies

Subassemblies that superelevate

Last updated: 2018-02-14

Total video time: 03:47

Subassemblies that superelevate

Exercise files: sub-asmbly-data-c3d16.zip

Start with CthE.dwg

sa-sub-supr-01.mp4 03:47

To view or modify the superelevation function of a subassembly

Page: 461

Published on: 2/21/2018

Subassemblies and assemblies

http://www.c3dkb.dot.wi.gov/data/rdwy-dsn/sub-asmbly/sub-asmbly-data-c3d16.zip
http://www.c3dkb.dot.wi.gov/video/rdwy-dsn/sub-asmbly/sa-sub-supr-01.mp4


 1. Left Click on Subassembly
 2. Contextual ribbon > Subassembly Properties > Subassembly properties dialog box > 

Parameters tab

 o Scroll down to superelevation data field
 o Left Click in field to access Pick Default Value dialog box

 o Select desired value
 o Ok

Superelevation fields vary from subassembly to subassembly. Check parameters carefully and 
thoroughly.

Conditional subassemblies

Last updated: 2018-02-14

Total video time: 06:11

Conditional subassemblies Cut/fill targets
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Exercise files: sub-asmbly-data-c3d16.zip

Start with CthE.dwg

sa-sub-cndtnl-01.mp4 03:25

To access default conditional subassemblies

 1. Ribbon > WisDOT Design tab > Palettes ON/OFF

 2. Ribbon > WisDOT Design tab > WisDOT & Civil Imperal

 3. Left Click on bottom of tabs in Tool Palette
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 4. select Conditional

 5. Left Click on ConditionalCutFill to access options for the subassembly

Info: The width and slope settings in the parameters of conditional subassemblies 
has no effect on the design. It is purely a visual reference.

Conditional subassemblies Horizontal targets
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sa-sub-cndtnl-02.mp4 02:46

Left Click on ConditionalHorizontalTarget to access options for the assembly.

Info: The width and slope settings in the parameters of conditional subassemblies 
has no effect on the design. It is purely a visual reference.

Subassembly help files

Last updated: 2018-02-14

Total video time: 04:42

Subassembly help files

Exercise files: sub-asmbly-data-c3d16.zip

Start with CthE.dwg

sa-sub-hlp-01.mp4 04:42

To access the subassembly help files

 1. Navigate to desired subassembly in Tool Palette
 2. Right Click on subassembly
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 3. Select Help

Addituionally to access WisDOT subassembly help files

 1. Ribbon > WisDOT Design tab > Subassembly Help

Tip: You can also use the command SHOWWISSUBHELP to access WisDOT sub-
assembly help files.

Assembly basics

Last updated: 2018-02-14

Total video time: 11:42

Assembly basics

Exercise files: sub-asmbly-data-c3d16.zip
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Start with CthE.dwg

sa-asmbly-basc-01.mp4 02:04

Create assembly

sa-asmbly-basc-02.mp4 03:39

 1. Home tab of ribbon > Create Design panel > Assembly drop down > Create Assembly

 A. Name: CthE-10+00 to 25+00
 B. Assembly Type: Other
 C. Assembly Style: WisDOT Standard
 D. Code set style: CRDR Proposed
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 E. OK
 2. Left Click to place assembly
 3. Double check label

Connect subassemblies to assembly

sa-asmbly-basc-03.mp4 02:59

Ribbon > WisDOT Design tab > Palettes ON/OFF > WisDOT & Civil Imperial

 1. LANES tab of TOOL PALETTE
 2. Left click LnExtendBase
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 3. PROPERTIES panel
 i. Lane width: 15

 4. Left click on Assembly marker
 5. Left click on ShldGeneric

 6. Left click on appropriate marker
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 7. Select the DAYLIGHT tab of the tool palette
 8. Left Click DaylightProfileControlled subassembly

 9. Left click on appropriate marker
 10. Right click and select Cancel
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Naming subassemblies in an assembly

sa-asmbly-basc-04.mp4 01:36

 1. Left Click on subassembly
 2. Contextual ribbon > Modify Subassembly panel > Subassembly Properties

 3. Subassembly Properties dialog box  >  Information tab
 4. Name: LnExtendBase-L-TARGETBikeLane
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 5. OK

Referencing subassembly parameters

sa-asmbly-basc-05.mp4 02:24

 1. Left Click on Assembly Marker
 2. Contextual ribbon > Modify assembly > Assembly Properties

 3. Assembly Properties dialog box > Construction tab > Item Window
 4. Left click to Select Left > ShldGeneric
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 5. In the Input values window, scroll down to Paved shoulder slope
 6. Click the Use checkbox

 7. In the Get value from field, select LnExtendBase-L-TARGET-BikeLane.Pavement slope 
[Output]
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 8. OK

Commands to change structure of subassemblies in assemblies

Last updated: 2018-02-14

Total video time: 04:53

Commands to change structure of subassemblies in assemblies

Exercise files: sub-asmbly-data-c3d16.zip

Start with CthE.dwg

sa-asmbly-sub-cmnd-01.mp4 04:53

Important to NOT use the base AutoCAD copy, mirror, or move commands with subassemblies.

Mirror

 1. Select subassemblies to mirror
 2. Contextual ribbon > Modify Subassemblies panel > Mirror
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 3. Select Assembly marker

 4. Esc

Create new assembly

 1. Ribbon > Home tab > Create Design panel > Assembly > Create Assembly

 2. Create assembly dialog > Name field
 3. Type CthE-25+00 to 35+00
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 4. OK

Copy

 1. Select lane subassembly on right side 

 2. Contextual Ribbon > Modify Subassemblies panel > Copy
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 3. Left click on Assembly Marker

 4. Window select all left side subassemblies

 5. Contextual Ribbon > Modify Subassemblies panel > Copy
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 6. Left Click on Assembly marker
 7. Left Click on left side shoulder subassembly

 8. Contextual Ribbon > Modify Subassemblies > Mirror
 9. Left Click on white edge of traveled way marker on right side lane
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Move

 1. Select subassembly to move

 2. Contextual Ribbon > Modify Subassemblies panel > Move
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 3. Left click on subassembly point marker of desired location

Copying entire assemblies

Last updated: 2018-02-14

Total video time: 03:52

Copying entire assemblies

Exercise files: sub-asmbly-data-c3d16.zip

Start with CthE.dwg

sa-asmbly-copy-01.mp4 03:52

Copy Assembly
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 1. Window select entire assembly

 2. Right click>Basic Modify Tools>Copy

 3. Left Click point of displacement
 4. Left Click new location below
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 5. Left Click new location to the right

 6. Enter to end command

Modify copied assemblies and rename

 1. Select Shoulder and Daylight assemblies

 2. Delete
 3. Esc
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 4. Left Click assembly marker
 5. Contextual ribbon>Modify Assembly panel>Assembly Properties>Assembly Prop-

erties dialog box>Information tab
 6. Change name to CthE-25+00 to 35+00

 7. OK
 8. RE Enter to regenerate labels

Editing subassembly parameters in assemblies

Last updated: 2018-02-14

Total video time: 02:33

Editing subassembly parameters in assemblies

Exercise files: sub-asmbly-data-c3d16.zip

Start with CthE.dwg

sa-asmbly-edit-sub-prmtr-01.mp4 02:33

Method 1
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 1. Left Click on Assembly Marker
 2. Contextual ribbon > Modify Assembly panel > Assembly Properties

 3. Assembly Properties dialog box > Construction tab
 4. In the Items window > Baseline > RightLeft Click on LnExtendBase

 5. In the Input Values window, scroll down to Lane Width
 6. Change value to 20
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 7. Apply
 8. OK

Method 2

 1. Left Click on subassembly
 2. Contextual ribbon > Subassembly Properties

 3. Subassembly Properties dialog box > Parameters tab
 4. Input Values window change the Lane width value to 15
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 5. OK

Method 3

 1. Left Click on subassebly
 2. Right Click
 3. Properties

 4. In the Properties panel, scroll down to the parameters
 5. Change lane width value to 16
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 6. Esc

Place WisDOT assembly in modelspace from tool palette

Last updated: 2018-02-14

Total video time: 01:38

Place WisDOT assemby in model space from tool palette

Exercise files: sub-asmbly-data-c3d16.zip

Start with CthE.dwg

sa-asmbly-plac-wisdot-01.mp4 01:38
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 1. Ribbon>WisDOT Design tab>Tools panel>Palettes ON/OFF

 2. Left Click on BEAM GUARD ASSEMBLIES tab

 3. Left Click on Beam Guard assembly
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 4. Left Click desired location in model space
 5. Enter

Create custom assembly

Last updated: 2018-02-14

Total video time: 04:46

Create custom assembly

Exercise files: sub-asmbly-data-c3d16.zip

Start with CthE.dwg

sa-asmbly-creat-cstm-01.mp4 04:46

 1. Home tab of ribbon > Create Design panel > Assembly > Create Assembly

 2. Name new assembly CthE-L-ETW-12+50 to 14+25
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 3. OK
 4. Left click in model space to place assembly
 5. Select the right side lane subassembly from the assembly above

 6. Contextual ribbon > Modify Subassebly panel > Copy
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 7. Left click on assembly marker CthE-L-ETX-12+50 to 14+25
 8. Left click on newly copied subassembly
 9. Contextual ribbon > Modify Subassembly panel > Subassemby Properties

 10. Select the Parameters tab of Subassembly properties dialog box
 11. Change the Pavement slope value to 2
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 12. OK
 13. Select the right side lane assembly from the assembly above
 14. Contextual ribbon > Modify Subassembly > Copy
 15. Left click on white marker of lane assembly

 

 16. Select the right side shoulder and daylight subassemblies from the assembly above
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 17. Contextual ribbon > Modify Subassembly panel > Copy
 18. Left click on white marker of newest lane subassembly

 19. Select the left side shoulder and daylight subassmblies from the assembly above

 20. Contextual ribbon > Modify Subassembly panel > Copy
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 21. Left Click on assembly marker CthE-L-ETW-12+50 to 14+25

Review subassembly parameters

 1. Left click on subassembly
 2. Contextual ribbon > Modify Subassembly panel > Subassembly Properties

 3. Parameters tab of Subassembly Propeties dialog box
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 4. Verify parameters are correct for assembly conditions
 5. OK

WisDOT subassemblies and superelevation (Civil 3D 2012 and beyond)

Last updated: 2015-04-21

WisDOT subassemblies and superelevation (Civil 3D 2012 and beyond) 

Civil 3D 2012 provides new superelevation controls.  This content explains what the new func-
tionality means for users of the WisDOT subassembly library.

The new superelevation functionality is described in the What’s New help file content, accessed 
in the top right corner of Civil 3D interface. You can also view the version upgrade videos at 
ftp://ftp.dot.wi.gov/dtsd/bpd/methods/c3d-trn/wisdot-c3d-train-manual.pdf#190_050_Super-
elevation_changes.

New features
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The C3D2012 stock subassembly library is built to work in tandem with new superelevation con-
trols in the superelevation wizard to add flexibility in defining how corridors handle super-
elevation. If you want to explore the new superelevation controls, build an assembly using 
Autodesk’s LaneSuperelevationAOR subassembly, run through different combinations of super-
elevation configurations, and monitor the changes to the assemblies’ behavior in a corridor. 
Controls like the inputs for Potential Pivot, Slope Direction, and specifying SE side different from 
insertion direction all work to allow flexibility in defining the Axis of Rotation through super-
elevation transitions.

The WisDOT subassembly library is not built to use this functionality. In fact, with some com-
binations of Superelevation wizard inputs, WisDOT subassembly corridors will produce a slew of 
error messages and may not read the intended lane slopes. The WisDOT subassembly library 
already has the superelevation controls needed for WisDOT design standards built into lane and 
shoulder subassembly logic. If you choose to use the WisDOT library for your roadway lanes and 
shoulders, the alignment superelevation should be developed in the superelevation wizard as 
follows:

Page: 496

Published on: 2/21/2018

Subassemblies and assemblies



Page: 497

Published on: 2/21/2018

Subassemblies and assemblies



Page: 498

Published on: 2/21/2018

Subassemblies and assemblies



Remember to run the Superelevation Update macro and you now have the baseline super-
elevation properties needed to use WisDOT subassemblies in your corridors. This same Undi-
vided – Crowned superelevation setup will work for all cases of general roadway design with 
WisDOT subassemblies.

For more information on WisDOT’s superelevation macro and why it is needed, see Civil 3D 
New User Training, alignments module.

WisDOT subassembly inputs

So how do you set up your WisDOT subassemblies’ superelevation controls in this system? For 
detailed information on subassembly behavior, review the subassembly help files. To help you 
get started, here’s a look at several different roadway typical section types:

Case 1: Single lane ramp, crown at lane edge, planar subgrade (shoulder slopes down at crown 
but subgrade continues upward)
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Case 2: Undivided Roadway with crown (Left side same settings as right)
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Case 3: Divided Roadway with median, baseline at median edge or center of median, crown 
between lanes (only showing one of the divided roadways, the other is a mirror image)
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Frequently asked questions

What do you prefer that we do? Use WisDOT lane/shoulder subassemblies, or stock? Should I 
change my assemblies to use the stock subassemblies?

Some possible scenarios: 
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I’m starting a new corridor

My corridor is built, but there’s time to change it

I have a PS&E in 4 months

The choice is yours. We developed the WisDOT subassemblies to use point, link, and shape 
codes that are compatible with the stock subassemblies’ codes, allowing use of WisDOT and 
Autodesk subassemblies side-by-side resulting in consistent surface and corridor output. And, 
with the new superelevation functionality in C3D2012 the Autodesk lanes and shoulders sub-
assembly offerings have the needed controls to develop superelevation as per our design stand-
ards. So you have some flexibility to choose which subassemblies work best for your design 
intentions.

There are limitations to this flexibility however. Each alignment has a single set of super-
elevation properties, and these superelevation properties may need to be different for WisDOT 
subassemblies vs. Autodesk subassemblies because of the differences in subassembly logic. The 
WisDOT subassemblies can’t correctly read the Axis of Rotation information created by some 
input combinations in the Superelevation Wizard, so you shouldn’t use both Autodesk and 
WisDOT lanes/shoulders on the same corridor baseline alignment. For each baseline alignment, 
use all WisDOT subassemblies on superelevated parts of your assemblies, or use all Autodesk 
subassemblies on superelevated parts of your assemblies. Don’t mix up lanes and shoulders sub-
assemblies, or other superelevated subassemblies, on the same baseline alignment. You can 
use non-superelevated WisDOT subassemblies in combination with Autodesk lanes and 
shoulders.

Keep in mind there is other functionality in some of the WisDOT lanes and shoulders that isn’t 
currently in the stock subassemblies. So you have to choose what’s right for your situation. 

Are you telling us to never use “Use Inside Lane SE”? What about an urban roadway with park-
ing lanes where the parking lane slope varies to match adjacent properties? Wouldn’t we need 
to use inside and outside lane superelevation there?

You can still use Inside Lane superelevation definition for situations that need it. WisDOT sub-
assemblies will correctly read the Inside Lane SE data. To include the Inside Lane Super-
elevation containers in an alignment’s superelevation properties, use a number value of 2 in 
the Number of lanes field in the Lanes dialog box of the Superelevation Wizard, other settings 
are as shown above.
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You probably will not get design-ready results from the Superelevation Wizard in this scenario; 
you may have to do some manual editing of the lane slope values and transition locations in the 
tabular editor. 
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Another way to do mass changes is to the tabular editor superelevation data is to export to a 
csv file, edit the csv file in Microsoft Excel, and import the edited csv back into the alignment’s 
tabular editor superelevation data. A csv file is a comma-separated value file that can be 
opened in Excel and edited with common spreadsheet copy-paste functions.

Corridor modeling fundamentals

Corridor basics

Last updated: 2018-02-12

Total video time: 03:14

crdr-basc-01.mp4 03:14

crdr-basc-data-c3d16.zip

Corridor Object - A 3 dimensional object built from horizontal, vertical and cross sectional geo-
metry.

Alignment - Controls the horizontal geometry of a corridor object

Profile - Controls the vertical geometry of a corridor object

Assembly - Controls the cross sectional geometry of a corridor object

Corridor properties

Last updated: 2018-02-14

Total video time: 08:03

Regions

Exercise files: crdr-data-c3d16.zip

Start with CthE.dwg

crdr-prprtis-01.mp4 02:31

Regions of a corridor are defined by a station range and an assembly
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To set the station range

 1. Left click in the Start Station column
 2. Type 1000
 3. Left click in the End Station Column
 4. Type 3250

 5. Enter

 

Frequency

crdr-prprtis-02.mp4 05:32

Frequency defines how often the assembly is applied along the baseline

To adjust frequency
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 1. Left click the ellipses in the frequency column

 2. Adjust frequency settings
 1. Along tangents 10
 2. Along curves At an incriment
 3. Curve increment 5
 4. Along spirals 25
 5. At alignment geometry points Yes
 6. At superelevation critical points Yes
 7. Along profile curves 5
 8. At profile geometry points Yes
 9. At high/low points Yes

 10. At offset target geometry points Yes
 11. Adjacent to offset target start/stop Yes
 12. Along offset target curves At an increment
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 13. Curve increment 5

 3. Add Additional stationing
 4. Left click Plus sign

 5. Type 1717.14
 6. Enter
 7. OK
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Create corridor

Last updated: 2018-02-14

Total video time: 01:51

Create corridor

Exercise files: crdr-data-c3d16.zip

Start with CthE.dwg

crdr-creat-01.mp4 01:51

 1. Home tab of ribbon>Create Design panel>Corridor

 2. Name the corridor Crd-CthE
 3. Select Alignment CthE
 4. Select Profile CthE
 5. Select assembly CthE-10+00 to 32+50
 6. Select Target Surface Exist
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 7. OK

The Corridor Properties dialog box opens
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Corridor targets

Last updated: 2018-02-14

Total video time: 05:44

Corridor targets

Exercise files: crdr-data-c3d16.zip

Start with CthE.dwg

crdr-trgt-01.mp4 05:44

Targeting allows you to create a more complex design geometry by widening or changing 
slopes based on targeted objects such as alignments, profiles, feature lines polylines, etc.

It is not recommended to target any xreffed objects.

 1. Left click on corridor
 2. Contextual ribbon>Modify Region>Edit Targets
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 3. Left click inside of region
 4. In the Target Mapping dialog box, scroll down to the Lane width left 

 5. Left click in the Object name column
 6. In the Set Width Or Offset Target dialog box, select alignments
 7. Left click on CthE-Left-15.000 (1)
 8. Click Add
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 9. OK
 10. Scroll down to Lane profile left
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 11. Left click in the Object name column
 12. In the Set Slope Or Elevation Target, select Profiles
 13. Select the CthE-Left-15.000 (1) alignment
 14. Select the CthE profile
 15. Click Add

 16. OK
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 17. OK

 

Create corridor regions

Last updated: 2018-02-14

Total video time: 04:24

Split regions

Exercise files: crdr-data-c3d16.zip

Start with CthE.dwg

crdr-creat-rgn-01.mp4 01:51

Split Region

 1. Left click on corridor 
 2. Contextual Ribbon>Modify Region>Split Region

 3. Left click inside corridor
 4. Left click the area to split region
 5. Left click to the right of the region break
 6. Left click a second region break

Page: 520

Published on: 2/21/2018

Corridor modeling fundamentals

http://www.c3dkb.dot.wi.gov/data/rdwy-dsn/crdr-fndmntl/crdr-data-c3d16.zip
http://www.c3dkb.dot.wi.gov/video/rdwy-dsn/crdr-fndmntl/crdr-creat-rgn-01.mp4


 7. Esc

Region Properties

 1. Left click on corridor
 2. Contextual ribbon>Modify Region dropdown>Region Propeties

 3. Left click inside region to change
 4. In the Corridor Region Properties dialog, left click the ellipses in the Assembly field
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 5. In the Edit Corridor Region dialog, change the Assembly to CthE-RiverRd-Int-Through

 6. OK
 7. OK
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 8. Esc

Add Region

 1. Contextual ribbon>Modify Region panel>Add Regions

 2. Type 3255
 3. Enter
 4. Type 4000
 5. Enter
 6. In the Create Corridor Region dialog, select the CthE-32+55 to 40+00 assembly
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 7. OK
 8. In the Target Mapping Dialog under Surfaces, select <Click here to set all> 

 9. In the Pick a Surface dialog box, left click on Exist
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 10. OK
 11. OK
 12. Esc, Esc

Corridor issues: waterfalls

Last updated: 2018-02-14

Total video time: 05:04

Corridor issues: waterfalls

Exercise files: crdr-data-c3d16.zip

Start with CthE.dwg

crdr-isu-wtrfl-01.mp4 05:04

To check for corridor waterfalls

 1. Left click on corridor
 2. Right click
 3. Select Object viewer
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 4. Left click, hold and move your mouse to orbit 

 5. Inspect where waterfall happens
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 6. Close object viewer

To fix waterfall

 1. Check design profile start station

 2. Left click on corridor
 3. Contextual ribbon>Modify Corridor panel>Corridor Properties
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 4. Change corridor start region station value to 1037

 5. OK
 6. Rebuild Corridor
 7. Inspect in object viewer

Corridor issues: bowties

Last updated: 2018-02-14
Page: 528
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Total video time: 03:29

Corridor issues: bowties

Exercise files: crdr-data-c3d16.zip

Start with CthE.dwg

crdr-isu-bowtie-01.mp4 03:29

Bowties happen when the corridor links cross over themselves.

Causes

 l Jog in alignment
 l Wide daylighting on the inside of a curve

How to recognize Bowties
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 l Corridor surface contours look odd
 l Corridor surface boundary won't create
 l Corridor doesn’t look right when orbiting in object viewer

Possible solutions

 l Adjust alignment
 l Adjust assembly
 l Adjust targets
 l Create a gap in the corridor

Corridor issues: missing daylights

Last updated: 2018-02-14

Total video time: 03:07

Corridor issues: missing daylights

Exercise files: crdr-data-c3d16.zip

Start with CthE.dwg

crdr-isu-miss-dalit-01.mp4 03:29

Missing daylight

Causes

 l No surface information in daylight ares

Page: 530

Published on: 2/21/2018

Corridor modeling fundamentals

http://www.c3dkb.dot.wi.gov/data/rdwy-dsn/crdr-fndmntl/crdr-data-c3d16.zip
http://www.c3dkb.dot.wi.gov/video/rdwy-dsn/crdr-fndmntl/crdr-isu-miss-dalit-01.mp4


 l Surface targets not set in corridor region

Fixes

 l Adjust daylight slopes
 l Request expanded surface data
 l Define surface targets

To define surface targets

 1. Left click on corridor
 2. Contextual ribbon>Modify Corridor panel>Corridor Properties

 3. Corridor Properties dialog box>Parameters tab
 4. Select the region 
 5. Left click in Set all targets column
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 6. Select <Click here to set all>

 7. Select the surface Exist

 8. OK
 9. OK
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 10. Select to Rebuild Corridor

Intersection objects

Intersection object basics

Last updated: 2018-02-14

Total video time: 04:45

Intersection object basics

Exercise files: int-objct-01-data-c3d16.zip

Start with CthE.dwg

int-objct-basc-01.mp4 04:45

To create an intersection you need to have 2 alignments that cross. These alignments will also 
need design profiles that accompany them.

To create an intersection object

 1. Home tab of the ribbon > Create Design panel > Intersections drop down > Create 
Intersection
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 2. Select the intersection point
 3. Shift+Right click to use apparent intersection snap

 4. Select the primary road alignment CthE
 A. In the first page of the Create Intersection dialog, accept defaults and click Next 

>
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 B. Geometry Details

Create or specify offset alignments: unchecked

 C. Create Intersection

 

Connecting geometry between setup corridors and intersection objects

Last updated: 2018-02-14

Total video time: 10:57

Setup corridor adjustments
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Exercise files: int-objct-01-data-c3d16.zip

Start with CthE.dwg

int-objct-setup-crdr-cnect-01.mp4 02:56

Turn off setup assembly links 

 1. Click on subassembly > Right click > Properties...

 2. Properties > ADVANCED Parameters
 3. Omit Link: Yes
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 4. Repeat for left side
 5. Close properties panel
 6. Click corridor > Contextual ribbon > Modify Corridor panel > Rebuild Corridor

Extract feature lines from setup corridor

int-objct-setup-crdr-cnect-02.mp4 02:03

To extract feature lines from corridor

 1. Left click on corridor
 2. Contextual Ribbon>Launch Pad>Alignment from Corridor
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 3. Left click on corridor feature line
 4. In the Create Alignment from Objects dialog, name the alignment CthE-ETW-RT-Setup
 5. Set Alignment style to RDWY Lane Edge
 6. Set Alignment label set to _No Labels
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 7. OK
 8. OK
 9. Left click on another corridor feature line

 10. In the Create Alignment from Object dialog, name the alignment CthE-ETW-LT-Setup

 11. OK
 12. OK

Create secondary profile

int-objct-setup-crdr-cnect-03.mp4 02:36

To create a secondary profile

 1. Zoom out in lower viewport
 2. Ribbon>Home tab>Profile & Section Views panel>Profile View dropdown>Create Pro-

file View
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 3. In the Create Profile View dialog, General, select the RiverRd alignment 

 4. Click Profile Display Options page
 5. Scroll to the right
 6. Change Style to PROF Existing
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 7. OK
 8. Change Labels to _No Labels

 9. OK
 10. Create Profile View
 11. Left Click in models space to place the profile view
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 12. Ribbon>Home tab>Create Design panel>Profile dropdown>Profile Creation Tools

 13. Left click on profile view grid
 14. In the Create Profile dialog, accept defaults
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 15. OK
 16. Profile Layout Tools toolbar>Tangents dropdown>Draw Tangents
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 17. Draw in new profile
 18. Right click to end command

 19. Close toolbar

Create intersection objects

int-objct-setup-crdr-cnect-04.mp4 03:22
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 1. Ribbon>View tab>Model Viewports panel>Viewport Configuration

 2. Ribbon>Home tab>Create Design panel>Intersections dropdown>Create Intersection

 3. Left click to select intersection location
 4. Select primary alignment
 5. In the Create Intersection - General dialog accept defaults
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 6. Next
 7. Adjust alignment order. RiverRd should be 2nd.
 8. Uncheck Create or specify offset alignments

 9. Create Intersection

Repeat steps 2 through 9 two more times for the remaining intersecting alignments

Inspect the design profile
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Feature lines and gradings

Grading basics

Last updated: 2012-10-01

Total video time: 17:15

Exercise files: grdg-basc-data-C3D12.zip

Grading Feature Fundamentals

grdg-basc-01.mp4 17:15

Requirement: Needed for grading: Site, Feature line, Grading criteria, Grading 
group and objects. 

Site  

 l Allows several objects to interact

 l Grading/feature lines, parcels, sometimes alignments

 l Objects in other sites will NOT interact

 l Grading groups and feature lines NEED a site to exist

Info: Feature lines are no longer required to be on a site in Civil 3D 2016

Feature Line 

 l Used for the grading footprint

 l Basically a 3D Polyline only smarter

 l Many editing options

 l Geometry and elevation

 l Can be added to surface as a breakline (separate from grading tools)

Grading Criteria

 l Rules for grading from footprint (feat line)

 l User defines two sides of right triangle

 l Slope and distance
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 l Slope and elevation

 l Distance and elevation

 l Unlocked criteria prompts for user entry, makes criteria more versatile for different 
uses/projects

 l Locked criteria takes default, speeds up grading process

Grading Group

 l Allow separate grading objects to interact

 l Grading objects and feature lines in different groups will not interact

 l Allows balancing of site volumes

 l Do not need to be contiguous

Grading workflow

Last updated: 2012-10-01

Total video time: 26:04

Grading Feature Workflow

grdg-wrkflw-01.mp4 26:04

Requirement: Have feature line(s) in place. 

Requirement: Have grading criteria available, plan what will be needed.

 1. Home tab > Create Design panel > Grading > Create Grading 
 2. On the Grading command toolbar. 

 l Set Grading Group.
 l Set Criteria Set, then first criteria to be used. 
 l Select the CREATE GRADING COMMAND

Creating feature lines. 

 1. Create 2D polyline, convert to feature line.
 l Will require elevation edits. 

 2. Draw feature line natively
 l Requires elevation edit for each vertex. 
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 3. Create feature lines from an alignment
 l The vertex elevations can be assigned from a profile on the alignmment

 4. Create feature lines the longitudinal feature lines on a corridor. 
 l These feature lines can be dynamically linked to the corridor. 

 5. Create feature line from an offset and difference in elevation using an existing feature 
line, survey figure or 3D polyline using Stepped Offset. 

Creating Grading Command. 

 1. Select Feature Line.
 2. Identify grading side
 3. Will this grading object be for the entire feature line, or just part of it?  
 4. Prompts specific to the criteria

Grading Transition

 1. Creates grading objects between areas of different slopes.
 l Select feature line
 l Select point between the two gradings. 

Grading Infill

 1. Grading object.
 2. Inside closed feature line shape
 3. Can be separate feature lines, as long as it’s closed and in the same site

Editing feature line elevations

Last updated: 2012-10-01

Total video time: 24:37

Editing feature line elevations overview

fl-edit-elev-01.mp4 24:37

Edit Elevations ribbon panel appears in Feature Line Context tab. 

 1. Select the feature line you need to edit
 2. In the context menu toggle on the Edit Elevation button.
 3. This opens the Elevation Edits panel

 All tools will focus on elevation component of the feature line.

Feature line edit elevations

Elevation Editor – in Edit Elevations panel or right-click menu. 
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 l Controls elevations of individual vertex points. 
 l Can set vertex elevations by assigning grades between vertex points
 l Can set raise/lower increment to affect several vertices
 l Can assign several vertices to take “surface” elevation

Insert Elevation Point – “Elevation Points” are a vertex that has no X/Y control, only elevation. 

 l Creates “bends” or elevation changes.
 l Symbolized as circular grip point on feat. line and in panorama. 

Delete Elevation Point – like delete PI, only for elevation points 

Quick Elevation Edit – allows immediate feedback of vertex elevation and feat. line slope by 
hovering cursor near feature line 

 l Can hover near any feature line, not just one selected.

Edit Elevations – Provides tooltip report of elevation nearest feature line vertex or slope of 
nearest feature line, line segment 

 l Left-clicking allows the nearest vertex/line slope to be edited.
 l Will function for any feature line, not just the selected one. 

Set Grade/Slope between Points – allows vertex elevations to be set by controlling the slope or 
grade of the feature line 

 l Can set multiple slopes at one time, along entire portion or portion of feature line.

Insert High/Low Elevation Point – Calculates a high or low elevation point by assigning grade 
forward and back from opposite ends of a feature line 

Raise/Lower by Reference – Raise or lower the elevation of a feature line by reference to an 
object with known elevation 

Set Elevation by Reference – Sets the elevation of a feature line vertex by reference to an 
object with known elevation 

 l Allows for relative grade/slope/difference between the object and the vertex.

Adjacent Elevation by Reference – Allows editing of an adjacent feature line’s elevation in rela-
tion to the selected feature line  

 l Options are Elevation difference, Grade or Slope.

Grade Extension by Reference – Sets elevations by extending the grade of a segment on 
another feature line.  

Elevation from Surface –Sets vertex points to surface elevations at their location  
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 l Intermediate Grade Break creates an elevation point where the feature crosses a sur-
face triangle (entire feature line).

Raise/Lower Feature Line – specifies elevation difference to raise or lower the feature line, or 
set to a specific elevation 

Editing feature line geometry

Last updated: 2012-10-01

Total video time: 20:57

Editing feature line geometry overview

fl-edit-gmtry-01.mp4 20:57

Allows for editing of the feature line in XY plane. 

Can adjust the feature line to represent a grading footprint or surface geometry more accur-
ately. 

Feature lines are like 3D polylines with more intelligence for grading functions, so editing is sim-
ilar to Polyline edits. 

Feature Lines have a “measuring stick” which uses stationing – this is not related to alignments

Open geometry editing tools

 l Select on the feature line > Edit Geometry toggle > Edit Geometry panel

Feature line edit geometry

Insert PI – places a vertex with X/Y/Z location control

Delete PI – can delete individual vertex points

 l Deletes whichever vertex is nearest

Break – identify begin and end of gap in feat. line

 l Results in two separate feature lines

Trim – trims feat line against an object, polyline, line, etc.

Join – glues two feature lines together

 l Two lines must have end points that are coincident
 l Result in one feat line from the two

Reverse – reverses direction of feat line “direction”
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Edit Curve – adjust curve radius, reports length, chord, and tangent data

Fillet – inserts curve tangent to two feature line legs

 l User identifies the vertex
 l R to set Radius
 l A to assign curve radius to ALL vertices along selected feature lines
 l J for joining two separate feature lines while filleting at that join point

Fit Curve – identify 3 or more line vertices and it creates an arc

Smooth – automated fit curve routine. No user input

Weed – to reduce number of vertices along feat. Line

 l Grading can hang up over too many small feature line segments
 l Will remove detail from feature line, user decides how much is appropriate

Stepped Offset – horizontal and vertical

 l Assign horizontal offset distance
 l Indicate which side of feature line to offset to
 l Provide vertical offset definition
 l G=grade, S=Slope, D=Difference (great for 0 or flat) E=Elevation, V=Variable

Daylight grading with feature lines

Last updated: 2014-03-10

Total video time: 44:55

Daylight grading ALTERNATIVE

crdr-ele-dylt-grdg-w-fl-01.mp4 9:58

To create a better transition between daylight slope regions. 

 l Subassembly transitions occur between frequency lines – not nearly far enough apart.

What Components are needed?

 l The Assembly
 l Two conditional subassemblies (per side) 
 l Two GenCF daylight subassembly per conditional subassembly (one with Final Link 

inserted or Omitted).
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 l Polyline for length of transition 

 l Identify where 4:1 to 2.5:1 transition occurs
 l Draw polyline from end of transition to point >100’
 l Add conditional subassemblies and adjusted GenCF to the assembly
 l Set corridor targets for all conditional subassemblies
 l Create grading feature line from corridor
 l Create grading criteria for surface targeting
 l Grade from corridor feature line to daylight

 l Begin with 4:1 for 5’ of feature line
 l End with 2.5:1 for last 5’ of feature line
 l Use grading transition in the middle of the feature line

 l Create Automatic Surface from the Grading Group Properties
 l Create data shortcut for grading surface
 l Reference this surface and paste into refinement surface.

 l 2012 versus 2014

Look for grading transition needs

crdr-ele-dylt-grdg-w-fl-02.mp4 16:13

You need to find where transition areas are too quick. If you aren’t certain where this might 
occur you can look for  telltale signs in your corridor design.

Look for a Transition "Notch" 

 l The transition from 4:1 to 2.5:1 will happen from one frequency line to the next. This sud-
den transition will create a "notch" in the edge of the corridor

 l Usually there will be two notches, one for the 4:1 to 2.5:1 transition and one for the 2.5:1 
to 4:1 transition.

Use the Section Editor to Confirm the Sudden Transition

 1. Select a frequency line near the sudden transition area
 2. Zoom in the section view to the side that is transitioning
 3. Select the Zoom Extents button drop-down and choose Zoom to an Offset and Elevation.
 4. In the Section Editor Station Selection, click the single arrow icons to advance one station 

at a time through the  transition station.
 5. Confirm the 4:1 slope in one station and 2.5:1 slope in the next.
 6. Close the Section Editor

Create the Transition Area Target

 l You need to create a target (or trigger) for the Conditional Subassembly to begin its 
work.
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Draw a 2D Polyline for the Correct Length

 1. Home tab > Draw panel > choose the Polyline tool 
 2. Begin drawing the target polyline at or near where the Transition area ends.
 3. This polyline can be any distance from the corridor. You can snap to the corridor for pos-

itioning.
 4. This polyline should be generally greater than 100’, suggested closer to 110’.
 5. If there is an arc in the corridor this polyline should follow that curve.
 6. Right-click and choose Enter to end the polyline command.

Create a Layer for the Target Polyline

 1. Home tab, Layer panel, Click the Layer Properties Manager
 2. In the left Filter window set the filter to All so that you can see all of the layers.
 3. Check to see if the layer P_Daylight-Transtion already exists.
 4. If it does, make that layer current.
 5. Select the P_Daylight-Transition layer
 6. At the top of the Layer Properties Manager select the green check icon to make it cur-

rent.
 7. If it does not already exist click the Create Layer icon at the top of the Layer Manager.
 8. Name the layer P_Daylight-Transition
 9. Make sure the Linetype is Continuous

 10. Make sure the No Plot option is turned on.
 11. At the top of the Layer Properties Manager select the green check icon to make it cur-

rent Select the target polyline(s)
 12. Change the layer of the polyline to the P_Daylight-Transition layer

Update the Assembly

This is assumed that an assembly is already in place. We will be adding conditional sub-
assemblies to that  assembly and moving the daylight subassembly to the end of the new con-
ditional subassemblies.

Add the Conditional Subassembly to the Existing Assembly

 1. Zoom into the GenCF subassembly that needs the conditional subassembly.
 2. Open the tool palette to place the subassembly.
 3. Home tab > Palettes panel > choose the middle button (or <ctrl> 3) .
 4. Select the Conditional tool palette tab.
 5. Select the Conditional Horizontal Target subassembly.
 6. Set the side to Left
 7. Leave the Type to Target Found
 8. Attach this subassembly to the Shoulder subassembly. Use the Selection Cycling to prop-

erly connect the  subassembly.
 9. In the Properties palette change the Type to Target Not Found.
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 10. Attach this conditional subassembly to the Shoulder subassembly. Use the Selection Cyc-
ling to properly connect  the subassembly.

Move the GenCF Daylight Subassembly to the Conditional Subassemblies

 1. Select the GenCF daylight subassembly
 2. Right-click and choose Move To.
 3. Select the attachment point at the end of the Not Found conditional subassembly.

Copy the GenCF to the Found Condition Subassembly

 1. Select the GenCF daylight subassembly.
 2. Right-click and choose Copy To.
 3. Select the newly placed copy of the GenCF.
 4. Right-click and choose Subassembly Properties
 5. Click the Parameters tab.

Rebuild the Corridor

 1. In the Include Daylight Link Omit Daylight Link and change the setting to Omit.
 2. In the toolspace, Prospector tab expand Corridors
 3. Right-click the corridor name. Choose Corridor Properties
 4. Parameters tab.
 5. Set All Targets.
 6. Under Surface targets click Set All Targets.
 7. Choose the EG surface.
 8. Find the Conditional Horizontal Targets and click in their value field.
 9. Change the type of target to Feature Lines, Survey Figures and Polylines.

 10. Click Select by Layer.
 11. Check mark the correct layer (P_Daylight-Transition)
 12. Repeat these steps for each Conditional Subassembly in the regions. This is necessary for 

both the Found  and Not Found conditions.
 13. Click OK to rebuild the corridor.

Extract grading feature line from corridor

crdr-ele-dylt-grdg-w-fl-03.mp4 13:21                    

We need to translate a corridor feature at the edge of our design into a grading feature line 
that the grading tools  will recognize and be able to work with.

Extract the Feature Line

 1. Select the feature line to extract.
 2. From the green context ribbon, Launch Pad panel, select the Feature Line from Corridor.
 3. In the dialog make sure these settings are set:
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 4. The Site should be unique, and not one that other grading in this file that our current 
work might interfere  with.

 5. Check the Name field and name the new feature line Daylight Grading Line West.
 6. Style checkmark and set to Standard.
 7. For Layer set to Use Current Layer.
 8. Make sure the Create Dynamic Link to Corridor is checked. This is the important option 

in this dialog!
 9. Click OK. Then <Esc>.

Begin the Grading

We will create a grading criteria (rules for the gradings to follow) then apply them to the grad-
ing area.

Start the Grading Tools

 1. Home tab > Create Design panel > Grading tools > select Grading Creation Tools .
 2. Select the second icon to set the Surface. Select EG.
 3. In the toolbar select the first icon, Grading Group.
 4. Name the Grading Group "Daylight Grading".
 5. Click OK.
 6. Hover over the fourth icon to check the grading criteria set.

Create and Set the Grading Criteria

 1. Select the button just past the drop down menu and select Copy Current Selection.
 2. On the Information tab name the criteria Daylight Grading.
 3. In the Criteria tab
 4. Change the Target to Surface.
 5. Make sure the Slope fields for Cut and Fill areas are both unlocked.
 6. Click OK.

Create the Grading

 1. Select the Create Grading icon.
 2. Select the grading feature line at the edge of the notched area. From the Selection Cyc-

ling dialog it is the Auto  Corridor Feature Line.
 3. Left click the Grading Side to the west of the feature line.
 4. Answer NO to the “Entire Length” prompt.
 5. Snap the Start Point to the beginning of the notch, the end of the daylight location.
 6. Confirm the station location by clicking Enter .
 7. For the length type in 1103, which is ~5’ from the start station.
 8. Confirm this station as well by clicking Enter 
 9. Type 4 to set the Cut Slope at 4:1.

 10. Type 4 to set the Fill Slope at 4:1.
 11. Pan to the north of the grading area notch.
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 12. Select the grading feature line. In the Selection Cycling dialog this will be the Auto Cor-
ridor Feature Line.

 13. Select to the west of the feature line for the grading side.
 14. Click approximately 5’ from the end, about where the last non-daylight frequency line is 

located.
 15. Confirm the station location by clicking Enter .
 16. Snap to the end of the grading by snapping to the beginning of the first daylight point.
 17. Confirm the station location by clicking Enter .

Create the Transition Grading

 1. From the Grading Creation toolbar select the Create Grading drop down button and 
choose Create Transition.

 2. Select the grading feature line. In the Selection Cycling this will be the Auto Corridor 
Feature Line.

 3. Click a point between the two gradings.

Create the surface from the grading group

crdr-ele-dylt-grdg-w-fl-04.mp4 5:23                     

Clean up the Grading Area

Turning off layers so that lines that do not need to be seen, but need to be used by the grading 
design, do not  distract from the design work.

Turn Off the Conditional Subassembly’s Target Line Layer

 1. Home tab > Layers panel > Layer Manager pull-down menu 
 2. Click the lightbulb to turn off the P_Daylight-Transition layer.
 3. Set the Current Layer to something other than the off layer.
 4. Home tab > Layers panel > Layer Manager pull-down menu  select the 0 layer to make 

it current

Create the Surface from the Grading Area

We need to make a surface from the grading tools. This surface will be dynamic to the grading, 
and any changes  that occur to the corridor design.

Access the Grading Object Diamonds

 1. If you cannot see the grading object diamond symbols:
 l Zoom out
 l Type RE to regen your screen
 l Zoom in and the grading diamonds should be larger and easier to find

 2. Select on one of the grading object diamonds
 3. In the green context ribbon select Grading Group Properties
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Create the Surface from the Grading Group

So that this surface can be referenced into other files, specifically the refinement surface file, 
we need to make a  data shortcut for the grading surface.

 1. Save the file.
 2. In the toolspace, Data Shortcut area, right-click on the Data Shortcut area header.
 3. Choose Create Data Shortcuts.
 4. Check mark the Surface-Daylight Grading surface.
 5. Click Ok
 6. Create a data shortcut for the grading surface.

Rural driveways

Last updated: 2017-06-06

Total video time: 79:59

Create Ex-Top Surface and Combine with Exist Surface

Exercise files: fl-grdg-rurl-dwy-01-data-C3D14.zip

fl-grdg-rurl-dwy-01.mp4 7:00

Rural driveway modeling requires targeting both the proposed work and existing ground. There-
fore, the two must be combined into a single surface. Utilize the Rfnt-Top surface and existing 
ground surface to create the Cmbn-Ex-Top surface.  This surface will be the driveway grading 
target.

 1. Start a new drawing and called Surf-Cmbn-Ex-Top.dwg.
 2. Data reference the existing ground surface and the Rfnt-All-Top surfaces.
 3. Create a new surf called Cmbn-Ex-Top.
 4. Paste in the existing ground surface and then the Rfnt-All-Top surface.
 5. Save the drawing and create a data shortcut for the Cmbn-Ex-Top surface

Create New Drawing for Driveway Surfaces

fl-grdg-rurl-dwy-02.mp4 5:01

 1. Create a new drawing using the wisdot template and save the drawing with an appro-
priate name such as RuralDwy.dwg

 2. Data shortcut reference the Cmbn-Ex-Top surface
 3. Data shortcut reference alignments for the centerline, edge of pavement, edge of paved 
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shoulder, and edge of gravel shoulder
 4. Xreference mapping dwg file(s)

Create Driveway Horizontal Geometry

fl-grdg-rurl-dwy-03.mp4 14:24

 1. Determine the approximate driveway limits (offset).  
 A. This can be done in multiple ways such as using your corridor section editor, or 

creating a quick profile along the driveway.
 B. The minimum extent of your driveway limits should be at the back slope of the 

adjacent ditch (slope intercept).
 C. Determine  whether you will need more than one slope to define your driveway 

for added culvert clearance or rollover control.
 2. Draw the driveway “top” in plan view on the P_DWY layer.

 A. Include the driveway entry radii and tapers.
 B. The driveway can be created with line and arcs, but the driveway edges should 

ultimately be converted to five polylines (left side, right side, match location, 
centerline, and edge of shoulder).

Determine Driveway Elevation/Grade

fl-grdg-rurl-dwy-04.mp4 11:33

 1. Create a new Site  
 A. Name the site the approximate location of the driveway (For example:  380+75 

LT).
 2. Convert the driveway match polyline into a feature line.

 A. Name the feature line appropriately (For example: 380+75 LT Match).
 B. Assign the Standard style to the feature line.
 C. The style assignment determines the elevation hierarchy of the feature lines in 

the site.
 D. Assign elevation to the feature line from the Cmbn-Ex-Top surface using the Elev-

ations from Surface command
 E. Make sure it is included in the site created for this driveway.
 F. It is highly recommended that you set up two viewports. One viewport should be 

set to plan view and the other should be set to an isometric view of the driveway 
location. 

 G. Set the isometric viewport to a rendered view style such as Conceptual. This will 
allow you to watch your driveway surface take shape as you build it.
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 3. Convert the edge of shoulder polyline into a feature line.
 A. Name the feature line appropriately (For example: 380+75 LT ES).
 B. Assign the Standard style to the feature line.
 C. Assign elevation to the feature line from the Cmbn-Ex-Top surface using the Elev-

ations from Surface command.
 D. Make sure it is included in the site created for this driveway.

 4. Convert the driveway centerline polyline into a feature line 
 A. Name the feature line appropriately (For example:  380+75 LT CL) 
 B. Do not assign the feature line a style. 
 C. The feature line will adopt its elevations from the edge of shoulder and match fea-

ture lines.
 5. Convert the driveway left and right side polylines into a feature lines.

 A. Name the feature lines appropriately (For example:  380+75 LT LT and 380+75 LT 
RT).

 B. Do not assign the feature line a style.
 C. The feature line will automatically adopt elevations from the edge of shoulder 

and match feature lines.
 6. Use the Grade/Slope Between Points command to straight-line grade the left and right 

sides between the edge of shoulder and the match location. 

Create Gradings

fl-grdg-rurl-dwy-05.mp4 9:43

 1. Create a Grading Group in the same Site as the driveway.  
 A. Name the Grading Group the driveway location.
 B. Check “Automatic Surface Creation” and “Use Group Name”.

 2. Set the Grading Criteria Set to Rural Driveway
 A. If your drawing does not have the Rural Driveway criteria set, use or create a 

slope to surface criteria.
 3. Create 6:1 Gradings along the left and right driveway feature lines. 

 A. If the roadway foreslope is steeper than the driveway side slope, the gradings 
should extend from the driveway slope intercept (match location) to approx-
imately +/-10' short of the edge of gravel shoulder.

 B. If the roadway foreslope is the same as or flatter than the driveway side slope, the 
grading can extend the full length of the feature line.

Tips: When prompted for the grading end location, it is useful to use the Length 
option at the command line. The command will then notify you of the length 
remaining to the end of the feature line.
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 4. Create additional gradings along the left and right driveway feature lines that match the 
roadway foreslope if the roadway foreslope is steeper than the driveway side slope. 

 A. These gradings should extend from a point about +/-0.01' from the end of edge of 
gravel shoulder to the edge of gravel shoulder.

Create Grading Transitions (only if the roadway foreslope is steeper than the driveway side slopes)

 1. Select Create Transition from the Grading Creation Tools
 2. Select the feature line
 3. Select a point between the 6:1 grading and 4:1 grading
 4. Save the drawing

Create Grading Infill for Driveway Top

 1. Choose the Create Infill command from the Grading Creation Tools
 2. Select the regions defining the top of the driveway and hit enter
 3. You will see the completed driveway surface in the isometric view
 4. Save the drawing

Driveways with skew and multiple slopes - Horizontal Geometry

fl-grdg-rurl-dwy-06.mp4 12:53

 1. All the steps outlined above apply
 2. Add an additional polyline representing the slope break in the driveway profile

Driveways with skew and multiple slopes - Determine Driveway Elevation and Grade

fl-grdg-rurl-dwy-07.mp4 7:22

 1. All the steps outlined above apply
 2. Convert the additional polyline representing the slope break in the driveway profile to a 

feature line
 3. Assign the feature line the  standard style
 4. Assign this feature line elevation by using the Adjacent Elevations by Reference com-

mand

Driveways with skew and multiple slopes - Create Gradings

fl-grdg-rurl-dwy-08.mp4 8:03

All the steps outlined above apply

Combine Driveway Surfaces into a Single Surface
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Exercise files: fl-grdg-rurl-dwy-02-data-C3D14.zip

fl-grdg-rurl-dwy-09.mp4 4:00

 1. Create Combined Driveway Surface
 A. Extract the boundary of each driveway surface
 B. Create a new surface called Rfnt-All-RuralDwy
 C. Toolspace > Prospector > Rfnt-All-RuralDwy surface definition > right-click on 

Edits > Paste Surface
 D. Select all of the individual driveway surfaces and click OK.
 E. Draw a polyline that encompasses all of the individual driveways.
 F. Toolspace > Prospector > Rfnt-All-RuralDwy surface definition > right-click on 

Boundaries > Add
 I. Type = Hide 

 II. OK  
 III. Select the polyline boundary that encompasses all the driveways.

 G. Toolspace > Prospector > Rfnt-All-RuralDwy surface definition > right-click on 
Boundaries > Add

 A. Type = Show
 B. OK
 C. Select individual driveway 3D polyline boundaries.

Corridor and refinement surfaces

Create corridor surface

Last updated: 2018-02-14

Total video time: 09:59

Top corridor surface creation

ProjectID\Design\Corridors\Crdr-25-begin.dwg

Exercise files: crdr-rfnt-srfc-data-c3d16.zip

Start with Crdr-Int-CthE-RiverRd.dwg

crdr-srfc-creat-01.mp4 03:19

Open Cdr-Int-CthE-RiverRd.dwg

c3d\12345678\Design\Corridors\Cdr-Int-CthE-RiverRd.dwg

To create corridor surface
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 1. Left click on corridor
 2. Contextual Ribbon > Modify Corridor > Corridor Surfaces

 3. In the Corridor Surfaces dialog on the Surfaces tab, left click create surface

 4. Rename surface Crdr-CthE-Top
 5. Change Add Data, Data type to Feature Lines
 6. Add the following codes: Crown, Daylight, Daylight_Sub, Ditch_Out, ES, ETW, Hinge
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 7. Left click Boundaries tab
 8. Right click Crcr-CthE-Top
 9. Select Corridor extents as outer boundary

 10. OK
 11. Rebuild Corridor
 12. Double check surface Toolspace > Prospector tab > Surface
 13. Esc

Datum corridor surface creation

crdr-srfc-creat-02.mp4 01:46

To create a datum surface
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 1. Left click on corridor
 2. Contextual ribbon > Modify Corridor panel > Corridor Surfaces

 3. On the Surfaces tab of the Corridor Surfaces dialog, Left click Create a corridor surface

 4. Rename the surface Crdr-CthE-Datum
 5. Change the Data type to Feature Lines
 6. Add the following codes: Crown_Sub, Daylight, Daylight_Sub, Ditch_Out, ETW_Sub, 

Hinge
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 7. Left click the Boundaries tab
 8. Right click on Crdr-CthE-Datum
 9. Select Corridor extents as outer boundary

 10. OK
 11. Rebuild Corridor

Base Course corridor surface creation

crdr-srfc-creat-03.mp4 03:46

To create base corridor surface
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 1. Left click on corridor
 2. Contextual ribbon > Modify Corridor panel > Corridor Surfaces

 3. On the Surfaces tab of the Corridor Surfaces dialog, Left click Create a corridor surface

 4. Rename the surface Crdr-CthE-BaseCourse
 5. Change the Data type to Feature Lines
 6. Add the following codes: Crown_Pave1, ES_Pave1, ETW_Pave1
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 7. Left click the Boundaries tab
 8. Right click on Crdr-CthE-BaseCourse
 9. Select Add Interactively...

 10. Left click on the appropriate corridor feature line
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 11. Make you way around the corridor clicking on feature lines that represent the desired 
boundary

 12. C Enter
 13. OK
 14. Rebuild Corridor

Data shortcut corridor surface

crdr-srfc-creat-04.mp4 01:08

To create Data Shortcuts

 1. Save  
 2. In the Prospector tab of Toolspace, Right click on Data Shortcuts
 3. Select Create Data Shortcuts
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 4. In the Create Data Shortcuts dialog, Check Surfaces

 5. OK

Refinement surface basics

Last updated: 2018-02-13

Total video time: 01:10

rfnt-srfc-basc-01.mp4 01:10

 l Corridor design is only one step in final surface creation
 l Other gratings or surface adjustments may be needed for final surface
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 l Refinement surface is the final surface, combination of all definitions, pasted together
 l Refinement surfaces source of data in section views, plans/profile sheets, etc.

 

 l One refinement surface for each final surface:
 o Top, Datum, Base

 l No matter how divided up the project definition
 o ALL Top surfaces in Rfnt-Top
 o ALL Datum surfaces in Rfnt-Datum
 o ALL Base surfaces in Rfnt-Base

 l Other gradings or adding breaklines

 

 l Pasting into final refinement
 o Last surface pasted takes precedence where there is conflict
 o Plan the order to be pasted
 o Top and Datum surfaces are defined to daylight, so there are large areas already 

exactly the same

Create refinement surface

Last updated: 2018-02-14

Total video time: 06:47

Top refinement surface creation

ProjectID\Design\Corridors\Crdr-25-begin.dwg

Exercise files: crdr-rfnt-srfc-data-c3d16.zip

Start with Surf-Rfnt-All-Top.dwg

rfnt-srfc-creat-01.mp4 02:41

Create top refinement surface

 1. Menu browser>New
 2. Select wisdot16.dwt
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 3. Open
 4. Menu browser>Save As
 5. Design>Surface
 6. Name: Surf-Rfnt-All-Top
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 7. Save
 8. Toolspace>Prospector tab>Data Shortcuts>Surfaces
 9. Right click Crdr-CthE-Top

 10. Create Reference...
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 11. Accept defaults
 12. OK
 13. Ribbon>Home tab>Create Ground Data panel>Surfaces dropdown>Create Surface

 14. Name surface Rfnt-CthE-Top
 15. Left click ellipses in style field
 16. Select Top Border
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 17. OK
 18. OK
 19. Toolspace>Prospector tab>Surfaces>Rfnt-CthE-Top>Definition
 20. Right Click Edits
 21. Select Paste Surface...
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 22. Select Crdr-CthE-Top

Page: 577

Published on: 2/21/2018

Corridor and refinement surfaces



 23. OK
 24. Double click mouse wheel
 25. Save
 26. Toolspace>Prospector tab>Data Shortcuts
 27. Right click Data Shortcuts
 28. Select Create Data Shortcuts...

 29. Select Rfnt-CthE-Top
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 30. OK

Datum refinement surface creation

rfnt-srfc-creat-02.mp4 01:58

 1. QNEW
 2. Save As
 3. Surf-Rfnt-All-Datum
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 4. Save
 5. Toolspace>Prospector tab>Data Shortcuts>Surfaces
 6. Right click Crdr-CthE-Datum
 7. Select Create Reference...
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 8. OK
 9. Ribbon>Home tab>Create Ground Data panel>Surfaces dropdown>Create Surface

 10. Name surface Rfnt-CthE-Datum
 11. Change style to Datum Border

 12. OK
 13. Toolspace>Prospector tab>Surfaces>Rfnt-CthE-Datum>Definition
 14. Right click Edits
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 15. Select Paste Surface...

 16. Select Crdr-CthE-Datum
 17. OK
 18. Double click mouse wheel
 19. Save
 20. Toolspace>Prospector tab>Data Shortcuts
 21. Right Click Data Shortcuts
 22. Select Create Data Shortcuts...
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 23. Select Rfnt-CthE-Datum
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 24. OK

 

Base Course refinement surfacce creation

rfnt-srfc-creat-03.mp4 02:08

 1. QNEW
 2. Save As
 3. Surf-Rfnt-All-Base

 4. OK
 5. Toolspace>Prospector tab>Data Shortcuts>Surfaces
 6. Right click Crdr-CthE-BaseCourse
 7. Select Create Reference...
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 8. OK
 9. Ribbon>Home tab>Create Ground Data panel>Surfaces dropdown>Create Surface

 10. Name Rfnt-CthE-BaseCourse
 11. Change style to Base Course Border

 12. OK
 13. OK
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 14. Toolspace>Prospector tab>Surfaces>Rfnt-CthE-BaseCourse>Definition
 15. Right click on Edits
 16. Select Paste Surface...

 17. Select Crdr-CthE-BaseCourse
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 18. OK
 19. Double click mouse wheel
 20. Save
 21. Toolspace>Prospector tab>Data Shortcuts
 22. Right click Data Shortcuts
 23. Select Create Data Shortcuts...

 24. Select Rfnt-CthE-BaseCourse
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 25. OK

Civil 3D QC surface checklist

Last updated: 2017-06-06

Civil 3D QC surface checklist

This spreadsheet is a tool to aid in reviewing the creation of project surfaces.  The spreadsheet 
can be editted to fit the review needs for each project.

Civil 3D QC surface checklist.xlsx

Rural intersection

Rural intersection: introduction

Total video time: 1:54

Last updated: 2018-02-20

Overview

The rural intersection topic is long. It is the culmination of many concepts in the "Roadway 
design - beginner" on page 1 training course. It starts with  mainline and side road alignments 
and profiles and an existing surface and goes through to refinement surfaces after the corridor. 
There are two primary reasons for this approach:

 1. Many of the steps and best practices used make more sense when seen in context with 
the rest of the workflow.

 2. We especially want new users to have the opportunity to work through all of the steps 
they are likely to see in a first production design project.
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 3. A rural intersection has the opportunity to train many workflows, tools, and best prac-
tices. All of these items may not be needed in any given project, but once learned, a user 
can choose to use a tool. Tools that are never learned are never used.

Content for existing designers

Many items that have been individual topics or not yet released have been incorporated into 
this workflow. Below is a list of topics that may have new or interesting concepts or tools for 
existing designers.

 1. Data management for objects that are used in corridor modeling and plan sheets

The following series of topics cover the organization of data so that named alignment 
objects can be used for corridor targeting and data shortcutted to a single file to be used 
as an xref in plan sheets.

 a. "Rural intersection: data management" on the facing page
 b. "Rural intersection: project-wide edgeline alignments" on page 592
 c. "Rural intersection: alternative layout layers" on page 594
 d. "Rural intersection: alternative layouts" on page 595
 e. "Rural intersection: mask project-wide edgeline alignments" on page 600
 f. "Rural intersection: create pavement file" on page 604

 2. Setup corridor and surface

Sometimes proposed geometry needs to be generated before a final corridor can be cre-
ated. We call a corridor with this purpose a setup corridor.

 a. "Rural intersection: setup assemblies" on page 611
 b. "Rural intersection: setup corridor" on page 613
 c. "Rural intersection: setup surface" on page 617

 3. Intersection objects to connect curb return profiles to mainline and sideroad geo-
metry

 a. "Rural intersection: side road setup corridor" on page 635
 b. "Rural intersection: curb return setup and assembly" on page 638
 c. "Rural intersection: curb return setup corridor" on page 639
 d. "Rural intersection: curb return profiles" on page 652

 4. Refinement surfaces

 a. "Rural intersection: create refinement datum surface" on page 703
 b. "Rural intersection: create refinement top surface" on page 707

 5. Optional edits - slope control profiles
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At the end of the exercise, some optional steps have been added. They show matching up 
the transition between a rural and urban shoulder so that the surfaces are smooth. These 
steps are not required for construction data packet deliverable, but they are very good 
practice for using the Slope/ Width control editor in conjunction with 
WisDOT subassemblies that use slope/width profile control.

 a. "Rural intersection: optional edits introduction" on page 719
 b. "Rural intersection: grading behind curb and gutter with corridor" on page 736
 c. "Rural intersection: grading behind curb and gutter with corridor" on page 736
 d. "Rural intersection: taper curb head ends to zero height" on page 743
 e. "Rural intersection: match top of gravel shoulder to top of terrace behind curb 

and gutter" on page 748
 f. "Rural intersection: edit shoulder foreslope to match ditch behind curb and gut-

ter" on page 765

Rural intersection: data management

Total video time: 4:26

Last updated: 2018-02-20

Exercise files: rurl-int-begin-data-c3d16.zip

Start with: 12345678\Design\aliprofs\AliProf-25.dwg

rurl-int-data-mngmnt-01.mp4 4:26

Data management

This will give a brief overview of the project as a whole to get a better understanding of how 
we are going to structure our project data and why we put certain objects in certain files.

This project is a reconstruction of WIS 25 along with a reconfiguration of some of the inter-
sections. We're going to square up 4th Avenue as best as we can. 

At 14th street we will create a T intersection and improve the angle.

At Upper Pine Drive we will create a T intersection and obliterate the stretch of road on the 
other side rerouting that traffic to 14th Street.

This project will be split among three designers. WisDOT will design the main corridor of WIS 
25 and the intersection at 4th Avenue. Two contractors will design the other intersections.

The following diagram shows how we are going to organize the project.
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The AliProf file will contain all the information pertaining to the entire project including the 
mainline alignments for Highway 25- centerline, Edge of travelway, edge of paved shoulder and 
edge of gravel surface. It will also include a dynamic intersection block for the initial  layout and 
alternative intersection designs.

The corridor drawings will contain objects that are specific to that intersection and are not pro-
ject wide. The corridor drawing for 4th Avenue will contain the edge line alignments for the 
turn lanes, the curb return, 4th Ave edge of pavement and edge of gravel.

All of the information created in those 4 drawings will get data referenced into the Pavt.dwg.

And then that data will be used as an Xref in the Plan Sheets drawing.

Tip: There are three designers on this project but even if there was a single 
designer it is best to still have three corridors. With a single designer you could 

Page: 591

Published on: 2/21/2018

Rural intersection



place all you edgeline alignments in the AliProf and then data reference them into 
the pertinent corridor file.

 1. Tan-Tan (with curves) > click on the beginning of the curb
 2. Hover over the end of the tangent- a + sign appears
 3. Hover over the next tangent and a + sign appears
 4. Hover out where the PI is and the intersection will be marked by dashed lines > left click
 5. Click the end of the curb > Enter
 6. Use the grip at the PI to move the curb into place
 7. Repeat for the final curb

Rural intersection: project-wide edgeline alignments

Total video time: 5:19

Last updated: 2018-02-20

Project-wide edgeline alignments

Exercise files: rurl-int-begin-data-c3d16.zip

Start with: 12345678\Design\aliprofs\AliProf-25.dwg

rurl-int-prjct-wid-edglin-ali-01.mp4 5:19

The alignments created here will be used throughout the entire project. They include the WIS 
25 centerline, edge of travelway, edge of paved surface and edge of gravel surface. 

The topographic mapping was used as an Xref to establish the side road alignments. When work-
ing in Civil 3D you want to show only the graphics that you need for any given task. The more 
that you show on the screen the more its going to degrade the performance of the application.

 1. Select the topographical Xref > Right click > Unload
 2. Home tab > Create Design > Alignment > Create Offset Alignment

 A. Select the main line alignment
 B. Set the auto naming to [Parent Alignment Name(CP)]>-<[Side]>-ETW

Info: Standard naming conventions can be found at: http://wis-
consindot.gov/rdwy/fdm/fd-15-05-att.pdf#fd15-5a3.4

 C. Station Range: 370+00 to 423+00
 D. No. of offsets on left/right: 1
 E. Incremental offset: 12.00'
 F. Alignment Style: RDWY Pavement Edge
 G. Alignment Labels: _None
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 3. Repeat the steps with the edge of paved surface and the edge of gravel surface 
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Rural intersection: alternative layout layers

Total video time: 4:37

Last updated: 2018-02-20

Alternative layout layers

Exercise files: rurl-int-prjct-wid-edglin-ali-end-data-c3d16.zip

Start with: 12345678\Design\aliprofs\AliProf-25.dwg

rurl-int-layout-layr-01.mp4 4:37

Tip: To make it easy to compare different design alternatives create new layers for 
each of them.

 1. Open layer manager
 2. Create new layer
 3. Begin each new layer name with P_RDWY to utilize the layer filters
 4. Give a description that explains the type of intersection

Page: 594

Published on: 2/21/2018

Rural intersection

http://www.c3dkb.dot.wi.gov/data/rdwy-dsn/rurl-int/rurl-int-prjct-wid-edglin-ali-end-data-c3d16.zip
http://www.c3dkb.dot.wi.gov/video/rdwy-dsn/rurl-int/rurl-int-layout-layr-01.mp4


 5. Double click on the 4thAve_Alt1 to make it the current layer

Rural intersection: alternative layouts

Total video time: 8:34

Last updated: 2018-02-20

Alternative layouts

Exercise files: rurl-int-prjct-wid-edglin-ali-end-data-c3d16.zip

Start with: 12345678\Design\aliprofs\AliProf-25.dwg

rurl-int-layout-altrnativ-01.mp4 4:36

 1. Set the layer to P_RDWY_4thAve_IntLayout_Alt1
 2. WisDOT Design tab > Parametric Design > Intersection Blocks > Int-Type-B-Tan
 3. The insertion point is the intersection of main line centerline and ETW of side road
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 4. Rotate > select the block > select the insertion point for the base > select a point along 
the ETW alignment

 5. Set the intersection angle by dragging the triangular grip over to the side road alignment
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 6. Adjust the lane width in the Design tab of the properties block
 7. Use the Standard detail drawing to determine the Radii based on the Q value
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Info: Standard detail drawings can be found at http://wis-
consindot.gov/rdwy/sdd/sd-09a01.pdf#1

 8. Repeat the steps with the west side of the intersection

rurl-int-layout-altrnativ-02.mp4 3:58

 9. Set the current layer to P_RDWY_4thAve_IntLayout2
 10. Copy the east intersection to a new layer

 A. Select the intersection block
 B. Home tab > Layer ribbon > Copy to layer
 C. Select the Alt2 layer to copy to
 D. Select the base point and then select the point again
 E. Turn off the Alt1 layer

 11. Insert a Type D intersection block on the west side of the road
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 12. Rotate it in place
 13. Set the intersection angle
 14. Set the side road width to 11'
 15. Set the W value to the width of the shoulder or 5'
 16. Set R1 to 40' and R2 to 70'
 17. Now you can toggle between the alternatives by turning on and off the layers

 

Rural intersection: mask project-wide edgeline alignments

Total video time: 6:59

Last updated: 2018-02-20

Remaining intersections & alignment masking

Exercise files: rurl-int-prjct-wid-edglin-ali-end-data-c3d16.zip

Start with: 12345678\Design\aliprofs\AliProf-25.dwg

 rurl-int-mask-prjct-edglin-ali-01.mp4 6:59

Repeat the process above to insert In-Type-B-Tan blocks for the other 2 intersections. 

Highlight all the intersection blocks and at the bottom of the properties switch the Visibility to 
graphics mode which will hide some of the lines making it less cluttered.
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The project wide edgeline alignments span through the intersection. This will not work for plans 
production purposes. We will need to mask the alignments in the intersection areas. For mask-
ing the alignments turn on all the block layers to match the mask to the intersection footprint 
that is the greatest.

 1. Select the alignment > Alignment Properties > Masking tab > Add Masking Region
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 2. Select the point at which the main road alignment matches into the side road taper

 3. Next select where the main road alignment matches into the turn lane taper
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 4. OK The part of the alignment in the intersection will now be masked
 5. Go back into the alignment properties and add a mask for the 14th street intersection
 6. Repeat the process to mask the EPS and EGS on both sides of the road
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Now that masking is complete the intersection graphics are much more presentable

Rural intersection: create pavement file

Total video time: 3:48

Last updated: 2018-02-20

Create pavt.dwg file

Exercise files: rurl-int-prjct-wid-edglin-ali-end-data-c3d16.zip

Start with 12345678\Design\aliprofs\AliProf-25.dwg

rurl-int-creat-pavt-fil-01.mp4 3:48
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With the project wide edgeline alignments complete we can now make data shortcuts for those 
objects

 1. Manage tab > Create Data Shortcuts
 2. Select all of the offset alignments OK

Warning: It is a bad practice to create data shortcuts for surface profiles. Instead of 
using data shortcuts for surface profiles, data shortcut the surface and make new 
surface profiles in the file where they are needed.

Comment: The pavement file is a repository for all the various edgelines in your project. 
They all get data referenced into the pavement file and then they get Xreferenced into 
the plan sheets
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 1. Open an new drawing > Save as Pavt.dwg in the Edgelines folder
 2. Data reference the edgelines from AliProf.dwg

 A. Toolspace > Prospector tab > Data Shortcuts > Alignments > Offset Alignments 
> 25-Left-EGS > right click > Create Reference

 B. Alignment style > RDWY Shoulder Aggregate 
 C. No labels
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 D. Continue with the other alignments making sure the alignment style is correct for 
each of them

Info: Note there are gaps in the alignments. This is from the masking. Those gaps 
will be filled in as we create more alignments in the corridor files. 

Rural intersection: create preliminary plans

Total video time: 7:12

Last updated: 2018-02-20

Preliminary plans 1

Exercise files: rurl-int-creat-pavt-fil-end-data-c3d16.zip

Start with: 12345678\Design\edgelines\pavt.dwg

rurl-int-prelim-pln-01.mp4 3:57

To print some preliminary sheets without having the corridor complete we can Xref 
AliProf.dwg. Because we masked the alignments to the larger of the blocks there will be some 
gaps when only Alt1 is showing. We will create some linework to fill that in.
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 1. In the AliProf.dwg set current layer to P_RDWY_PavtEdge 
 2. Draw a polyline to from the edge of the block across the intersection to the other edge 

of block
 3. Trim the line to the edges of the other Alt block
 4. Repeat with the EPS and EGS
 5. Select all the new polylines and create a block
 6. Set the block layer to Alt2
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Preliminary plans 2

rurl-int-prelim-pln-02.mp4 3:15

 7. Open Preliminary.dwg in the SheetsOther folder
 8. Xref pvmt.dwg
 9. Xref AliProf.dwg- this will give us the intersection lines

Info: The AliProf file contains a lot of information that is not necessary here.

 10. In Layer Properties in the AliProf Xref freeze all the layers except the ones starting with 
P_RDWY

 11. In 4thAve Alt1 viewport double click in the view frame to activate it
 12. Freeze the Alt2 layer in this view only
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 13. In Alt 2 view Freeze Alt1 layer

This gives you a preliminary plan set without creating the corridors
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Rural intersection: setup assemblies

Total video time: 5:04

Last updated: 2018-02-20

Setup assembly
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Exercise files: rurl-int-prelim-pln-end-c3d16.zip

Start with: 12345678\Design\aliprofs\AliProf-25.dwg

rurl-int-setup-asmbly-01.mp4 5:04

The design team has decided to go with the Intersection with the turn lane so freeze the layer 
Alt2. We're going to create a setup corridor to the AliProf drawing to know the elevation at the 
main road ETW and what elevation to tie the curb and gutter ends. The setup corridor will 
develop a surface that we can pull a profile from for those critical locations.

 1. Select all the intersection blocks and change the visibility to Design mode
 2. Home tab > Create Design > Assembly > Create Assembly
 3. Name it 25-Setup-ETW > OK > Place in drawing

Tip: Assemblies and corridors display better if you change the display scale 
to 1 IN:10FT or 1 IN:5FT 

 4. WisDot Design tab > WisDOT & Civli Imperial palette > General Subassemblies tab > 
MultiUseWidthAndSlopeLinks

 5. Place on the assembly

 6. Select the assembly and Assembly properties to set the parameters

 7. Repeat for the left side
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Rural intersection: setup corridor

Total video time: 6:13

Last updated: 2018-02-20

Setup corridor

Exercise files: rurl-int-prelim-pln-end-c3d16.zip

Start with: 12345678\Design\aliprofs\AliProf-25.dwg

rurl-int-setup-crdr-01.mp4 6:13

 1. In the WisDOT Design tab select label assemblies select All and enter

 2. Home tab > Create Design > Corridor
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Info: The FDM has the maximum frequency spacing requirements: http://wis-
consindot.gov/rdwy/fdm/fd-15-05.pdf

 3. Set the start and end stations to include the entire footprint of the intersection
 4. Set the frequency to 2.5'
 5. OK > Rebuild Corridor
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 6. Select corridor and Add Regions
 7. Set the regions for 14th street and Upper Pine to include the footprint of the entire inter-

section
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 8. With the Corridor selected use the Match Parameters command > select the first region 
as the source and then the next two as destinations
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 9. Add critical frequencies where the elevation has to be absolutely correct like at the curb 
and gutter line and where the side road centerline crosses the main road ETW

 A. Select the corridor
 B. Modify Corridor Sections panel > Add a Section
 C. Select the end of curb and ETW at centerline of intersecting roadway

 

Rural intersection: setup surface

Total video time: 2:45

Last updated: 2018-02-20
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Setup surface

Exercise files: rurl-int-prelim-pln-end-c3d16.zip

Start with: 12345678\Design\aliprofs\AliProf-25.dwg

rurl-int-setup-srfc-01.mp4 2:45

Create the setup surface from the setup corridor

 1. Select the corridor > Corridor Surfaces > Create Corridor Surfaces
 2. Rename it to Crdr-25-setup-ETW
 3. Style > Top Triangles
 4. Set Data type to Links and Code to Top > +

 5. OK > Rebuild Surface
 6. Select the corridor and set the codes to No display
 7. Feature lines tab > select all feature lines > No Display
 8. Create a data shortcut for the Corridor surface
 9. Save

Rural intersection: create corridor file

Total video time: 4:07

Last updated: 2018-02-20

Create corridor file

Exercise files: rurl-int-setup-srfc-end-c3d16.zip

Start with 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-creat-crdr-fil-01.mp4 4:07

Create the setup surface from the setup corridor
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 1. Open a new WisDOT template file > save as Crdr-25-4thAve in the corridor folder
 2. Create Data References

 A. Surfaces > Existing Ground > Existing border Display style
 B. Surfaces > Crdr-25-Setup-ETW > No Display
 C. Alignments > Centerlines > 25 > 1IN 40FT Ticks 100' Major 500' Minor
 D. Alignments > Centerlines > Lcl-4thAve > 1IN 40FT Ticks 100' Major 500' Minor
 E. Alignments > Offset Alignments > add all offset alignments with No Display to 

their respective layers
 3. Xref AliProf.dwg and adjust the layers

 A. Layer Properties > AliProf 
 B. Select all P_RDWY > invert selection > freeze
 C. Freeze 14thSt-IntLayout
 D. Freeze UpperPine-IntLayout

Rural intersection: side road profile

Total video time: 13:43

Last updated: 2018-02-20

Side road profile

Exercise files: rurl-int-creat-crdr-fil-end-data-c3d16.zip

Start with: 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-creat-sdrd-prfl-01.mp4 4:54

Create the setup surface from the setup corridor

 1. Home tab > Create Design > Profile > Create Profile
 2. Alignment > Lcl-4thAve
 3. Surfaces > Existing > Add > Draw in Profile View
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 4. Profile Display Options tab > Labels > No Labels
 5. Accept the remaining defaults > Create Profile View
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 6. Place in drawing off to the side

Comment: To create a proposed profile you need to have an idea where to match exist-
ing ground. One of the controlling factors is knowing the extents of the superelevation of 
the curve. To quickly find that add a label to the alignment.

 1. Select the alignment > Right click > Edit Alignment Labels
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 2. Type drop down > Superelevation Critical Points > Add
 3. Check none > check Begin normal crown and End normal crown
 4. OK > OK
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Comment: The corridor will have to begin at 43+21 and end at 53+05

 1. Home tab > Create Design > Profile > Profile Creation Tools
 2. Select 4thAve alignment > Profile view
 3. <[Alignment Name]>-Prop > PROF Proposed style > WisDOT Standard Label set
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 4. Draw Tangents without curves 
 5. Use the transparent command Profile Station and Elevation from Plan > follow prompts
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 F. Select the profile view
 G. Select the surface
 H. Select the beginning point by typing in the Station 43+20
 I. Select the end station 53+05
 J. Enter > Enter
 K. A profile is created that is tied into the existing ground at the beginning and end station

Side road profile (intersection object)

rurl-int-creat-sdrd-prfl-02.mp4 5:41

With the ends of the profile tied in we can now tie down the profile to match into highway 25 at 
the centerline and both edges. The intersection object tool locks profile alignment combinations 
together. We will lock the proposed profile to the highway 25 existing profile.

 1. Home tab > Create Design > Intersections > Create Intersection
 2. Select the intersection point of the two alignments
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 3. The command line prompts you for the main road alignment which is the controlling 
alignment- Select Highway 25

 4. Name > <Primary Name>-<Secondary Name>
 5. Make sure 25 is the main alignment and Lcl4thAve is the secondary > uncheck create off-

set alignments
 6. Create Intersection- a PVI is created and the elevation is locked down

 7. Create surface profile for Highway 25 ETW 
 A. Home tab > Create Design > Profile > Create Surface Profile
 B. Alignment > 25-Left-ETW > Crdr-25-Setup-ETW > Add
 C. Alignment > 25-Right-ETW > Crdr-25-Setup-ETW > Add > OK

 8. Home tab > Create Design > Intersections > Create Intersection
 9. Select the ETW

 10. Select 25-Right ETW for the main alignment > Lcl4thAve secondary
 11. Uncheck create offset alignments > Create intersection
 12. Repeat with the left side
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 13. Create Intersection- a PVI is created and the elevation is locked down
 14. The key locations for the profile are locked down

Info: Because 4thAve crosses Highway at a skew the slopes are not 2%. 
They are 2% when perpendicular.

Side road profile continued

rurl-int-creat-sdrd-prfl-03.mp4 3:08

The rest of the work is design work. the PVI's and elevations have been pre-determined and 
they will just be entered here.
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 1. Select the profile > Profile Properties > Design Criteria tab
 2. Check Use criteria-based design and Use design criteria file > WisDOT Design Criteria 

2009.xml > WisDOT Standard-Desirable Category 1 > OK

 3. Select Geometry Editor > Insert PVI 
 4. Use the transparent command Profile Station Elevation

Sta 44+35 Elev 1141.03'
Sta 46+30 Elev 1137.50'
Sta 51+60 Elev 1141.00'

 5. Press Enter 3 times to complete the task

 6. Create Free Vertical Curve (Parabola) 
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 7. Select the first entity and second entity on screen > Length = 230'

 8. Select the next two tangents > Length = 155'
 9. Select the last two tangents > Length = 150'

Info: In the tabular editor you can see the minimum K values based on the 
design speed established on the alignment.

Rural intersection: intersection edgeline alignments

Total video time: 23:27

Last updated: 2018-02-20

Corridor alignments

Exercise files: rurl-int-creat-sdrd-prfl-end-data-c3d16.zip

Start with 12345678\Design\Crdr-25-4thAve.dwg

rurl-int-crdr-edglin-ali-01.mp4 4:00

The rest of the work is design work. the PVI's and elevations have been pre-determined and 
they will just be entered here.

 1. Home tab > Create Design > Alignment > Alignment Creation Tools
 2. Draw Tangent- Tangent without curves > name it 25-Right-TrnLn > RDWY Pavement 
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Edge style > No Labels > OK 
 3. Trace the entire reference block ETW

 4. To better view the alignments fade the xref to 60
 5. Home tab > Create Design > Alignment > Alignment Creation Tools
 6. 25-Right-EPS > RDWY paved shoulder
 7. Trace the paved shoulder in the block
 8. Repeat the process with the gravel shoulder
 9. Repeat all the steps for the left side

Corridor alignments continued

rurl-int-crdr-edglin-ali-02.mp4 7:08
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There are two alternatives for creating the side road edgeline alignments.

Method 1:  Create offset alignments from the centerline alignment from construction limit to 
construction limit.  Mask the alignments between the curb return approach tapers.  Create sep-
arate alignments for the curb return approach tapers.

Upside-

• Dynamic connection to the centerline alignment.  Reactive to side road geometric 
changes. (still requires manual edits at the curb return approach tapers)

• Less risk to the curb return intersection objects because they are based on sep-
arate alignments for the tapers.

Downside-

• Minimum of 4 additional alignments to manage.

• More alignments to target with the corridor.

Method 2: Create a single alignment for each edgeline from construction limit to construction 
limit.

Upside-

• Less alignments to target.  Allows for expanded use of the Match Corridor Region 
Parameters command.

• Less alignments to create and manage, especially related to data shortcuts.

Downside-

• Requires more editing if side road geometry changes.

• May need to recreate curb return intersection objects if side road geometry 
changes.

Create the alignment

 1. Create a offset of 11' on either side of the 4th Avenue alignment to have something to 
snap to 

 2. Create 3' offsets from those lines for the shoulder
 3. Home tab > Create Design > Alignment > Alignment Creation Tools
 4. Lcl-4thAve-Left-ETW > RDWY Pavement Edge style > No Labels
 5. Draw Tangent- Tangent without curves
 6. Select the transparent command Station Offset
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 7. Specify the station 4320 > -11' offset (for left side) > Escape > Select the PC and enter

Tip: The best snaps to have turned on right now are the Endpoint, Inter-
section and Extension

 8. Draw Tangent- Tangent without curves > Select the PT and then the PC > Enter
 9. Draw Tangent- Tangent without curves > Select the next PT > start of taper > end of 

taper > extension to ETW > across the intersection > back of curb > finish the tapers
 10. Draw Tangent- Tangent without curves > last PT > use the Station Offset transparent tool 

5305 > -11'
 11. Free Curve Fillet (Between two entities, through point) > select the two tangents and 

then a point along the curve

Tip: Using the Selection cycling here ensures that you are grabbing the 
alignment and not the poly line which are on top of each other.
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 12. Repeat with the remaining curves > Enter to end the command
 13. Repeat all the steps for the shoulder and the ETW & EGS on the right side

Corridor alignments continued

rurl-int-crdr-edglin-ali-03.mp4 5:29

Comment: The final alignments are the curb return alignments. The curb return blocks 
slightly overlap the ETW alignment. We will have intersection objects tying down the 
ends of the curb and gutter. Intersection objects work best when the intersecting align-
ments have some overlap.

 

 1. Home tab > Create Design > Alignment > Alignment Creation Tools
 2. Name > Int-25-4thAve-SE-CG > RDWY Curb&Gutter Flange > No Labels

Tip: All alignments should be created in a clockwise direction. This allows 
the use of one assembly for all the curbs. 

 3. Tan-Tan (No curves) > draw the beginning and end tangents on the curb
 4. Free Curve Fillet (between two entities, through point) > Select the tangents then a point 

of the curve
 5. Repeat for the NE C&G

Comment: An alternate method is to us tangent with curve command.

Corridor alignments continued

rurl-int-crdr-edglin-ali-04.mp4 6:50
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Start by masking the part of the alignments that we don't want to see in the Plans Productions 
drawings

 1. Select an alignment > Alignment Properties > Masking tab > Select region > select the 
edge of the alignment where you want to mask > OK

 2. Repeat with all the other alignments to clean up the drawing
 3. Create Data Shortcuts > Select all the miscellaneous Alignments just created
 4. Open the pavement file
 5. In TOOLSPACE Prospector tab select an alignment > right click > Create Reference > Set 

Alignment Style > No Labels
 6. Repeat with all the miscellaneous alignments
 7. Select the Home tab > Create Design > Alignment > Alignment Creation Tools
 8. Draw Tangent- Tangent without curves > name it 25-Right-TrnLn > RDWY Pavement 

Edge style > No Labels > OK 
 9. Trace the entire reference block ETW

Tip: There is a part of the block that overlaps the 25-Right-ETW alignment 
10' before the start for the taper. It is best practice to overlap the alignments 
this way instead of starting right at the end of the matching alignment to aid 
in conditional targeting.

 10. To better view the alignments fade the xref to 60
 11. Home tab > Create Design > Alignment > Alignment Creation Tools
 12. 25-Right-EPS > RDWY paved shoulder style
 13. Trace the paved shoulder in the block
 14. Repeat the process with the Gravel shoulder
 15. Repeat all the steps for the left side

Rural intersection: side road setup corridor

Total video time: 5:25

Last updated: 2018-02-20

Side road ETW setup corridor

Exercise files: rurl-int-crdr-edglin-ali-end-c3d16.zip

Start with: 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-creat-sdrd-setup-crdr-01.mp4 5:25
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Comment: In the AliProf.dwg we made a Highway 25 setup corridor which will be used 
to tie down the curb and gutter elevation. We need another setup corridor to tie down the 
curb and gutter elevations for 4th Ave.

 1. Create the Assembly
 A. WisDOT Design tab > WisDOT & Civil Imperial palette > General tab 
 B. Home tab > Create Design > Assembly > Create Assembly

 C. Place the Assembly off to the side
 D. MultiUseWidthAndSlopeLinks > Place on the assembly

Right inside width 20.000'
Right inside SE Use outside lane SE
Right outside width 5.000'
Right outside SE Use outside lane SE
Left inside width 20.000'
Left inside SE Use outside lane SE
Right outside width 5.000'
Right outside SE Use outside lane SE

 E. OK
 2. Home tab > Create Design > Corridor
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 3. Set the Baseline and Region Parameters to the end of each taper
 4. Set the frequencies to 2.5'
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 5. OK > OK > Rebuild Corridor
 6. Add Sections at the back of curb
 7. Create corridor surface > adjust the name > No Display > Top code > Add as a breakline 

> OK
 8. In the corridor change the code set to No Display and the feature lines to No Display

Rural intersection: curb return setup and assembly

Total video time: 3:56

Last updated: 2018-02-20

Setup curb & gutter assembly

Exercise files: rurl-int-creat-sdrd-setup-crdr-end-data-c3d16.zip

Start with: 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-cr-setup-prfl-asmbly-01.mp4 3:56

Comment: Develop the curb return profiles by creating another setup corridor. This setup 
corridor will give us a range of where we can set our curb return profiles. The range is 
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developed by setting a minimum and maximum slope away from 25 ETW and 4thAve 
centerline

 1. WisDOT & Civil Imperial palette > Setup Assemblies tab > Setup-Curb-Prof
 2. Place by the other assembly 
 3. Set Assembly Properties

 A. Max slope -4%
 B. Min slope -1%
 C. Norm slope -2%

 4. Home tab > Create Design > Profile > Create Surface Profile
 5. Select the Int-25-4thAve-NE-CG alignment > Exist surface > Add > OK

 6. Repeat for the other three corners

Rural intersection: curb return setup corridor

Total video time: 12:16

Last updated: 2018-02-20

Setup curb & gutter profile corridor
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Exercise files: rurl-int-creat-sdrd-setup-crdr-end-data-c3d16.zip

Start with: 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-cr-setup-crdr-01.mp4 4:24

Info: Develop the curb return profiles by creating another setup corridor. This setup 
corridor will give us a range of where we can set our curb return profiles. The range 
is developed by setting a minimum and maximum slope away from 25 ETW and 
4thAve centerline

 1. Home tab > Create Design > Corridor > 4thAve-Setup-CG-Prof
 2. Alignment > Int-25-4thAve-NE-CG
 3. Set the frequencies to 2.5' and set the profile settings to No
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 4. Set Targets

 

Target Object Name Subassembly

Target Align-
ment

25-Right-ETW

Lcl-4thAve

Target ETW Ali_Prof and Sideroad 
Ali_Prof

Target Align-
ment

Int-25-4thAve-NE-CG
Max Slope-TARGET-Curb Return 
Ali
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Target Object Name Subassembly

Target Align-
ment

25-Right-ETW-Crdr-25-
Setup-ETW

Lcl-4thAve-Prop

Target ETW Ali_Prof and Sideroad 
Ali_Prof

 5. OK > OK
 6. Because the targets are similar between the NE and SE corners we can quickly create 

the SE corner using data from the NE
 7. Select corridor > Add Baseline > Select the SE Alignment > OK > Add region > Select the 

beginning and end of the CG > Setup-Curb-Prof > OK > OK
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 8. With the corridor still selected > Match Parameters > Select the NE then the SE > Enter
 9. Edit targets > Change the Max slope to SE from NE
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Setup Curb & Gutter Profile Corridor Continued

rurl-int-cr-setup-crdr-02.mp4 3:07

 1. With corridor selected > Add base > Select the SW CG > Click the beginning and end of 
CG > 

 2. Alignment > Int-25-4thAve-SW-CG
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 3. Set the frequencies to 2.5' and set the profile settings to No
 4. Set targets

 

Target Object Name Subassembly

Target Align-
ment

25-Left-ETW

Lcl-4thAve

Target ETW Ali_Prof and Sideroad 
Ali_Prof

Target Align- Int-25-4thAve-SW-CG Max Slope-TARGET-Curb Return Ali

Page: 647

Published on: 2/21/2018

Rural intersection



Target Object Name Subassembly

ment

Target Align-
ment

25-Left-ETW-Crdr-25-
Setup-ETW

Lcl-4thAve-Prop

Target ETW Ali_Prof and Sideroad 
Ali_Prof

 5. Because the targets are similar between the SW and NW corners we can quickly create 
the NW corner using data from the SW

 6. Select corridor > Add Baseline > Select Profile > Add region > Select the beginning and 
end of the CG > Setup-Curb-Prof > OK > OK

 7. With the corridor still selected > Match Parameters > Select the SW then NW
 8. Edit targets > Change the Max slope to NW from SW
 9. Highlight the corridor > Match Parameters > Settings > Only Match Frequencies 
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 10. Select the SE region then the SW & NW > Enter

Setup curb & gutter profile corridor continued
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rurl-int-cr-setup-crdr-03.mp4 4:49

 1. Select the corridor > Section Editor
 2. Viewport Configuration 

Info: From the curb return baseline the corridor finds the 25-ETW or Lcl4thAve 
centerline and then projects three slopes- the min, max and norm. Those slopes 
can be set to whatever is needed but for this project they are -1%, -4% & -2%. That 
gives a range in which to set the final profile. Next we will create three surfaces- 
one for each slope.

 1. Select corridor > Corridor Surfaces 
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 2. Rebuild Corridor
 3. Profile > Create Profile from Surface > Select SE Alignment > Select the three surfaces > 

Add > Change style to RDWY Lane Edge
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 4. Draw in Profile View > Profile Display Options > No Labels > Create Profile View

 5. Repeat with the three other corners

Rural intersection: curb return profiles

Total video time: 12:35

Last updated: 2018-02-20

Curb & gutter profiles

Exercise files: rurl-int-cr-setup-crdr-end-data-c3d16.zip

Start with: 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-cr-prfl-01.mp4 3:39

Tip:  This symbol indicates the corridor is out of date. 
Right click and you can rebuild. They can also be set up to rebuild automatically. 
The advantage of auto rebuild is you get automatic feedback on design changes. 
The disadvantage is every time changes are made the corridor will take time to 
rebuild.

 1. In the corridor properties set the code set style to No Display and select all the feature 
lines > No Display

 2. Profile > Create Surface Profile > 25-Right-Trn-Ln alignment > Crdr-25-Setup-ETW sur-
face > Add > OK
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 3. Repeat for the left side
 4. Repeat for the 4thAve right and left sides

Setup curb & gutter profile corridor continued

rurl-int-cr-prfl-02.mp4 5:39

 1. Profile > Profile Creation Tools > Select the Profile view > <[Alignment Name]>-Prop > 
OK

 2. Tan Tan No curves > draw a line past the extents of the profiles (elevation doesn't matter 
here)

 3. Repeat for the other three corners
 4. Intersection > Create Intersections > Select the intersection point > 25-Right-TrnLn is 

main > deselect create offset alignments > Create 
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 5. Repeat for the other seven intersections

Curb & gutter profiles continued

rurl-int-cr-prfl-03.mp4 3:17

Comment: Now we will refine the profiles so they fit nicely within the slope ranges we 
have created

 1. Select a profile > Geometry Editor > Insert PVI 
 2. Place it somewhere in between the slope ranges

Page: 654

Published on: 2/21/2018

Rural intersection

http://www.c3dkb.dot.wi.gov/video/rdwy-dsn/rurl-int/rurl-int-cr-prfl-03.mp4


Page: 655

Published on: 2/21/2018

Rural intersection



 3. Repeat with the other curves
 4. Use the grip at the PVI to drag it to a place that fits well
 5. When there is a pronounced grade change you can smooth it out by adding a vertical 

curve
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Rural intersection: create mainline assembly with conditional subassemblies

Total video time: 8:26

Last updated: 2018-02-20

Part 1

Exercise files: rurl-int-cret-mnln-asmbly-cndtnl-01-begin-data-c3d16.zip

Start with: 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-creat-mnln-asmbly-cndtnl-01.mp4 4:48

Here we will build the assemblies for the corridor design. These assemblies will use conditional 
subassemblies so one assembly can do much of the design work for the entire intersection. This 
is an optional method; a more traditional method would be to build a series of assemblies that 
react to regions in the corridor which we will cover in the side roads design.

 1. Home > Create Design > Assembly > Create Assembly
 2. Name it 25-FullSection- something to easily identify later
 3. Place in drawing by other assemblies
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 4. WisDOT Design > WisDOT & Civil Imperial > Lanes tab > LnExtendBase  

 5. Accept the defaults and select the assembly twice to add the sub to each side

 6. Tool Palette > Conditional tab > Conditional Horizontal Target
 7. Place a Target Not Found and a Target Found at the right edge of the roadway
 8. Place a Target Not Found at the end of the Target Found Subassembly
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 9. Tool Palette > Lanes tab > ShldGeneric
 10. Use the default parameters and attach to the Target Not Found subassembly

 11. Tool Palette > Daylights & Slopes tab > DaylightProfileControlled
 12. In the Parameters box 

 A. Ditch/Fill switch > Ditch to create a ditch all the time even with fill
 B. Ditch backslope > 4.00:1
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 C. Daylight fill slope > 4.00:1
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 13. Select the outside of the ShldGeneric subassembly
 14. This conditional assembly completes the main road assembly or the areas where there is 

no turn lane
 15. Save to use for the next exercise

Part 2

Exercise files: rurl-int-cret-mnln-asmbly-cndtnl-01-begin-data-c3d16.zip

Start with the previous exercise or start with: 12345678\Design\Corridors\Crdr-25-
4thAve.dwg

rurl-int-creat-asmbly-cndtnl-02.mp4 3:38

This step will build the conditional Target Found where there is a turn lane

 1. Highlight the right lane assembly
 2. Modify Subassembly tab > Copy
 3. Select the end of the Found > Not Found conditional
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 4. Highlight the curb & gutter subassembly and copy to the outside of the lane

Tip: In this condition the subassembly represents the turn lane which starts narrow 
and widens. The target will override the width parameter but it may start early or 
overlap. To safeguard against this set the lane width parameter in the subassembly 
properties to 0.01'
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 5. In the Curb and gutter subassembly properties set the paved width to 0.00'

 6. Highlight all the conditional subassemblies 
 7. Modify Subassembly > Mirror
 8. Select the outside of the left lane

Rural intersection: rename subassemblies

Total video time: 4:23

Last updated: 2018-02-20
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Exercise files: rurl-int-cret-mnln-asmbly-cndtnl-01-begin-data-c3d16.zip

Start with: 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-renam-sub-01.mp4 4:23

Tip: It is critical to make sure all of the names of the subassemblies are correct. 
You can do it as you are building them or after the assembly is built. Be sure to 
label right or left side and what the assembly targets.

 1. LnExtendBase-R
 2. CondHorizTarget-TrnLn-NotFound-R
 3. CondHorizTarget-TrnLn-Found-R
 4. CondHorizTarget-IntCore-NotFound-R
 5. ShldGeneric-R
 6. LnExtendBase-TrnLn-R
 7. ShldGeneric-TrnLn-R
 8. DaylightProfileControlled-R
 9. DaylightProfileControlled-TrnLn-R

 10. Tip: If you label all of the subassemblies before you mirror them the names 
will follow them. Then you would only have to change each R to an L. These 
don't have to be labeled- labels are shown here for informational purposes.

 11. LnExtendBase-L
 12. CondHorizTarget-TrnLn-NotFound-L
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 13. CondHorizTarget-TrnLn-Found-L
 14. CondHorizTarget-IntCore-NotFound-L
 15. ShldGeneric-L
 16. LnExtendBase-TrnLn-L
 17. ShldGeneric-TrnLn-L
 18. DaylightProfileControlled-L
 19. DaylightProfileControlled-TrnLn-L

Rural intersection: create side road assemblies

Total video time: 4:30

Last updated: 2018-02-20

Exercise files: rurl-int-creat-trgt-ali-int-cor-end-data-c3d16.zip

Start with: 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-creat-sdrd-asmbly-01.mp4 4:30

In this topic we will build the assembly for the secondary road, 4th Avenue

 1. Home > Create Design > Assembly > Create Assembly
 2. Name it 4thAve-FullSection
 3. Insert it just below the other assembly
 4. Select each of the roads > copy and paste to the new assembly
 5. Select the curb and gutter and daylight assemblies > copy and past to 4thAve-FullSection
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 6. Info: As the corridor enters the intersection there may be sections where it 
doesn't have daylight. For these we will create an assembly with just one 
side of the road. Because 4thAve does not go through the intersection but 
skips over it we will create a null assembly for that area.

 7. Copy the 4thAve assembly twice to just below it
 8. Delete the right subassemblies from the left copy
 9. Delete the left subassemblies from the right copy

 10. Rename to 4thAve-DayLeft and 4thAve-DayRight

 11. Home > Create Design > Assembly > Create Assembly
 12. Name it 4thAve-Null
 13. Do not add sub assemblies

Warning: It is important at this point to make sure all your subassemblies are 
named appropriately. If you haven't already take some time to rename them all so 
you can find them later.

Rural intersection: create curb return assemblies

Total video time: 7:57
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Last updated: 2018-02-20

Info: No matter which way you decide to do your assemblies, whether you do con-
ditional subassemblies or use the more traditional regions method, the curb return 
fillet assemblies will have to be made separately. 

Assembly with no daylight

Exercise files: rurl-int-creat-sdrd-asmbly-end-data-c3d16.zip

Start with 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-creat-cr-asmbly-01.mp4 3:27

 1. Home > Create Design > Assembly > Create Assembly
 2. Name it Curb Return Fillet
 3. Copy the pavement from the left side
 4. Open the Subassemblies Properties > Parameters tab

 A. Pavement slope > 2.00%
 B. Crown location > Outside
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 C. Inside base extension width > 5.00'

Info: This subassembly is going to start at the curb and build back toward the 
crown; most other assemblies start at the crown. The inside base extension will cre-
ate a sub base for the curb and gutter.

 5. Tool Palette > Barriers tab > CGBasic
 6. Properties > Parameters

 A. Curb and gutter size > Wi 36"
 B. Wi 36" curb types > D 6" curb sloped
 C. Terrace slope (%) > -4.00%
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 D. Select the Assembly

Info: There is a slight overlap of the sub base and curb. That material will be meas-
ured along the bottom where they overlap.

 7. Save for next exercise

Assembly with daylight

Exercise files: Continue with previous data set or start with: rurl-int-creat-cr-asmbly-01-end-
data-c3d16.zip

Start with 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-creat-cr-asmbly-02.mp4 3:35

There may be time that you need to daylight the back of curb. Start by copying the curb and gut-
ter assembly.
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 1. Select the new assembly > Properties
 2. Rename Curb Return Fillet Daylight
 3. Tool Palette > General Assemblies tab > LinkProfileControlled
 4. Properties > Parameters

 A. Slope > -4.00:1
 B. Outer Point > Ditch_In
 C. Link > Top,LABELSLP

Tip: The exact spelling and capitalization is very important for the coding that 
comes up later.

 5. Tool Palette > Daylight tab > CutFillProfileControlled
 6. Properties > Parameters

 A. Offset to measure recoverable slope from > 1.00'
 B. Recoverable slope > 6.00:1
 C. Clear zone distance > 1.00'
 D. Recoverable fill slope distance > 1.00'
 E. Cut slope > 4.00:1
 F. Fill slope > 4.00:1

 7. Connect the subassembly to the back end of the LinkProfileControlled sub
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Rural intersection: label assemblies

Total video time: 8:34

Last updated: 2018-02-20

Exercise files: rurl-int-creat-cr-asmbly-02-end-data-c3d16.zip

Start with: 12345678\Design\Corridors\Crdr-25-4thAve.dwg
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rurl-int-labl-asmbly-01.mp4 1:54

One of the tools that is not strictly necessary but that can be very helpful is the Label Assem-
blies tool.

 1. To label single assembly
 A. WisDOT Design tab > Label Assemblies
 B. Input text size- 0.075 is good
 C. Enter for single
 D. Press any key to continue- unless you want to erase label
 E. Select the Assembly
 F. Left click on the screen to place it

 2. To Label all assemblies at once
 A. WisDOT Design tab > Label Assemblies
 B. Input text size- 0.075 is good
 C. Type A > Enter- all labels are created

Rural intersection: create target alignments for intersection core

Total video time: 3:05

Last updated: 2018-02-20

Exercise files: rurl-int-lbl-asmbly-end-data-c3d16.zip

Start with: 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-creat-trgt-ali-int-cor-01.mp4 3:05

The next step is to create the targets for the interior of the intersection core. The regular 
assembly is going to build the road and the turn lane but when it gets to the intersection we 
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want it to drop everything except the lane edge. We will create an alignment that stretches 
across the intersection.

 1. Home > Create Design > Alignment > Alignment Creation Tools

 2. Name it: Int-25-4thAve-IntCore-Rt
 3. Alignment Style > RDWY Lane Edge

 4. Use the tangent tangent no curve tool to draw from the beginning of intersection to the 
end
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 5. Close out the tool bar
 6. Repeat the above steps for the left side
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Info: These alignments do not need to be data referenced. We will be using them 
only in the file. If needed they could be data referenced if they were needed else-
where.

Rural intersection: mainline assembly corridor targeting

Total video time: 7:47

Last updated: 2018-02-20

Horizontal targets

Exercise files: rurl-int-creat-trgt-ali-int-cor-end-data-c3d16.zip

Start with: 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-mnln-asmbly-crdr-trgt-01.mp4 5:55

Here we will start to build the corridor starting with Highway 25. One assembly will almost all 
of the design but we have to do quite a bit of targeting first.
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 1. Home tab > Create Design > Corridor Set the following parameters

 2. Start Station > 370+00.00'
 3. End Station > 423+00.00'
 4. Frequency > 25.00'
 5. Open Target Mapping dialog box
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 6. Surfaces > All Existing
 7. Set Parameters carefully > Add > OK

 8. Repeat for the left side
 9. Save for the next exercise

Vertical targets

Exercise files: Continue with previous data set or start with: rurl-int-creat-trgt-ali-int-cor-
end-data-c3d16.zip

Start with 12345678\Design\Corridors\Crdr-25-4thAve.dwg
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rurl-int-mnln-asmbly-crdr-trgt-02.mp4 1:52

 1. LnExtendBase-R > 25-Right-ETW-25-Right-ETW-crdr-25-Setup-ETW
 2. LnExtendBase-TrnLn-R > 25-Right-TrnLn-25-Right-TrnLn-Crdr-25-Setup-ETW

 3. Repeat for the left
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 4. OK > OK > Rebuild Corridor

Rural intersection: create side road regions

Total video time: 8:45

Last updated: 2018-02-20

Insert assemblies

Exercise files: rurl-int-mnln-asmbly-crdr-trgt-end-data-c3d16.zip

Start with: 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-creat-sdrd-rgn-01.mp4 3:59

Here we will add in the side road using regions for 4th Ave

 1. Select the Corridor > Corridor Properties > Parameters tab > Add Baseline > Lcl-
4thAve 
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 2. Alignment > Lcl-4thAve
 3. Profile > Lcl4thAve-Prop
 4. Right click the region and Add Region
 5. Select the 4thAve-FullSection to start

 6. Select the region > In Start Station click select on screen > Select the beginning of one of 
the alignments
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 7. End Station > Select from screen
 8. Select the first curb return
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 9. Right click the region > Insert region - After

Info: Because the curb return will be the target on the left side here we will only 
have lane and daylight on the right hand side until the other curb and gutter starts.
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 10. Assembly > 4thAve-Day-Right > Select the start of curb return on the right

 11. Right click that region > Insert Region - After > Assembly > 4thAve-Null > Select the 
nearest curb return on the far side of intersection
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 12. Right click the null region > Insert Region - After > 4thAve-Day-Left > End Station > select 
the next curb return
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 13. Right click the new region > Insert Region - After > 4thAve-FullSection > End Station > 
End of the alignments
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 14. OK > Rebuild Corridor
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 15. Save for use with next exercise

Set targets

Exercise files: Continue with previous data set or start with: rurl-int-mnln-asmbly-crdr-trgt-
end-data-c3d16.zip

Start with 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-creat-sdrd-rgn-02.mp4 4:46

Now we will make sure the targets are correct for 4thAve. You can go into Corridor Properties 
and select the ellipse for each one and edit there or better yet select Edit Targets and select the 
region. That way you will only be show the targets in that region.

 1. Select the Corridor > Edit Targets > Select the first region
 2. Surfaces > Click here to set all > Exist
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 3. The next section will only have targets on the right
 4. The other Daylight section will only have targets on the left
 5. The last section will be targeted the same as the first

 6. Save

Rural intersection: create curb return regions

Total video time: 9:09

Last updated: 2018-02-20
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Regions without daylight

Exercise files: rurl-int-cr-rgn-01-end-data-c3d16.zip

Start with: 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-cr-rgn-01.mp4 5:05

To finish of the corridor design we need to create the curb return fillet regions. these will be 
assemblies that move along the curb return baseline and shoot back towards the lane edge of 
25 and the centerline of 4th Ave. We will use a no daylight assembly in the southern 2 quad-
rants. Later we will make daylight versions in the north quadrants.

 1. Corridor Properties > Parameters tab > Add Baseline
 2. Alignment > Int-25-4thAve-SE
 3. Profile > Int-25-4thAve-SE-CG-Prop
 4. Alternately you can select from screen
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 5. Right click the Baseline > Add Region > Assembly > Curb Return Fillet
 6. Select the Beginning and the End of the curb return
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 7. Set the frequencies to 2.50'
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 8. Open the Target Mapping dialog box
 9. Target Lane Width to Lcl4thAve (the centerline of the side road)

 10. Target Lane Width a second time to 25-Left-ETW

Info: The 25-Left-ETW is not visible right now, it is masked out so you aren't able to 
select from the screen.

 11. Target Lane Profile to 25-Left-ETW > 25-Left-ETW-Crdr-25-Setup-ETW
 12. Target Lane Profile a second time to Lcl4thAve > Proposed Profile
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 13. OK > OK > Rebuild Corridor

Tip: If the corridor doesn't match up perfectly you may have to manually add a fre-
quency.

 14. Highlight the Corridor > Edit Frequency > Select the Region
 15. In the Frequency dialog box select the + and left click the point on the screen
 16. OK > the frequency is added
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 17. Repeat the steps with the SE curb return
 18. Save for the next exercise

Regions with daylight

Exercise files: Continue with previous data set or start with: rurl-int-cr-rgn-01-end-data-
c3d16.zip

Start with 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-cr-rgn-02.mp4 4:04

For the north two curb returns we will add a daylight

 1. Corridor Properties >  Parameters tab > Add Baseline > Int-25-4thAve-NE-CG
 2. Horizontal Alignment > Int-25-4thAve-NE-CG
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 3. Right click the Baseline > Add Region > Assembly > Curb Return Fillet Daylight
 4. Select the beginning and end of curb return
 5. Set frequencies to 2.50'
 6. Target Lane Width to Lcl4thAve (the centerline of the side road)
 7. Target Lane Width a second time to 25-Right-ETW
 8. Target Lane Profile to 25-Right-ETW > 25-Right-ETW-Crdr-25-Setup-ETW
 9. Target Lane Profile a second time to Lcl4thAve > Proposed Profile

 10. OK > OK > Rebuild Corridor
 11. Repeat for the NE curb return

Rural intersection: create corridor datum surface

Total video time: 4:18

Last updated: 2018-02-20

Exercise files: rurl-int-cr-rgn-02-end-data-c3d16.zip
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Start with: 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-creat-crdr-datm-srfc-01.mp4 4:18

Now we will create data surfaces from the corridor. Because the top and datum surfaces over-
lap in a lot of areas we use a surface progression to not duplicate the data. Conventional sur-
face progression truncates the top surface where the top and datum meet- daylight areas of 
the back of the curb and gutter. The alternate progression is the opposite where the top goes to 
the daylight and the datum is truncated. You can find more on this by searching for Surface Pro-
gression in the C3DKB.

 1. Select the corridor > Corridor Surfaces > Create Corridor Surface > Rename it Crdr-25-
Datum

 2. Data type > Feature lines
 3. Specify code

 A. Berm_In
 B. Berm_Out
 C. CG_Terrace
 D. Clear_Zone
 E. Crown_Sub
 F. Daylight 
 G. Daylight_Sub
 H. Ditch_In
 I. ETW_Sub
 J. ETW_Sub_CG

 4. Boundaries tab > right click Surface > Corridor extents as outer boundary 
 5. OK > Rebuild Corridor
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 6. To check the surface right lick the surface in Prospector tab > Surface Properties > Sur-
face Style > P Contours 2' Major: 0.5' Minor

 7. Save the file
 8. Right click on Data Shortcuts > Create Data Shortcuts > select the surface
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Rural intersection: create corridor top surface

Total video time: 6:18

Last updated: 2018-02-20

Create surface

Exercise files: rurl-int-creat-crdr-datm-srfc-end-data-c3d16.zip

Start with: 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-creat-crdr-top-srfc-01.mp4 2:01

 1. Open Corridor Surfaces dialog box
 2. Create new surface named Crdr-25-Top
 3. Data Type > Feature Lines
 4. Specify code

 A. BackCurb
 B. Crown
 C. Daylight_Sub
 D. EPS
 E. ES
 F. ETW
 G. FaceCurb
 H. Flange
 I. Flowline_Gutter
 J. TopCurb
 K. ETW_Datum_CG

 5. Save for the next exercise

Create boundary
Page: 698

Published on: 2/21/2018

Rural intersection

http://www.c3dkb.dot.wi.gov/data/rdwy-dsn/rurl-int/rurl-int-creat-crdr-datm-srfc-end-data-c3d16.zip
http://www.c3dkb.dot.wi.gov/video/rdwy-dsn/rurl-int/rurl-int-creat-crdr-top-srfc-01.mp4


Exercise files: Continue from previous exercise or start with: rurl-int-creat-crdr-datm-srfc-
end-data-c3d16.zip

Start with: 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-creat-crdr-top-srfc-02.mp4 4:17

For the 25-Top Boundary we are not going all the way out to daylight so the corridor extents 
would be too far out from the last data point. Instead we will Add boundary interactively.

 1. In the Boudaries tab right click the corridor > Add Interactively
 2. Pick the Daylight_Sub Feature Line and a red line stretches out from it

 3. Drag the line to the end where it meets the curb and gutter and left click
 4. Start the line again at the ETW_Datum_CG Feature Line
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 5. Left click the end of this line to end and start again on the Daylight_Sub

 6. Click the end and start again across the corridor
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 7. Then to the end of Daylight_Sub
 8. Then to ETW_Datum_CG
 9. Continue following the two feature lines and hit C to close when you get back to the 

beginning of 25
 10. Change Surface Properties to contours to see results
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 3. Right click on Data Shortcuts > Create Data Shortcuts > select the surface
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Rural intersection: create refinement datum surface

Total video time: 4:26

Last updated: 2018-02-20

Exercise files: rurl-int-creat-crdr-top-srfc-end-data-c3d16.zip

Start with: 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-creat-rfnt-datm-srfc-01.mp4 4:26

Now that the corridor top surface and datum surface are created and data referenced into the 
project we will create the refinement surface files 
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 1. Create a new file > QNew

 2. Save As > up 1 level and into Surfaces folder > Srfc-Rfnt-All-Datum
 3. Save
 4. Toolspace > Prospector tab > Data Shortcuts > Surfaces > right click Crdr-25-Datum > 

Create Reference

Tip: You could set the style so it is visible but at this point it is better to leave 
as _No Display so when the Refinement surface is created the end result is 
visualized.

 5. Home tab > Create Ground Data > Create Surface
 6. Name it- Rfnt-25-Datum 

Tip: You could set the Style to P Border to just see the outline but it is better 
to set it to P Contours 2' Major:0.5' Minor to show that the surface is every-
where you want it to be.

 7. Toolspace > Prospector tab > Surfaces > Rfnt-25-Datum > Definition > right click Edits > 
Paste Surface > OK
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 8. Zoom Extents to see the surface
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 9. Save
 10. Right click Data Shortcuts > Create Data Shortcut
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Info: You can see the grading for ditches on the northern curb returns where 
they are daylighted. This video shows the acceptable minimum for design. If 
you had grading surfaces done you could add them here. We will cover grad-
ing, pipe clearance and other design options in later videos.

Rural intersection: create refinement top surface

Total video time: 4:59

Last updated: 2018-02-20

Exercise files: rurl-int-creat-rfnt-datm-srfc-end-data-c3d16.zip

Start with: 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-creat-rfnt-top-srfc-01.mp4 4:59

Next we will build the top refinement surface. We had to do the datum surface first because 
the datum surface does play a role in creating the top surface. That is how the conventional 
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surface progression works- the datum is be pasted in from daylight to daylight and the top sur-
face is being pasted on top.

 1. Create a new file > QNew

 2. Save As > Srfc-Rfnt-All-Top
 3. Save
 4. Toolspace > Prospector tab > Data Shortcuts > Surfaces > right click Crdr-25-Top > 

Create Reference
 5. Toolspace > Prospector tab > Data Shortcuts > Surfaces > right click Rfnt-25-Top > Create 

Reference

Tip: You could set the style so it is visible but at this point it is better to leave 
as _No Display so when the Refinement Top surface is created the end res-
ult is visualized.

 6. Home tab > Create Ground Data > Create Surface
 7. Name it- Rfnt-25-Top > _P Contours 2' Major:0.5' Minor

Tip: You could set the visual style to anything you want but setting it to some-
thing noisy like this will help visualize how the surface is progressing.

 8. Toolspace > Prospector tab > Surfaces > Rfnt-25-Datum > Definition > right click Edits > 
Paste Surface > OK

 9. Toolspace > Prospector tab > Surfaces > Rfnt-25-Top> Definition > right click Edits > 
Paste Surface > OK
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Warning: It is important that these are created in the right order. What ever is 
pasted second will override what was pasted first. Whenever there is a con-
flict what was save last wins. You could set the visual style to anything you 
want but setting it to something noisy like this will help visualize how the sur-
face is progressing.

 10. Save
 11. Right click Data Shortcuts > Create Data Shortcut
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Info: This video shows the acceptable minimum for design. If you had grad-
ing surfaces done you could add them here. We will cover grading, pipe 
clearance and other design options in later videos.

Rural intersection: design surface edits

Total video time: 7:46

Last updated: 2018-02-20

In this video we will show a few common edits that can be synchronized throughout the project 
to keep the refinement surfaces up to date. We will be addressing some of the common edits 
that most intersections will need and how to quickly deal with them.

Remove extra triangles

Exercise files: rurl-int-creat-rfnt-top-srfc-end-data-c3d16.zip
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Start with: 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-dsn-srfc-edit-01.mp4 1:16

Here we will turn on surface triangles and clean up triangles that break through the barrier 
somehow. Open the Crdr-25-4thAve file.

 1. Prospector tab > Surfaces > right click Crdr-25-Datum > Surface Properties > Surface 
style > P Triangles

 2. Select one of the triangles to highlight the surface
 3. Edit Surface > Delete lines
 4. Highlight the triangle lines you want to delete being careful not to delete ones you want
 5. Enter to delete > Escape to end command
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 6. Save to use for the next exercise

Add breaklines in curb returns to datum surface

Exercise files: Continue with the previous data set or start here: rurl-int-dsn-srfc-edit-01-end-
data-c3d16.zip

Start with: 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-dsn-srfc-edit-02.mp4 2:26

The surface is not respecting the frequency lines in parts of the intersection because some of 
the centerline points of 25 points can see the centerline points on 4thAve better then the curb 
returns. To fix this we will add breaklines from curb return to the intersection of 25 and 4thAve.

 1. Change current layer to P_Crdr_Base
 2. Using the line command create a line from the edge of curb return at the mid point to 
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the intersection of the quadrants

 3. Toolspace > Prospector tab > Crdr-25-Datum > Definition > right click Breaklines > Add 
Breaklines

 4. Description > Intersection > OK
 5. Select all 4 of them > OK
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Info: This might not be perfect through here. You can add more breaklines to refine 
it more if needed. Save here to push any referenced data out.

 6. Save for the next exercise

Add breaklines in curb returns to top surface

Exercise files: Continue with the previous data set or start here: rurl-int-dsn-srfc-edit-02-end-
data-c3d16.zip

Start with: 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-dsn-srfc-edit-03.mp4 2:24

 1. Set the Crdr-25-Datum surface to _No Display
 2. Set Crdr-25-Top to P Triangles
 3. Using the line command create a line from the edge of curb return at the mid point to 
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the intersection of the quadrants

 4. Toolspace > Prospector tab > Crdr-25-Top > Definition > right click Breaklines > Add 
Breaklines

 5. Select the 4 lines

Tip: When using the multi-select window the last line added will be above 
the rest. Use this tool to select the lines just created and not the previous fea-
ture lines.
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Synchronize edits to refinement surfaces

Exercise files: Continue with the previous data set or start here: rurl-int-dsn-srfc-edit-03-end-
data-c3d16.zip

Start with: 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-dsn-srfc-edit-04.mp4 1:40

Now we'll go to the design surfaces and make sure they updated appropriately. Because the 
Crdr25-Datum file was not open while we made the original changes the synchronization should 
have happened but this can also be done manually. We will also rebuild Rfnt-25-Datum.

 1. Open Srfc-Rfnt-All-Datum.dwg
 2. Prospector tab > Surfaces > right click Crdr-25-Datum > Synchronize 
 3. Right click Rfnt-25-Datum > Rebuild
 4. Save will push the changes out to any file using the refinement surface including the top
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 5. Open Srfc-Rfnt-All-Top
 6. Prospector tab > Surfaces > right click Rfnt-25-Top > Rebuild
 7. Save

Rural intersection: optional edits introduction

Total video time: 4:03

Last updated: 2018-02-20

rurl-int-optnl-edit-intro-01.mp4 4:03

Optional edits introduction

Before showing the optional edits to help the shoulder elevations and the curb and gutter elev-
ations match we will show you an overview of the results to help you decide if these options are 
necessary. These edits are optional only used if you find a special need to make the resulting 
surface more like what will be constructed out in the field.

Info: To show the changes clearly colors of the links have been changed here: 
green for the shoulder, yellow for the terrace behind the curb and gutter. We've also 
removed several point code labels that were cluttering the view.

 1. Match the curb head closer at the match point between the shoulder and the curb.
 2. Before

 3. After
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 4. Flatten the shoulder slope as we approach the curb and gutter match point. this will 
make the ditch point of the shoulder match more closely to the ditch point that would res-
ult from the back of terrace point.

 5. Before

 6. After
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 7. There is now almost a 6:1 slope vs. the original 4:1

Rural intersection: grading behind curb and gutter with feature lines

Total video time: 14:28

Last updated: 2018-02-20

What we will look at now are the several control options you have over the corridor. We have 
shown the minimum for design and now we are going to look at some tools and workflows for 
different design situations. Instead of being tied to make adjustments to targets at curb return 
where daylight is added you may choose to create feature lines to the area behind the curb 
return. This process will add a lot of flexibility on how to edit and control the graded area, but it 
does come with a lot of manual control.

Add back of terrace

Exercise files: rurl-int-dsn-srfc-edit-03-end-data-c3d16.zip

Start with: 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-grdg-bhnd-cg-fl-01.mp4 6:34

Starting in the SW quadrant there is a big gap in the surface area. We will add in a manual fea-
ture line to build a surface in this area which will then be pasted into the refinement surface fur-
ther down the project.

 1. Home tab > Create Design > Feature Line> Create Feature Line
 2. Change the layer to P_CRDR-Base
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 3. Select the daylight_sub feature line just outside the back of curb and gutter it will inherit 
the elevation of that point

 4. Select the same feature line on the far side of quadrant

 5. Enter to Specify elevation
 6. Insert a PI somewhere along the middle- it can be adjusted later
 7. Enter to specify elevation
 8. Select Free curve fillet between two entities or Radius if you know the radius
 9. Adjust the grips to get it to match the back of curb closely- it will not be tangent 
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anymore

 10. Save to use for the next exercise

Add ditch, slope intercept and back of curb

Exercise files: Contiue with previous data set or start with: rurl-int-dsn-srfc-edit-03-end-data-
c3d16.zip

Start with 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-grdg-bhnd-cg-fl-02.mp4 2:46
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 1. Home tab > Create Design > Feature Line> Create Feature Line
 2. Set lalyer to P_Crdr-Base
 3. Select the Ditch_In feature line it will inherit the elevation of that point

 4. Select the same feature line on the far side of quadrant

 5. Enter to Specify elevation
 6. Insert a PI somewhere along the middle- it can be adjusted later
 7. Enter to specify elevation
 8. Select Free curve fillet between two entities or Radius if you know the radius
 9. Adjust the grips to get it to match the other feature line
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 10. Repeat for the Daylight Feature Line
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Requirement: Because this is a daylight feature line we need to go through 
an extra step to make sure it drapes over the ground surface

 11. Select the feature line
 12. Edit elevations tab > Elevations from surface
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 13. Select Existing Surface 
 14. Insert intermediate grade break points > yes
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 15. OK > Escape

Info: We need to add one more feature line along the corridor. This one needs to 
be based off the corridor so if there are any changes to the corridor it will react with 
it.

Page: 728

Published on: 2/21/2018

Rural intersection



 16. Left click the outside corridor line > Create Feature Line from Corridor

 17. Layer > P_Crdr-Base
 18. No Smoothing

Tip: In many cases smoothing works great but it does change the elevation 
slightly and will create little holes in the surface.

 19. OK > Escape
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 20. When you hover over it you can see it is identified as an Auto Corridor Feature Line

 21. Save for use in the next exercise

Create surface

Exercise files: Continue with previous data set or start with: rurl-int-dsn-srfc-edit-03-end-
data-c3d16.zip

Start with 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-grdg-bhnd-cg-fl-03.mp4 5:08

Now we need to create a surface from the four feature lines.
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 1. Home > Create Ground Data > Surfaces > Create Surface
 2. Name in Grdg-Int-SW-Quad
 3. Change style to Contours 2' Major:0.5'Minor
 4. OK

 5. Prospector > Surfaces > Grdg-Int-SW-Quad > Definitions > right click Breaklines > Add
 6. Type > Standard
 7. Weeding > yes > 5.00'
 8. Supplementing > 10.0'
 9. Mid-ordinate distance > 0.125

Info: The supplementing factor can never be less than the Weeding factor as 
they have opposite functions. The mid-ordinate distance should be low 
because it is a curve but if you get too low it could cause excessive com-
puting time.

 10. Select the lines being careful to select the Auto Corridor Feature Line 
 11. OK
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 12. Change the surface style to P_Triangles and you can see triangles that should not be part 
of that surface
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 13. Highlight surface > Edit Surface > Delete Line
 14. Select all the lines outside the surface > Enter > Escape
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 15. Save > Create Data Shortcuts

Info: This will be pasted into the refinement surface

 1. Design > Surfaces folder > Srfc-Rfnt-All-Datum.dwg > Open
 2. Data Shortcuts > right click Grdg-Int-SW-Quad > Create Reference
 3. Project > Surfaces > Rfnt-Int-All-Datum > Definition > right click edits > Paste surface > 

Select Grdg-Int-SW-Quad 
 4. OK
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Rural intersection: grading behind curb and gutter with corridor

Total video time: 9:40

Last updated: 2018-02-20

In this session we will continue with a series of optional additions to the design by adding an 
alignment and profile target for ditch control. This will provide a greater amount of control as 
deign changes are needed later on. This is optional and only need if you are concerned with spe-
cific clearances such as pipe clearances or other specific situations that require a higher level 
of precision.

Create ditch alignment

Exercise files: rurl-int-grdg-bhnd-cg-fl-end-data-c3d16.zip

Start with: 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-grdg-bhnd-cg-crdr-01.mp4 3:18
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Starting in the NW quadrant the curb daylights far before the rest of the corridor. Here we 
would want to add a ditch that matches up with whats going on with the rest of the corridor.

 1. Home tab > Create Design > Alignment > Alignment Creation Tools
 2. Name it Int-25-4thAve-NW-Ditch
 3. Alignment Style > ALI Proposed

 4. Tangent Tangent (No curves)
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 5. Select along the edge of gravel surface starting and ending a ways into the corridor to 
help it blend in. The further back you select the more lead in you have and you can tell a 
better story as you are trying to design the profile.

 6. Insert a PI somewhere along the middle- it can be adjusted later
 7. Select Free curve fillet between two entities or Radius if you know the radius
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 8. Select two points along the curve as it approaches and leaves the PI

 9. Save for use in the next exercise

Create ditch profile

Exercise files: Continue with data set or start with: rurl-int-grdg-bhnd-cg-fl-end-data-
c3d16.zip

Start with 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-grdg-bhnd-cg-crdr-02.mp4 2:46

Even though this will be a proposed surface we will create a profile from surface
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 1. Home tab > Create Design > Profile > Create Profile from Surface
 2. Alignment > Int-25-4thAve-NW-Ditch

 3. Select Surfaces > Crdr-25-Datum Add > Draw in Profile View

 4. Profile > Profile Creation Tools
 5. Select the defaults
 6. Draw tangent to tangent no curves
 7. Snap to each of the points
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 8. Save

Target parameters

Exercise files: Continue with previous data set of start wit:rurl-int-grdg-bhnd-cg-fl-end-data-
c3d16.zip

Start with 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-grdg-bhnd-cg-crdr-03.mp4 2:13

 1. Highlight the corridor > corridor properties > NW quadrant > Targets
 2. Width of Offset dropdown > Width > LinkProfileControlled > OK 
 3. Int-25-4thAve-NW-Ditch > Add > OK

 4. Elevation > LinkProfileControlled > Int-25-4thAve-NW-Ditch > Add > OK
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 5. OK > OK > Rebuild Corridor

Synchronize refinement datum surface
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Exercise files: Continue with previous data set of start with: rurl-int-grdg-bhnd-cg-fl-end-
data-c3d16.zip

Start with 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-grdg-bhnd-cg-crdr-04.mp4 1:23

This has changed the way the corridor surface area is built in this area so first save the file to 
force the changes onto the refinement surface. Open the Rfnt-All-Datum file to synchronize.

 1. Prospector tab > Surfaces > right click Crdr-25-Datum > Synchronize
 2. Right click Rfnt-25-Datum > Rebuild
 3. Save

Rural intersection: taper curb head ends to zero height

Total video time: 9:14

Last updated: 2018-02-20

Here we are looking at optional edits that can further refine your intersection design. One of 
the optional edits that can solve some of the transition from shoulder to curb return issues that 
you may run into in a very detailed manner would be to suppress the curb head at the begin-
ning and end of the curb return area. This will better reflect whats going to happen out in the 
field and actually give a truer elevation of the tie ins. Keep in mind that this is not necessary 
unless you need a higher level of precision for your design. 

Create slope control profile

Exercise files: rurl-int-grdg-bhnd-cg-crdr-end-data-c3d16.zip

Start with: 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int/rurl-int-tapr-crb-head-01.mp4 2:47

We are going to use the slope width control editor on an alignment that's already there. The 
profile views will be affected at the end of the process. You can make a note here that the bot-
tom line of one of these views is 1120' so you can set the views back after this process is done.

 1. WisDOT Design tab > Slope / Width Control Editor > Create tab
 2. Alignment > Int-25-4thAve-SW-CG > It gets a New Profile Name with the prefix ZCP-
 3. Go from the beginning to the end of the stations
 4. Slopes > 0.0
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Tip: Without closing this window you could create the profiles for the other 3 
quadrants here.

 5. Save

Edit slope control profile

Exercise files: Continue with the previous data set or start here: rurl-int-grdg-bhnd-cg-crdr-
end-data-c3d16.zip

Start with 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-tapr-crb-head-02.mp4 2:35
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Here we will create a table to control the slope width through the curb return. There was a 10' 
overlap in the design so the curb return does not start until station 10+00 and ends 10' before 
the station ending.

 1. WisDOT Design tab > Slope / Width Control Editor > Edit tab
 2. Station 10+00 > Slope/Width: 0.0' > Add
 3. Station 20+00 > Slope/Width: 0.5' > Add
 4. Station 79+00 > Slope/Width: 0.0' > Add
 5. Station 69+00 > Slope/Width: 0.5' > Add
 6. Update Profile From Table

Tip: You could do the other 3 quadrants here before closing the window.

 7. OK > OK > Rebuild Corridor
 8. Save

Finish all quadrants

Exercise files: Continue with previous data set or start here: rurl-int-grdg-bhnd-cg-crdr-end-
data-c3d16.zip

Start with 12345678\Design\Corridors\Crdr-25-4thAve.dwg
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rurl-int-tapr-crb-head-03.mp4 2:37

Here we will finish the other 3 quadrants

 1. WisDOT Design tab > Slope / Width Control Editor > Create tab
 2. Alignment > Int-25-4thAve-NW-CG > It gets a New Profile Name with the prefix ZCP-
 3. Go from the beginning to the end of the stations
 4. Slopes > 0.0
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 5. Repeat for the remaining two quadrants
 6. OK > OK > Rebuild Corridor
 7. Save

Info: Zoom out and you can see the profile views are very large now. We will go 
into each one and change the elevation range to 1120' as we had mentioned at the 
beginning of this topic.
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 1. Select the profile view > Profile view properties > User Specified Height > 1120'

 2. Repeat with the other 3 profile views
 3. Save

Synchronize refinement datum surface

Exercise files: Continue with previous data set or start here: rurl-int-grdg-bhnd-cg-crdr-end-
data-c3d16.zip

Start with 12345678\Design\Surfaces\Srfc-Rfnt-All-Datum.dwg

rurl-int-tapr-crb-head-04.mp4 1:15

We will now synchronize the data with the surface files. Because these files were closed when 
we saved the changes to the corridor file the will update automatically but it is still necessary to 
rebuild the corridor.

 1. Start with Srfc-Rfnt-All-Datum.dwg
 2. Prospector tab > Surfaces > right click Rfnt-25-Datum > Rebuild
 3. Open the Srfc-Rfnt-All-Top.dwg
 4. Prospector tab > Surfaces > right click Rfnt-25-Datum > Rebuild
 5. Save

Rural intersection: match top of gravel shoulder to top of terrace behind curb and gutter

Total video time: 4:22:30

Total video time: 8:56
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Last updated: 2018-02-20

There are more optional ways you can further refine your corridor intersection. One of the 
easier ways to affect the design width is to align the shoulder and width match points. Because 
of the differing elevations of the two areas, creating a tie in point will help your surfaces trans-
ition more appropriately or more seamlessly. This process is just adjusting the target align-
ments so EGS matches back of terrace.

Edit shoulder alignments along mainline

Exercise files: rurl-int-grdg-bhnd-cg-crdr-end-data-c3d16.zip

Start with: 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-mtch-egs-top-trrc-bhnd-cg-01.mp4 2:55

Move some alignments along the main line so the EGS lines up with the GC Terrace Feature 
Line

 1. Select the EGS Alignment on right side
 2. Geometry Editor > Add PI near the last frequency
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 3. Drag the end of the alignment out to the CG Terrace Feature Line
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 4. Highlight the left ETW alignment and drag the alignment out to the CG Terrace > 
Rebuild Corridor
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 5. Save

Info: The other feature lines of the corridor will adjust with the alignment. The grad-
ing along the curb return will have to be adjusted.

Edit feature lines behind curb and gutter

Exercise files: Continue with previous data set or start here: rurl-int-grdg-bhnd-cg-crdr-end-
data-c3d16.zip

Start with 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-mtch-egs-top-trrc-bhnd-cg-02.mp4 2:10

 1. Highlight a feature line behind the Back of Curb grading in the SW quadrant
 2. Drag the end grip to line up with the corridor
 3. Repeat with the other two feature lines
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 4. Prospector tab > Surfaces > right click Int-SW-Quad-Grading > Rebuild
 5. There may be some extra lines to remove
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 6. Save

 

Finish quadrants and synchronize refinement datum surface

Exercise files: Continue with previous data set or start here: rurl-int-grdg-bhnd-cg-crdr-end-
data-c3d16.zip

Start with 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-mtch-egs-top-trrc-bhnd-cg-03.mp4 3:51

Repeat on the north side
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 1. Highlight Lcl-4thAve-Left-EGS alignment
 2. Drag the end to the CG_Terrace

 3. Highlight the 25-Left-TrnLn alignment
 4. Insert PI at the start of the taper
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 5. Drag the end of the alignment to the GC_Back of Terrace feature line
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 6. On the NE side select the 25-Right-TrnLn Alignment 

Tip: Because elements overlap here make sure the Selection Cycling func-
tion is on. This can be found in the Snap settings dialog box Selection Cyc-
ling tab.
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 7. Drag the end of the alignment to match the CG Terrace feature line
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 8. Select the Lcl-4thAve-Left-EGS
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 9. Drag it to CG_Terrace
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 10. Select Lcl-4thAve-Right-EGS
 11. Drag the end to the CG_Terrace
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 12. Rebuild Corridor
 13. Select the Int-25-4thAve-NW-Ditch
 14. Adjust the grips to tie into the CG_Terrace

 15. Rebuild Corridor
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 16. Save
 17. Open Srfc-Rfnt-All-Datum
 18. Prospector tab > Surfaces > right click Rfnt-25-Datum > Rebuild
 19. Save
 20. Open Srfc-Rfnt-All-Top
 21. Prospector tab > Surfaces > right click Rfnt-25-Top> Rebuild
 22. Save

Rural intersection: edit shoulder foreslope to match ditch behind curb and gutter

Total video time: 6:03

Last updated: 2018-02-20
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Here we will look at optional edits for the transition between the shoulder area into the curb 
return area. If this transition requires a higher level of precision such as when a culvert pipe 
depth is a concern, then transitioning from a 4:1 slope to a 6:1 slope will help match into that 
curb return area and reduce the amount of awkward transition. There are some subassembly 
parameters that respond well with the slope/width control editor. 

Create slope control profile

Exercise files: rurl-int-creat-cr-asmbly-02-end-data-c3d16.zip

Start with: 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-edit-shldr-frslp-mtch-dtch-bhnd-cg-01.mp4 3:19

 1. WisDOT Design tab > Slope/Width Control Editor 
 2. Alignment > 25-Right-TrnLn-EGS
 3. Station Range > Select from screen the end of the curb and gutter for end station
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 4. Input the start station at 2+11 or 100' back
 5. Start slope > 0.25
 6. End slope > 0.167
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 7. Save

Create slope control profile

Exercise files: rurl-int-creat-cr-asmbly-02-end-data-c3d16.zip

Start with 12345678\Design\Corridors\Crdr-25-4thAve.dwg

rurl-int-edit-shldr-frslp-mtch-dtch-bhnd-cg-02.mp4 2:44

 1. Corridor > Corridor Properties > 25-FullSection > Targets
 2. Slope Elevation Targets > Foreslope from profile > ShldGeneric-TrnLn-R
 3. Alignment > 25-Right-TrnLn-EGS
 4. Select ZCP-25-Right-TrnLn-EGS > Add
 5. OK > OK > OK > Rebuild Corridor
 6. Save
 7. Open Srfc-Rfnt-All-Datum
 8. Prospector tab > Surfaces > right click Rfnt-25-Datum > Rebuild
 9. Save

 10. Open Srfc-Rfnt-All-Top
 11. Prospector tab > Surfaces > right click Rfnt-25-Top> Rebuild
 12. Save
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Roadway design requirements, tips, info, and warnings

Last updated: 2017-09-13

Create corridor surfaces as early as you can in the design process.

When creating a design corridor, create the corridor surfaces immediately along with it. Main-
tain the corridor surface feature line list as the design concept evolves. Inspect these surfaces 
as design modifications are made.

A design can look OK in the corridor, but it might not be structured properly to make corridor 
surface development as easy as it should be. This structural problem in the corridor data can 
lead to significant design rework if it isn't identified early. Fortunately there is an easy way to 
see these problems. They show up visibly in the surface models. 

Significant time will be spent reworking design if corridor surfaces are not created early and 
the resulting surface models inspected as the design progresses.

Why corridor links are not allowed to define, or help define corridor surfaces:

Methods hears this question frequently, presumably because the use of corridor links would 
save time in defining and maintaining the definition of corridor surface models. Making the use 
of corridor links even more attractive is the "overhang correction" functionality in corridors 
that helps clean up areas of vertical links in our corridor surfaces. With all these benefits tied to 
the use of corridor links in surface definition, why does WisDOT require corridor surfaces be 
defined by corridor feature lines only? 

Let's discuss the Design Model deliverables before answering this question. Here are a few key 
aspects of the Design Model deliverables:

 l The principle component of Design Model packages are surface models.  The surface 
models communicate design intent clearly, more so than the other deliverables in the 
Design Model.

 l Proposed surface model longitudinal breaklines are also an important deliverable. Some 
contractors will choose not to use Design Model surface models in construction oper-
ations, and will instead develop their own sets of surface models that suit their con-
struction operations and workflows. Contractors who anticipate following this practice 
have clearly stated that the longitudinal breaklines of proposed surfaces will be most use-
ful to them in their Construction Model development efforts.

 l The primary source of longitudinal breaklines in the Design Model surface models is the 
list of corridor feature lines used to define corridor surfaces. 

 l It is critical that all the data in Design Models be:
 l Consistent with the plan
 l Consistent with itself
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 l Must be complete, with no missing information.

Again, why not use corridor links to define surface models?

 l One reason is that using corridor links to define corridor surfaces significantly increases 
the risk that the designer will not specify all the needed corridor feature lines in the cor-
ridor surface definition, leading to delivery of an incomplete set of breaklines in the 
Design Model package. By adding corridor links to the definition, the designer will fix 
problems in the corridor surface related to missing corridor feature lines. This is bad. 
Those problems should be visible to the designer, not hidden or fixed behind the scenes. 
If corridor links are not used in surface definition, the absence of needed corridor fea-
ture lines will be clearly visible to the designer, especially in corridor section editor. 
When corridor links are used in the surface definition, the missing corridor feature line 
problems are hidden from the designer making it very easy to deliver an incomplete set 
of longitudinal breaklines in the Design Model. The end result: a Design Model package 
with surface models that are inconsistent with breaklines. This is a deal-breaker as far as 
the use of corridor links is concerned, WisDOT deliverable requirements will disallow use 
of corridor links in corridor surface definition until this problem is resolved.

 l Overhang correction functionality cleans up surface model triangulation in areas of ver-
tical links, but it does not correct the problem in the longitudinal breaklines. If overhang 
correction is used to fix these problems in design, the problems will reappear when con-
tractors use Design Model breaklines to develop Construction Model surfaces. See Road-
way Design Workflow Tip #3 for a method to collect these vertical link problems without 
using "overhang correction".

 l Longitudinal breakline data leads to better, more consistent roadway surface model tri-
angulation than cross sectional patterned data. This is a similar concept as survey col-
lection. Originally WisDOT collected survey data for DTM surfaces in the traditional 
cross sectional collection pattern. Experience taught us that longitudinal breakline col-
lection of roadway data results in better triangulation overall, and survey collection prac-
tices changed to a longitudinal feature based collection pattern for existing ground 
surface models. The same is true for proposed surface models. Many times that tri-
angulation from cross sectional elements, such as corridor links, is OK. But some situ-
ations that commonly appear in roadway terrain areas will triangulate incorrectly with 
cross sectional based data, use of longitudinal roadway features (corridor feature lines) 
corrects those triangulation errors.

Vertical links

3. How can I correct vertical link problems in my proposed surface models without using "over-
hang correction" with corridor links in the corridor surface definition, or without using a surface 
edit actions on the refinement surface?
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 l A vertical link is created when 2 corridor feature lines (CFLs) that are the same offset dis-
tance from the baseline, are both used in defining the same surface model. Fix the ver-
tical link problem by inserting LinkWidthAndSlope subassembly to your assembly. 

 l Using a generic link subassembly like LinkWidthAndSlope, create a new CFL to replace 
one of the old CFLs from the vertical link. Offset the new CFL from the old CFL by 0.01'. 
Use the new CFL in the corridor surface definition, remove the old CFL from the corridor 
surface definition.
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System performance

When modifying corridors, turning off all baselines that are outside the area you are working in 
will improve system performance. When finished working with the corridor turn all baselines 
back on and rebuild the corridor before saving and closing the DWG file, this will ensure the cor-
ridor surfaces are completely constructed through the full extents of the corridor.
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Parameter overrides

Avoid using "Parameter Overrides" to make changes to your corridor. Make the needed to 
changes to the input parameter values in your assemblies instead.

Parameter overrides will save time when initially used, but will cost you much lost time overall.

Parameter overrides are tied to a station, not a location in coordinate space. If baseline sta-
tioning shifts, parameter overrides are all incorrect and must be redone.

Design changes are difficult to execute within corridors that are heavy on parameter overrides.

Changes made in parameter overrides are much less visible in the design data than are inde-
pendent assemblies and regions. 

Info: Parameter overrides can be a useful tool for experimenting with results of dif-
ferent input parameter values. But once the correct input parameter solution is iden-
tified, remove the parameter overrides and implement the changes with a copy of 
the assembly and new corridor region.

Conditional subassemblies

Explore using conditional subassemblies ConditionalHorizontalTarget and ConditionalCutOrFill 
in your designs.
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These can save a lot of time in design by: consolidating multiple typical section scenarios within 
a single assembly, reducing corridor structure complexity by reducing number of regions. 

ConditionalHorizontalTarget makes transition locations between typical sections easier to 
adjust because the locations are defined by a target object that can be moved easily. Condi-
tionalCutOrFill makes it easier to manage multiple daylighting solutions within a single 
assembly/region. There are many other timesaving uses of conditional subassemblies, they are 
very flexible tools that open up opportunities for creative corridor design solutions.

Use a target oriented philosophy in corridor design

Don't try to manage all the roadway cross section geometry changes with input parameters, 
use horizontal and vertical target objects to define geometry when you can. Create target 
objects for applicable horizontal roadway features.

Use single object representation in design data

Don't have multiple objects representing the same thing, use a single object and reference it 
when needed. Design changes are much easier to manage when this approach is followed. 

 l Example: Use the same objects for corridor targeting that are used for plan sheet road-
way feature graphics. Doing so will help keep plan sheets and Design Models syn-
chronized.

Info: Note: Be careful about making copies. If you copy a dwg, you now have a 
copy of all the objects that lived in the original dwg. Those objects now need to be 
renamed in the new dwg.

Viewing surfaces

Don’t just look at surfaces in the corridor section editor. This only tells part of the story. Orbit 
around the surface to look for problems early and often.

Building corridors

Build as much of your design as you can in the corridor. You can do more than you think there.

Building surfaces

Refinement surfaces represent the current state of your design. Corridors are one source of 
refinement surface definition, but feature lines and other 3D linework can also be used as 
breaklines and/or grading surfaces.

Intersections

Build corridors from intersections outward. Designing in Civil 3D is easier if this is done.

Assemblies
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Use copies of assemblies in different regions rather than reusing the same assembly in multiple 
regions

Unintended changes can occur to a design when there are multiple regions using the same 
assembly. The assembly could be modified for a specific situation, forgetting the modification 
will be applied to the other regions. It is better to have multiple identical assemblies of dif-
ferent names than it is to have a single assembly used multiple times.

Combining surfaces

Projects with multiple design corridors can combine multiple corridor surfaces (of the same 
type) into a single refinement surface by using multiple "Paste" operations.

Subassembly types

Use both WisDOT subassemblies and Autodesk subassemblies.

The 2 subassembly libraries can be used effectively in the same design. 

The one problem with this in practice is the combining of WisDOT subassemblies with Autodesk 
subassemblies using Axis of Rotation (AOR) superelevation functionality. Use of AOR requires 
differences in baseline superelevation definition that are not compatible with WisDOT sub-
assemblies. See Roadway Design Workflow Tip #16.

Subassembly with superelevation functionality

 Don't use WisDOT subassemblies in the same baseline (horizontal reference line) as Autodesk 
subassemblies with Axis of Rotation (AOR) superelevation functionality.

 

Use of AOR requires differences in the baseline's superelevation definition that are not com-
patible with WisDOT subassemblies. If you need to use Autodesk AOR subassemblies in your 
design, don't use the WisDOT subassemblies with slope control by superelevation on the same 
baselines as the Autodesk AOR subassemblies.

Generic links

It is possible to build your entire roadway assembly with generic link subassemblies. That may 
not be the best way to construct an assembly, but thinking that way can help solve unique 
assembly problems for which there is no subassembly.

Downstream design

Keep the data flowing down stream. (Follow the Civil 3D Project Data Map)
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There is a uni-directional flow to the data relationships in the WisDOT roadway design work-
flow, the Civil 3D Project Data Map depicts this idea. Keeping this concept in mind will help 
keep your project data structured and operating correctly, and help you avoid data problems 
such as circular references.

Target naming

For subassemblies that require targeting, name them so you know what the target should be. 
Example name: TARGET-ETW AliProf and SideRoad AliProf

Dividing corridors

A corridor can easily be broken apart into multiple corridors in separate files, but multiple cor-
ridors cannot be combined together easily.

Surface profiles

Do not create data shortcuts of surface profiles. Instead, data reference the surface and create 
the surface profile in each drawing it is needed.

This practice reduces the total amount of objects in your data shortcut list. This practice will 
also make it easier to avoid circular references, and it may improve system performance in 
some situations.

Surface edit tools

Avoid use of surface editing tools. It is better to make changes through corridor tools, or use of 
feature line and 3D linework as breaklines, and the Civil 3D grading tools.

Use of surface edit tools will make changes to the surface model, but those changes will not be 
in the breakline delivery for those surfaces, leading to Design Model data inconsistency. These 
design changes can be made in a way that will promote better data consistency.

Example: using the "Swap Edge" command can alter triangulation of a refinement surface as 
desired, but the same can be accomplished by adding a feature line or 3D poly or line as a 
breakline to the refinement surface.

Longitudinal breaklines

Info: The purpose of the corridor in our design workflow is to create the lon-
gitudinal breaklines of our proposed work surface models.

Refinement surfaces

Info: Refinement surfaces represent your finished design work, they are the 
design goal. Refinement surfaces are the surface models for proposed work in 
Design Model delivery. 
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Surface models are the goal of roadway design, not cross sections.

Cross sections have traditionally been the primary goal of roadway design, but not anymore. 
They have been replaced by surface models as the primary form of roadway design output. 
Cross sections are now a by-product of the design process. Develop Design Model surface mod-
els correctly, and then cut sections on those surface models for plan sheets.

Corridor link graphics

It is OK to use corridor link graphics in plan sheet section views.

Some people prefer the look of cross sections achieved by keeping corridor links visible in plan 
sheet section views, this is acceptable practice.  

But, in all cases, the correct refinement surface models must be visible in plan sheet section 
views also. This is a key quality control element in our design workflow that helps ensure plan 
sheets and Design Models are consistent with each other.

Unneeded corridor feature lines

Turn off connection of unneeded corridor feature lines to improve system performance.

Some subassemblies produce corridor points which are assigned multiple point codes. When a 
corridor is constructed, by default a corridor feature line is created for each corridor point 
code. Corridor points with multiple codes produce multiple coincident corridor feature lines. 
The redundant corridor feature lines can be turned off by un-checking them in the Corridor 
Properties dialog box as shown below, only 1 corridor feature line per corridor point is needed 
to define surface models.

Page: 777

Published on: 2/21/2018

Roadway design requirements, tips, info, and warnings



Page: 778

Published on: 2/21/2018

Roadway design requirements, tips, info, and warnings





Cross-sections

Sample lines, sections, and volumes

Last updated: 2012-10-01

Total video time: 10:12

General steps:

xsec-smpl-ln-sctn-vlm-01.mp4 10:12

 1. WisDOT12.dwt
 2. Save to ProjectID\SheetsPlan directory
 3. Use Data Shortcuts to make a reference to the alignment & profile.
 4. XREF Corridor drawing
 5. Create Sample Lines
 6. Create Section Views and/or compute materials

Frequency lines vs sample lines 

 l Used to compute slope intercept and other cross section info (i.e. super elevation slope)
 l Corridor data can be overridden at frequency stations
 l Will vary in length depending on assembly or distance to slope intercept
 l Frequency distance depends on design situation (i.e. 5’ frequency in intersections)

Sample lines

 l Used in preparation to show data in section views for plotting
 l Needed to compute end area volumes
 l Best practice is to have all of your sample lines at a uniform length
 l No design changes can be made via sample lines

Section views

 l Primarily used for plotting
 l Great place to verify your design

 l No design changes can be made from section views
 l Design changes must be made in the corridor drawing

 l Laid out on Sheets

A Sheet refers to the grid, print area and sheet border

The section view refers to the supporting information shown with the section; offset text, elev-
ation text, and station value.

The section refers to station-specific data that is coming in for the surfaces and corridor.
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Quantities

For earthwork quantities all you need is:

 l An Existing Surface
 l A Final Datum surface

Tip: Other surfaces such as rock, marsh, excavation below subgrade (EBS) and 
embankment are optional

Material quantities come from Corridor Shapes

Sample line creation

Last updated: 2012-10-01

Total video time: 24:57

Before you create sample lines:

Exercise files: xsec-smpl-ln-creat-01-data-C3D12.zip

xsec-smpl-ln-creat-01.mp4 16:01

 1. Start a new drawing based on WisDOT12.dwt
 2. Save the new file to ProjectID\SheetsPlan folder
 3. Create data shortcut reference to the centerline alignment & design profile
 4. XREF the corridor drawing.

Data references and cross sections

Tip: “Don’t I need more data references? What about my existing surface?”

 l Corridors do not have the ability to be shared via data shortcut.
 l Sample lines are unique objects that can “pull” data through the corridor XREF.
 l The corridor and any surfaces associated with it will come over automatically when you 

create sample lines.
 l Existing surface
 l Corridor Top
 l Corridor Datum

Sample line terminology:

Swath Width: length of one side of a sample line as measured from the centerline.

Tip: Use the default of 150’ if you plan to plot at 1”=20’ 
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Tip: Use swath widths of 75’ if you plan to plot at 1”=10’

Sampling Increment: Standard distance between sample lines

Additional Sample Controls: optional additional stations where sample lines can be auto-
matically generated

Exercise: Create sample lines

 1. Verify that your data shortcuts path is listed as c:\Civil 3D Projects\11111111\
 2. Start a new drawing based on WisDOT12.dwt
 3. Save the file as C:\Civil 3D Projects\11111111\SheetsPlan\090100_xs.dwg
 4. In the Toolspace > Prospector tab > Data Shortcuts, expand Centerline alignments.
 5. Expand the alignment USH 51 Best Fit from Exist
 6. Expand Profile
 7. Right-click Proposed Profile Final and select Create Reference.
 8. Click Ok .
 9. Zoom extents to view the alignment.

Info: Because you go for the profile, you will not have to repeat the process for the 
alignment. The data for he profile is not available in the drawing but we do not 
need to see the profile to proceed. If you wish, you could make the profile visible by 
going to Home tab > Profile & Section Views panel and selecting Profile View > 
Create Profile view.

 10. Click Attach DWG
 11. Browse to c:\Civil 3D Projects\11111111\Design\Corridors and select Corridor-USH51 

North Segment.dwg.
 12. Click Open .
 13. Set the reference type to Overlay
 14. Be sure all checkboxes for Specify on screen are clear.
 15. Set the Path type to Relative Path
 16. Click Ok.
 17. Quick Access Toolbar > Save .
 18. Home tab > Profile & Section Views Panel > Sample Lines .
 19. When prompted to select an alignment,click Enter  (to pick from a list).
 20. Select USH 51 Best Fit from Exist (this will be the only available alignment) 
 21. Click Ok.
 22. Expand the Data source column so you can see the full names of the data you are work-

ing with.
 l Set the style for the surface Exist to EX Ground
 l Set the style for USH 51 Best Fit from Exist Scorridor to XS Sheets with Links
 l Set the style for the corridor Top surface to Final Top
 l Set the style for the corridor Datum surface to Final Datum
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 23. Click Ok
 24. You will now see the Sample Line Tools toolbar
 25. From the Sample Line creation methods icon (pulldown) select the By Range of Stations 

option. 
 26. In the Create Sample Lines - By Station Range dialog box:
 27. Set the Start Station to 191+00.00
 28. Set the End Station to 214+00.00
 29. Scroll down and change the At Superelevation critical stations to False.
 30. Click Ok.
 31. vClose the corridor is out of date warning
 32. Save the drawing.

Situations where you may need to make changes to your sample lines:

Exercise files: xsec-smpl-ln-creat-02-data-C3D12.zip

xsec-smpl-ln-creat-02.mp4 8:56

 l You need to add sample line stations
 l You need to change the swath widths

 l For example to 75’ from 150’ (or vice versa)
 l More section information is available

 l Examples: a new corridor surface is generated; a pipe network needs to be shown

Tip: #1 Rule of Sample Lines and Cross Sections: Always look for a way to makes 
changes to the group as a whole.

Exercise: Modify sample lines

 1. Verify that your data shortcuts path is listed as c:\Civil 3D Projects\11111111\
 2. Open the file 090100_xs.dwg

Adding a sample line

 1. Home tab > Profile & Section Views panel > Sample Lines .
 2. Click Enter to pick an alignment from the list.
 3. Highlight USH 51 Best Fit from Exist 
 4. Click Ok

Tip: Because a sample line group already exists for this alignment, you will not 
need to set styles as you did in the previous example. Any stations you create will 
be added to the existing group.
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Changing sample line lengths

 1. Select any sample line in the drawing.
 2. Context tab > Modify panel > Group Properties .
 3. Select the first row in the listing of sample line stations.
 4. Scroll to the bottom of the listing.
 5. Hold Shift  and select the last row of the listing.
 6. Click one of the left offset values and type 75Enter .
 7. Click one of the right offset values and  type 75Enter ..
 8. At this point, all rows should read 75’ for both left and right swath widths.
 9. Click Ok

 10. click Enter to accept the swat width of 150 to the left
 11. click Enter to accept a swath width of 150 to the right.
 12. Click Esc to end the command.
 13. Close the panorama dialog box if you receive a “corridor is out of date” warning.

Add more data; sample more sources

Info: To mimic the effect of more project data being added after sample lines are 
created, you will import a LandXML file containing pipe information. You will then 
use the Sample More Sources tool to ensure that pipes will appear as part of the 
sampled data.

 1. Insert Tab > Import panel > Land XML  .
 2. Browse to the file 130-020-002-pipes.xml
 3. Click Open.
 4. Click Ok
 5. Click the green checkbox to dismiss this message.
 6. Click any sample line in the drawing.
 7. Sample Line contextual tab > Sample More Sources.
 8. Select the drainage item listed under Available sources.
 9. Click Add.

 10. Click Ok.
 11. Save the Drawing. 

Calculate and report volumes

Last updated: 2012-10-01

Total video time: 17:18

Computing volumes

xsec-calc-rpt-vlm-01.mp4 5:42
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You can compute volumes as soon as you have:

 l Proposed Data
 l Datum surface
 l Corridor

 l Sample Lines
 l Sample lines must “see” the proposed data, so use Sample More Sources as 

needed.

Analyze tab > Compute Materials panel > Volumes and Materials   

When computing volumes for the first time:

Click Edit Style.

Click Ok

You will then see materials listed in the Compute Materials dialog box.

Warning: Never click OK with the compute materials dialog box empty! It WILL 
crash otherwise.

Exercise: Calculate volumes

Exercise files: xsec-calc-rpt-vlm-01-data-C3D12.zip

Info: If you successfully completed the previous exercise where you created 
sample lines, you may continue working in that file. If not, extract the example files 
associated with this exercise to your local Civil 3D projects folder.

 1. Verify that your data shortcuts path is listed as C:\Civil 3D Projects\11111111\
 2. Open the file 090100_xs.dwg
 3. Analyze tab > Volumes and Materials panel > click Compute Materials .
 4. Click Edit Style  
 5. You do not need to make any changes

 6. Tip: The Compute Materials dialog will now have spots for different mater-
ials. You do not need to fill in every type of surface, but you do need to fill in 
at least the Existing Surface and Datum surface.

 7. Click Ok.
 8. Click the <Click Here to Set All> field next to the Exist surface.
 9. Choose the Exist surface

 10. Click the <Click here to set all> field next to Final Datum.
 11. Choose the USH 51 Best Fit from Exist - (1) Datum.
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 12. Click Ok.
 13. You will receive a message indicating that “Not all of the named surfaces or corridor 

shapes have been mapped to an object in the drawing…” 
 14. Click Ok.
 15. Save the drawing.

Volume reports

xsec-calc-rpt-vlm-02.mp4 6:27

Info: A Volume Report creates a text file that will open in Internet Explorer.

Volume tables & material volume tables

Total Volume Table and Material Volume table place information directly into AutoCAD.

The Style sheet determines the format and what information is shown when generating a 
volume report.

Exercise: report volumes

If you successfully completed the previous exercise where you created sample lines, you may 
continue working in that file. If not, extract the example files associated with this exercise to 
your local Civil 3D projects folder.

 1. Verify that your data shortcuts path is listed as c:\Civil 3D Projects\11111111\
 2. Open the file 090100_xs.dwg
 3. Analyze tab > Volumes and Materials panel > Volume Report. .
 4. Click the folder icon next to Select a Style sheet.
 5. Select Earthwork.xsl
 6. Click Ok.
 7. When Internet Explorer pops up, it may ask you if you would like to run scripts. Click Yes.
 8. Right-click anywhere in the browser window and click Select All  
 9. Right-click again and click Copy. 

 10. Launch Microsoft Excel. (Keep Civil 3D and the Internet Explorer Window open.)
 11. Right-click and paste using the Match Destination theme option.
 12. Save the Excel Spreadsheet as Earthwork 11-10-2012.xls in C:\Civil 3D Pro-

jects\11111111\Design\Quantities\EWKDetailWorkbooks\
 13. Close Excel.
 14. Save the Civil 3D drawing. 

Exercise: Calculate & report structure volumes

Exercise files: xsec-calc-rpt-vlm-02-data-C3D12.zip
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xsec-calc-rpt-vlm-03.mp4 5:09

Info: If you successfully completed the previous exercise where you created 
sample lines, you may continue working in that file. If not, extract the example files 
associated with this exercise to your local Civil 3D projects folder.

 1. Verify that your data shortcuts path is listed as c:\Civil 3D Projects\11111111\
 2. If you receive a message “Corridor is out of date and may be out of sync with other 

objects,” dismiss panorama by clicking the green checkbox.
 3. Analyze tab > Volumes and Materials panel > Compute Materials. .
 4. Click Ok.
 5. Click Add New Material .

 6. Tip: You may need to expand the listing using the + sign

 7. Rename the New Material to ASPHALT.
 8. Change the Quantity Type to Structures.

 9. Warning: This step is very important. If you forget to change the type to struc-
tures, it will not allow you to add a corridor shape to the earthwork table.

 10. Change the Data Type to Corridor Shape.
 11. With USH 51 Best Fit from Exist - (1) Pave 1 as the active corridor shape, click the + sign.
 12. Change the Corridor shape to USH 51 Best Fit from Exist - (1) Pave 1 and click the + sign.

 13. Info: By adding both of these corridor shapes to the Asphalt material, they 
will be lumped together for one overall asphalt volume - of course if these 
need to be separate pay items in “real life” you can make a separate material 
entry for the different types of asphalt.

 14. Click Add New Material.
 15. Rename the material to BASE.
 16. Change the Quantity Type to Structures.
 17. Change the Data Type to Corridor Shape.
 18. With USH 51 Best Fit from Exist - (1) Base as the active corridor shape, click the + sign.
 19. Click Add New Material.
 20. Name it SUBBASE.
 21. Repeat the previous steps to make sure this is a Structure-type computation.
 22. Add the subbase corridor shape to this material.
 23. Click Ok.
 24. If you receive a message “Corridor is out of date and may be out of sync with other 

objects,” dismiss panorama by clicking the green checkbox
 25. Analyze tab > Volumes and Materials panel > Volume Report. . 
 26. Click the folder icon next to the Select a Style Sheet field.
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 27. Click the Select Material. option.
 28. Click Ok.
 29. Click Yesto the message that displays.
 30. Using the same techniques as the previous exercise, select all of the information and 

paste it into an excel spreadsheet.
 31. Save the excel spreadsheet as Corridor.xls in C:\Civil 3D Pro-

jects\11111111\Design\Quantities\EWKDetailWorkbooks\
 32. Close Excel.
 33. Save the AutoCAD file. 

Modify sheet style

Last updated: 2012-10-01

Total video time: 06:12

Exercise: Modify styles

xsec-mdify-sht-styl-01.mp4 6:12

Info: For this example, use the file www.C3DKB.dot.wi.gov/data/130/130-040-xs-
styles- example.dwg. This is a self-contained example project where you will have 
a chance to experiment with changing style options.

 1. Select one of the section views or sheets.
 2. From the Section View Context tab > Section View Properties  > Edit Group Plot Styles

 .
 3. When prompted to pick a graph,  select a magenta offset labels along the bottom of any 

view.
 4. Click Enter.
 5. Switch to the Array tab.
 6. Change the Row spacing to 1.5” 
 7. Click Ok.
 8. You should see that the spacing between each view has increased.
 9. Section View Context tab > Section View Properties  > Edit Group Plot Styles 

 10. When prompted select the magenta offset labels along the bottom of any view.
 11. Click Enter
 12. Switch to the Display tab.
 13. Click the light bulb next to Minor Horizontal Grid.
 14. Click the light bulb next to Minor Vertical Grid.

 15. Info: This will hide or “turn off” these items.

 16. Click Ok.
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 17. Change the annotation scale of the drawing to 1IN 20 FT.
 18. Select one of the sheets or views
 19. Click Update Group Layout
 20. You should see that the spacing between each view has increased.
 21. Section View Context tab > Section View Properties  > Edit Group Plot Styles 
 22. When prompted select the magenta offset labels along the bottom of any view.
 23. Switch to the Array tab
 24. Change the Column spacing to 0.01”
 25. Click Ok

Info: You should see that two columns don’t quite fit on a page.

 26. Save the drawing. 

Section view creation

Last updated: 2012-10-01

Total video time: 29:32

Section views and scale

Exercise files: xsec-vw-creat-01-data-C3D12.zip

xsec-vw-creat-01.mp4 7:00

 l When creating views it is important that all of the scales you choose agree with each 
other:

 l Annotation Scale
 l Section View Style
 l Section Template

Exercise: Create section views

Info: If you successfully completed the previous exercise where you created 
sample lines, you may continue working in that file. If not, extract the example files 
associated with this exercise to your local Civil 3D projects folder.

 1. In the Toolspace > Prospector tab > Data Shortcuts verify the working folder is c:\Civil 
3D Projects\11111111\

 2. Open 090100_xs.dwg.
 3. If you receive a message “Corridor is out of date and may be out of sync with other 

objects,” dismiss panorama by clicking the green checkbox.
 4. Change the drawing annotation scale to 1 in:10FT
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 5. Click Save.
 6. Home tab > Profile & Section Views panel > Section Views  > Create Multiple Views.
 7. On the Section Placement page of the wizard, click the ellipsis next to Template for Cross 

Section Sheet.
 8. Click the ellipsis again to browse to the file wisdot12-09-xs.dwt.
 9. This will be located in: C:\Users\<your_name>\AppData\Local\Autodesk\C3D 

2012\enu\Template\USWI\planproduction\xsection\
 10. Pick the X-Section 1 IN 10 FT Horiz 10 FT Vert option for the layout.
 11. Click Ok.
 12. Make sure the group plot style is set to By Page Bottom to Top
 13. Click Next.
 14. Verify that the offset range is set to Automatic and is listed as -75 and 75’.

Info: This length comes directly from the sample lines and should be left as-is.

 15. Click Next
 16. Do not make any changes to the elevation range page. 
 17. Click Next.
 18. On the Section Display options page, clear the checkboxes next to:

 l CutCommon
 l Embankment
 l Asphalt
 l Base
 l Subbase

 19. Click Next.
 20. No action is needed on the Data Bands or Section View Tables pages, so Click Create Sec-

tion Views  .
 21. Click off to the side in an empty location on your drawing.
 22. You should have many pages of cross sections.
 23. Save the drawing. 

Adding an additional sample line

Exercise files: xsec-vw-creat-02-data-C3D12.zip

xsec-vw-creat-02.mp4 7:39

Warning: Do not graphically delete section views!

Use the Delete option from the right-click menu in prospector!

#1 Rule of Sample Lines and Cross Sections:

Always look for a way to makes changes to the group as a whole.
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In other words, if you a repeating a task on multiple stations – there is probably a better way!

Exercise: Add n additional sample line & add it to the section views.

Info: If you successfully completed the previous exercise where you created 
sample lines, you may continue working in that file. If not, extract the example files 
associated with this exercise to your local Civil 3D projects folder.

 1. In the Toolspace > Prospector tab > Data Shortcuts verify the working folder is c:\Civil 
3D Projects\11111111\

 2. Open 090100_xs.dwg.

Info: If you receive a message “Corridor is out of date and may be out of sync with 
other objects,” dismiss panorama by clicking the green checkbox.

 3. Home tab > Profile and Section Views panel > Sample Lines  .
 4. click Enter  
 5. Select USH 51 Best Fit from Exist 
 6. Click Ok.
 7. When prompted to key-in a station along the alignment, type 19155Enter 
 8. Type 75Enter 
 9. Type 75Enter 

Info: Feel free to experiment by adding stations on your own. Just remember to set 
the swath widths to the uniform 75’ for both the left and right sides. If you add a 
sample line where one already exists, civil 3d will ask if you wish to delete the old 
one.

 10. Click Esc
 11. Home tab > Draw panel > Rectangle .
 12. Draw a rectangle directly over the first sheet.
 13. In Prospector, go to the alignment area.

 l Expand USH 51 Best Fit from Exist
 l Expand Sample Line Groups
 l Expand Section View Groups
 l Right-click section view groups and select Delete

 14. Home tab > Profile & Section Views > Rectangle > Section Views > Create Multiple 
Views  

 15. On the General page of the wizard, set the Section view style to Sheets 1 In 10 FT Horiz 
10 FT Vert

 16. Click Next.
 17. Click the ellipsis next to Template for Cross Section Sheet.
 18. Click the ellipsis again to browse to the file wisdot12-09-xs.dwtg.
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 19. Pick the X-Section 1 IN 10 FT Horiz 10 FT Vert option for the layout.
 20. Click Ok.
 21. Make sure the group plot style is set to By Page Bottom to top.
 22. Click Next.
 23. Verify that the offset range is set to Automatic and is listed as -75 and 75’.

Tip: This length comes directly from the sample lines and should be left as-is.

 24. Click Next.
 25. Do not make any changes to the elevation range page.
 26. Click Next
 27. On the Section Display options page, clear the checkboxes next to:

 l CutCommon
 l Embankment
 l Asphalt
 l Base
 l Subbase

 28. Click Next.
 29. No action is needed on the Data Bands or Section View Tables pages, 
 30. Click Create Section Views.. 
 31. Using the rectangle you created earlier as a guide, place the section views in the same 

location by snapping to the lower-left corner of the rectangle.
 32. Save the drawing.

ROW and utilities

Exercise files: xsec-vw-creat-03-data-C3D12.zip

xsec-vw-creat-03.mp4 7:09

The example uses Beam Guard but the technique can be used for:

 l Utilities
 l Right-of-way labels
 l Any item that needs to be shown in section with a unique style.

Overview of steps

 l An alignment is needed for the horizontal location
 l A profile is needed for the elevation component

 l Usually developed from a surface
 l Use the Section View Group Properties

 l Add Profile Grade
 l Set Marker style as needed
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Exercise: Showing beam guard in section

Info: If you successfully completed the previous exercise where you created 
sample lines, you may continue working in that file. If not, extract the example files 
associated with this exercise to your local Civil 3D projects folder.

 1. In the Toolspace > Prospector tab > Data Shortcuts verify the working folder is c:\Civil 
3D Projects\11111111\

 2. Open 090100_xs.dwg.

Info: If you receive a message “Corridor is out of date and may be out of sync with 
other objects,” dismiss panorama by clicking the green checkbox.

 1. Insert tab > Import panel > click Land XML   
 2. Import the file  130-050-003-beamguard alignments.xml with all the default settings.
 3. Click Ok.
 4. Manage tab  . .
 5. Save the drawing.
 6. On the Styles panel, click Import.
 7. Browse to file  Beam Guard Style.dwg in the files included with this chapter.
 8. Clear all other style options except for Beam Guard Left. and Beam Guard right..
 9. Clear the checkbox for Import Styles.

 10. Click Ok.
 11. Click any sheet or section view.
 12. Contextual tab > View Group Properties  .
 13. Open the Section Views tab.
 14. Scroll over and find Profile Grade.
 15. Click the ellipsis.
 16. From the Alignment list, pick Beam Guard North.
 17. Click Add.
 18. Set the Marker style to Beam Guard R.
 19. From the Alignment list, pick Beam Guard South.
 20. Click Add.
 21. Set the Marker style to Beam Guard L.
 22. Click Ok.
 23. Click Ok.

Info: You should now see beam guard at every station.

 24. Save the drawing.

Exercise: Create sheets

Page: 793

Published on: 2/21/2018

Section view creation



Exercise files: xsec-vw-creat-04-data-C3D12.zip

xsec-vw-creat-04.mp4 7:44

Info: Add the sheets to the sheetset manager. 

 1. Click the ellipsis and browse to C:\Civil 3D Projects\11111111\SheetsPlan

Info: If you successfully completed the previous exercise where you created 
sample lines and multiple section views, you may continue working in that file. If 
not, extract the example files associated with this exercise to your local Civil 3D pro-
jects folder.

 2. In the Toolspace > Prospector tab > Data Shortcuts verify the working folder is c:\Civil 
3D Projects\11111111\

 3. Open 090100_xs.dwg.

Info: If you receive a message “Corridor is out of date and may be out of sync with 
other objects,” dismiss panorama by clicking the green checkbox.

 4. Output tab > Plan Production Panel> Click Create Section Sheets   
 5. Under the sheet set area of the Create Section sheets dialog box, switch the radio button 

over to Add to Existing Sheet set.
 6. Click the ellipsis.
 7. Browse to C:\Civil 3D Projects\11111111\SheetsPlan\planproduction.dst
 8. Click Open
 9. Click Create Sheets

 10. Click Ok to confirm that the drawing will be saved.

Tip: After a moment multiple tabs will appear for each sheet. If you do not see the 
new tabs right away, close the drawing and go back in.

 11. Save the drawing.

WisDOT standards - section views

Last updated: 2010-07-01

Total video time: 58:59

Section views for plan sheets – file management

xsec-wisdot-stnd-01.mp4 2:04
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 l File location = ProjectID\\SheetsPlan folder

Section Views for plan sheets – data referencing data shortcut references

xsec-wisdot-stnd-02.mp4 4:42

 l Baseline Alignments
 l Roadway Model Surfaces

 l Utility Surface Profiles
 l Ultimate Right-of-Way Surface Profiles
 l Corridor dwg file

Section views for plan sheets – graphic content

xsec-wisdot-stnd-03.mp4 5:19

 l Proposed objects are represented by the Roadway Model Surfaces
 l Corridors provide automated labeling

Corridor links are typically not visible

xsec-wisdot-stnd-04.mp4 6:56

 l XSSheets code set style
 l XSSheets With Links code set style

Utilities and RW markers are tied to surface profiles

xsec-wisdot-stnd-05.mp4 4:47

 l Edge of lane markers

Section views for plan sheets – adding labels

xsec-wisdot-stnd-06.mp4 1:39

 l Why do we need manual labels?
 l Because the corridor isn’t always visible, so automated labeling needs to be sup-

plemented with manual labels.
 l Elevation-Offset labels
 l Slope-Percent labels
 l Slope-Ratio labels

Adding labels - elevation/offset
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xsec-wisdot-stnd-07.mp4 2:47

Adding labels - slope percent

xsec-wisdot-stnd-08.mp4 3:20

Adding labels - slope ratio

xsec-wisdot-stnd-09.mp4 1:59

Section views for plan sheets – custom text markers

xsec-wisdot-stnd-09.mp4 5:34

 l Single Custom Text Marker Using Block

Multiple custom text markers at common points using corridor feature lines 1

xsec-wisdot-stnd-10.mp4 10:05

Multiple custom text markers at common points using corridor feature lines 2

xsec-wisdot-stnd-11.mp4 5:25

Section views for plan sheets – conclusion

xsec-wisdot-stnd-12.mp4 4:22

 l File Management
 l Data Referencing
 l Graphic Content
 l Labels
 l Custom Text Markers

Exercise DS1800 - Create section views for plans

Last updated: 2017-06-06

Total video time: 104:03

Exercise files: xsec-creat-xs-pln-data-C3D10.zip

xsec-creat-xs-pln.pdf
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Introduction/unzip project dataset

xsec-creat-xs-pln-01.mp4 2:54

Ensure corridor surfaces are current

xsec-creat-xs-pln-02.mp4 3:08

Open corridor file, synchronize data shortcuts and rebuild corridor

Ensure refinement surfaces are current

xsec-creat-xs-pln-03.mp4 4:25

Open refinement surfaces files, synchronize data shortcuts and rebuild refinement surfaces

Ensure roadway model surfaces are current

xsec-creat-xs-pln-04.mp4 4:28

Open Roadway Model surfaces files, synchronize data shortcuts and rebuild Roadway Model sur-
faces

Create section view DWG. Create references

xsec-creat-xs-pln-05.mp4 8:09

 1. Create a new section view drawing from the main WisDOT design template, and save it 
in the SheetsPlan project folder

 2. Data shortcut reference roadway model surfaces, and centerline alignments
 3. XREF the corridor drawing

Matchline layout explanation

xsec-creat-xs-pln-13.mp4 3:28

Create matchline alignments

xsec-creat-xs-pln-14.mp4 7:50
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 1. Create polylines utilizing the Station-Offset transparent command to create a polyline 
parallel with the mainline alignment which runs from the starting station of the inter-
section to the ending station of the intersection which is offset to the end of the curb 
return. Do this on each side of the alignment to create 2 polylines (see video). 

 2. Home tab > Alignment > Create Alignment from Objects
 l select left polyline and enter name Matchline1
 l type = Miscelaneous
 l style = XS Sample Line
 l label style = _No Labels
 l Erase existing entities = check on

 3. Repeat step 2 for the right matchline polyline naming it Matchline2

Create sample lines by range of stations 1

xsec-creat-xs-pln-15.mp4 6:05

 1. Home tab > Sample Lines
 l Leave name and sample line styles as default
 l Select data sources to sample:

 l Deselect all corridor surfaces
 l Leave all roadway model surfaces selected and set respective surface 

styles:
 l RoadwayModel-Datum = Final Datum
 l RoadwayModel-BaseCourse = Final Base Course
 l RoadwayModel-Top = EX Ground
 l RoadwayModel-Exist = Final Top

 l Deselect Exist surface coming from Corridor file XREF
 l Leave corridor section selected and set the style to XS Sheets

 l  OK

Create sample lines by range of stations 2

xsec-creat-xs-pln-16.mp4 8:20

 1. Sample Line Tools > Sample line creation method > By range of stations
 l Station Range:

 l From alignment start = False
 l Start Staion = 366+00
 l To alignment end = False
 l End Station = 383+95.00

 l Left Swath Width:
 l width = 150'
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 l Right Swath Width:
 l width = 150'

 l Sampling Increments:
 l 50' for all settings

 l Additional Sample Controls:
 l At Range Start = True
 l At Range End = False
 l At Horizontal Geometry Points = True
 l At Superelevation Critical Staions = True

 2. Sample Line Tools > Sample line creation method > By range of stations

 l Station Range:
 l From alignment start = False
 l Start Staion = 383+95.00
 l To alignment end = False
 l End Station = 385+44.82

 l Left Swath Width:
 l Snap to alignment = True
 l Alignment = Matchline1

 l Right Swath Width:
 l Snap to alignment = True
 l Alignment = Matchline2

 l Sampling Increments:
 l 50' for all settings

 l Additional Sample Controls:
 l At Range Start = False
 l At Range End = False
 l At Horizontal Geometry Points = True
 l At Superelevation Critical Staions = True

 3. Sample Line Tools > Sample line creation method > By range of stations

 l Station Range:
 l From alignment start = False
 l Start Staion = 385+44.82
 l To alignment end = False
 l End Station = 395+00

 l Left Swath Width:
 l Snap to alignment = False
 l Alignment = 150'

 l Right Swath Width:
 l Snap to alignment = False
 l Alignment = 150'
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 l Sampling Increments:
 l 50' for all settings

 l Additional Sample Controls:
 l At Range Start = False
 l At Range End = True
 l At Horizontal Geometry Points = True
 l At Superelevation Critical Staions = True

 4. OK

Create multiple section views

xsec-creat-xs-pln-17.mp4 2:54

 1. Set annotation scale to match the viewport scale on your section view sheets (1"=20')
 2. Home > Section Views > Create Multiple Views

 l General
 l Alignment = STH25BestFit
 l Sample Line Group Name = SLG-1
 l Station Range = Automatic
 l Section View Style = Sheets
 l Group Plot Style = By Page Top to Bottom

 l Offset Range
 l Offset Range = Automatic

 l Elevation Range
 l Elevation Range = Automatic

 l Section Display Options
 l These settings should all be coming in correctly from the sample line group 

settings
 3. Create Section Views
 4. Select location in model space for section view placement

Inspect section views

xsec-creat-xs-pln-18.mp4 4:30

 1. Check for all of the roadway model surfaces to be present and styled correctly
 2. Check for presence of corridor labels and markers
 3. Confirm accuracy of intersection sections

Add special stations to section views

xsec-creat-xs-pln-19.mp4 6:58
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 1. Prospector > Alignments > Centerline Alignments STH25BestFit > Sample Line Groups 
> SLG-1 > Section View Groups

 l delete the Section View Group
 2. Home > Sample Lines

 l select STH25BestFit alignment
 3. Sample Line Tools > Sample line creation methods > At a station

 l Snap to any critical stations to create additional sample lines in location such as 
drainage sections, driveways, changes at typical sections for taper lanes etc

 l Enter left and right swath widths after each station selection
 4. Recreate the section view group exactly as was done the first time

Add r/w and utilities to section views

Refer to the training topic for "Projecting 3D objects onto cross sections" below

Review

xsec-creat-xs-pln-21.mp4 2:19

Projecting 3D objects onto cross sections

Last updated: 2015-04-13

Total video time: 13:36

Projecting 3D objects onto cross sections

Exercise files: xsec-prjct-3d-obj-onto-xs-01-data-C3D14.zip

Exercise files: xsec-prjct-3d-obj-onto-xs-01-finished-data-C3D14.zip

xsec-prjct-3d-obj-onto-xs-01.mp4 8:25

Info: ** NOTE ** This method should only be used if a survey database is not avail-
able. If a survey database is available, that provides a shorter workflow for pro-
jecting survey figures onto cross sections. That method is found at 130.075.002.

Prerequisites

Info: Before starting this training module users should have a working knowledge 
of Civil 3D corridor modeling and cross section sheet production. The cross sec-
tions sheets drawing should have already been created before moving on to this 
module
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Objectives

Projection styles are used to project AutoCAD objects such as 3Dpolylines, feature lines, blocks, 
3D cogo points, survey figures and 3D solids onto profile views and section views. Objects are 
represented by marker styles and label styles. Projection styles are very useful in showing loc-
ations of utilities, and ROW locations in section views. Elevations can be assigned to the pro-
jections based on the object elevation itself or based on a surface or profile. Projection styles 
are dynamically linked to the objects they reference. However, when projected objects are 
added to a drawing, the markers and labels do not update until the projections command is re-
run. This module will demonstrate how to apply and update projection styles for feature lines.

Obtaining data from utilities file

Tip: Data found in existing conditions utilities files can be inserted into a cross sec-
tion drawing for use with projection styles.

 1. Open  C:\WisDOT\design\c3d\12342014\BaseData\Uti-Ex.dwg.
 2. Info: Each of the utilities line work groups (electric, gas, etc.) will need to be 

converted to feature lines.

 3. Home tab > Layers panel > Isolate .
 4. Select a representative polyline from each utility.
 5. Home tab > Create Design panel > Feature Line > Create Feature Lines From Objects .
 6. Select all visible linework.
 7. In the Create Feature Lines dialog box, check the Style box in order to select the proper 

style. 
 8. From the Feature Line Style drop-down list select the appropriate E UTL layer for each 

utility group.
 9. Click Erase Existing Entities .

 10. Save Uti-Ex.dwg. 

Info: This file will be inserted into your cross sections drawing later in the workflow.

Setting up the cross section drawing for projections

 1. Open Crdr-25_xs.dwg
 l Tip: Ensure that the corridor file is an XREF in the cross section draw-

ing.

 2. Ensure that the following data has been referenced:
 l Exist surface

 l Info: Note: All projections will use the existing ground surface to set 
elevations.
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 l Proposed centerline alignment and design profile
 l All existing ROW alignments

 3. Ensure that your sample line group has been created, and that your section views exist in 
the drawing.

Create feature lines from existing ROW alignments

Tip: Alignments cannot be projected in Civil 3D, but feature lines can be created 
from the existing ROW alignments, and these can be projected.

 1. Home tab > Create Design panel > Feature Line > Create Feature Line From Alignment
 .

 2. Uncheck the Weed Points option
 3. Select E RW Existing Right-Of-Way for the style, 
 4. Click Ok. 

Info: This will need to be done for each separate existing ROW alignment.

 5. Insert Uti-Ex.dw Into Cross Section Drawing

Info: The Uti-Ex.dwg file will now need to be inserted into the cross section draw-
ing, and the feature lines from that file will need to be assigned to a site.

 6. Insert tab > Block panel > Insert .
 7. Browse to the Uti-Ex.dwg file for the project, and make sure none of the boxes are 

checked for Insertion Point, Scale, or Rotation.
 8. Be sure to check the Explode option.
 9. Click Ok.

 10. Right-click in model space and select Quick Select.
 11. In the Quick Select dialog box select:

 l Apply to: Entire drawing
 l Object type: Feature line
 l Operator: Select All
 l Click Ok .

 12. Right-click in model space and select Move to Site
 13. Choose the same site which was created for the existing ROW feature lines created from 

alignments and select OK. 

Info: This will ensure that all of the newly inserted feature lines are associated with 
a site. If this is not done, these feature lines will not get projected.
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Applying utilities projection styles to cross sections

 1. To project all feature lines to the cross section views type 
PROJECTOBJECTSTOMULTISECTEnter 

 2. Select either a section view or a sample line from model space.
 l When the dialog box appears, uncheck all object types from the list except feature 

lines.
 l Keep the Style as Use Object.
 l Elevation Options should be set to surface Exist.
 l Label Style should be set to <None>

 3. Check your section views to confirm that the markers for utilities and ROW are showing 
up.

 4. Editing Projection Styles
 5. Projection styles can be edited after being applied, and can also be removed or added.
 6. Type PROJECTOBJECTSTOMULTISECTEnter.
 7. Uncheck everything but feature lines.
 8. Set the setting just as detailed in the last step. 
 9. Click Ok.

Info: A message will appear with an option to overwrite the definition of already 
existing projections, or to leave them as they are. If any feature lines were deleted 
in plan view, the user can choose to overwrite the definition in order to remove the 
corresponding projection markers in the section views. If new feature lines were 
added to plan view then these will now be added into the section views.

Projecting utilities into cross-sections

Exercise files: xsec-prjct-3d-obj-onto-xs-02-data-C3D14.zip

Exercise files: xsec-prjct-3d-obj-onto-xs-02-finished-data-C3D14.zip

xsec-prjct-3d-obj-onto-xs-02.mp4 5:11

Prerequisites

Info: Before starting this training module users should have a working knowledge 
of Civil 3D corridor modeling and cross section sheet production. The cross sec-
tions sheets drawing should have already been created before moving on to this 
module.

Objectives

Projection styles are used to project AutoCAD objects such as 3Dpolylines, feature lines, blocks, 
3D cogo points, survey figures and 3D solids onto profile views and section views. Objects are 
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represented by marker styles and label styles. Projection styles are very useful in showing loc-
ations of utilities, and ROW locations in section views. Elevations can be assigned to the pro-
jections based on the object elevation itself or based on a surface or profile. Projection styles 
are dynamically linked to the objects they reference. However, when projected objects are 
added to a drawing, the markers and labels do not update until the projections command is re-
run. This module will demonstrate how to apply and update projection styles for survey figures.

Obtaining utilities data from survey database

Info: Survey figures representing existing conditions utilities found in the project 
survey database can be inserted into a cross section drawing for use with pro-
jection styles.

 1. Open  Crdr-25_xs.dwg

Info: This dwg should already have the corridor file as an XREF within it, and the 
section sheets created.

 2. The Exist surface is data referenced into the drawing.
 3. Toolspace > Survey tab right-click on Survey Databases and choose Set Working 

Folder.
 4. Set the working folder location to C:\WisDOT\design\c3d\12342014\BaseData\Surveyg  
 5. Click Ok.
 6. Toolspace > Survey tab > Survey Databasesright-click on Projection Styles Training. 
 7. Click Open for Edit. 

Info: This will open the example survey database to give you access to insert data 
into your current drawing.

 8. Right-click on each query you would like to insert and select Insert into drawing.

Tip: If you would like to insert them all at once, you can right-click on the Figures 
heading and select Insert into drawing.

 9. Confirm that the survey figure have been inserted into model space in your cross sec-
tions drawing, 

 10. Toolspace > Survey tab > Survey Databasesright-click on Projection Styles Training 
database 

 11. Click Close survey database.
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Applying utilities projection styles to cross sections

 1. Type PROJECTOBJECTSTOMULTISECTEnter..
 2. Select either a section view or a sample line from model space.

 l When the dialog box appears, uncheck all object types from the list except survey 
figures.

 l Keep the Style as Use Object.
 l Elevation Options should be set to surface Exist.
 l Label Style should be set to <None>. 
 l Click Ok.

 3. Check your section views to confirm that the markers for utilities are showing up.

Reloading survey figures after survey database update

Warning: When inserting survey figures to a drawing from survey database, these 
inserted figures are not “live”. This means that if there is a change to the survey fig-
ures made within the survey database, those changes will not automatically take 
place within the drawing they have been inserted into.

Warning: You will have to be working in the cross sections drawing when com-
pleting the following steps.

 1. If only one utility group was modified you will only need to reload that one query.
 2. Right-click on the query for that utility group and 
 3. Click Remove from drawing. .
 4. Right-click on the query a second time and click Insert into drawing. . 

Tip: This will effectively give you the newest survey figures from the survey data-
base.

Info: If changes were made to many of the utility groups it will be quicker just to do 
the above steps on the Figures heading in the Survey tab of toolspace. However, 
this will add all survey figures to the drawing so in many cases this may not be 
desirable.

Updating projection styles

Info: Projection styles will need to be updated if changes have been made to the 
survey database.

 1. Type PROJECTOBJECTSTOMULTISECTEnter.
 2. Uncheck everything but survey figures.
 3. Set the setting just as detailed in the original steps.
 4. Click Ok.
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Info: A message will appear with an option to overwrite the definition of already 
existing projections, or to leave them as they are. If any feature lines were deleted 
in plan view, the user can choose to overwrite the definition in order to remove the 
corresponding projection markers in the section views. If new feature lines were 
added to plan view then these will now be added into the section views.
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Quantities

WisDOT standards - earthwork

Last updated: 2010-07-01

Total video time: 71:20

WisDOT earthwork

qnty-erthwrk-wisdot-stnd-01.mp4 24:22

Earthwork – file management

 l File location = {ProjID}\Design\Quantities folder
 l File naming
 l Drawing Template

Earthwork – data referencing

 l Data Shortcut References:
 l Baseline Alignments
 l Roadway Model Surfaces
 l Subsurface
 l Corridor Marsh Excavation Surface

 l Xreferences:
 l Corridor dwg file

Earthwork – matchline alignments

 l Why?
 l Matchline Layout
 l Matchline Alignment Naming

Earthwork – sample line groups and sample lines

 l Sample Line Groups
 l Naming

 l SLG - Parent Alignment Name
 l Surfaces
 l Corridors
 l Display Styles
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Sample lines

 l Naming
 l SL – Station Value

 l Spacing

Earthwork - sample line groups and sample lines

qnty-erthwrk-wisdot-stnd-02.mp4 14:52

Earthwork – assign materials list

 l Material List
 l Naming – does it matter?
 l Surfaces
 l Corridor Shapes
 l Check out “SLG - Sections”

Earthwork – create reports

 l File Type
 l XML

 l File Naming
 l EwkDetail-Alignment Name or Sample Line Group Name

 l Folder Management
 l Place in \Quantities\EWKDetailReports folder

 l Why?

Earthwork - create reports

qnty-erthwrk-wisdot-stnd-03.mp4 25:53

Earthwork – create earthwork detail Excel workbooks

 l File Naming
 l EwkDetail-Alignment Name or Sample Line Group Name

 l Folder Management
 l Place in \Quantities\EWKSummaryWorkbooks folder

 l Why?

Earthwork – checking the results

 l Surface to Surface
 l Why won’t the numbers be exact?

Earthwork - summary
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qnty-erthwrk-wisdot-stnd-04.mp4 6:13

Earthwork – summary

 l Earthwork DWG file
 l Data to Xreference and Data Reference
 l Create Matchline Alignments
 l Create Sample Line Groups and Sample Lines
 l Assign Material Criteria to Sample Line Groups
 l Create Earthwork Detail XML Reports
 l Create Earthwork Detail Excel Workbooks
 l Create Earthwork Summary Excel Workbooks
 l Check your work

Exercise DS1900 - Create earthwork reports

Last updated: 2010-07-01

Total video time: 131:13

Exercise files: qnty-creat-erthwrk-rpt-data-C3D10.zip

qnty-creat-erthwrk-rpt.pdf

Create marsh excavation surface

qnty-creat-erthwrk-rpt-01.mp4 14:04

Create the Marsh Excavation limits surface in the Corridor-STH25-4thAve.DWG file and save 
the MarshEXCSurface data shortcut. This surface will be used when we compute Earthwork 
Quantities.

 1. Open Corridor-STH25-4thAve.dwg
 2. Create the STH25-Corridor-MarshExcSurface surface from the corridor. 

 l From Corridor Properties dialog
 l Select Surfaces tab
 l Press Create a Corridor Surface button
 l Enter Surface Name STH25-Corridor-MarshExcSurface

 l Select a Type = Links
 l Select the Code = MarshEx
 l Press the Add Surface Item button
 l Select a Type = Feature Lines
 l Select the Code = Marsh_Bottom
 l Press the Add Surface Item button
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 l Select a Type = Feature Lines
 l Select the Code = Marsh_Daylight
 l Press the Add Surface Item button

 l Corridor Properties dialog Press Ok
 3. Visually inspect the STH25-Corridor-MarshExc surface, and add an outer boundary if 

necessary.
 4. Create a data shortcut for the STH25-Corridor-MarshExc surface

Info: Marsh bottom surface was loaded previously

Info: Rock surface was loaded previously

Info: STH25-4thAve Corridor (Assemblies) solve for Marsh Excavation limits

Create DWG

qnty-creat-erthwrk-rpt-02.mp4 9:49

 1. Create the Earthwork-STH25.dwg from the main WisDOT design template. 
 2. XREF the Corridor-STH25-4thAve.dwg file. 
 3. Data reference the 4thAve and STH25BestFit alignments and profiles
 4. Data reference the STH25-RoadwayModel surfaces

 l STH25-RoadwayModel-BaseCourse
 l STH25-RoadwayModel-Datum
 l STH25-RoadwayModel-Exist
 l STH25-RoadwayModel-Top

Create matchlines 1

qnty-creat-erthwrk-rpt-03.mp4 11:31

 1. Open the Earthwork-STH25.DWG file
 2. Create Graphics that locate the Curb Center of Curve for all (see video)

Create matchlines 2

qnty-creat-erthwrk-rpt-04.mp4 7:01

 1. Home Ribbon > Create Design > Alignment > Alignment Creation Tools
 l Alignment Name: Matchline - STH25-Left
 l Type: Miscellaneous
 l Description: Earthwork matchline left
 l Alignment style: RDWY Lane Edge
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 l Alignment label set: _No Labels
 l Alignment Layout Toolbar > Tangent-Tangent-No Curves

 l PI 1 = SW Quadrant Curb center
 l PI 2 = Intersection of 4thAve and STH25 Lane edge left
 l PI 3 = NW Quadrant Curb center

 2. Home Ribbon > Create Design > Alignment > Alignment Creation Tools
 l Alignment Name: Matchline - STH25-Right
 l Type: Miscellaneous
 l Description: Earthwork matchline right
 l Alignment style: RDWY Lane Edge
 l Alignment label set: _No Labels
 l Alignment Layout Toolbar > Tangent-Tangent-No Curves

 l PI 1 = SE Quadrant Curb center
 l PI 2 = Intersection of 4thAve and STH25 Lane edge right
 l PI 3 = NE Quadrant Curb center

 3. Extend the matchline alignments beyond the slope intercepts for Matchline-STH25-Left 
alignment
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 4. Extend the matchline alignments beyond the slope intercepts for Matchline-STH25-Right 
alignment
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Create sample lines 1

qnty-creat-erthwrk-rpt-05.mp4 10:41

 1. Open the Earthwork-STH25.dwg file
 2. Create the Sample Line Group SLG-STH25BestFit

 l Home Ribbon > Sample Lines > Create Sample Lines
 l Name: SLG-STH25BestFit
 l Sample Line Style: Standard
 l Sample Line Label Style: Standard
 l Sample Surfaces:

 l STH25-RoadwayModel-Exist
 l Style = Ex Ground

 l STH25-RoadwayModel-Datum
 l Style = Final Datum

 l STH25-RoadwayModel-Top
 l Style = Final Top
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 l STH25-RoadwayModel-Base Course
 l Style = Final Base Course

 l Marsh
 l Style = Marsh

 l Rock
 l Style = Rock

 l STH25-4thAve
 l Style = No Display

 l STH25-4thAveSTH25-Corridor-MarshExcSurface
 l Style = Marsh

Info: STH25-4thAve is the Corridor. It is read from the Xref’d Corridor DWG file.

Info: The STH25-4thAve STH25-Corridor-Datum, Top and BaseCourse surfaces 
are the surfaces created from the Xreferenced Corridor DWG file. The Road-
wayModel surfaces use these Corridor surfaces and include edits. We therefore 
want to use the RoadwayModel surfaces for Quantities

Info: EXIST is included because it was used in the Xreferenced Corridor DWG 
file. We do not want to use this surface. We will use the STH25-RoadwayModel-
Exist surface. It is recently created and takes into consideration Construction sta-
ging (if applicable).

Info: vSTH25-4thAve STH25-Corridor-MarshExcSurface comes from the Xref’d 
Corridor DWG file. We do not have any RoadwayModel edits to this surface and 
will use it directly from the Corridor DWG file.
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 3. Create Sample Lines for stations 366+00 to PC of SE Quadrant (add to the sample line 
group SLG-STH25BestFit)

 l From the Sample Line Tools toolbar Select Edit Name Template button (next to 
Sample Line name).

 l From the Name Template dialog Highlight <[Next Counter(CP)]> in Name field 
Select Sample Line Station Value in Property Fields

 l Press Insert
 l Press OK
 l From the Sample Line Tools toolbar Select the By Range of Stations selection
 l From the Create Sample Lines- By Range of Stations dialog

 l From Alignment Start = False
 l Start Station = 366+00
 l To Alignment End = False
 l End Station = 383+95 (PC of SE Quadrant)
 l Left Swath width = 100
 l Right Swath Width = 100
 l Note: Swath width must extend to the limits of the slope intercepts or Earth-

work will not be computed completely.
 l Sampling Increments = 50 for all
 l Note: 50 ft increments for Rural Roadway outside of intersection area
 l Additional Sample Controls:

 l At Range Start = True
 l At Range End = True
 l At Horizontal Geometry Points = True
 l At Superelevation Critical Stations = True

 l Press Ok

Page: 817

Published on: 2/21/2018

Exercise DS1900 - Create earthwork reports



Info: Creates Sample lines for Stations 366+00 to Sta 383+95 at 50 ft increments 
with extra sample lines at critical stations

Info: Sample Line Tools remains open
 4. Create Sample Lines for intersection stations (383+95 to 385+44.83)

 l From the Sample Line Tools toolbar Select the By Range of Stations selection
 l From the Create Sample Lines- By Range of Stations dialog

 l From Alignment Start = False
 l Start Station = 383+95
 l To Alignment End = False
 l End Station = 385+44.55 (PT of NW Quadrant)
 l Left Swath width

 l Snap to Alignment = True
 l Alignment = Matchline-STH25-Left

 l Right Swath Width
 l Snap to Alignment = True
 l Alignment = Matchline-STH25-Right

 l Note: Swath width must extend to the limits of the slope intercepts or Earth-
work will not be computed completely.

 l Sampling Increments = 5 for all
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 l Note: 5 ft increments for Rural Roadway within intersection area
 l Additional Sample Controls:

 l At Range Start = False
 l At Range End = True
 l At Horizontal Geometry Points = False
 l At Superelevation Critical Stations = False

 l Press Ok

Info: Creates Sample lines for Stations 383+95 to 385+44.55 at 5 ft increments

Info: Sample Line Tools remains open

 5. Create Sample Lines from intersection to end of project (385+44.83 to 395+00)
 l From the Sample Line Tools toolbar Select the By Range of Stations selection
 l From the Create Sample Lines- By Range of Stations dialog

 l From Alignment Start = False
 l Start Station = 385+44.83 (PT of NW Quadrant)
 l To Alignment End = False
 l End Station = 395+00 
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 l Left Swath width
 l Snap to Alignment = False 
 l Width = 100

 l Right Swath Width
 l Snap to Alignment = False
 l Width = 100

 l Note: Swath width must extend to the limits of the slope intercepts or Earth-
work will not be computed completely.

 l Sampling Increments = 50 for all
 l Note: 50 ft increments for Rural Roadway outside of intersection area
 l Additional Sample Controls:

 l At Range Start = False
 l At Range End = True
 l At Horizontal Geometry Points = True 
 l At Superelevation Critical Stations = True

 l Press Ok
 l Exit Sample Line Tools toolbar

Info: Creates Sample lines for Stations 385+44.55 to 395+00 at 50 ft increments

Create sample lines 2
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qnty-creat-erthwrk-rpt-06.mp4 6:08

 1. Create the Sample Line Group SLG-4thAve
 l Home Ribbon > Sample Lines > Create Sample Lines

 l Name: SLG-4thAve
 l Sample Line Style: Standard
 l Sample Line Label Style: Standard
 l Sample Surfaces:

 l STH25-RoadwayModel-Exist
 l Style = Ex Ground

 l STH25-RoadwayModel-Datum
 l Style = Final Datum

 l STH25-RoadwayModel-Top
 l Style = Final Top

 l STH25-RoadwayModel-Base Course
 l Style = Final Base Course

 l Marsh
 l Style = Marsh

 l Rock
 l Style = Rock

 l STH25-4thAve
 l Style = No Display

 l STH25-4thAveSTH25-Corridor-MarshExcSurface
 l Style = Marsh
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Info: STH25-4thAve is the Corridor. It is read from the Xref’d Corridor DWG file.

Info: The STH25-4thAve STH25-Corridor-Datum, Top and BaseCourse surfaces 
are the surfaces created from the Xreferenced Corridor DWG file. The Road-
wayModel surfaces use these Corridor surfaces and include edits. We therefore 
want to use the RoadwayModel surfaces for Quantities

Info: EXIST is included because it was used in the Xreferenced Corridor DWG 
file. We do not want to use this surface. We will use the STH25-RoadwayModel-
Exist surface. It is recently created and takes into consideration Construction sta-
ging (if applicable).

Info: vSTH25-4thAve STH25-Corridor-MarshExcSurface comes from the Xref’d 
Corridor DWG file. We do not have any RoadwayModel edits to this surface and 
will use it directly from the Corridor DWG file.

 2. Create Sample Lines for Stations 46+00 to 49+18.63 (NW Quadrant CC)
 l From the Sample Line Tools toolbar Select the By Range of Stations selection
 l From the Create Sample Lines- By Range of Stations dialog

 l From Alignment Start = False
 l Start Station = 46+00
 l To Alignment End = False
 l End Station = 49+18.57 (CC of NW Quadrant)
 l Left Swath width = 100
 l Right Swath Width = 100
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 l Note: Swath width must extend to the limits of the slope intercepts or Earth-
work will not be computed completely.

 l Sampling Increments = 50 for all
 l Note: 50 ft increments for Rural Roadway outside of the intersection area
 l Additional Sample Controls:

 l At Range Start = True
 l At Range End = True
 l At Horizontal Geometry Points = True
 l At Superelevation Critical Stations = True

 l Press Ok

Info: Creates Sample lines for Stations 46+00 to 49+18.63 at 50 ft increments with 
extra sample lines at critical points

Info: Sample Line Tools remains open
 3. Create Sample Lines for Intersection Stations to edge of pavement on mainline 

(49+18.63 to 49+88)
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 l From the Sample Line Tools toolbar Select the By Range of Stations selection
 l From the Create Sample Lines- By Range of Stations dialog

 l From Alignment Start = False
 l Start Station = 49+18.57
 l To Alignment End = False
 l End Station = 49+88 (Edge of pavement along mainline)
 l Left Swath width

 l Snap to an Alignment = True
 l Alignment = Matchline-STH25-Left

 l Right Swath Width
 l Snap to an Alignment = True
 l Alignment = Matchline-STH25-Left

 l Note: Swath width must extend to the limits of the slope intercepts or Earth-
work will not be computed completely.

 l Sampling Increments = 5 for all
 l Note: 5 ft increments for Rural Roadway within the intersection area
 l Additional Sample Controls:

 l At Range Start = False
 l At Range End = False
 l At Horizontal Geometry Points = True
 l At Superelevation Critical Stations = True

 l Press Ok
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Info: Creates Sample lines for Stations 49+18.57 to 49+88 at 5 ft increments

Info: Sample Line Tools Toolbar remains open
 4. Create Sample Lines from edge of mainline pavement to end of intersection (50+12 to 

50+81.26)
 l From the Sample Line Tools toolbar Select the By Range of Stations selection
 l From the Create Sample Lines- By Range of Stations dialog

 l From Alignment Start = False
 l  Start Station = 50+12 (Edge of pavement along mainline)
 l To Alignment End = False
 l End Station = 50+81.26
 l Left Swath width 

 l Snap to an Alignment = True
 l Alignment = Matchline-STH25-Right

 l Right Swath width 
 l Snap to an Alignment = True
 l Alignment = Matchline-STH25-Right

 l Note: Swath width must extend to the limits of the slope intercepts or Earth-
work will not be computed completely.
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 l Sampling Increments = 5 for all
 l Note: 5 ft increments for Rural Roadway within the intersection area
 l Additional Sample Controls:

 l At Range Start = False
 l At Range End = True
 l At Horizontal Geometry Points = True
 l At Superelevation Critical Stations = True

 l Press Ok

Info: Creates Sample lines for Stations 50+12 to 50+81.26 at 5 ft increments

Info: Sample Line Tools Toolbar remains open
 5. Create Sample Lines from edge of mainline pavement to end of intersection (50+81.26 

to 53+45)
 l From the Sample Line Tools toolbar Select the By Range of Stations selection
 l From the Create Sample Lines- By Range of Stations dialog

 l From Alignment Start = False
 l  Start Station = 50+81.26 (PT of SE Quadrant)
 l To Alignment End = False
 l End Station = 53+45
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 l Left Swath width 
 l Snap to an Alignment = False
 l Width = 100

 l Right Swath width 
 l Snap to an Alignment = False
 l Width = 100

 l Note: Swath width must extend to the limits of the slope intercepts or Earth-
work will not be computed completely.

 l Sampling Increments = 50 for all
 l Note: 50 ft increments for Rural Roadway outside of the intersection area
 l Additional Sample Controls:

 l At Range Start = False
 l At Range End = True
 l At Horizontal Geometry Points = True
 l At Superelevation Critical Stations = True

 l Press Ok
 l Exist the Sample Line Tools toolbar

Info: Creates Sample lines for Stations 50+81.26 to 53+45 at 50 ft increments
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Create sample lines 3

qnty-creat-erthwrk-rpt-07.mp4 6:27

 1. Grip Edit the length of the Sample lines in the NE (and SE) Quadrant of the Intersection
 l Do not overlap the STH25BestFit sample lines
 l Extend to the slope intercepts where applicable
 l Should not have situations where Sample Lines overlap Sample Lines within the 

same Sample Line Group
 2. Select a Sample Line Select the Arrow on the Sample Line (it turns red) Drag Back to the 

desired ending location (Osnap intersection)
 3. Repeat for other Sample Lines

Assign materials 1

qnty-creat-erthwrk-rpt-08.mp4 8:59

 1. Apply Materials Criteria to SLG-STH25BestFit Sample Line Group
 l Toolspace > Prospector > Alignments > STH25BestFit > Sample Line Groups
 l Right-click SLG-STH25BestFit Sample Line Group and click Properties

 l From Sample Line Group Properties dialog Select Material List Tab
 l Press Import Another Criteria button (lower right)
 l From Select a Quantity Takeoff Criteria dialog Select WisDOT Mass Ordin-

ate then click OK
 l From Compute Materials –SLG STH25BestFit dialog use the <Click here to 

set all> for all surfaces
 l Exist = STH25-RoadwayModel-Exist
 l Final Datum = STH25-RoadwayModel-DATUM
 l Final Marsh Excavation Limits = STH25-4thAveSTH25-Corridor-

MarshExcSurface
 l Final Marsh Bottom = MARSH
 l Final Marsh Waste Limits = Leave Blank
 l Rock = Rock
 l Final EBS Limits = Leave Blank
 l Final Structure Excavation Limits = Leave Blank
 l Marsh Excavation Shape = STH25-4thAveMarshEx
 l Click OK

Info: A message that not all of the named surfaces have been mapped appears. 
We know this… Press OK
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 2. From Sample Line Group Properties – SLG-STH25BestFit dialog Material List tab rename 
the Material List to Earthwork-SLG-STH25BestFit

Info: Civil 3D allows overlapping areas when defining materials criteria.

Info: CutCommon - the Cut area defined below Existing ground surface and 
above Datum surface

Info: CutMarshExcLimits – sometimes our Exist surface if higher than the pro-
posed Datum within the Marsh Excavation limits. Removal of this road core is 
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MarshExcavation. This area will also show up as CutCommon as it is below Exist 
surface and above Datum surface. In order to compute accurate Com-
monExcavation quantities we will reduce the CutCommon by the CutMarshEx-
cLimits when processing the Earthwork Detail workbooks.

Info: CutMarshBottom – sometimes we have ditches where there is Marsh. These 
ditches should be classified as MarshExcavation (CutMarshExLimits is included 
in this area). Marsh Ditches are also classified as CutCommon because they are 
Above Datum and Below Exist surfaces.

Info: MarshExc is also stored as a shape in the Corridor DWG file. We need this 
shape in order to distinguish between the different Marsh Excavation possibilities 
and compute total areas correctly.

 3. Adding a surface to a Sample Line Group after the SLG has already been created
 l Toolspace > Prospector > Alignments > STH25BestFit > Sample Line Groups
 l Right-click SLG-STH25BestFit Sample Line Group and click Properties

 l From Sample Line Group Properties dialog
 l Select Sections Tab
 l Select Select More Sources
 l From Section Sources dialog

 l Select Surfaces from Available Sources
 l Press ADD
 l Press Ok

 l Press Ok in Sample Line Group Properties dialog to accept

Info: Note: if these new section surfaces were to be used in your material list, you 
would have to change the Material List to reflect those new surfaces.

Assign materials 2

qnty-creat-erthwrk-rpt-09.mp4 1:27

 1. Apply Materials Criteria to SLG-4thAve Sample Line Group
 l Toolspace > Prospector > Alignments > 4thAve> Sample Line Groups
 l Right-click SLG-4thAve Sample Line Group and click Properties

 l From Sample Line Group Properties dialog Select Material List Tab
 l Press Import Another Criteria button (lower right)
 l From Select a Quantity Takeoff Criteria dialog Select WisDOT Mass Ordin-

ate then click OK
 l From Compute Materials –SLG 4thAve dialog use the <Click here to set 

all> for all surfaces
 l Exist = STH25-RoadwayModel-Exist
 l Final Datum = STH25-RoadwayModel-DATUM
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 l Final Marsh Excavation Limits = STH25-4thAveSTH25-Corridor-
MarshExcSurface

 l Final Marsh Bottom = MARSH
 l Final Marsh Waste Limits = Leave Blank
 l Rock = Rock
 l Final EBS Limits = Leave Blank
 l Final Structure Excavation Limits = Leave Blank
 l Marsh Excavation Shape = STH25-4thAveMarshEx
 l Click OK
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Info: Note: A message that not all of the named surfaces have been mapped 
appears. We know this… Press OK

Info: This loads the Materials List associated with the SLG-4thAve

Info: Note: there can be more than one material list per SLG
 2. From Sample Line Group Properties – SLG-4thAve dialog Material List tab rename the 

Material List to Earthwork-SLG-4thAve

Create reports

qnty-creat-erthwrk-rpt-10.mp4 7:13

 1. Open the Earthwork-STH25.dwg
 2. Synchronize Data References
 3. Clear Panaroma Events (Actions > Clear All Events)
 4. Analyze tab > Volumes and Materials > Volume Report
 5. In report Quantities dialog:

 l Alignment = STH25BestFit
 l Sample Line Group = SLG-STH25BestFit
 l Material list = Earthwork-SLG-STH25BestFit
 l Style sheet = leave as it is
 l Check Display XML Report ON
 l Press Ok
 l If a message ‘allow scripts to run’ appears, Press Yes
 l Close the HTML Report (the Text Report)
 l From the QuantityReportTempXML.XML Report Select File > Save As

 l \12345678\Design\Quantities\EWKDetailReports\EWKDetail-
STH25BestFit.xml

Info: Note: this saves the STH25BestFit materials information to a named XML 
file. We will use this file as input when we create Earthwork Detail Excel work-
books.

 6. Analyze tab > Volumes and Materials > Volume Report
 7. In report Quantities dialog:

 l Alignment = 4thAve
 l Sample Line Group = SLG-4thAve
 l Material list = Earthwork-SLG-4thAve
 l Style sheet = leave as it is
 l Check Display XML Report ON
 l Press Ok
 l If a message ‘allow scripts to run’ appears, Press Yes
 l Close the HTML Report (the Text Report)
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 l From the QuantityReportTempXML.XML Report Select File > Save As
 l \12345678\Design\Quantities\EWKDetailReports\EWKDetail-4thAve.xml

Create earthwork detail report 1

qnty-creat-erthwrk-rpt-11.mp4 6:37

 1. Create the Earthwork Detail workbook for STH25BestFit
 l Toolbox tab > WisDOT Toolbox > WisDOT Reports > WisDOT Earthwork 

Detailed
 2. In Earthwork Details dialog box:

 l Detail Import Options = Express
 l Press Browse button
 l Navigate to \Quantities\EWKDetailReports folder, Select EwkDetail-

STH25BestFit.XML file
 l Complete Expansion Factors as follows

 l Fill = 1.25
 l Rock = 1.1
 l Cut = 1
 l Marsh Backfill = 1.5
 l EBS Backfill = 1.3
 l Reduced Marsh in Fill = 0.6
 l Reduced EBS in Fill = 0.8

 l Complete Mass Ordinate Considerations as follows
 l Backfill Marsh with Common = do not check
 l Backfill EBS with Common = do not check
 l Use Marsh in Fill = check
 l Use EBS in Fill = check

 l Output Earthwork Spreadsheet
 l Press Browse
 l From Save Report File As dialog
 l Press Create New Folder
 l Folder Name = EWKDetailWorkbooks
 l Select EWKDetailWorkbooks folder
 l File name = EwkDetail-STH25BestFit.XLS
 l Press Save

 l From Earthwork Details dialog Press Create Report button 
 l If Microsoft Excel is Running dialog appears, press Ok
 l When Excel Workbook appears click Cancel for the Earthwork Details dialog
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 3. Inspect EwkDetail-STH25BestFit.XLS file

Create earthwork detail report 2

qnty-creat-erthwrk-rpt-12.mp4 12:30

 1. Create the Earthwork Detail workbook for 4thAve
 l Toolbox tab > WisDOT Toolbox > WisDOT Reports > WisDOT Earthwork 

Detailed
 2. In Earthwork Details dialog box:

 l Detail Import Options = Express
 l Press Browse button
 l Navigate to \Quantities\EWKDetailReports folder, Select EwkDetail-4thAve.XML 

file
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 l Complete Expansion Factors as follows
 l Fill = 1.25
 l Rock = 1.1
 l Cut = 1
 l Marsh Backfill = 1.5
 l EBS Backfill = 1.3
 l Reduced Marsh in Fill = 0.6
 l Reduced EBS in Fill = 0.8

 l Complete Mass Ordinate Considerations as follows
 l Backfill Marsh with Common = do not check
 l Backfill EBS with Common = do not check
 l Use Marsh in Fill = check
 l Use EBS in Fill = check

 l Output Earthwork Spreadsheet
 l Press Browse
 l From Save Report File As dialog
 l Press Create New Folder
 l Folder Name = EWKDetailWorkbooks
 l Select EWKDetailWorkbooks folder
 l File name = EwkDetail-4thAve.XLS
 l Press Save

 l From Earthwork Details dialog Press Create Report button 
 l If Microsoft Excel is Running dialog appears, press Ok
 l When Excel Workbook appears click Cancel for the Earthwork Details dialog

 3. Inspect the EwkDetail-4thAve.XLS file

Create earthwork summary report 1

qnty-creat-erthwrk-rpt-13.mp4 6:42

 1. Create a combined Excel Spreadsheet for Earthwork Summary
 2. From Windows Explorer:

 l Navigate to \Wisdot\Design\C3D\12345678\Design\Quantities folder
 l Create a New Folder named EarthworkSummaryWorkbooks

 3. Open the EWKDetail-STH25BestFit.XLS file
 l Save As  Quantities\EarthworkSummaryWokbooks\EwkSummary-STH25-

4thAve.XLSx
 4. Open the EwkDetail-4thAve.XLSx file

 l Right Click the EwkDetail-4thAve.XML Worksheet
 l Select Move Or Copy
 l Select the To Book = EwkSummary-STH25-4thAve.XLSX
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 l Select the Before Sheet = EWKDetail-STH25BestFit.XML
 l Check the Create a Copy checkbox
 l Press Ok
 l Close the EwkDetail-4thAve.XLSx file

 5. Inspect the EwkSummary-STH25-4thAve.XLSx file

Create earthwork summary report 2

qnty-creat-erthwrk-rpt-14.mp4 6:05

 1. Run the Earthwork Summary Macro on the EwkSummary-STH25-4thAve.XLSX file
 l Toolbox tab > WisDOT Toolbox > WisDOT Reports > WisDOT Earthwork Sum-

mary
 2. In the frmEarthworkSummary dialog

 l Summary Sheet Options = Express
 l Summary Sheet Divisions = All Details to one Division
 l Expansion Factors by materials = leave same as when EWK Detail workbooks were 

created
 l Mass Ordinate Considerations = leave same as when EWK Detail workbooks were 

created
 l Select Browse for Earthwork Spreadsheet
 l Select EwkSummary-STH25-4thAve.XLSX file
 l Press Open
 l Press Create Report in frmEarthworkSummary dialog

Check earthwork summary

qnty-creat-erthwrk-rpt-15.mp4 15:59

 1. Compute Earthwork between surfaces
 2. Open Earthwork-STH25.DWG file
 3. Analyze tab > Volumes and Materials > Volumes Dashboard
 4. Click Create Volume Surface:

 l Base Surface = STH25-RoadwayModel-Exist
 l Comparison Surface = STH25-RoadwayModel-Datum
 l This is a check for the Cut and Fill

 5. Compare Earthwork comps to EwkSummary-STH25-4thAve.XLSX quantities
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Plotting & layouts

Exercise PLPR0305 - printing

Last updated: 2010-07-01

Total video time: 03:43

Printing

plt-lyout-prnt-01.mp4 2:07

Exercise PLPR0350 - Create roll plot

Last updated: 2010-07-01

Total video time: 02:49

Exercise files: plt-lyout-roll-plt-data-C3D14.zip

Create roll plot

plt-lyout-roll-plt-01.mp4 2:49

Exercise DD0100 - Import table on layout

Last updated: 2010-07-01

Total video time: 02:07

Exercise files: plt-lyout-imprt-tbl-lyout-data-C3D10.zip

Import table on layout

plt-lyout-plt-overrides.mp4 2:07

Exercise PR0105 - Create plan & profile sheets w/annotation

Last updated: 2011-07-01

Total video time: 27:46

Exercise files: pln-prod-creat-pp-w-anno-data-C3D10.zip

Create plan and profile sheets with annotation
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pln-prod-creat-pp-w-anno-01.mp4 2:52

 1. Delete project data and download and unzip this exercise. 
 2. Create plan and profile sheets with annotation
 3. Create a sheet set file.
 4. View tab > Palettes panel > Sheet Set Manager .
 5. In Sheet List, right click down arrow, 
 6. Click New Sheet Set...

 l Create a sheet set using an example sheet set. 
 l Click Next. 

 7. Sheet Set Example
 l Select a sheet set to use as an example: 

 8. Plan Production. 
 l Click Next.

Sheet Set Details

 l Name of new sheet set: 050201
 l Description: 4th Ave Plan & Prof
 l Store sheet set data file (.dst) here: 

 l C:\WisDOT\design\c3d\12345678\SheetsPlan

 l Click Sheet Set Properties.
 l Sheet Set Custom Properties 
 l County: BARRON
 l Highway: STH 25
 l Project No: 1234-56-78
 l Title Plan Profile: FOURTH Avenue
 l Click Ok.
 l Click Next.
 l Click Finish.

Annotate alignments and profile

pln-prod-creat-pp-w-anno-02.mp4 2:11

 1. Toolspace > Prospector tab > Data Shortcutsright click 4th Ave alignment 
 2. Click Open Source Drawing..

Tip: Annotate alignments and profile by adding annotation to Description.

 3. Right-click on either object and click Properties.
 4. Click on the Information tab and enter the annotation in the Description box.

Create Data Shortcuts
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pln-prod-creat-pp-w-anno-03.mp4 1:51

 1. Save the file.
 2. Refresh the data shortcuts
 3. Toolspace > Prospector tab > Data Shortcutsright click "4th Ave.
 4. Click Remove..
 5. Data Shortcuts > Create Data Shortcuts 

Create Data Shortcuts dialog

 1. Make sure 4th Ave alignment and profiles are checked. 
 2. Click Ok. 
 3. Save and close the file.
 4. Save new file for Sheets. C:\WisDOT\design\c3d\12345678\SheetsPlan\050201.dwg

XREF topo data into view frame group file

pln-prod-creat-pp-w-anno-04.mp4 2:26

 1. Set annotation scale to 1 IN:40 FT.
 2. XREF topo data into view frame group file.
 3. Home tab > Layers panel > Freeze 

Create data reference of profile

pln-prod-creat-pp-w-anno-05.mp4 2:52

 1. Save the file.
 2. Data shortcut 4thAve alignment and profile into view frame file.

Create Alignment Reference dialog... 

Toolspace > Prospector tab > Data Shortcuts > right-click 4thAve alignment > Create Refer-
ence

 l Alignment style: ALI Proposed
 l Description: F
 l Alignment label set: Ticks 100' Major:25' Minor[DESC]

 

Toolspace > Prospector tab > Data Shortcuts > right-click 4thAve-Exist > Create Reference. 
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 l Profile style: Existing
 l Profile label set: _No Labels

Toolspace > Prospector tab > Data Shortcuts > right-click 4thAve > Create Reference.

On Create Profile Reference dialog...

 l Profile style: Proposed
 l Profile label set: Standard [ALI DESC]

Info: **NOTE** Profile label set "Standard [PROF DESC]" available for ditch and 
miscellaneous profiles.

View annotations.

Tip: Do not add profile view. Profile views for layouts are created automatically and 
managed by ViewFrameGroup.

Add alignment PI labels

pln-prod-creat-pp-w-anno-06.mp4 1:35

 1. Save the file.
 2. Annotate tab > Labels & Tables ribbon > Add Labels button (picture, not text to get 

full dialog box) 
 3. Add Labels dialog 

 l Feature: Alignment
 l Label type: Multiple Tangent Intersections
 l Tangent intersection label style: PI Station[DESC]

 4. Click Add  
 5. Select the alignment 4thAve in model space.

Create View Frames

pln-prod-creat-pp-w-anno-07.mp4 3:16

Create View Frame Group - 

Output tab > Plan Production panel > Create View Frames 

Create View Frames - Alignment dialog... 

Alignment

 l Alignment"4thAve
 l Station Range Automatic. Click Next.
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Sheets

 l Sheet Settings: Plan and Profile
 l Template: wisdot10-pp40.dwt|PlanProf 1 IN 40 FT
 l Click Next

View Frame Group

 l Name 0502 Fourth Ave
 l View Frame Name VF - 0502<[Next Counter]> and click Next
 l Under Match Lines

 l Verify values and click Next
 l Click Create View Frames

Modify the station range of Profile Views

pln-prod-creat-pp-w-anno-08.mp4 1:42

 1. Save the file.
 2. Verify and modify station range of Profile Views to better fit sheets. 

Tip: It is much easier to change view frame location prior to creating profile views 
and sheets.

 3. Slide location with diamond grip. 
 4. Rotate with circle grip.

Create sheets

pln-prod-creat-pp-w-anno-09.mp4 4:39

Create Sheets > Output tab > Plan Production ribbon > Create Sheets button

Create Sheets dialog

 l Layout Creation All layouts in the current drawing
 l Layout name 05020<[Next Counter(CP)]>
 l Click Next

Sheet Set

 l Sheet Set: Add to existing sheet set: 0502
 l Click Next.
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Profile Views

 l Other profile view options Choose settings:
 l Click Profile View Wizard
 l Create Multiple Profile Views > Profile Display Options

 l Profile 4thAve
 l Layer: P_Prof-Base  
 l Style: PROF Proposed
 l Labels: Standard [ALI DESC] 

 l Profile 4thAve-Exist
 l Layer: P_E_PROF 
 l Style: PROF Existing
 l Labels: _No Labels

 l Create Multiple Profile Views > Data Bands
 l Select band set: Elevation Both (Exist Left, Proposed Right)
 l Set band properties:  Set Profile1 to 4thAve and Profile2 to 4thAve

 l Click Finish
 l Click Create Sheets

Results

pln-prod-creat-pp-w-anno-10.mp4 4:22

Warning: View Frames automate the creation of sheets, but do not provide a live 
link to them. Changing view frame location will probably mean re-creating sheets.

Tip: Profile views split at matchline. No overlap. Overlap can be achieved by chan-
ging the station range. However, alignment of plan and profile views may not be 
exact.

Exercise PR0205 - Create cross section sheets

Last updated: 2011-07-01

Total video time: 21:20

Create a sheet set file

pln-prod-creat-xs-01.mp4 3:07

Warning: This exercise should only be used with Civil 3D 2010. An improved work-
flow for creating cross sections can be found at 190.010
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 1. Delete project data and download and unzip this exercise. 
 2. Create plan and profile sheets with annotation
 3. Create a sheet set file.

 l View tab > Palettes panel > Sheet Set Manager icon 
 l In Sheet List, right click down arrow
 l Click New Sheet Set
 l Begin - create a sheet set using an example sheet set. 
 l Click Next
 l Click Next
 l Sheet Set Example - Select a sheet set to use as an example: planproduction
 l Click Next.
 l Sheet Set Details

 l Name of new sheet set: 090101
 l Description: STH 25
 l Store sheet set data file (.dst) here:

 l C:\WisDOT\design\c3d\12345678\SheetsPlan
 l Click Sheet Set Properties

Sheet set custom properties

pln-prod-creat-xs-02.mp4 2:44

 1. Sheet Set Properties > Sheet Set Custom Properties 
 l County: BARRON
 l Highway: STH 2
 l Project No: 1234-56-78
 l Title Cross Section: STH 25

 2. Click Ok.
 3. Click Next.
 4. Click Finish.
 5. Right-click the sheet set 090101
 6. Click Close Sheet Set
 7. Open file C:\WisDOT\design\c3d\12345678\SheetsPlan\090101_xs.dwg

XREF corridor

pln-prod-creat-xs-02.mp4 3:56

 1. Freeze all unnecessary corridor layers

Tip: This will eliminate a lot of unneeded file space in your plot.
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 2. Home tab > Layers panel > Layers Properties icon
 3. Click XREF Corridor-STH25-4thAve.dwg
 4. Select layers Corridor-STH25-4thAve|P_XS-Base and Corridor-STH25-4thAve|P_XS_

Text
 5. Right-click and click Invert Selection
 6. Click Freeze Column to freeze for the rest of the layers 
 7. Close Layer Properties dialog

Create cross section layouts with a Map Book part 1

pln-prod-creat-xs-04.mp4 3:54

 1. type MAPWSPACEEnter
 2. Select On.
 3. Click on the Map Book tab.
 4. Click New. 
 5. Click New Map Book.
 6. Create Map Book dialog

 l Source: Model Space
 l Book Name: xs
 l Sheet Template > Settings
 l Choose a Sheet Template: C:\Documents and Settings\%username%\Local Set-

tings\Application Data\Autodesk\C3D 2010\enu\Tem-
plate\USWI\planproduction\xsection\wisdot10-xs20h-20v.dwt

 l Choose a Layout: X-Section 1 IN 20 FT Horiz 20 FT Vert
 l Layout Options: 

 l Uncheck the two Includes. 
 l Set the Scale Factor: 20

Tip: This number should always match the scale of the sheet template.

Create cross section layouts with a Map Book part 2

pln-prod-creat-xs-05.mp4 3:34

Tiling Scheme > ...By Number 

 1. Click Pick Upper Left >>. 
 2. Snap and click on the top left corner of the first cross section sheet. 
 3. Count the number of rows and columns (sheets).

 l Columns: 10
 l Rows: 1
 l % overlap of each tile: 0
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 l Naming Scheme: Columns and Rows.
 l Rows: Leave the defaults.
 l Columns: Change the Start with and Increment by both to 1
 l Key and Legend: Leave set to None

 4. Sheet Set > Create New Subset 
 5. Choose Sheet Set file: C-WisDOT-design-c3d-12345678-SheetsPlan-090101.dst
 6. Position new subset: Can be left as is or changed to user preference.
 7. Click Preview Tiles >>.

Info: The dialog will disappear and show dashed lines around the area to become 
sheets. If you zoom or pan, the dashed lines will disappear, key-in [r] to refresh 
them. Press Enter to return to the map book dialog. If your tile preview was not cor-
rect, make the necessary changes in the dialog until it previews correctly.

 8. Click Generate
 9. Save the file.

Editing Map Book settings for cross-sections

pln-prod-creat-xs-06.mp4 4:05

 1. If there were any errors made when creating the cross-sections or if changes need to be 
made, access the map book by: 

 2. Map Task Pane > Map Book . 
 3. Right-click the map book xs
 4. Click Edit Settings and Rebuild.

Tip: Changes can then be made in any of the settings and the layouts and Sheet 
Set can be regenerated.

Title sheet

Last updated: 2013-04-10

Total video time: 59:05

pln-prod-ts.pdf

Starting a title sheet

pln-prod-ts-01.mp4 5:24
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Info: *Note* - This exercise creates a new file in a project folder. There are no con-
nections to this file and the rest of the project, so an exercise project dataset is not 
included. Save the file in an existing training project.

 1. Menu Browser > New 
 2. USWI > PlanProduction > Title 
 3. wisdot12-SHT10.dwt  

Save the started file to the proper directory

 1. Menu Browser > Save As
 2. Project Folder > SheetsPlan   
 3. Name the title sheet 010101_ti.dwg

Attaching a location sketch

pln-prod-ts-02.mp4 14:40

Attach as an External Reference (XREF) 

Most common file types

 l DWG 
 l DGN
 l PDF

Need to scale DGNs and PDFs

Hide/Display Model/Layout tabs 

 1. Right-click on tabs to hide layout tabs 
 2. Right-click on the model

Attaching a PDF in Modelspace

 1. This method will work for PDF, DGN or DWG XREFs 
 2. Insert tab > Reference panel > Attach   
 3. In XREF Manager click Attach button drop down.- 
 4. Choose Attach PDF. 
 5. Project folder\BaseData\Mapping\Orig\Chippewa.pdf.

 l Clear the Specify on screen option for Insertion Point
 l Clear the Specify on screen option for scale
 l Clear the Specify on screen for Rotation
 l Path Type should be Relative Path
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Scaling the XREF 

Scale command

 1. Home tab > Modify panel > Scale 
 2. Select the XREF
 3. Base Point is 0,0

 l Reference option in the scale command
 l type SCALEEnter  
 l Assign the base point location
 l Type VEnter 
 l Find the bar scale (or some known quantity of distance) on the XREF
 l Snap to the first point, then second point to graphically identify the ref-

erence length
 l Type in the distance that the reference points were supposed to be

 4. Tip: Enter this in feet, so for a mile you would type 5280.

 5. Zoom Extents to see the scaled XREF. Double check distances.

Change the color of the XREF to monochrome

 1. Select on the edge of the XREF.
 2. Context ribbon > Adjust panel > Monochrome .

Title sheet refinement

pln-prod-ts-03.mp4 18:01

 1. Setting the attached sketch in the layout tab viewport.
 2. Adding Begin/End Project Notes and Project indications in the sketch area.

Setting the sketch in the layout viewport

 1. Switch to the layout tab.
 2. Activate the viewport by double clicking inside the viewport.
 3. Unlock the viewport - click the small padlock icon next to the viewport scale list.
 4. Inside the active and unlocked viewport double click to zoom extents.

Creating a scale for the viewport

 1. If the scale of the sketch area does not exist select on the scale list and choose Custom.
 2. Type in the appropriate name of the scale. Example: 1” = 1/2MI
 3. Paper Units should be 1 unit
 4. Drawing Units should be 2140 (for half mile in feet).
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 5. In the scale list select that new scale.
 6. Inside the active viewport pan to the where the location sketch should display.
 7. Lock the viewport. Next to the scale list, click the padlock icon.

Set the titleblock notes per project information titleblock multiline text

Info: The scale information in the titleblock is MTEXT (multiline text). 

 1. Double click on the text to edit it. 
 2. Enter the correct distance. Example 1/2 (the MI is already there).
 3. Double click on the Total Length…text to edit. 
 4. Enter the length of your project.

Titleblock attribute text

 1. Double click on any part of the titleblock block. This opens the Enhanced Attribute Editor 
to access the attributes associated with the titleblock.

 2. Enter the Values for the appropriate fields.

Placing markings on the location sketch 

Placing Begin/End Project multileader text

 1. Annotate tab > Leaders panel > Multileader drop down.
 2. Choose Begin End Project to choose that style.
 3. Change the active layer to the layer that the notes should be on
 4. In the Layer Manager pull-down select P_MISC.
 5. Home tab > Leader panel > Multileader  .
 6. Select first where the arrowhead should be.
 7. Select second where the beginning of the text should be.
 8. Type the proper note, BEGIN PROJECT STA. 99+00. 

 l Click outside the text box to end typing.
 9. Set the End Project location. END PROJECT STA. 102+50.

 l Click outside the text box to end typing.

Placing project location line

Tip: Make sure you are in Paperspace, not working through the viewport in 
Modelspace.

 1. Check the status bar for the Model/Paper toggle reads Paper. If it does not click the 
Model button and it switches to Paper.

 2. Start the polyline command and draw in where the project road location is.
 3. Home tab > Modify panel pull-down > Edit Polyline. 
 4. Choose W for width and set the polyline width to something appropriate for the scale of 

the location sketch. In this example the width was .25.
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Title sheet finishing touches

pln-prod-ts-04.mp4 15:33

Editing the viewport information.

 1. Double click inside the viewport to activate it.
 2. Click the padlock icon next to the scale list to unlock the viewport for scaling and pan-

ning.
 3. Select the scale list and choose a new scale.
 4. Pan as necessary. You may need to select the scale again to ensure this was not 

“bumped” during the panning.
 5. Lock the viewport with the padlock next to the scale list.
 6. Zooming in now will hold the viewport scale but allow you to see the page closer.
 7. Delete the original polyline that marks the project road location.
 8. Redraw the polyline and set the width to something appropriate to the new sketch scale.
 9. Move the Begin/End Project notes to the new locations.

 10. Double click on the Begin and End Project MTEXT to edit the location stations and other 
details.

 11. Edit any titleblock information that may have changed due to the changes in the project. 
Double click on the titleblock to access the Enhanced Attribute Editor.

Placing Town-Range numbers at sketch margins 

Placing the town line marker

 1. Find where the section corners are located in the sketch. 
 2. Start the line command
 3. Home tab of the ribbon - Draw panel - Line command - Create Line icon  OR type L or 

LINE at the command line
 4. You can turn on the ORTHO function by typing <F8> to keep the line straight to the car-

dinal directions.
 5. Draw a line of appropriate length near the location sketch viewport.

Placing the town text

 1.  Annotate tab of the ribbon > Multiline text  (or type MTEXT)
 2. vPlace a text window near the Town-Range line.
 3. vIn the text editor ribbon select the 120 scale text style.
 4. vFrom the text editor ribbon select the Justification tool and choose MC for middle cen-

ter.
 5. vIn the text box type the Town numbers: T-10-W T-9-W.
 6. vClick outside the text box to end the typing
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Move the town text and line to the proper location

 1. Select on the text, select the middle grip point and snap it to the midpoint of the Town 
line.

 2. Copy the text and town line to the next town corner location.
 3. Double click the text to edit the contents for the next town: T-9-W T-8-W.

Copy town text to create range text

 1. Copy the Town text and line near where the Range corner is located.
 2. Rotate the Range text using -90 as the angle.
 3. Use the MOVE command to move the line and range text into its proper location.
 4. Double click the range text and type in the range information: R-29-N R-28-N
 5. Copy the range text to the next range corner.

Copy Town and Range text to other side of location sketch

 1. Copy the range text and lines to the other side of the location sketch.
 2. Use the MOVE command to refine the location of both.
 3. Copy the Town text and lines to the other side of the location sketch.
 4. Use the Move command to refine the text and line location.

Change the name of the layout tab 

 1. Double click on the layout tab text to edit. 
 2. Type the new name of the tab.

Plotting the title sheet as a single page. 

 1. Plotting a single page
 2. You can right-click on the layout tab and choose plot.

 l Or you could go to the Quick Access Toolbar and choose the plot icon.
 3. In the Plot dialog:

 l Make sure the plotter is set to WisDOT PDF.pc3
 l Make sure that the paper size is set correctly
 l Make sure the plot area is set to Layout
 l Make sure the scale is set to 1:1
 l Make sure the Pen Style Table is set to WisDOT gshade (for greyscale) or wisdot 

monochrome (for black/white plotting).Make sure the plot with linetypes and plot 
styles are turned on

 4. Requirement: When you click plot you will choose a location for where the 
PDF file is to be saved. This should be in the project SheetsPlan folder.

 5. Click the preview button to double check how the plot will look.
 6. Check the preview for the edges of the titleblock fitting on the page, text location, color, 

general readability.

Page: 852

Published on: 2/21/2018

Title sheet



 7. You can zoom and pan inside the plot preview.
 8. You can choose the plot icon from the preview or click the X to close the preview and 

return to the plot dialog.

Adding the title sheet to the sheet set manager

pln-prod-ts-05.mp4 5:27

Opening the sheet set manager

 1. Home tab > Palettes panel pull-down > Sheet Set (Or type SSM at the command line).
 2. In the Sheet Set Manager tool palette, at the top click Open drop down.

 l Click Open
 l Browse to ProjectID\SheetsPlan\planproduction.dst

Create a subset in the project 

 1. Right-click on the title of the project. 
 2. Choose Create New Subset
 3. Name the subset name Title Sheet

Adding a layout tab to the sheet set manager.

 1. In the Sheet Set Manager right-click on the title of the project (or the name of the appro-
priate subset) 

 2. Choose Import Layout as Sheet. 
 3. Browse to the file location and select the file.

 4. Tip: Or with the sheet set manager open right-click on the layout tab and 
choose Import Layout as Sheet

 5. Check mark the appropriate layout tabs from the drawing(s) you are adding.
 6. Check that the layout tabs you are adding do not have a status that this drawing is 

already in another sheet set.

Plotting or publishing from sheet set manager

Tip: You can plot individual sheets from the sheet set manager, 

 1. Right click on a subset or the project name and choose Publish > Publish to PDF .
 2. Or publish groupings of pages by right clicking on a subset or the project name and 

choose Publish > Publish to PDF . This will create a multipage PDF file.

Styles, labels, and tables

Last updated: 2010-07-01
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Total video time: 12:30

Styles, labels, and tables

pln-prod-styl-lbl-tbl-01.mp4 12:30

 l Styles

 l Style Labels

 l Annotation Labels

 l Tables

Exercise - Annotate cross sections

Last updated: 2011-07-01

Total video time: 06:32

Exercise files: pln-prod-anno-xs-data-C3D12.zip

Annotate cross sections

pln-prod-anno-xs-01.mp4 3:16

 1. Modify and set Section View Group settings including annotations.
 2. Delete project data and download and unzip this exercise.
 3. Open file 12345678\SheetsPlan\090101_xs.dwg

Set section view group bottom to top

 4. Toolspace > Prospector tab, right-click Section View Group - 1
 5. Click Properties.
 6. Under Group Plot Styleset to "By Page Bottom to Top".
 7. Click Ok.
 8. Click Ok.

Annotate section station labels

pln-prod-anno-xs-02.mp4 3:16

 1. From Prospector, click Section View Group - 1
 2. Click one of the sections in the list below. Press Ctrl+A to select all sections
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 3. Right-click the selected sections and click Select. Press Ctrl+1 to view the Properties win-
dow of all sections.

 4. Change Description to F
 5. Change Style to Sheets 1 IN 20 FT Horiz 20 FT Vert
 6. Press Esc to clear the selection
 7. Description can also be entered in Create Section View workflow.
 8. Home tab > Profile & Section Views ribbon > Section Views button > Create Multiple 

Views.
 9. Create Multiple Section Views dialog > General > Description: F
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Data exchange

Translate DGN to DWG workflow using Civil 3D 2016

Last updated: 2017-12-18

Translate DGN to DWG workflow using Civil 3D 2016

This workflow document will outline the steps involved to translate a MicroStation DGN file to 
AutoCAD 2016 DWG file format. The workflow will be Civil 3D based and the final deliverable 
will be the DWG file.

Warning: The DGN import and export capabilities are designed to provide a fun-
damental exchange of information between MicroStation V8 DGN files and 
AutoCAD DWG files. However, translating data from one format to a completely dif-
ferent format has inherit compromises and substitutions.

Simple elements: Simple geometric objects such as lines, arcs, and circles, and properties such 
as layer assignments correlate directly between the DWG and DGN data formats.

Elements with custom properties: Data with built-in features or variations are visually approx-
imated. For example, text and dimensions might have specialized formatting, and color defin-
itions might be customized.

Product-specific features: Some data cannot be translated completely. For example, product-
specific features such as data fields or dynamic blocks can be represented visually but not beha-
viorally.

No symbol color: AutoCAD only supports colors for lines so all entities in the DGN file that have 
a color property set for a symbol in MicroStation lose the symbol color when imported as a 
block.

Multilines do not retain linetypes: When importing DGN files that contain multilines, any line-
types associated with the multilines do not display.

Closed property of polyline not retained: The closed property of a DGN polygon or closed 
polyline is automatically set to No when imporproting a DGN file into AutoCAD. This is done to 
ensure that linetypes display properly.

Import to AutoCAD

 1. In AutoCAD Civil 3D create a New drawing.
 2. From the Application Menu Button select Open > DGN. The Import DGN File dialog will 

appear. 
Command: DGNIMPORT
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 3. Select the file you want to convert and then select Open. The DGN Import Settings dialog 
will appear.

 4. Check ON Import into current drawing and select Ignore duplicate names radio button.
 5. In the External DGN references section of the dialog select the radio button Translate ref-

erences to blocks or xrefs.
 6. In the Specify DGN units to convert to DWG units select the Master units radio button.

Info: 
In the Import DGN Settings dialog box, if you select “Import into Current Drawing” and 
select the “Translate References to Blocks or Xrefs” option in the External DGN ref-
erences section, all referenced DGN files are converted to block references. If you do 
not select “Import into Current Drawing” and select the “Translate References to Blocks 
or Xrefs” option, then all referenced DGN files are converted to DWG external ref-
erences.

If you are importing a V7 DGN file that MicroStation V7 DGN file does not have ByLayer 
setting for color. The user may want to use the Standard DGN mapping rather than the 
WisDOT one to preserve colors.

 7. Click the WisDOT DGN-DWG IMPORT as the setup.
 8. Click the OK button. The Import DGN dialog will close and the file will be imported.
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 9. Zoom extents the drawing and Select All the elements.
 10.  Properties dialog

 l Color = ByLayer
 l Linetype = ByLayer
 l Lineweight = ByLayer

Verify the imported drawing

 1. In AutoCAD Civil 3D go to the Ribbon and the View tab > Coordinates panel select World 
icon.

Info: 
World aligns the UCS with the world coordinate system (WCS). You can also click the 
UCS icon and choose World from the origin grip menu.From the pull down menu View > 
3D Views > Plan View > World UCS
Command: PLAN [W]Enter

Plan view set to World displays an orthographic view of the XY plane of a specified user 
coordinate system.

 2. Locate a known coordinate location in the file and verify the coordinates out to 3 
decimal points.

 3. Save drawing and then Exit AutoCAD Civil 3D.

Translate DWG to DGN workflow using Civil 3D 2016

Last updated: 2017-12-18
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Export to AutoCAD

This workflow document will outline the steps involved to translate an AutoCAD Civil 3D 2016 
file formation to MicroStation V8 DGN file format. The workflow will be Civil 3D based and the 
final deliverable will be the V8 DGN file. 

 1. In AutoCAD Civil 3D open DWG drawing file you want to convert to MicroStation DGN.
 2. At the command line EXPORTTOAUTOCAD. The Export drawing name dialog will 

appear with the file name you are exporting with an ACAD- prefix.

 3. Click the Save button. The file will be exported to the folder.
 4. The export may take some time to complete depending on the complexity of the drawing 

and the number of Civil 3D objects. If you get a warning message OK to keep the process 
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moving.

Info: Exporting a Civil 3D file to AutoCAD will create a new DWG file with all AEC 
objects exploded. The default Export Options should work for most files. If any 
options need to be changed use the command entry: -EXPORTTOAUTOCAD or 
AECTOACAD. 

Export to MicroStation DGN

 1. In AutoCAD Civil 3D open the previously exported ACAD-file. Use the AUDIT command to 
fix any errors. Some of the colors of the elements may have changed now that the Styles 
are not being used.

 2. Export > Export Civil 3D Drawing
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 3. Export to file type > MicroStation DGN
 4. External DWG references > Bind and Insert
 5. Files to Export > Current drawing only
 6. > Include sheets if you wish to export the layout sheets
 7. Destination Folder > Navigate to the folder you want it saved in
 8. OPTIONAL: enter a prefix or suffix to add to the filename when exported
 9. Files to Export > check or uncheck the layouts as needed
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 10. Export Settings

 11. Export file type > MicroStation DGN
 12. Seed file > C:\WisDOT\Stnd\C3d2016\StartupTemplates\wisdot-seed3d.dgn
 13. OK
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 14. Export 
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 15. The Export Status dialog box will appear. Wait for the DGN(s) to be created.

 16. OK.

Warning: The Export to MicroStation DGN process doesn't always work. It is 
common for it to fail or crash Civil 3D without explanation. If this happens con-
tact support.cae@dot.wi.gov for help.

Verify DGN results
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 1. Open the exported DGN file in MicroStation.
 2. Locate a known coordinate location in the file and verify the coordinates out to 3 

decimal points.
 3. MicroStation pull down menu > Settings > Design File. The Design File Settings dialog 

will appear.
 4. Working Units = US Survey Feet

DGN cleanup

Color

 1. MicroStation pull down menu > Settings > Color Table
 2.  Color Table dialog > File > Default The WisDOT default color table will be loaded.

ByLevel symbology

 3. Select All elements in the drawing. 
 4.  Change Attributes  icon

 A. Color = Checked on
 B. Style = Checked on
 C. Weight = Checked on
 D. All others = Not checked
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 E. Then accept the change in the MicroStation view.

 5. Clear the selection set.

Text

 6. In the MicroStation file all the AutoCAD text has been converted to TrueType fonts. This 
causes display issues with some of the characters as shown below.

 7. Select All elements in the drawing. Select the Change Text Attributes icon. From the 
Tool settings dialog check on Font and set it to “5 dot_font5” then accept the change in 
the MicroStation view.
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 8. Clear the selection set.
 9. Save Settings and Exit MicroStation.

Importing PDF and XLS files

Last updated: 2012-01-10

Total video time: 2:05

Importing PDF and XLS files

data-xchng-imprt-pdf-xls-01.mp4 2:05

Insert (PDF) and Paste (XLS)
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Non-Survey base data

Working with spatially referenced DWG, image, and GIS files

Last updated: 2012-01-10

Assign coordinate system to active DWG and any DWG files to be attached

 1. Application Menu > Drawing Utilities > Drawing Settings.
 l Drawing Settings dialog box > Units and Zone tab.

 l In the zone area at the bottom of the tab, change the category to "USA, Wis-
consin".

 l Change the available coordinate system to the one desired. Make sure that 
the units are set correctly.

 l OK

If other DWG files are to be georeferenced, repeat this process for all DWG used to be used.

Open the Map Task Pane

The rest of the commands required to attach files correctly georeferenced are part of Civil 3D’s 
Map functionality. These commands can be found in the "Planning and Analysis" workspace, but 
that workspace does not contain the Tool space. Therefore, open the Map task pane to add 
required functionality to the "Civil 3D" workspace.

At the command prompt, MAPWSPACE Enter. Press Enterat the next prompt to set the task 
pane on. The Task Pane should be visible.

The rest of the commands can all be found in the same area, but have slightly different options 
depending on what type of file is being attached.

Attach DWG

 1. Map Task Pane > Display Manager tab > Data button > Add Drawing Data > Attach 
Source Drawings

 l This will open the Define/Modify Drawing Set dialog box.
 l Click Attach... This will open the Select Drawings to Attach dialog box.
 l The first time this dialog is used, an alias will need to be set for any drives other 

than the C drive.

Set N drive as an alias

 1. Select Drawings to Attach dialog box > Create/Edit Aliases  
 l It can be found two buttons to the right of the drive letter dropdown. This will 

open the Drive Alias Administration dialog box.
 l For Drive Alias Details Drive Alias: N
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 l Actual Path: \\wis31fp1\n3public (This is an example in drive for the Wisconsin 
Rapids office. A user's individual in drive can be found by looking at the path after 
the N drive in My Computer in Windows Explorer.)

 2. Click Add. The alias letter and path should appear in the Drive List window. Click Close.
 3. Select the alias letter where the DWGs are in the Look in: window.
 4. Navigate to the folder with the DWGs. Highlight the files to attach. Click Add.
 5. When all of the DWGs have been selected, click OK. This will return the user to the 

Defined/Modify Drawing Set dialog box.
 6. Click on the drawings to be attached, or click Select All. Click OK.
 7. The files may not display immediately. If this occurs, in the Task Pane, click the Map 

Explorer tab. The attached files should show up under Drawings. Right-click on the file 
name and click "Quick View" to view the file.

How to use a data connection

All types of data connections work in a similar manner. The following instructions will use a 
shape file for an example. Data connections to local files can either be at the folder level or at 
the file level. A folder full of shape files can be managed through one data connection.

 1. Click Add SHP Connection.
 l Connection name: Set this to something meaningful. "Dane County Tax Parcels” 

for instance.
 l Source file or folder: Click either the Open File or Browse Folder buttons to nav-

igate to the correct location. This field will then fill in with the correct inform-
ation.

 l When the source is populated, the Connect button will be enabled. Click Connect . 
This will open the AddDatatoMap dialog.

The available files will display in a window. If Civil 3D can read the files projection information, 
it will show up here under Coordinate System. If a coordinate system is not found,<unknown > 
will be displayed.

 2. To set the coordinate systems for files, click on the file to set under Schema, then click 
the Edit Coordinate Systems button. This will open the Edit Spatial Contexts dialog box.

 l Click on the files to set the coordinate system for and click Edit.... This will open 
the Coordinate System Library dialog box.

 l In the Category: window, select the appropriate category of coordinate sys-
tems. For example, USA, Wisconsin.

 l In the Unit: window, select the appropriate unit. For example, US Survey 
Foot.

 l In the main window, click the coordinate system to be assigned to the ref-
erenced file.

 l Click Select. This will bring back the Edit Spatial Contexts dialogbox.
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 l Click OK. This will bring back the AddDatatoMap dialog. The correct coordinates 
system should show up in the main window.

 l Click Add to Map. The contents of the file should show up in model space and also 
show up in the Task Pane. Raster images will also show up in the AutoCAD ref-
erence dialog.

Working with GIS data

This section will not attempt to go into all of the different options available to work with GIS 
data in Civil 3D.

 l In Task Pane > Display Manager, right-click on any data layer to see all of the possible 
options associated with it.  From this right-click menu, data display, selection, labeling, 
data table viewing, and other options can be accessed.
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Reports

Civil 3D stock reports

Last updated: 2012-08-24

Total video time: 62:33

rpt-sum-stock.xls

Exercise files: rpt-c3d-stok-data-C3D10.zip

Civil 3D reports introduction

rpt-c3d-stok-01.mp4 11:55

 l WisDOT C3D Reports worksheet explained 0:00
 l StockReportSummary worksheet explained 1:46
 l Alignment_Curve Report Explained 2:32
 l Setup Project data for Reporting 4:00
 l Pick the Correct drawing file 6:44
 l Run the Report from Toolbox 7:55
 l Export to XML Report dialog 8:15
 l HTML Report Review 9:00
 l Save the CivilReport.HTML file 9:48
 l Summary, things to remember 11:34

Stock alignment reports

rpt-c3d-stok-02.mp4 14:30

Alignment Design Criteria verfication Report 0:20

 l Open Drawing File 0:39
 l Prespector Toolbox - Run Report 1:32
 l Fill Dialog 1:50 
 l Save File 2:38 
 l Review Report 3:30    

General Legal Description for Alignment 4:16  

 l Skip this     Incremental Stationing Report 4:30  
 l Select Alignment 
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 l Start/End Sta 5:10
 l Save to 5:20
 l Review Report 5:40    

PI Station Report 6:12  

 l Select Alignment 6:30  
 l Start End 6:54
 l Save to 7:05 
 l Review Report 7:20    

Stakeout Alignment 7:34  

 l Points 7:40  
 l Store the Points 7:56  
 l Insert Points Manually 8:30 
 l Review Points Collection 8:56
 l Run Report 9:04
 l Select Alignment 9:20
 l Select Points 9:40
 l Stationing start/end 10:00  
 l Save to 10:30
 l Review Report 10:48  

Alignment Station and Curve 11:25

 l Alignment Station and Curve Report requirements 11:35
 l Run Report 12:00
 l Select Alignment 12:10
 l Review Report 12:50     Compare running without all check boxes on 14:00   

Stock corridor reports

rpt-c3d-stok-03.mp4 10:46

Corridor Reports Summary 0:20 

Feature Line Report 0:40   

 l Switch Project 1:00  
 l Run Report 1:20  
 l Select Alignment 1:45  
 l Corridor Points 2:18  
 l Report Name and Location 2:50  
 l Create Report 3:38  
 l Review Report 3:50     
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Feature Line Report - Corridor Links  

 l Corridor Links 4:24
 l Link Code 4:42
 l Report Name and Location 5:00 
 l Review Report 5:06 

Feature Line Report - Surface Report 5:25

 l Sample Line Group 5:36  
 l Select Surface 5:46  
 l Report Name and Location 6:18
 l Review Report 5:06    

Slopestake Report 6:36

 l Requirements 7:05 
 l Create some Sample Lines 7:14 
 l Sampling Surfaces 7:45
 l Station Range 8:12
 l Run Slopestake Report 9:00  
 l Report Name and Location 9:45  
 l Create Report 10:06  image  
 l Review Report 10:28

Summary 10:36  

Stock parcel reports

rpt-c3d-stok-04.mp4 9:20

Parcel Report Summary 0:10

 l Parcel Area Report 0:40
 l Generic Legal Description 1:06
 l Inverse Report 1:28
 l Report Review 2:20
 l Save as 3:04
 l Metes and Bounds 3:38
 l Report Review 3:56
 l Save as 4:08
 l Pacel Area in CSV 4:12
 l Report Review 4:44
 l Save As 4:56
 l Parcel Map Check 5:20
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 l Description 5:32
 l POB 6:00

 l Save As 6:32
 l Report Review 7:00
 l Parcel Volume Report 7:34
 l Surveyors Certificate 7:56
 l Run Report 8:04
 l Report Review 8:32
 l Save As 9:04

Stock point reports

rpt-c3d-stok-05.mp4 7:21

Point Report Summary worksheet 0:10 

 l Points in CSV 0:35 
 l Switch to Corridor-STH25-4thAve. DWG file 0:40  
 l Report Review 1:54 
 l Save as 3:10      
 l Points List 3:21 
 l Report Review 3:38 
 l Save as 3:54      
 l Radial Stakeout 4:00 
 l Allow Blocked content 4:36  
 l Report Review 5:30  
 l Save as 5:45      
 l Station Offset Report 6:12 
 l Report Review 6:54
 l Save as 7:18  

Stock profile reports

rpt-c3d-stok-06.mp4 4:52

 l Profile Report Summary worksheet 0:10 
 l Incremental Station Elevation Difference 0:25
 l Report Review 0:48     
 l Incremental Stationing Report 1:12 
 l DWG File Data Referencing a Profile 1:28 
 l Report Review 2:20      
 l Profile Design Criteria Check does not work  
 l Profiles in CSV 2:40
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 l Report Review 3:20  
 l Save as 4:00    
 l PVI Station 4:08 
 l Report Review      

 l PVI Station and Curve 
 l Report does not work      

 l Vertical Curve Report
 l Report does not work

Stock surface reports

rpt-c3d-stok-07.mp4 3:49

 l Surface Report Summary worksheet 0:20
 l Select Earthwork-STH25BestFit.DWG for surface reporting 1:45
 l Surface Points to CSV 2:21
 l Report Review 2:48
 l Surface Report 3:12
 l Report Review 3:43

WisDOT custom reports

Last updated: 2012-08-24

Total video time: 49:48

rpt-sum-wisdot.xls

WisDOT alignment and point reports

rpt-wisdot-01.mp4 21:56

Right-click rpt-sum-wisdot.xls review 0:20

 1. Alignments - SuperElevation Transition Report
 l Select DWG (Earthwork-STH25-BestFit.DWG) 1:10
 l Running Reports if Toolbox does not work 2:00
 l Command: Netload 2:20
 l Select Reports.DLL 2:40
 l Command: SETransitions 3:20
 l Report Super Transitions at even stations
 l Save as 4:05
 l Report Review 5:00
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 2. Run SETransitions Again 5:35
 l Report Slope Change
 l Save as 5:50
 l Review Report 6:25

 3. Parcel -Legal Descriptions Report
 4. Switch to Corridor-STH25-4thAve.DWG 7:00
 5. Run LegalDescriptions command 7:20

 l Custom Header 7:50
 l Save AS 8:30
 l Review Review 8:50

 6. Points Reports Summary rpt-sum-wisdot.xls 9:00
 7. Points - Describe Points Report 11:16
 8. Run DescribePoints command 11:36

 l Create Points 11:50
 9. Run DescribePoints command 13:05

 l Individual Points selection
 10. Review Report 13:45
 11. Run DescribePoints command 14:10 (use spacebar to repeat last)

 l Offset Alignment selection
 l Save as 14:40

 12. Rerun Report because Offset limits were too limited 15:00
 13. Rerun Report because Offset limits were too limited 15:20
 14. Review Report 15:40 
 15. Points - Stakeout - From Remote Point

 l Run Stakeout command 16:00
 l From Remote Point 16:20
 l Review Report 17:00 

 16. Points - Stakeout - Even Stations
 l Run Stakeout command 17:18
 l Review Report 17:30

 17. Points - Stakeout - Offset Alignment
 l Run Stakeout command 17:46
 l Review Report 18:06

 18. Points - SOE
 l Run SOE command 18:40
 l Do Not Select Boundary Limits 19:25
 l Review Report 19:54

 19. Points - Course Table
 l Run CourseTable command 20:40
 l Review Report 21:20

WisDOT profile and corridor reports
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rpt-wisdot-02.mp4 11:51

ReportSummaryWisDOT.xls review 0:20

 1. Reported from Corridor-STH25-4thAve.dwg
 2. Profile - Profile Grades
 3. Run ProfileGrades command 1:21
 4. Station Limits 1:50
 5. Offsets 2:20
 6. Save as 3:40
 7. Open Report from Windows Explorer 5:00
 8. Review Report 5:20 
 9. Change File to Earthwork-STH25BestFit.DWG

Corridor - Topsoil Computations

 1. Summary 6:40
 2. Explain Differences betwwen Sample Line Group and Station Spacing 7:16 
 3. Run Topsoil command 7:40
 4. Please PARDON HILL FARMS announcements! Select Boundary Limits 8:30
 5. Real Offset inputs 9:30
 6. Save as 9:40
 7. Review Report 10:10 

WisDOT feature line reports and Import Station Offset Depth

rpt-wisdot-03.mp4 16:01

 1. Reported from Earthwork-STH25BestFit.DWG
 2. Feature Line Report - Offset from Alignment Summary 0:20

 l Open Surface-STH25-Refinement.DWG 2:30
 l Netload Reports.dll
 l 3:17
 l Featureline command 3:30
 l No Alignments Data Reference 4thAve 4:00
 l Run FeatureLine command 4:10
 l Report Offset from Alignment - 4:40
 l Report 4:45

 3. Feature Line Report - Feature Line Run FeatureLine command 5:05
 l Report feature line 5:14
 l Review Report 5:30 
 l Summary 6:00
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 4. Import Station Offset Depth file 6:30
 l Create a New DWG file 7:00
 l Save As Exist-Sub.DWG 7:20
 l Create Reference to 4th Ave alignment 7:40
 l Create SOD file (4thAveSub.txt) 9:30
 l Save File as 4thAveSub.SOD Netload Importsoe.dll 11:20
 l Run ImportSOE Command 11:30
 l Create Reference to EXIST surface 11:58
 l Rerun ImportSOE command 12:30
 l Import 13:30
 l Create Marsh Surface 13:56
 l Add Point Group 14:12
 l Add Point Group to Surface 14:56
 l Change Marsh Surface style 15:10
 l Review Surface 15:30  

Superelevation reports

Last updated: 2013-01-13

Total video time: 10:28

Exercise data: rpt-super-data-C3D12.zip

Export superelevation transition data to Excel

rpt-super-01.mp4 5:51

This segment will demonstrate how to create a Data Shortcut reference of the baseline align-
ment and then create a superelevation transition data report by using the export to CSV tool in 
the Superelevation tabular Editor.

 1. Create drawing from template
 l Create a new drawing using the wisdot12.dwt template.
 l Save the drawing in the project’s Construction folder.
 l Create the Alignment Data Shortcut Reference
 l Navigate in the Toolspace, on the Prospector tab and expanding the Data Short-

cuts collection. Select the alignment under the Alignment/Centerline Alignments 
collection, then right-click and select Create Reference.

 l The default alignment style and Alignment label set will work fine for visual ref-
erence.

 2. Click OK
 3. Save the drawing.
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Export Superelevation Transition Data in the Superelevation Tabular Editor to an Excel file

 4. Select the alignment from the drawing
 5. Select Superelevation in the contextual ribbon
 6. Select “View Tabular Editor” button

The Superelevation Tabular panorama displays all the superelevation transition data for each 
curve.

 7. In the panorama click  Export superelevation data and save the data as a CSV file in the 
Construction subfolder of the project.

Review the CSV file data and format in Excel.

WisDOT toolbox, superelevation transition macro

rpt-super-02.mp4 4:37

This segment will demonstrate how to use the WisDOT Superelevation Transition Macro to cre-
ate an Excel file using the Even Station Increment report setting and then the Slope Change 
report setting.

 1. Create drawing from template
 l Create a new drawing using the wisdot12.dwt template.
 l Save the drawing in the project’s Construction folder.

 2. Create the Alignment Data Shortcut Reference
 l Navigate in the Toolspace, on the Prospector tab and expanding the Data Short-

cuts collection. Select the alignment under the Alignment/Centerline Alignments 
collection, then right-click and select Create Reference.

 l The default alignment style and Alignment label set will work fine for visual ref-
erence.

 l Click OK
 l Save the drawing.

 3. Create an Excel file using the Even Station Increment Report Setting
 l Toolspace -> Toolbox tab -> WisDOT Toolbox -> Reports-> Alignment Reports-> 

right-click  SuperElevation Transition -> Execute.
 l Select the alignment(s) in the tabular area, or use the ‘Select” button to pick from 

the drawing. There are two report options. One is to report by even station incre-
ments and the other is to report by increments of cross slope change.

 l To create an even station increment report, select the “Use Even Stationing” 
under Report Settings, and supply the desired Station Increment.

 l To create a cross slope change report, select the “Use Slope Change” under 
Report Settings, and supply the desired Slope Change frequency.
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 l Choose which Lane and Shoulder section locations you wish to include in the 
report.

 l Supply a name for the Output file and save it in the project construction subfolder.
 l There is an option to “Auto open report upon completion”.
 l Click Create Report.

Review the CSV file data and format in Excel.

Inquries used in construction

Last updated: 2013-01-13

Total video time: 24:40

Cutting quick cross sections

rpt-cnst-inqry-01.mp4 15:39

This segment will demonstrate how to use the Quick Cross Section tool, and the Quick Profile 
command to create quick cross sections. These tools can cut cross sections across multiple sur-
faces, so at least one tin surface must exist in the drawing.

The Quick Cross Section tool creates a temporary cross sections view for instant viewing, with 
no select, or data extraction capabilities the view will disappear once any key is pressed.

Info: The Transportation Extension must be installed. This is an add-on available 
from the Autodesk Subscription site.

 1. Open or create the drawing that has the project alignment and surface you wish to query 
the data from, along with any location reference objects.

 2. Toolspace > Toolbox > Transportation Extension > Utilities > Surfaces > Quick Cross 
Sections > Enter

 l Select the surface (multiple surfaces may be selected) and press the space bar
 l This tool has two cross section options;
 l 3p, which creates a single cross section by selecting 2 points as the cutting plan, 

and the last point to define the direction the cross section is viewed from.
 l Multiple, option allows the user to create a path for multiple sections by selecting 

points, then prompts for frequency, and left and right widths, to create multiple 
section along the defined path.

Info: The section(s) may be viewed using zoom and pan only.

Notice once the mouse is clicked or a key pressed, the cross section view no longer exists.

Page: 882

Published on: 2/21/2018

Reports

http://www.c3dkb.dot.wi.gov/video/mcro-rpt/rpt/rpt-cnst-inqry-01.mp4


 3. The Quick Profile command, under Home, Create Design, Profile, can use the following 
objects as the cutting plane to build a cross section; 2D or 3D lines or polylines, Lot lines, 
feature lines, Survey figures, and a series of points. This command creates a temporary 
Profile View and samples selected surfaces.

 l Select an object listed above as the cutting plane, or select a series of points in the 
model space.

 l Select the surfaces to sample, along with a visual style in the dialog.
 l Select the Profile view Style.
 l OK and pick a point in the drawing area to place the Quick Profile.

Info: The Quick Profile view and surface profiles created do not disappear once the 
mouse is clicked or a key pressed. The Quick profile remains as an object until the 
save drawing command is used.

The elevation data can be extracted from the Quick Profile using the same tools as a profile. 
Use the ‘Profile Station and Elevation at Point” option in the Inquiry Tool under Profile.

When using an object as the cutting plane, the relationship between the object and the quick 
profile is dynamic. This means the object can be moved, stretched, vertices added or subtracted 
and the quick profile updates the profiles and view automatically and instantaneously.

Extracting grades from the roadway model

rpt-cnst-inqry-02.mp4 2:44

 1. Open or create the drawing that has the project surfaces you wish to query the data 
from.

 2. Navigate to and select the Inquiry Tool found on the Analyze ribbon tab and expand the 
Surface list.

 l Select “Surface Elevation and Grade at Point”
 l Select the surface in the pull down list next to Surface Name
 l Select point by coordinate

 3. Click the Object Select icon next to Point Coordinate to pick the location in the drawing 
area, or type the coordinates into the textbox.

Notice a temporary slope area symbol shows the direction of the grade at the picked location.

 4. Use the Copy to Clipboard to extract the current data within the Inquiry Tool dialog, to a 
file.

Each data box can also be extracted independently. Hover over a data box with the cursor then 
use the mouse-right-click, Copy to Clipboard option.

Extracting elevations from cross-sections
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rpt-cnst-inqry-03.mp4 4:04

This segment will demonstrate how to use the Inquiry Tool to extract Elevation data from Sec-
tions and Section Views.

 1. Open the drawing that has the project sections you wish to query the data from.
 2. To extract elevation information in a section view that is not on a surface use the “Sec-

tion View Offset and Elevation at Point” option by selecting a section view in the drawing 
area, then select Inquiry on the contextual ribbon.

 l Select the “Section View Offset and Elevation at Point” as the inquiry type.
 l When prompt to select section view, chose the section from the list or use the 

Object Select icon to pick the section view from the drawing area.
 l Info: Pick the grid or the labels of the section view and not the sec-

tions.

 l Select point by coordinate
 3. Press the Object Select icon next to Point Coordinate to pick the location in the section 

view, or type the coordinates into the textbox.
 4. Use the Copy to Clipboard to extract the current data within the Inquiry Tool dialog, to a 

file. Each data box can also be extracted independently. Hover over a data box with the 
cursor then use the mouse-right-click, Copy to Clipboard option.

 5. To extract elevation from a point on a surface section use the “Section Offset and Elev-
ation at Point” option by selecting a surface section in a section view, then select Inquiry 
on the contextual ribbon.

 l Select the “Section Offset and Elevation at Point” as the inquiry type.
 l When prompt to select the section, chose the section from the list or use the 

Object Select icon to select the section from one of the section views.

Info: Pick the surface section, not the section view.

 6. Select the offset point in a section view by using the Object Select icon next to Offset and 
selecting the offset location in a section view. Once a location in the section view has 
been picked, typing the offsets into the textbox will produce elevation data along the 
selected surface section in that section view.

Info: Select inside a different section view to inquiry elevation information about 
the same surface section in a different section view.

A different surface section can be selected at any time, or picked from the list.

 7. Use the Copy to Clipboard to extract the current data within the Inquiry Tool dialog, to a 
file. Each data box can also be extracted independently. Hover over a data box with the 
cursor then use the mouse-right-click, Copy to Clipboard option.
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Extracting coordinates, stations and offsets of any location

rpt-cnst-inqry-04.mp4 2:13

 1. Open or create the drawing that has the project alignment and surface you wish to query 
the data from. Navigate to and select the Inquiry Tool found on the Analyze ribbon tab 
and expand the Alignment list.

 l Select “Offset and Surface Elevation at Point”
 l Select the alignment in the pull down list next to Alignment Name
 l Select the surface in the pull down list next to Surface Name
 l There are two option for initially picking the location
 l Select point by coordinate

 2. Press the Object Select icon next to Point Coordinate to select the location in the drawing 
area, or type the coordinates into the textbox

 l Select point by station
 3. Press the Object Select icon next to Station and select the station location in the drawing 

area, or type in the station in the textbox. Then select the offset location in the drawing 
area, or type the offset in the textbox.

Notice the pick for the station point, and the pick for the offset point are independent of each 
other.

 4. Use the Copy to Clipboard to extract the current data within the Inquiry Tool dialog, to a 
file. Each data box can also be extracted independently. Hover over a data box with the 
cursor then use the mouse-right-click, Copy to Clipboard option.
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Macros

DWG version tool

Last updated: 2016-03-14

DWG Version Tool operation

Description

The DWG Version application allows the user to quickly view the AutoCAD version of each dwg 
file in a project.

General operation

This is a stand-alone application run outside of Civil 3D.  The basic operation is as follows:

 l Create a desktop shortcut to the DWG Version application on your Windows desktop.

 l Open Windows Explorer and navigate to the folder containing your Civil 3D projects.
 l Click and drag the project folder from Windows Explorer then drop it on top of the DWG 

Version shortcut icon.
 l The dwg files in the project folder as well as every sub folder will be processed and dis-

played in the dialog listing.
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File

Open

The Open menu option allows the user to select one or more dwg files to process using the 
standard Windows Open dialog.

Open folder

The Open Folder menu option allows the user to select a folder for processing. All dwg in the 
selected folder and subfolders will be processed.

Save As

The Save As menu option generates a text file containing the information shown in the list.

Clear list when adding more files

 l Checked ON – The list of displayed files is cleared when a new file or folder is opened.
 l Checked OFF – Newly opened files or folders are appended to the end of the list.

Block index tool

Last updated: 2016-03-14

Block Index Tool operation

Description

The Block Index tool imports a DWG block file and creates layout grids containing rep-
resentations of each block in a file.

General operation

Access the macro at Toolspace -> Toolbox -> WisDOT Toolbox -> WisDOT Macros -> Other -> 
Block Index Tool
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When launching the tool the user should be in a blank drawing, or a drawing that contains pre-
vious layouts created by the Block Index for updating.

The Block Index tool cannot be run on a drawing that is currently open. Please close the target 
block file to run the tool.
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Sheet setup

All existing sheet layouts in the drawing will be removed. New sheet layouts containing block 
index grids will be created. 

Rows

Enter the number of rows for the block index grid.

Columns

Enter the number of columns for the block index grid. 

Page size

Select the desired page size for the layout.

Show insertion point

When the checkbox is toggled on, an “X” will be placed for each block to identify 
the insertion point.

Show all visibility states

When the checkbox is toggled on, every visibility state for each dynamic block will 
be created in the block index. When the checkbox is toggled off only the default 
state for each dynamic block will be created in the block index.

Block drawing name

Select the name of a drawing file containing blocks to be indexed.

Create

Clicking the Create button will start the process. All existing layouts in the drawing 
will be removed. New layouts will be generated creating pages for the index. Lay-
outs will be named using the name of the selected block drawing file followed by a 
four-digit page number. (When completed if a displayed layout does not appear to 
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be oriented properly, select a different layout tab or the model space tab, then 
select the previous layout tab to regenerate the display.)

Text display

The Block Index page text is generated using the text style that is set current in the 
drawing. To control the size and display of the text, set a desired text style current 
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before running the Block Index tool.
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P. S. & E.
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Contractor data

Contractor data basics

Last updated: 2017-01-09

Total video time: 02:42

cntrctr-data-basc-01.mp4 2:42

Construction data file basics

Contractor data files are files exported from design files. They do not have a live connection to 
the files they were created from. They need only be generated for P.S.& E. delivery. Reference 
FDM 19-10-43.10 for delivery requirements and FDM 15-5-3 Att 3.3 for file naming con-
ventions.

ConstData folder structure

Requirement: The ConstData folder structure is outlined in FDM 15-5 Attachment 
3.1

Export ACAD DWG files

Last updated: 2017-06-06

Total video time: 04:10

Exercise files: cntrctr-data-C3D14.zip

cntrctr-data-xprt-dwg-01.mp4 4:10

Export reference alignment drawing files

 1. Open  12345678\Design\AliProfs\AliProfSTH25-Best-Fit.dwg
 2. Menu Browser > Export – DWG > 2013
 3. In the Export Drawing Name dialog browse to the project 12345678\ConstData\CD-

Design\CD-Align and type in the filename 12345678-AliProf-RL.dwg

Export roadway design model surface drawing files

 1. Open 12345678\Design\Surfaces\Surface-STH25-Refinement-Top.dwg
 2. Menu Browser > Export – DWG > 2013
 3. In the Export Drawing Name dialog browse to the project 12345678\ConstData\CD-

Desgn\CD-Surfaces and type in the filename 12345678-Top-Surf.dwg.
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Export right-of-way drawing files

 1. Open 12345678\RW\rwex.dwg
 2. Menu Browser > Export – DWG > 2013
 3. In the Export Drawing Name dialog browse to the project 12345678\ConstData\CD-RW 

and type in the filename 12345678-RW-Ex.dwg
 4. Open 12345678\RW\rwpr.dwg
 5. Menu Browser > Export – DWG > 2013
 6. In the Export Drawing Name dialog browse to the project 12345678\ConstData\CD-RW 

and type in the filename 12345678-RW-Pr.dwg

Export LandXML files

Last updated: 2017-06-06

Total video time: 04:43

Warning: A known issue has been identified related to Wisconsin county coordin-
ate projections. Please make sure to use to only use projections beginning with 
"WisDOT NAD83/". Please review Wisconsin coordinate projection problem - 
SDB/DWG for more information.

Exercise files: cntrctr-data-C3D14.zip

cntrctr-data-xprt-xml-01.mp4 4:43

Export reference alignment and profile LandXML files

 1. Open drawing file 12345678\Design\AliProfs\AliProfSTH25-Best-Fit.dwg
 2. Output tab > Export panel > Export to LandXML
 3. In the Export to LandXML dialog click the Uncheck All option at the top of the dialog.

 A. Check mark the Alignments area. This will select all of the alignments and any 
related profiles.

 B. OK

 4. In the Export LandXML dialog browse to the folder 12345678\ConstData\CD-Design\CD-
Align and type in the filename 12345678-AliProfs-RL.xml

 5.  Save

Export roadway design model surface LandXML files
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 1. Open drawing file 12345678\Design\Surfaces\Surface-STH25-Refinment-Top.dwg
 2. Output tab > Export panel > Export to LandXML.

 A. In the Export to LandXML dialog click the Uncheck All option at the top of the dia-
log.

 B. Check mark the Surfaces area. This will select all of the surfaces in this file.
 C. OK

 3. In the Export LandXML dialog browse to the folder 12345678\ConstData\CD-Design\CD-
Surfaces and type in the filename 12345678-Surf-Top.xml

 4.  Save

Export right-of-way LandXML files

 1. Open drawing file 12345678\RW\rwex.dwg
 2. Home tab > Export panel> Export to LandXML.

 A. In the Export to LandXML dialog click the Check All option at the top of the dialog.
 B. Make sure all of the checkmarks are on.
 C. OK

 3. If there is nothing in the file to export, close the file and continue to the next LandXML 
export. If there is data then do the following:

 A. In the Export LandXML dialog browse to the project 12345678\ConstData\CD-RW 
and type in the filename 12345678-Ali-Pts-RW-Ex.xml

 B. Save
 4. Open drawing file 12345678\RW\rwpr.dwg
 5. Home tab > Export panel> Export to LandXML.

 A. In the Export to LandXML dialog click the Check All option at the top of the dialog.
 B. Make sure all of the checkmarks are on. 
 C. OK
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 6. In the Export LandXML dialog browse to the project 12345678\ConstData\CD-RW and 
type in the filename 12345678-Ali-Pts-RW-Pr.xml

 7. Save

Extract surface model

Last updated: 2017-01-11

Extract surface model

Refer to the training topic Extract Design Surface Data Utility overview for detailed instructions

Copy metadata for contractor data into ConstData folder

Last updated: 2017-06-06

Total video time: 01:03

Exercise files: cntrctr-data-C3D14.zip

cntrctr-data-cpy-metadata-to-constdata-fldr-01.mp4 1:03

Copy the metadata folder

 1. Right-click the Windows Start button (lower left of screen) > Open Windows 
Explorer

 2. Browse to the project and open the 12345678 folder.
 3. Open the project 12345678\Metadata folder.
 4. Right-click on the WisDOT-C3D-Meta.docx file >  Copy
 5. Open the project 12345678\ConstData folder.
 6. Right-click in the open folder > Paste

Export alignment description csv files

Last updated: 2017-06-06

Total video time: 02:44

Exercise files: cntrctr-data-C3D14.zip

cntrctr-data-xprt-ali-desc-csv-01.mp4 2:44

Export alignment description csv files

 1. Reference FDM 19-10-43 Att. 43.3
 2. Open drawing file 12345678\Design\AliProfs\ AliProfSTH25-Best-Fit.dwg
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 3. Toolspace > Toolbox tab > WisDOT Reports > Alignment Reports > right-click on 
Describe Alignment > Execute

 A. Alignment to Describe = STH25BetFit
 I. If you know the alignment but don’t want to scroll through the list and find 

the name click the Select button to choose it graphically from the screen.
 B. Output Filename = 12345678\ConstData\CD-Design\CD-Align\12345678-DESC-

Ali.csv  
 4. Create Report
 5. If Excel opens review the file and close Excel.

Export alignment superelevation CSV files

Last updated: 2017-06-06

Total video time: 05:02

Exercise files: cntrctr-data-C3D14.zip

Export alignment superelevation CSV files

cntrctr-data-xprt-ali-supr-csv-01.mp4 1:57

 1. Open drawing file 12345678\Design\AliProf\AliProfSTH25-Best-Fit.dwg
 2. Select the centerline alignment STH25BestFit graphically.
 3. Green context ribbon > Modify > Superelevation button > from the drop down 

choose View Tabular Editor
 4. Tabular Editor panorama > select the Export Superelevation Data icon

 5. In the Export to CSV dialog browse to the project 12345678\ConstData\CD-Design\CD-
AliProf and type in the filename 12345678-Super-AliProf.csv
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 6. Save

Clean up alignment superelevation csv file

cntrctr-data-xprt-ali-supr-csv-02.mp4 3:05

Info: If your design has no “inside” lanes or shoulders (non-divided design) you 
will need to delete extra columns from the csv file.

 1. Ope file 12345678\ConstData\CD-Design\CD-Align\12345678-Super-AliProf.csv
 2. Review this file. It had superelevation data for both the outside lanes and shoulders as 

well as the inside lanes and shoulders. Nothing needs to be cleaned out of this file.
 3. Ope file Superelevation Example.CSV
 4. Select the Column G header (Left Inside Lane) then CTRL + select following columns:

 A. Column H (Left Inside Shoulder)
 B. Column K (Right Inside Lane)
 C. Column L (Right Inside Shoulder)

 5. Right-click > Delete to remove  columns.
 6. Save  

Export cross-section slope stake files

Last updated: 2017-06-06

Total video time: 03:23

Exercise files: cntrctr-data-C3D14.zip

cntrctr-data-xprt-xs-slp-stk-01.mp4 3:23

Run the slope stake report

 1. Reference FDM 19-10-43 Att. 43.3
 2. Open drawing file 12345678\Design\Quantities\Earthwork-STH25.dwg
 3. Toolspace > Toolbox tab >  WisDOT Toolbox > WisDOT Reports >  Other Reports > 

right-click on Slope Stake > choose Execute
 4. In the Slopestake Report dialog make the following selections:

 A. Baseline Alignment = STH25BestFit
 B. Sample Line Group = SLG-STH25BestFit
 C. Surface = STH25-RoadwayModel-Datum
 D. Output Filename > Browse > browse to the project folder 12345678\Con-

stData\CD-X-Section > 12345678-Slp-Stk-STH25BestFit.csv
 E. Create Report
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 5. If the Excel file opens, review it then close it.

Info: Refer to the Slope Stake Report training for more details

Zip ConstData for delivery

Last updated: 2017-06-06

Total video time: 01:43

Exercise files: cntrctr-data-C3D14.zip

cntrctr-data-zip-constdata-for-dlvry-01.mp4 1:43

Zip ConstData for delivery

Zip the ConstData folder

 1. Right-click Windows Start button (lower left of screen) > Choose Open Windows 
Explorer > Browse to the project 12345678 folder > Right-click on the ConstData 
folder > choose WinZip (or whichever zip program you have) > From the Zip fly out 
menu choose Add to ConstData.Zip

 2. OK
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Rename the ConstData.ZIP file

 1. Windows Explorer > right-click on the ConstData.ZIP file > Rename
 2. In the file name field type 12345678-Contractor-Data.
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